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Preface

Preface
This preface introduces information sources that can help you use the application and this guide.

Using Oracle Applications
To find guides for Oracle Applications, go to the Oracle Help Center.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website.
Videos included in this guide are provided as a media alternative for text-based topics also available in this guide.

Diversity and Inclusion
Oracle is fully committed to diversity and inclusion. Oracle respects and values having a diverse workforce that increases
thought leadership and innovation. As part of our initiative to build a more inclusive culture that positively impacts our
employees, customers, and partners, we're working to remove insensitive terms from our products and documentation.
We're also mindful of the necessity to maintain compatibility with our customers' existing technologies and the need to
ensure continuity of service as Oracle's offerings and industry standards evolve. Because of these technical constraints,
our effort to remove insensitive terms is ongoing and will take time and external cooperation.

Contacting Oracle
Access to Oracle Support
Customers can access electronic support through Oracle Support. For information, visit My Oracle Support or visit
Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions
Please give us feedback about Oracle Applications Help and guides. Please take one of the following surveys:
• For web-based user guide, Web-based User Guide Survey
• For tutorial feedback, Tutorial Survey
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Your Company’s Configuration
You can configure Oracle Field Service to your specific business requirements, such as the type of work performed, the
kinds of skills available for assignment, the way in which working calendars are organized, and so on. You can configure
the settings for all these requirements on the Configuration page.
Most configuration settings are available on the Configuration page. However, depending on the way you have
implemented the application for your company, some of the settings might be placed in individual menu items or
grouped under different menu items. Your user type configuration determines the options displayed on the menus.
The configuration elements are grouped logically on the Configuration page:
• General (the settings related to the general principles of the company operation):

◦
◦
◦
◦
◦
◦

About
Business Rules
Link Templates
Work Schedules
Work Zones
Work skills

• Resources, Activities, Inventories (the settings related to the resources the company employs, the activities it
performs and the inventory used in the course of their performance):

◦
◦
◦
◦
◦
◦

Properties
Capacity Categories
Time Slots
Resource Types
Activity Types
Inventory Types

• Displays (the settings related to the general appearance of the application, page layouts, languages and
translations):

◦
◦
◦
◦
◦

Glossary
Display
Themes
Filters
Forms & Plugins

• Users, Security, Integrations (the settings related to user management and system access):

◦

Organizations
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Login Policies
User Types
Applications
Oracle Knowledge
Integration Cloud Service

• Subsystems (the settings related to Oracle Field Service modules):

◦
◦
◦
◦

Statistics
Outbound Integration
Collaboration
Message Scenarios

Items are added only to the groups listed earlier. Each item, when clicked, leads to the corresponding configuration
page.

Configuration Page Access and Visibility Settings
You can allow or deny access to the Configuration page for each user type. This means, all users of that type either
have the Configuration item in their menu or not. The visibilities that set the user access to this page are hidden, readwrite, and read-only.
You can configure the items and their visibilities on the Configuration page in a dedicated context layout,
Configuration. Similar to other context layouts, you can configure the Configuration page for each user type.
This means that all users of the selected type see the same items on the page with the same level of visibility. The
Configuration context layout can include only the company configuration items. Therefore, the Add property
dialog box contains only the list of items related to company configuration. The reverse is also true—the company
configuration items are not included in the action list of any other context layout.

Configure Business Rules
Business Rules help you configure the application to suit your requirements.
The Business Rules visibility profile permission controls the access to the Business Rules page. You must set this
permission for each user type that manages Business Rules. If the action is not configured for a user type, or if no
visibility is defined, the users don’t see the Business Rules page. If you select ReadOnly, Business Rules is placed into a
view-only mode. If you select Read/Write for this setting, the user can manage Business Rules in Oracle Field Service.
1. Click Configuration.
2. In the General section, click Business Rules.
The Business Rules page appears.
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3. Complete these fields:
Field

Description

General
Work Skills Support

If a feature is disabled (unselected) the settings defined for it are retained in the application, but

Work Zones support

no restrictions are applied.
Work skills and work zones are critical settings greatly affecting performance, particularly,
activity assignment to resources. When they are enabled, they impose these constraints on the
process of activities assignment and reassignment:

◦
◦
◦

Routing takes into account work skills and work zones and assigns activities only to
resources matching the work skill and work zone requirements of the activities.
All newly-created activities have work skills and work zones calculated for them and,
therefore, will be correctly assigned afterwards
Self-assignment, Quota management, manual activities move or assignment are
subjected to work skills and work zones check

All these factors contribute to higher application performance and help improve the use of
the workforce. Disabling work skills support and/or work zones support may result in Routing
results below optimum and, therefore, must be used with care.

Service Window Support

If selected, by default the Service Window placeholder is selected when an activity or
teamwork is created (must be defined).

Points Support

Select the box if you use points. When points are used, each shift and corresponding work
schedule is assigned a certain number of points, which are a relative expression of the required
work to be performed within such work schedule. Similarly, each activity may be also assigned
a certain number of points. As the resource completes activities in their route, their points are
added and compared to the total number required for the work schedule. Points may be used
by Routing in activities assignment.

Overnight Work

The number of hours for overnight work since midnight. Use only if you have overnight work
activities. Select the time zone that is used to define when your work-day closes. If the value is
greater than 0, it is possible to create activities for the previous day’s route and perform other
route modifications based on the time zone setting value.
Working time ____ hours since midnight <…..>
This setting affects the logic of data saving by the Daily Extract functionality. If the company
does not support overnight shifts, the extraction period covers time since the previous
extraction till the end of the previous day. If the company supports overnight shifts, the Daily
Extract data for the previous day is available for extraction after the overnight setting expires,
that is, at 00:00 AM + overnight. If the data is extracted before that time, the resulting files
contain data from two days before. It is recommended to schedule the Daily Extract process
several minutes after the overnight setting expires to guarantee that only the relevant data is
extracted.

Full-time Equivalent

Used in the Planning section of Calendars. The value is a company wide setting. The value
converts the calendar to a Full-time Equivalent resource. For example: If the resource works
from 08:00-16:00 (8 hours) and the Full-time Equivalent value = 8 this resource will be shown
as 1 Full-time Equivalent.
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Field

Description

Expose mass and repeating activities

The number of days in advance in which the template activities are created in technicians’

for these number of days

routes automatically.
The default value is '0', which means that such activities are not instantiated automatically, but
are created only when a route is created. When you modify the value and save it, Oracle Field
Service scans all the technician routes and instantiates the templates for the dates that match
the configured period. If you increase the value, then the application includes more dates into
consideration for automatic instantiations. If you decrease the value, then the application does
not remove the existing instantiated activities, instead processes fewer dates from then on.
When you add a new resource or change the templates and schedules, the application changes
the activities accordingly.

Note: Instantiating activities may require significant time, especially if you increase the
value and there are many technicians in the application. It also generates a significant
amount of transactions such as events (routeCreated, activityCreated) and outbound
messages for the "Activity is created" launch conditions.

Activity Priority

Activity priority is used by Routing to assign urgent activities, immediate activities, and to
prioritize activities for self-assignment on the map. You can use any custom property of activity
with type string, enumeration, or integer, but not fields. The configuration consists of these
parameters:

◦

Property to define priority: Defines the activity property that will be used to identify
urgent, immediate, and self assignment activities.
Urgent activities have these values of the property: Defines the specific values of
the property, which make the activity urgent or immediate. Several values of the same
property can be used as criteria. In this case the values must be separated by commas
in the field. The order of property values defines the priority level. The value listed first
will have the highest priority, with other values following in the descending order. For
example, if you have a privileged customer, you may specify it as a specific value (such
as "PC") in an activity property, so it qualifies the activity as urgent. For enumeration
properties, you must specify the enumeration values.
Normal activities have these values of the property: Defines the specific values of the
property, which make the activity normal. For example, in-house activity selected as "IN"
in an activity property may qualify the activity as normal.
When activities are routed using the immediate routing run option or the urgent routing option,

◦

◦

the priority specified in the field that you select here are considered. For example, a company
must always perform repairs as soon as possible to reduce service disruptions. In this case,
the company may have a custom property which indicates that the activity is "Repair" to
consider an activity as urgent. The preferred ETA for Urgent activities is the earliest possible
time. SLA start time does not have any impact on Urgent activities, which means, SLA violation
is expected behavior. Further, even if you select Immediate routing, SLA start time does not
have an impact on the Urgent activities ETA.
Enable the Visit functionality

Define Bundling Keys for a Visit

Visit Bundling Keys

Define Bundling Keys for a Visit

Maps and Geocoding
Available Countries

Geocoding is the process of finding associated geographic coordinates (latitude and longitude)
from other geographic data, such as street addresses, or zip codes (postal codes). Geocoding
data is required for Routing and is critical for Map/driving directions.
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Description
Proper geocoding information is necessary for every country that this instance of the
application is operating within. The Available Countries field allows adding additional countries
for geocoding purposes.
Select the + symbol to select an additional country form the drop-down list. Select the pencil
icon to edit the country name for localization purposes.

Default Country for Geocoding

Determines from which country the Available Country list above is used as the default country
for geocoding.

Zip Code Format

Defines the format of ZIP (postal) code and state code values, when applicable. Both fields
are used in the activity coordinates resolution from its geographic address. The ZIP value is
validated by the Inbound API, therefore, its format is important. When the ZIP value sent by
the Inbound API does not correspond to the format set in the Business Rule, the API returns an
error. However, when the Free Post code option is selected, the ZIP value is not validated and
will always be accepted.

State Format

The State format field includes Free format and US. Select US for addresses in the USA having a
strict 2-letter state code format. For all other countries with different civil entity systems, select
Free.

GPS

Identify technician by – Determines how a unique technician is identified within the context of
GPS plotting.
These items are applicable with Oracle Field Service Smart Location Cloud Service:

◦
◦
Map Parameters

Resource is considered idle if moved less than __ meters within _- minutes
Resource is considered to be at the activity location if the distance is less than __
meters -

Defines the items related to the Map page:

◦
◦
◦

Distance Measurement Units: Specifies whether distance is measured in miles or
kilometers.
Ignore coordinates with accuracy less than: Sets the minimum sufficient accuracy level
for geocoding. The minimum sufficient accuracy level is the coordinate’s accuracy which
is considered acceptable for usage. The coordinates below the specified level will not be
used as insufficiently accurate.
Baidu Maps and Geocoding parameters: Indicates the server key and browser key for
Baidu maps, which are used to authenticate the user or organization using the service.

Note: Driving directions for Oracle map and geocoding are only shown in these languages:
(English (default), French, German, Italian, and Spanish). The default maps and geocoding
provider is Oracle. Google or Baidu can be used, if it is part of your subscription. To use
Google or Baidu maps, contact Oracle Sales. Further, you can have only one provider (Oracle,
Google, or Baidu) configured in the application. Information about the geocoding provider is
displayed on the Configuration > About page, Enabled Services section.

Map Layers

Lets you add two types of map layers: Work Zone layer (work zone shapes) and custom map
layers (for example, places of interest such as gas stations or gas pipelines) on top of the map.
You can add a Work Zone layer or a new map layer, modify or delete an existing layer, and
change the permissions for an existing layer. When you click Add new, the Add Map Layer
dialog box appears. You can either upload shape files through the interface or through an API,
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Description
or you can provide the path to MapViewer from where the custom layer is obtained. You also
see these sections:

◦
◦
◦

Status: Indicates the status of the layer. If the shape file is uploaded successfully and is
ready for use, the status displays a green check mark. If the shape file is not uploaded
properly or has any errors, the status displays a red cross mark.
Map layers: Provides the name of the map layer and the date on which it was last
updated. If the map layer is not available, this column provides the reason such as: Shape
loading failed.
Permissions: User types to which the layer is assigned. If there are multiple user types,
they are displayed as, ‘<user type> and <number> more’. For example, ‘Technician and 3
more’. This column is empty for the Work Zone layer.

Note: The Permissions option is not available for a Work Zone layer.
Properties of Work Zone layers:

◦
◦
◦

Nearby Radius and Nearby SLA

Each Work Zone can have only one map layer, and if it does not exist, the message, No
configured layers appears.
You can create only one Work Zone layer. After a Work Zone layer is created, the Create
Work Zone layer option is grayed out on the Add map layer dialog box and the message
"Only one layer for work zone shapes can be created" is displayed.
When you delete a Work Zone layer through the metadata API, only the layer is deleted.
The shape files are not deleted from the database. However, when you delete a Work Zone
layer from the Manage interface, by selecting the Delete associated shapes option, the
layer and its associated shapes are deleted.

Defines the criteria of the nearby activities search on the Nearby page. It does not affect the
Scheduling layer on the Map page. The Scheduling layer shows all activities in the visible part of
the map.
The Nearby Radius value sets the radius of the circular area in which nearby activities is to be
searched. The Nearby SLA parameter sets the SLA expiration period which activities must have
to match the search criteria. The default values are 50 kilometers as the radius and 60 days as
the SLA. The minimum values are 1 km and 1 day, respectively. The maximum values are 1000
km and 1000 days, respectively. As the result, the functionality searches a circular area with
the center in the resource location and the radius equal to the Nearby Radius value, selecting
the activities with SLA expiring within the period defined as Nearby SLA. Any activities not
conforming to these criteria will not be included in the search results.

Company Boundaries

The latitude and longitude coordinates of the company’s geographical work area. Activities can
be performed only within these boundaries that are a set of squares. To identify a square, its
top left and bottom right corners are defined. If no boundaries are defined the company can
perform work anywhere. Additional boundaries can be added by clicking the + symbol.

Retention period
Activity, Inventory, Service Request and
History information

The retention period for the activities in the past, customer related inventory, service requests,
and the associated activity history. It also includes the service requests, messages, logs such
as activity history, quota history, configuration log, changes to resources and users. The default
value is 90 days. You can set a value between 1 and 90 days. The background data purge
process takes into account the updated value whenever the process runs the next time. If the
difference between the changed numbers is huge (for example, you change from, 90 to 3 days),
the purge process may take up to 24 hours.
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Description
CAUTION: Do not set the value to 1 (one), if you have set the 'Overnight work' setting on
Business Rules to a number greater than 0 (zero). If you do so, your data may be purged
before the Daily Extract process runs.

Collaboration History

The retention period for Collaboration chat history. The default value is 90 days. You can set
a value between 1 and 90 days. The background data purge process takes into account the
updated value whenever the process runs the next time. If the difference between the changed
numbers is huge (for example, you change from, 90 to 3 days), the purge process may take up
to 24 hours.

Resource Position History

The retention period for the resource's GPS coordinates. Resources locations are extracted as
part of the Daily Extract process. You can retrieve them through the 'Get last known positions
of resources' and 'Get position history for resource for certain date' Core API requests. The
default value is 90 days. You can set a value between 1 and 90 days. The background data
purge process takes into account the updated value whenever the process runs the next time.
If the difference between the changed numbers is huge (for example, you change from, 90 to 3
days), the purge process may take up to 24 hours.
Note: The value for this field must be less than the value for 'Customer, resource and user
information'. As part of the background data purge process for 'Customer, resource and user
information', information about queues are also removed. Resource locations are gathered at
the queue level, so they cannot be shown on the page when the queue is removed.

Daily Extract files

The retention period for files that are generated by the Daily Extract process and retrieved
through the 'Download daily extract file' Core API method. The default value is 90 days. You
can set a value between 1 and 90 days. Updated value is taken into account for when the Daily
Extract files are generated the next time. The retention period for existing Daily Extract files is
the period that was defined when files were created.

Quota Management
Quota Management

These items are applicable with Oracle Field Service Capacity Cloud Service:

◦

Measurement units for Quota and Available Capacity
Defines the general settings affecting Quota Management functionality. Particularly, the
user can choose the units of measurement to display Quota and Used values by setting
the Quota and available capacity are defined in parameter. The available values are hours,
man-days and minutes. Internally, all values are calculated in minutes anyway, and are
converted to the selected unit when the corresponding value is displayed in the Quota
View.
When man-days is selected as the unit of measurement, the Number of hours per man
day is field appears where the correlation between man-days and hours can be defined.
Ultimately, this parameter is used to convert man-hours into minutes.
When the Quota is defined as percentage of the capacity available by calendar, sometimes
it requires adjustment. To adjust the value, the system estimates the capacity available by
calendar, processes the already booked activities (to calculate the Other activities value),
and, finally, recalculates the Quota in minutes using the defined percentage value.
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Description

◦

Recalculation period
You can set a predefined time interval for Quota and Capacity recalculation using the
every [ ] minutesfield.
Valid values: 1 to 1,440 minutes
Default value: 10 minutes
Also, you can recalculate quota and capacity for a predefined future period (defined as
days or calendar weeks). For example, if you enter 10 minutes and set 3 calendar weeks for
Quota and Capacity recalculation, then the recalculation occurs after every 10 minutes for
3 calendar weeks.
The Calendar Week (duringdrop-down list) option is processed based on the value
selected from the First Day of the Weekdrop-down list in the Display page.
When you use the Calendar Week option, all remaining days of the current week (unless
the start day is the week start day selected using the First Day of the Week drop-down
list) plus all days of these weeks are considered.
However, if the recalculation period is set to 7 days, the recalculation is performed for
7 days only. The maximum value for the Calendar Week option is set to 99 days or 15
calendar weeks.
You can select the recalculation start day (current day, tomorrow, or day after tomorrow)
from theThe Corresponding quota values are automatically adjusted starting from
drop-down list.
The Quota and Capacity is recalculated for the Available Capacity, Booking Status, and
Quota pages.

Note: When an activity is booked during the predefined recalculation period, then
irrespective of the routing schedule and the specified recalculation period, the values in the
Available Capacity, Booking Status, and Quota pages are recalculated immediately.

Capacity Intervals

See Define Time Intervals section in the Oracle Field Service Capacity Cloud Service Guide.

Search Fields

Define the Activity Search Fields and Define the Inventory Search Fields
Note: Search uses the first 40 characters of the search string. Inventory search does not
support enumeration type fields.

Related Topics
• Add a Map Layer

Configure Activity Map Markers
You can configure map markers to differentiate between the non-scheduled and not assigned activities that are
displayed on the Scheduling layer on the Route map and on the Dispatch Console map.
1. Click Configuration > Business Rules .
2. In the General section, go to Non-scheduled Not assigned activity map markers.
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You can see that Urgent (red big circle) and Other (yellow small circle) are available by default.
3. Click the pencil icon.
4. On the Activity map markers dialog box, click the plus icon, and complete these fields:
Field

Description

Activity Markers

The predefined shape to indicate the activity.

Filter

The condition to display the activity. All the filters that are configured on the Configuration >
Filters page that satisfy these conditions are displayed here:

◦
◦

The entity is Activity.
The List/Time/Map/Daily check box is selected.

If you have selected a dynamic field such as Activity type or Work zone, a field appears below
Filter to add the value. You can use the same marker with multiple filters.
Filter value

The value for the condition. For example, if you have selected Activity type for Filter, select
Installation for the Work Type. You can use the same filters multiple times, with different
conditions. For example, you can use the Days to SLA filter with conditions equal to 2 or 7.

5. Click OK. Repeat steps 4 and 5 and add more markers.
You can add a maximum of 10 markers.
6. Use the stack icon to reorder the markers.
The first marker in the list gets the highest priority, the second marker gets the second priority and so on.
When multiple activities are displayed in a cluster on the map, the application determines the marker based on
the priority assigned to it.
Note: You cannot reorder Urgent and Other markers.
7. Click the minus icon to delete a marker.
8. Click OK on the Activity map markers dialog box.
9. Click Save on the Business Rules page.

How Geocoding Works
Oracle Field Service attempts to geocode a location using the address data that is provided when the activity is created.
The application uses these fields when attempting to geocode the location:
• Address (caddress)
• City (ccity)
• State (cstate)
• Zip/Postal Code (czip)
• Country (country_code)
Data provided in these fields are submitted to the geocoding service without any modification or manipulation. When
the geocoding service resolves a location, it returns a response with an accuracy level. In understandable terms it is
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accurate up to the address, accurate up to the street, and accurate up to the city. The location is resolved based on the
selection made in the Ignore coordinates with accuracy less than setting on the Business Rules page. For example:
• If the value for Ignore coordinates with accuracy less than is Address, and the geocoding service returns
Accurate up to the Intersection, the location is not resolved, because the lowest acceptable level based on the
configuration is Address.
• If the value for Ignore coordinates with accuracy less than is Intersection and the geocoding service returns
Accurate up to the Address, the location is resolved, as it exceeds the lowest acceptable level based on the
configuration of Intersection.
Ignore coordinates with accuracy less than includes these options in descending order:
• Address: Indicates an accuracy level of the exact premise. Usually requires an exact match of the address
(including house number, street name, street type/suffix/prefix), city, state, zip, and country.
• Intersection: Indicates an accuracy level of a major intersection, usually of two major roads.
• Street: Indicates an accuracy level of a street.
• Route: Indicates a named route (such as US 101). This may not apply to all countries.
• Zip: Indicates an accuracy level of the zip/postal code. May also require a city name and country match.
• City: Indicates an accuracy level of the city. May also require the country name to be matched.
• County: Indicates an accuracy level at the county level. This type may indicate a minor civil administrative level.
Not all countries have this type of administrative levels.
• State: Indicates an accuracy level at the state level. Within the United States, these administrative levels are
states. Not all countries have this type of administrative levels.
• Country: Indicates an accuracy level of the country. If you update an existing activity (with resolved coordinates)
with a new country_code, the coordinates for the activity are reset to zero (acoord_x=0, acoord_y=0).
The better the data quality, the more likely the location is resolved. For example - if you submit “10 Henr St Chartley, MA
02712”, the accuracy level will most likely result in something less then an accuracy level of Address, because Henry is
misspelled. Other items to watch out for are extra characters or spaces in the fields, missing or wrong address prefix
or suffix, abbreviations that don't match postal guidelines, a new address that is not in any geocoding service, wrong
data (wrong zip/post code or street name), and partial data. Any of these items can cause challenges with resolving an
address.

Best practices
• We strongly recommend that you send us the geo-coordinates when you create activities. This ensures that
the coordinates are available for use in the application. Send the values using Coordinate X (acoord_x) and
Coordinate Y (acoord_y).
• For the activities associated with the Activity Types that have the Calculate travel option selected, we
encourage you add and populate address fields. This helps the application use the information to make the best
possible decision.
• We recommend setting the Ignore coordinates with accuracy less than to Zip. Any other settings may result
in fewer locations being resolved or too many locations resolved with a low level of accuracy.
• don't include additional address elements in the Address (caddress) field. The element includes but is not
limited a business name, unit, flat, suite, floor number, and so on.
• Avoid uncommon abbreviations, or abbreviations that are part of a defined standard used by the postal
authority. It is possible that “Ave”, “Ave.” and “Avenue” can lead to different accuracy resolutions.
• You may have to experiment to find the best way to send address data to Oracle Field Service.
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Add a Map Layer
Map layers are layers that are added on top of a map to identify places of interest that are specific to your business. For
example, you may add a layer that shows only the airports in a specific area. You can add layers through an external
source or internally through APIs. You can use APIs or you can upload a file from your local device to upload shape files
for each layer. You can also add a layer for your work zone, which is visible to all users.
If you are adding a map layer internally, you must upload the shape file through the metadata API.
Note: Work Zone layers are not displayed on the Map view.
1. Click Configuration.
2. In the General section, click Business Rules.
3. In the Maps and Geocoding section, click Add new.
The Add Map Layer dialog box appears.
4. Select whether you want to create a Work Zone layer or a map layer.
You can add only one Work Zone layer; after you add it, the Create work zone layer option is grayed out.
5. Enter the name of the layer in the preferred language.
The languages displayed here are the languages that you have selected for Company language in the Display
page. This option is not available for the Create work zone layer option. The application adds the name ‘Work
Zone Layer’ automatically and translates into the required languages.
6. Add a label for the custom layer in the Label field.
If you have added a custom layer through the metadata API, the name is suggested as you type it. If you have
not added any layer through API and you don't add an external source, you cannot save the layer. This option
is not available for the Create work zone layer option. The application adds the name ‘wz_layer’ automatically
and translates into the required languages.
7. Select the status of the layer in the Status drop-down list.
A layer with the Active status is available and a layer with the Inactive status is not available. This option is not
available for the Create work zone layer option.
8. Select the location from which you want to use the shape for the layer:

◦
◦

◦
◦

Upload local file: Select this option to upload a shape file from your local device. You must select a zip
file that doesn't exceed 150 MB. If the file is not a valid zip file, or if the zip file exceeds 150 MB, an error
message is shown. You must correct the errors and upload again. Oracle Field Service stores this file until
you delete the layer with the associated shape file.
Upload file using URL: Select this option to upload a shape file that is available on a different computer.
These fields are displayed:
- URL to shape file: Enter the URL to the location where the shape file is available. Use only a secure
protocol, that is, a HTTPS URL.
- Username and Password: Enter the username and password to access the shape file location.
- SRID: Enter the shape identifier that was generated in the application in which the shape was
created.
Upload shapefile later via API: Select this option to upload a shape file through API.
Use already uploaded shape: Select this option to use a shape that is already uploaded. The list of
available shapes is displayed and these details are displayed:
- Layer label: The label of the layer.
- Last updated: The date on which the shape file was last updated.
- Source URL: The URL in which the shape file is uploaded.

11

Oracle Field Service

Administering Oracle Field Service

◦

Chapter 1

Configure the General Settings

Use external data source: Select this option to use an external data source to display custom layers.
This functionality requires Oracle MapViewer where the layers are created and stored. These fields are
displayed:
- MapViewer URL: Path to MapViewer from where the layer data is obtained.
- Data source: The source of the map layer data used by MapViewer.
- Theme: Layer name in MapViewer.

All the fields are mandatory. If a field is left empty, the window is rejected with the error message:
{field_name} is empty.
9. Click OK and then click Save on Business Rules.
By default, users of all user types have access to the new custom layer. If the status is Active, the application
verifies if:
◦ Data for this layer is present in the database.

◦
◦

Data is consistent and not corrupted.
There are no errors when displaying the layer on map.

If these conditions are satisfied, the layer is saved and displayed on the team map, activity list, and activity
details map pages.
Review this information before uploading shape files:
Requirements for the shape file:
• The shape file must be in a zip archive.
• Column names in the shape file must contain only alphanumeric characters and underscore ('_').
• Column names must begin with an alphabet.
Shape file restrictions:
• When uploading a shape file using HTTPS, these restrictions apply: WebLogic's default certificate validator
does not accept certificates with wildcards (including Google Drive certificate).
• SRID value should be a valid SRID.
• A maximum of 2 GB is available for extracted shape file data that is uploaded and hosted in Oracle Field Service.
• If a shape file contains a column with the name "SHAPE_AREA" (case insensitive), it is renamed as
“SHAPE_AREA_".
• If a column name is same as an Oracle Database reserved word, then an underscore ("_") is prefixed to the
column name. The full list of Oracle Database reserved words is available at: Oracle Database Reserved Words.
Recommendations:
• It is recommended that you use shape files with compressed data size less then 50 MB. The shape file data is
extracted and stored in the browser memory (when showing to end user), so the size of the file may heavily
influence the browser performance, including the inability to show the map layer.
• It is not recommended to use polylines for work zones.

Display a Work Zone Layer on a Map
You can display a Work Zone layer on the map, only if you have added it to the Business Rules page. Before you display
a layer on the map, you must select the shape identifier on the Edit Map Layer dialog box. The shape identifier helps
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you identify the shape when you are working on a different page. For example, the shape identifier can be the internal
serial number.
1.

Note: In the list of possible shape identifiers, attribute columns are shown with only unique values (no
duplicates).

1. To select the shape identifier:
a. Click Configuration > Business Rules .
b. Go to the Map layers section.
c. Click Modify against the layer for which you want to add the shape identifier.
d. In the Edit Map Layer dialog box, select a value in the Shape Identifier drop-down list.
2. To display the Work Zone layer on the map:
a. Click Configuration > Work Zones .
b. Select or create the work zone for which you want add the shape identifier.
c. Add the value of the shape identifier in the Work Zone Shapes field.
d. Click Update or Add.
The work zone shape corresponding to the selected shape identifier is displayed on the map.

Update Shape Properties
After you upload a shape, you can modify its properties such as visibility on the Map hint.
1. Click Configuration.
2. In the General section, click Business Rules.
3. In the Map layers section, click the stack icon next to layer that you want to modify and click Modify.
The Edit map layer dialog opens and displays the information in the Layer info and Shapes sections. The
information in the Shapes section depends on the way in which you have uploaded the shape.
4. Select a title for the shape in the Shape title column drop-down list.
This title is displayed for the shape on the Map view.
5. Click Shape Hint Button and select a plug-in or custom form.
The name of the plug-in or custom form that you select here is displayed as a button (link) in the custom map
layer hint. When a user clicks the link, the plug-in or form opens. To delete a plug-in or a custom form that is
configured for a custom map layer, you must clear 'Shape hint button' field.
To send parameters to the plug-in or custom form, specify the values in the Plugin/Form Field column in the
Shape Hint table. This maps the fields in the shape file to the parameters in the plug-in or custom form. For
plug-ins, the parameters are sent as additional parameters within the 'openParams' section. For custom forms,
the fields are populated based on the specified names.
To send the coordinates of the point where the user clicked on the map to the plug-in or custom form, specify
the corresponding parameters in Plugin/Form Field column.
6. Fill up these fields in the Shape hint columns section:
Field

Description

Visible on hint

Select the check box if you want to display the property in the hint on the Map view.

Latitude and Longitude

Enter the name for Latitude and Longitude in your plug-in or custom form. These fields capture
the coordinates of the point where the user clicked on the map.

Source

Asset property as defined in the shape file.

13

Oracle Field Service

Chapter 1

Administering Oracle Field Service

Configure the General Settings

Field

Description

Label

Enter a meaningful name for the property in the hint.

Plugin/Form Field

Enter the name of the property that maps to the corresponding source field. This column is
visible only when you select 'Shape hint button'. The parameter that you specify in this column
is sent to the configured plug-in or form upon opening.

7. Click Submit and then click Save on Business Rules.
The changes are saved.

Assign Permissions to a Map Layer
When you upload a shape, by default it is available for all user types. You can change the permissions as to which users
can see which shape.
1. Click Configuration.
2. In the General section, click Business Rules.
3. In the Map layers section, click the stack icon next to layer that you want to modify and click Permissions.
The Select user types dialog appears. By default, all the user types are selected.
4. To remove access to the selected layer, click the minus icon next to the user type.
5. To provide access to a layer, click the plus icon. Select the check boxes next to the user types to whom you want
to provide access.
6. Click Save.
The changes are saved. The updated permissions come into effect the next time the user of the corresponding
user type logs in.

Delete a Map Layer
You can delete just a map layer, or a layer and its associated shape files. You can delete the layer using the metadata
API, or through the Business Rules page.
1. Click Configuration > Business Rules .
2. Go to the Map layers section.
3. Click the menu on the right against the layer that you want to delete and click Delete.
The Delete map layer dialog box appears.
4. To delete just the layer, click Delete.
If you go to the Add map layer dialog box and select the Use already uploaded shapefile option, the shape
file that was related to the deleted layer is displayed in the list.
5. To delete the layer and its associated shape files, select Delete associated shapes and then click Delete.
If you go to the Add map layer dialog box, the Use already uploaded shape file option is not available. This is
because, the shape file that was associated with deleted layer was removed from the Geospatial Database.
6. Click Save on the Business Rules page.
Note: Deleting a layer and its associated shape file is possible only through the Core Application interface.
The metadata API DELETE method removes only the layers from the database.

Download a Shape File that was Uploaded from a Local Device
Sometimes, you may want to download a previously-uploaded file to edit and upload as a new layer.
1. Click Configuration > Business Rules .
2. Locate Map Layers.
3. Click the stack icon and then click Modify against the layer from which you want to download the file.
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4. Click the filename in the Source file field.
The file is downloaded to your local device.

Define Bundling Keys for a Visit
Oracle Field Service sends configured notifications for each activity separately. If several activities (appointments) are
scheduled on the same day for a customer and you want to send one notification of each kind (for example, day before,
reminder, or change notifications) to the customer, then select the Enable Visit Functionality check box to activate the
Visit functionality.
Use the Visit Bundling Key field to define the criterion for a visit. The criterion can include an activity property field,
where you can set the length of the property values and determine whether the property values are case sensitive.
The application compares the values defined in the activity fields against the specified criterion. Activities are grouped
together as a visit, only if the values of all visit bundling keys match the specified criterion. To ensure that external
system messages are sent properly, you must add a launch condition using visit triggers while configuring message
scenarios.
Note: A single activity can appear on the Links tab with a Visit ID if the Visit bundling criteria are met.
When routing is run using Immediate Assignment and if the Bundling setting is used (only available in Immediate
Assignment routing), then the Immediate Routing plan uses the Visit Bundling key for route optimization. For example,
when you use the activity address as a bundling key and run routing for urgent activities, then routing finds activities
that are on the same address as the urgent activity to create visits. For more details, refer to the Immediate Activity
Assignment section in the Oracle Field Service Using Routing Cloud Service Guide. After you define the visit bundling
keys, click Save to recalculate the existing activities according to the new visit settings. To define bundling keys for a
visit:
1. Click Configuration.
2. Click Business Rules in the General section.
3.
4.
5.
6.
7.
8.

The Business Rules page appears.
Select the Enable the Visit functionality check box.
Click the Modify icon.
Click the Plus icon.
Select the required keys.
Click Add.
Use these filters to specify additional criterion for grouping activities:

◦
◦

Length: Enter an integer value between 0 to 99. For example, if you enter 5, then the first 5 values of the
activity property are considered.
Function parameter: Select a parameter to determine whether the activity property values are case
sensitive, case insensitive, first word case sensitive, first word case insensitive.
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9. Click Save.
Note: If there are already visits in the system, and if the visit bundling keys are changed, then after
recalculation, the visits no longer matching the keys are split into individual activities. ‘Not Done’ status for a
visit is defined as follows:
◦ All the work orders in the visit have final statuses.

◦

A 'notdone' visit either contains a 'notdone' work order or several work orders with 'completed'
and 'cancelled/deleted' statuses.

Example of How to Define Bundling Keys for a Visit
Assume that an installation activity is scheduled for a customer on 21st June, 2016 and is the only notification you send
to the customer. The installation activity involves the activities, installing the hardware and installing the software but
you want the customer to receive only one notification.
Assume that installing the hardware is assigned to technician William and installing the software is assigned to
technician Philip. Both activities are scheduled on the same day at 4 to 5 pm and 5 to 6 pm respectively. Assume these
details for the customer:
• Account number: 123456
• Address: 77 Discovery Drive, Bozeman, Montana 59718
Since both the activities are performed on the same day for the same customer and at the same location, and the goal
is to notify the customer only once, it is necessary to bundle the activities together and schedule a visit. Let us select
Account Number and Address properties as the bundling keys from the Configuration, Business Rules page and click
Save. Since the values defined in the activity fields (that is, Account number and Address) match the selected criteria
(that is, Account Number and Address properties selected as the bundling keys); the activities, installing the hardware
and installing the software, are grouped together as a visit. To verify whether the activities are grouped as a visit:
1.
2.
3.
4.

Select Dispatch, Activities.
Select the technician William from the resource tree.
Select the Installing the hardware activity from the dashboard and view the activity details.
Select the Links tab.
A Visit number is displayed with the Pending status.

5. Repeat steps 1 through 4 for the Installing the software activity.

Define the Activity Search Fields
The application uses the activity property fields defined in the Search section of the Business Rules page to search for
activities.
You can also edit the activity property fields in the Search section of the Business Rules page to define additional
search fields to search for activities. For example, assume that the activities are searched using the Name and Account
Number activity fields. Now, you want to search the activities using the Address activity field. You can specify an
additional search field as follows:
1. Click Configuration.
2. Click Business Rules in the General section.
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The Business Rules page displays.
3. Click the Edit icon for Activity Search fields in the Search section.
4.
5.
6.
7.

The Activity Search Fields dialog box displays.
Click the Plus icon.
Select the Address field.
Click Add.
Click OK.
The Address field displays in the Activity Search Fields section.

8. Click Save.
9. Click the search icon and click Search Preferences.
The Search preferences dialog box displays the selected search categories.
10. Select the by Address check box.
11. Click the Back to Search button and enter an address, for example, 7700 Technology Way, in the Search field.
When you search for an activity or a resource, the search fields are selected in the order defined in the Search
preferences dialog box. You can perform these tasks in the Search Preferences dialog box:
◦ Click the reorder icon to drag and drop the required activity search fields in the list to rearrange the order.

◦
◦

Select or deselect the required activity search fields to add or remove the activity search fields.
Select an option from the Date drop-down list to refine the activity search results.

Note: Search uses the first 40 characters of the search string.
The activities matching the specified address display.

Define the Inventory Search Fields
The application uses the inventory property fields defined in the Search section of the Configuration > Business Rules
page to search for inventories.
You can also edit the inventory property fields in the Search section of the Business Rules page and define additional
search fields to search for inventories. For example, assume that the inventories in the application are searched using
the Model and Item Number inventory fields. Now, you want to search the inventories using the Serial Number field. You
can specify an additional search field as follows:
1. Click Configuration.
2. Click Business Rules in the General section.
The Business Rules page displays.
3. Click the Edit icon for Inventory Search fields in the Inventory Search Fields section.
4.
5.
6.
7.

The Inventory Search Fields dialog box displays.
Click the Plus icon.
Select the Serial Number field.
Click Add.
Click OK.

The Serial Number field displays in the Inventory Search Fields section.
8. Click Save.
9. Click the Search icon.
10. Enter the Serial Number (for example, 8779808797) in the Search field and click Search.
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The inventory matching the specified serial number displays.
Note: Search uses the first 40 characters of the search string. Inventory search does not support
enumeration type fields.

Capacity Time Intervals
The time interval set consists of time intervals delimited with a comma (","). Time intervals within the time interval set
cannot have time period in common (with the only exception of a "point in time" time interval.

Link Templates
Link Templates are link profiles containing link type, time between activities constraints, scheduling constraints, and
assignment constraints. Links between the activities are created with the help of Link Templates.
Linked activities ensure scheduling and detailed planning for complicated, multi-step tasks, which may potentially
involve different resource types, different times, and time constraints. Configuring all these link constraints in a multistep task allows our routing engine to assign and schedule activities while meeting all of the requirements.
The Link Templates page includes the list of link types that exist in the application. You can edit the existing links and
add new ones. You cannot remove the existing activity link types, you can only deactivate them.
Access to the Link Templates page is controlled by the Link Templates visibility profile permission. You must set this
permission for each user type that you want to manage Link Templates. If the action is not configured for the user type
or if no visibility is defined, Link Templates is not visible to the user. If you select ReadOnly, Link Templates is available in
the view only mode. If you select Read/Write for this setting, the user can manage Link Templates.

Add a Link Template
Link Templates are link profiles that describe how activities are linked. The templates contain the type of link,
constraints for the time between activities, scheduling constraints, and assignment constraints. Links between the
activities are created with the help of Link Templates.
1. Click Configuration.
2. In the General section, click Link Templates.
3. Click Add Link Template.
The New Link Template dialog box is displayed.
4. Select the appropriate icon that represents the way in which you want to link activities.
The fields below the icons change based on your selection.
5. Complete these fields:
Field

Description

Minimum interval

Minimum time interval between activities. Select one of the options:

◦

Adjustable: The time interval is adjustable with the specified default value.
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Description

◦
Maximum interval

Maximum time interval between activities. Select one of the options:

◦
◦
◦
Assignment constraints

Non-adjustable: The time interval is non-adjustable with the specified predefined value.

Adjustable: The time interval is adjustable with the specified default value.
Non-adjustable: The time interval is non-adjustable with the specified predefined value.
Unlimited: The time interval is unlimited, with no restrictions.

Whether there are any constraints in assigning the activities to resources. Click Different
resources if the linked activities can be performed by different resources. Click Same resource
if the linked activities must be performed by the same resource.

Scheduling constraints

Whether there are any constraints in scheduling the activities. Click Different days if the linked
activities can be performed on different days. Click Same day if the linked activities must be
performed on the same day.

Link for the 1st activity

Specifies translations for the first activity. English is set as a default language, unless other
languages are specified. You must also specify the label for this link which will be used by
external applications.

Link for the 2nd activity

Specifies translations for the second activity. English is set as a default language, unless other
languages are specified. You must also specify the label for this link which will be used by
external applications.

Label

A unique identifier for this Link template.

Status

Whether this activity link type is available for selection as an option on the Add link page.

Calendars
Create and Delete Work Schedules
Work schedules are templates that are made up of a combination of shifts (working time) and non-working times. When
grouped as a work schedule, you can apply these shifts all at once to a bucket or to an individual resource.
1. Click Configuration.
2. In the General section, click Work Schedules.
The Work Schedules page appears.
3. Click Add work schedule.
The Add work schedule dialog box appears.
4. Enter a name and a unique label for the new work schedule.
While the name must be representative of the work schedule time frame, there is no functional correlation
between the name and the shifts that will be contained within the schedule.
5. Select the Active check box if you want the work schedule to be visible for assignment.
6. Click OK to save the work schedule.
7. To delete a work schedule, select the check box and click Delete.
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Note: You cannot delete a work schedule if it is currently assigned to a resource. You must remove it from the
resource or bucket first, and then delete it from the list.

Add Shifts to a Work Schedule
After you have created a work schedule, you can add the shifts and non-working times that will be included in the
overall period of time.
1. Click Configuration.
2. In the General section, click Work Schedules.
The Work Schedules page appears.
3. Click Items to the right of the work schedule that you want to add a shift to.
The shift list for the selected work schedule appears.
4. Click Add Shift.
The Add shift dialog box appears.
5. Click the Shift drop-down list to view the available shifts.
6. Select a Start date and End date for the period of time that this shift should be associated with the work
schedule.
Leaving the End date field empty implies that the shift will be a part of the work schedule indefinitely.
7. Add any comments for clarification or detail.
8. Select one of these options in the Repeats drop-down list:
◦ Daily – Allows for inclusion of the shift such as every other day or every 3rd day. This option requires a
value in the field labeled every _____ day(s).
◦ Everyday – The shift applies to everyday without exception.

◦
◦

Weekly – Allows for shifts that are used on a regular weekly pattern. Select the days that apply to this
particular shift using the check boxes for the individual days. Indicate the frequency of this pattern
weekly by adding a value to the every ____ weeks(s) field.
Yearly – Select a date range for the shift that will recur every year.

9. Click OK to save the shift to the work schedule.
10. Repeat the steps for each additional shift that you want to apply to this work schedule.

Add Non-Working Time to a Work Schedule
In addition to shifts, you may apply non-working time to certain work schedules. This could accommodate work
schedules that include non-standard work time such as four-day workweeks or even holidays that occur on the same
day every year. Keep in mind that many of the non-working reasons (illness, bereavement) tend to be used more
frequently on a one-off basis for individual resources as days off occur.
1. Click Configuration.
2. In the General section, click Work Schedules.
The Work Schedules page appears.
3. Click Items to the right of the work schedule that you want to add non—working time to.
The selected work schedule appears.
4. Click Add non-working time.
The Add non-working time dialog box appears.
5. Complete these fields:
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This table describes the fields available on the Add non-working time dialog box:
Field

Description

Shift Type

Select from Regular or On Call depending on which shift type you want the non-working
reason to be associated with.

Reason

Select the applicable reason from the drop-down list. This list is populated from entries in
Company Settings, Non-Working Reasons.

Start Date | End Date

Select the date range that this non-working will be valid for. Open-end dates imply that the
non-working reason will be indefinitely associated with the work schedule.

Comments

Enter any comments about the non-working reason. If Other is selected as a reason, then the
Comments field becomes mandatory.

Repeats

Select the appropriate option from the drop-down list. Options are:

◦
◦
◦
◦
Date Selections

Daily – Allows for inclusion of the shift such as every other day or every 3rd day. This
option requires a value in the field labeled every _____ day(s).
Everyday – The shift applies to everyday without exception.
Weekly – Allows for shifts that are used on a regular weekly pattern. Select the days that
apply to this particular shift using the check boxes for the individual days. Indicate the
frequency of this pattern weekly by adding a value to the every ____ weeks(s) field.
Yearly – Select a date range for the shift that will recur every year.

Enter the date selections based upon the previous selection. Dates are inclusive.

6. Click OK.
The new non-working reason is added to the work schedule.

Add a Non-Working Reason
If a resource is not available for work during their regular work schedule or shift, then you must apply a non-working
reason (for example, illness, vacation, bereavement) to explain their absence. Once set, this reason appears on the
calendar within the Daily view.
1. To view the Non-Working Reasons page:
a. Click Configuration.
b. In the General section, click Work Schedules.
The Work Schedules page appears.
c. Click Non-Working Reasons.
2. To add a new non-working reason, click Add non-working reason.
3. To edit an existing non-working reason, click Modify on the far right of the grid.
In either case, you will be prompted to enter a name and a label (unique identifier) for the non-working reason.

Shifts
Shifts are standard patterns of working time. They determine when a resource is available for work.
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Add a Shift
Use this feature for non-standard types of shift that don't fall within the traditional 24-hour clock. You can create
separate shifts for each working time pattern within your organization.
1. Click Configuration.
2. In the General section, click Work Schedules.
The Work Schedules page appears.
3. Click Shifts.
The Shifts page appears.
4. Click Add Shift.
The Add Shift dialog box appears.
5. Fill up these fields and then click OK:
Field

Description

Name

Enter a name for the shift, as it appears in the application.

Label

A unique identifier for this shift.

Type

Select an option from the drop-down list. Common shift types include Regular for standard
periods of time, or On-call for longer time frames that a resource might be available, after
the regular shift ends. Select the color coded on-call icon that you want to attach to the shift.
When you add this shift to a resource, this icon is displayed on the Dispatch Console, Manage,
Calendar, and Resource Calendar pages, and on the resource avatar.

Active

Click the check box to activate (make available for use) this shift.

Time From

Enter the start time for this shift.

Time To

Enter the end time for this shift.

Points

Within the application, points are used as limiters. If activities are assigned point values (based
on different completion durations, complexity, value, etc.), then assignment caps can be
determined on a shift-by-shift basis. Once point thresholds are reached for a resource to which
that shift is assigned, then routing will allocate no more activities to that resource.

Add an Activity to a Shift
Add an activity to a shift, when you want to add the activity to the calendars of all of the resources that have the shift
assigned to them.
1. Click Configuration, Work Schedules, Shifts.
The Shifts list displays.
2. Click the Activities link in the row of the shift that you want to add the activity to.
3. Click Add Activity.
The Add Activity page displays. If this activity is an internal activity, the layout of the page changes. If it is a
customer-facing activity, the layout stays the same.
4. Complete the applicable fields.
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Field name

Action

Activity Type

Select the activity type from the Activity Type drop-down list.

Name

Enter the customer’s name. Used for customer-facing activities only.

Work Order

Enter the work order number associated with this activity.

Duration

Enter the amount of time that the activity lasts.

Position in Route-Not Ordered

The activity is not ordered, and appears in the Not Ordered column in the Time view.

Position in Route-Ordered

The activity is displayed on the resource's route. If you specify a time slot, the activity displays
in that time slot. Otherwise, it displays as pending at the beginning of the route.

Time Slot

Select the period of time within which this activity can be started.

Activity Notes

Enter any notes associated with this activity.

Recurrence-Repeats-Daily

Apply to schedules such as every other day or every 3rd day. If you select this option, add the
frequency of occurrence in the field Days between occurrences.

Recurrence-Repeats-Everyday

Applies to every day schedules that repeat without exception and without any modification
options.

Recurrence-Repeats-Weekly

Apply calendars that have a regular weekly pattern. Select the days that apply to this shift using
the check boxes for the individual days. Indicate the frequency of this pattern weekly by adding
a value to the Weeks between occurrences field.

Recurrence-Repeats-Yearly

Occurs every year from the selected date entered in the From day until the date entered in the
To day field.

5. Click OK.

Work Skills
What is a Work Skill?
Work skill is the job-specific skills necessary to perform an activity. These act as a defining criteria to match activities
with the resources.
You can use Work Skills to capture the task attributes to assign the work. Work skills identifies the following attributes:
• The expertise of a resource
• The expertise required to perform an activity
You must create the work skills and then assign them to the resources and work skill conditions.
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Create a Work Skill
Work skills are client-specific sets of skills or competencies, required by resources to perform their assigned activities.
1. Click Configuration.
2. In the General section, click Work Skills.
The Work Skills page appears.
3. Click Add new.
The Add work skill dialog box appears.
4. Complete these fields:
Field

Description

Name

Enter a descriptive name for the work skill in at least one of the language fields (for example,
New Install, Video, Outage, etc.). This is the wording that will appear to users within the
application.

Label

Enter a unique string for this work skill. This is how the work skill will be identified within the
database.

Sharing of the skill in the team

Select from the drop-down list:

◦
◦
◦
◦
Active

Maximal — Team gets the maximal work skill level of all the team members (default).
Minimal — Team gets the minimal work skill level of all the team members.
No Sharing —This work skill, if assigned to a team member, it does not affect skills of the
team.
Summary — Team gets the total sum of work skill levels of all the team members The
work skill sharing parameters will define if a specific activity can be assigned to a teamholder but not higher than 100.

Select the check box to activate. If active, the work skill and its conditions are used by the
routing engine. If inactive, the skill and its conditions still exist but are not used by the routing
module.

Example of Sharing Work Skill
A team gets the total sum of work skill levels of all the team members. The work skill sharing parameters define whether
a specific activity can be assigned to a team-holder, but not higher than 100. In this example we will consider how
sharing influences work skill allocation in the group. If a resource is assigned a group of work skills (G) and some work
skills explicitly (WS), and there is an intersection of skills, then the explicitly assigned work skills prevail. A resource that
is not assigned any work skills is considered to obtain all the work skills with 100 qualification.
Work Skills

Team Holder

Team Member 1

Team Member 2

WS0 - Maximal

WS0 (100)

G: [WS0 (1),WS1 (1),WS2 (1) , WS3 (1), WS4(10)

WS1 - Maximal

WS3 (100)

WS4 (1)]

WS2 – No Sharing

G: [WS3 (10), WS4(10)]

G: [WS0(20), WS2(20)]
G: [WS0(30), WS2(30)]

WS3 - Minimal WS4 – Summary
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Team Member 1

Team Member 2

Effective work skills of the team-holder:
• WS0(100) - Maximal(100, 1, 30)
• WS1(1) - Maximal(0, 1, 0)
• WS2(0) – No Sharing (0, 1, 30), team-holder doesn't have this skill
• WS3(0) - Minimal(100, 1, 0)
• WS4(21) – Summary (10, 1, 10)

Delete, Activate, or Deactivate a Work Skill
You cannot delete a work skill that is currently assigned to at least one resource. You can set the active or de-active
status at any time. Deactivated work skills are not deleted from the application and are unavailable for selection.
1. Click Configuration, Work Skills.
The Work Skills page appears.
2. Select the check box next to the work skill that you want to delete, activate, or deactivate.
3. Click Delete, Activate, or Deactivate.
4. Click OK.

Temporary Work Skills
Determine the skills required to perform an activity and the skills of the technicians. Based on these technician skills
activities are assigned to perform.
You can use this feature to set up a date range during which a skill is considered actual. These settings are part of the
work skill settings of a resource and define the period during which the resource is considered having a certain skill of
a certain level. This feature is helpful when some skills require periodic certification, some equipment is available for
limited time only and if a planned maintenance is scheduled which requires special skills.
If no work skills have been explicitly assigned to a resource, the resource is assumed to permanently have all work skills
configured in the system with the maximum ratio. If any work skills have been assigned, the resource has only those
work skills with the specified ratios.

Define a Temporary Work Skill
Set up the assignment period for each work skill or work skill group assigned to a resource. When a work skill or work
skill group is selected for a resource, its start and end dates can be defined in the calendar.
1. Open Settings > Resource Info > Work Skills
2. Click the add (plus) button.
The Add Work Skills dialog box appears, as shown in this screenshot:
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3. Select the appropriate work skills from the list.
4. (Optional) Assign the work skill ratio.
If the ratio is not defined, the resource is considered to have the maximum work skill ratio of 100.
5. Select the From and To dates of the skill assignment period from the Calendar.
By default, the start date is always set to the current date making the work skill applicable immediately. If the
start date is changed to a past date, it will still be replaced with the today's date, as the application does not
support changes to past data. The end date can be left blank to mark the skill assigned permanently
6. Click Save.
The work skill is assigned to the resource separated with semi colons. The name of each work skill is followed
by its ratio and assignment dates in parentheses. The work skills are displayed according to these rules:
◦ Work skills terminated in the past are not displayed

◦
◦
◦

Assignment dates are shown in the 'from… to…' format. When the start date is in the past, from date is
not shown. When end date is not set, to date is not displayed.
If a work skill level is set to 100, the level is not displayed.
Inactive work skills are shown in gray font.

Note: If the resource is not assigned with the work skills, the resource is assumed to permanently have all the
work skills configured in the system with the maximum work skill ratio.

Edit Work Skills
Update the work skills of a resource as an when the resource acquires more skills or proficiency. You can also delete the
work skills of a resource.
1. Open Settings > Resource Info > Work Skills
2. Click Edit.
The Edit Work Skills dialog box opens, as shown in this screenshot:
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3. Update the changes and click Save.
The work skills are updated based on these rules:
◦ Overlapping records with same work skill and same ratios are automatically merged into one. The start
date of the merged record is the To date of the first record, and the end date of the merged record is the
From date of the latest record
◦ Records with same work skills and different ratios will not be merged. Two different records are created.
However, if their assignment periods overlap, the input is rejected with the message, Overlapping of
intervals for the same skills is not allowed. The assignment periods have to be adjusted so that they no
longer overlap. This screenshot shows the Work skills page, where you have tried to add the same work
skill with overlapping intervals, and the corresponding error message:

◦
◦

If a work skill is deleted, it is marked terminated on the previous day.
If a work skill is updated, the old work skill is marked terminated on the previous and the new work skill
record starts from the current date.
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Work Skill Conditions
To ensure that a resource has the ability to perform subsequently assigned activities, a correlation must be made
between incoming activity skill requirements and the skills specified for each resource. The Work skill functionality
is what that correlation is based on. Work skills are set up first, and then are assigned to resource records, with the
appropriate levels of qualification set for each.
Incoming activities are also assigned Work Skills, which are then matched up with resources with corresponding skills
during routing. For the application to know which Work Skills to assign to the activities, however, another correlation
must be made. This correlation is referred to as Work Skill Conditions – criteria that is based on certain field values
of activities. Work Skill Conditions are what the application uses to define which Work Skills should be assigned to
activities. Each Work Skill has at least one condition that refers to a specific field and value in the incoming activity
record. An example of this could be where an install Work Skill’s condition is to look for the field/value of “WO_TYPE =
1” (“1” being code for an install). If this condition were found within the activity record, then the application assigns that
Work Skill to the activity.
• The application assigns as many work skills to an activity record as there are conditions found.
• If multiple works skills are assigned to an activity, then the same list of skills must be associated with a resource
record in order for that resource to be considered for that job.
• If required and preferred skill levels are used to define Work Skills and conditions, then routing matches
activities to available resources with equal or higher qualifications of the skills as it determines who should be
assigned which activities.

Create a Work Skill Condition
A work skill condition correlates incoming activity skill requirements with the skills possessed by resources. Work skill
conditions are used to determine which activities are assigned to which resources.
You must add work skills before adding work skill conditions.
1. Click Configuration.
2. In the General section, click Work Skills.
3. Click Work skill conditions.
The Work skill conditions page appears.
4. Click Add new.
The Add work skill condition dialog box appears.
5. Complete these fields:
Field Name

Description

Work skill name

The work skill for which you want to add a condition. These work skills are created in the Add
work skill dialog box.

Required level

The minimum qualification level of the skill a resource must have, to be considered for the
activity. Only resources that have the required level or better skills are selected for the activity.

Preferable level

If more than one resource meets or exceeds the required level, then the one(s) with the level
that is closest in number to the “preferable level” is selected for the activity.
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Field Name

Description

Add new condition

A new condition for the work skill. Three new fields appear. Select the field for which you want
to add the condition and select the condition. For example, suppose you want the work skill
Install to be assigned to a technician who has a minimum skill level of 75, for work order types
IN. Select the Work skill name as Install, enter 75 for Required level, click Add new condition and
then select W/O Type, In, and IN.

6. Click Save.
The work skill condition is saved. When a new activity is added, these work skill conditions are used to
determine which work skills are assigned to the activity.

Create a Work Skill Group
You can bundle selected work skills into work skill groups, This creates greater ease and flexibility for assigning skills
to resources. You can continue to assign individual work skills and work skill groups, creating a more accurate resource
work skill record. You must define work skill groups to be used for capacity categories, if different work skills must
consume quota from a single capacity category.
1. Click Configuration.
2. In the General section, click Work Skills.
3. Click Work skill groups.
The Work skill groups page appears.
4. Click Add new.
The Add work skill group dialog box appears.
5. Complete these fields:
Field

Description

Name

Enter the work skill group name. If you have set multiple languages for the application, input
boxes appear for the different languages.

Label

Enter a unique identifier for this work skill group.

Active

Select the check box to make this work skill group active.

Can be assigned to a resource

Select the check box if you want the work skill group to be able to be assigned to a resource
record. If a group is assigned to a resource, then that the resource obtains all the work skills
defined for the group.

Can be added to a capacity category

Select the check box if you want the work skill group to be able to be assigned to a capacity
category. If a capacity category contains a group of work skills, then an activity is considered a
match to the category if it 'requires' at least one of work skills from the group.

6. Click Save.
The Work skill groups page appears.
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7. Click the pencil icon in the Work Skills cell to add work skills and their qualification level.
The Edit work skill window appears.
8. Click to select the work skill and activate the Qualification Level field.
9. Click Save when done.
10. To modify a work skill group, click the Name cell.
The Edit work skill group: [Work skill group name] window appears, which is similar to the Add work skill
group window.

Delete a Work Skill Group
You can delete a work skill group, if you don’t need it any more.
1. Click Configuration.
2. In the General section, click Work Skills.
3. Click Work skill groups.
The Work skill groups page appears.
4. Select the check box next to the work skill group that you want to delete.
5. Click Delete.
6. Click OK.

Work Zones
Work Zones
A work zone is the defined geographical area within which a resource can perform activities. Work zones are defined
within the work zone dictionary, and are then assigned to resource records.
A temporary work zone is a work zone that is not a resource’s typical work zone, but that is assigned to the resource for
a specific period of time. Temporary work zones override a resource's regularly assigned work zones. A work zone key
consists of a field (or combination of fields) and length-specific values, that when identified within an activity record,
determines which work zone gets associated with that activity. You can view, add, and modify work zones from the
Work Zone page.
Routing assigns activities to resources taking into account the work zones of those resources and assigning only those
activities that are within his or her work zone.

Add a Work Zone
Work Zone is unique to each company and reflects how geographic regions are divided for more effective and efficient
routing.
Ensure that you have added the required travel areas.
1. Click Configuration.
2. In the General section, click Work Zones.
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The Work Zones page appears.
3. Click Add new.
The Add Work Zone dialog box appears.
4. Fill up these fields:
Field

Description

Work Zone Name

A meaningful name to describe the group of Work Zone key values that make up the Work
Zone.

Work Zone Label

A unique identifier for the Work Zone.

Status

Status of the Work Zone—active or inactive.

Delimiter

Choose whether commas separate locations in the Work Zone Keys list or each location
appears on a new line.

Travel Area

A higher level bundling of zones used by the application’s statistics engine.

Work Zone Keys

Values within and formatted as defined by the overall Work Zone field key, that will positively
associate an incoming activity with a particular Work Zone.

Actions

Click Modify to edit the Work Zone.

Work Zone Shapes

Work Zone shapes are used as visual representations of Work Zones on the map and, as a tool
for yet more subtle definition of Work Zones. For example, if the company chooses to define
its Work Zones by city names or postal codes the Work Zones may be rather large. At the same
time, several shapes can be attached to the Work Zone dividing it into geographically smaller
areas. This way, one team can work in one shape and another team – in another shape while
still working in the same Work Zone.
If used, enter the shape identifier. The property serving as the shape identifier is defined
during the shape configuration via the Metadata API. For example, if ZIP code is used as shape
identifier, enter one or more ZIP codes associated with Work Zone shapes.

5. Click Add.
The Work Zone is saved.
Note: The Work Zone identifiers must be unique. If you have used the identifier for another Work Zone, the
error message: Key {identifier} conflicts with key {identifier} of Work Zone {work_zone_name} is displayed.

View Work Zone
Work Zone is unique to each company and reflects how geographic regions are divided for more effective and efficient
routing. The keys that define zones can be anything with geographic relation – a zip code, address portion, network
items (nodes, sub-nodes), map grids, or even geo-coding.
1. Click Configuration.
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2. In the General section, click Work Zones.
The Work Zones page appears and displays these fields:
Field

Description

ID

System-generated number used to identify a unique Work Zone.

Status

The Work Zone can be active and available for routing or inactive and not available for routing.
Green tick mark indicates active and red cross indicates inactive.

Work Zone Name

A meaningful name to describe the group of Work Zone key values that make up the Work
Zone.

Work Zone Keys

The exact values that can be found within the primary key (field) that are used to associate the
activity record with a Work Zone.

Actions

Click Modify to edit the Work Zone.

Shapes

Link appears if one or more shapes have been added to at least one Work Zone. Clicking Shape
opens the map showing the shapes associated with the selected Work Zone. For adjacent
shapes the map shows one common area formed by the combined shapes.

3. Click View to filter the Work Zones.

Modify a Work Zone
After you create a Work Zone, you cannot delete it, but you can activate or deactivate it. You can also modify the work
zone by changing the name, or by adding or removing locations from it.
1. Click Configuration.
2. In the General section, click Work Zones.
The Work Zones page appears.
3. Click Modify for the Work Zone that you want to modify.
The Edit Work Zone dialog box appears.
4. Change as required and click Update.
Current activities are recalculated per the modifications. Any future activities will be routed according to the
newly modified Work Zones. For precautionary reasons, any Work Zone changes must be performed outside of
the application’s peak usage time.
Note: Changing the status of a Work Zone to Inactive stops routing from using the Work Zone or any of its
locations.

Modify a Work Zone Key
A work zone key helps you identify a work zone with a short name. The work zones that you create are automatically
assigned with the key or convention that you define in the Work Zone Key dialog. By default, City is the work zone key
in the application.
1. Click Configuration.
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2. In the General section, click Work Zones.
3. Click Modify next to Work Zone Key in the header area.
The Work Zone Key dialog appears.
4. To retain City as the key and just change the length of the key, change the number in the Length field. In the
next field, select whether you want the entire key as case insensitive, or just the first letter.
5. Click OK.
The existing work zone keys are modified to conform to the new configuration.
6. To add a new field as the key, click the plus icon in the Work Zone Key dialog.
The list of fields available in the application is displayed in alphabetical order.
7. Select a field of your choice and click Add.
The newly added field is displayed in the Work Zone Key dialog.
8. Add the length of the key in the Length field. In the next field, select whether you want the entire key as case
insensitive, or just the first letter.
9. Click OK.
The modifications are applied to the existing work zone keys.

Export and Import Work Zones
You can export and import Work Zones to move the information between two instances. You can export and import
Work Zones either through API or through the user interface. The Export and Import buttons available on the Work
Zones page.
1. Click Configuration > Work Zones .
2. Click Export.
An XML file is generated with this information:
◦ XML format and product version

◦

Information about Work Zone keys

◦

- field
- property (can be present only if 'field' equals 'property')
- function ('case insensitive' or 'first word case insensitive')
- length
- order
Information about Work Zones:

- Work Zone name
- travel area
- status (active or inactive)
- Work Zone shapes
- Work Zone keys (order and formula are taken into account)
3. To import Work Zones, click Import.
You can import only the Work Zones that are exported from this application.
4. Click Browse and select the file that you want to import and then click Import.
The Work Zones are imported based on these rules:
◦ Work Zone keys and shape IDs for imported Work Zones must be unique. If either of them is not unique,
the Work Zone is not imported.
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If a Work Zone is present in the company configuration and is absent in the imported XML file, the Work
Zone is deactivated.
If a Work Zone is present in both, company configuration and imported XML file, it is updated if valid.

If a Work Zone is absent in the company configuration and is present in the imported XML file, it is
created if valid.
The Work Zones are imported and the summary of results is displayed. The results show the number of
successfully imported Work Zones and number of Work Zones which failed to import.
Related Topics
• Example of Work Zone Export XML Structure

Example of Work Zone Export XML Structure
When you export Work Zones, an XML file is generated. This topic provides a sample structure.
<?xml version="1.0" encoding="UTF-8"?>
<workZones formatVersion="1" productVersion="16.8.0">
<workZoneRules>
<rule field="ccity" collation="case insensitive" length="4" order="0" />
</workZoneRules>
<items>
<item status="active" travelArea="sunrise_enterprise" workZoneLabel="ALTAMONTE SPRINGS"
workZoneName="ALTAMONTE SPRINGS">
<keys>
<key>alta</key>
</keys>
<shapes>
<shape>cass</shape>
<shape>gene</shape>
</shapes>
</item>
<item status="active" travelArea="sunrise_enterprise" workZoneLabel="TEX" workZoneName="TEXAS">
<keys>
<key>andr</key>
<key>colo</key>
<key>kerm</key>
<key>lubb</key>
<key>midl</key>
<key>odes</key>
</keys>
<shapes>
<shape>wint</shape>
<shape>port</shape>
</shapes>
</item>
<items>
</workZones>
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Add a Travel Area
Travel areas define the maximum allowed travel territory for a company and can contain groupings of work zones.
Typically, companies have at least one high-level travel area listed.
1. Click Configuration.
2. In the General section, click Work Zones.
3. Click Travel Areas.
The Travel Areas page appears.
4. Click Add travel area.
The Add travel area dialog box appears.
5. Fill up these fields:
Field

Description

Name

Name of the travel area.

Label

Your company specific unique identifier for the area.

6. Click OK.
The Travel Areas page appears.

Travel Time Prediction
Oracle Field Service uses time-based prediction for travel time. This topic describes how travel time is calculated in the
application.
Travel time between two activities is calculated as a combination of:
• Statistical “Learned” estimation
• "Straight-Line" estimation
Note: You can specify durations for specific activities and technicians through APIs. For more information, see the
REST API for Oracle Field Service guide.

Statistical “Learned" Estimation
Statistical Learned estimation is based on the historical travel times between two locations. These locations are
represented by geographical areas, termed as Travel Keys. A Travel Key is typically a portion of or the entire Post Code
or ZIP Code. When a resource records travel between two locations, the values are added to the statistics to produce a
learned estimate of the travel between that set of Travel Keys. To produce and use a Statistical Learned Estimate for the
travel time between two activities, both activities must contain a value that is part of the Travel Key and the Travel Keys
must have enough historical travel data.

35

Oracle Field Service

Administering Oracle Field Service

Chapter 1

Configure the General Settings

Note:
• The travel time between two Travel Keys is adjusted over time as more data is collected.
• Generally travel time for an activity is considered to be the time between the end of the previous activity and
the start of the current activity. If there is idle time after the end of the previous activity (before the start of
predicted travel to the current activity; for example, the current activity was assigned to the route after the
previous activity ended), then the recorded travel time is not considered for the statistics.

Airline Distance Method
Oracle Field Service calculates the airline speed and parking time for each travel key separately. If one travel key
encompasses an urban area, where speeds are low and parking times are high, while another key is located in a rural
area with higher speeds and minimal parking times, travel time estimations using company-wide values may not be
as accurate as possible. Estimations are likely to be more accurate when the airline distance speed and departure, or
parking time are based on the values collected for individual travel keys. If there is enough reported data for a travel key,
the airline speed and parking time is estimated based on the collected data. If there isn't enough reported travel data,
the travel time estimate uses the default airline speed and parking time, as defined for the entire organization on the
Configuration > Statistics page.
For travel within a travel key, the travel time estimate is the straight-line distance divided by the airline distance speed of
the travel key plus the departure or parking time of the travel key.
Travel time estimate = Distance/Airline distance speed + parking time

For travel between two travel keys, the travel time estimate is the average of the travel time estimates calculated using
each of the keys.
Travel time estimate = 0.5 * (Distance/Airline distance speed of key 1 + parking time of key 1) + 0.5 *
(Distance/Airline distance speed of key 2 + parking time of key 2)

The final estimated travel time may be based on the airline distance estimation combined with statistically calculated
travel durations.
Override Airline Distance Based Travel
You can use the Statistics API to override the travel estimations based on airline distance with any value you deem
appropriate for each travel key. If a calculated override value exists, that value will be used to determine the travel time.
For more information on the API, see the REST API for Oracle Field Service guide.
Travel time estimation
Oracle Field Service uses a parameter called Coordinated Travel Weight (CTW) to combine the two methods of
estimations described earlier. CTW is a company–level value and is calculated using the Coordinate calculation weight
parameter. Coordinate calculation weight is configured at the company level, in the Statistics page. The formula is:
Travel Time = Statistical x (1-CTW) + Straight Line x CTW

For example, if you set CTW to 0.5, the travel time is the average of the two.
Exceptions:
• If the CTW value is 0.0, only the Statistical Learned estimation is used. If no Travel Key is available, the Default
Travel time is used.
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• If the CTW value is 1.0, only the Airline Distance Method is used. If coordinates are not available for both
activities, the Default Travel time is used.
• If neither Statistical Learned estimation nor Airline Distance Method is available, the Default Travel time is
used. The Default Travel time is a single configuration at the company level.
Additional adjustments
After routing is performed, the application may adjust Travel Time further for activities that are pending and ordered on
a route. This adjustment may occur when the application is unable to find a Statistical “Learned" record that matches
the pair of Travel Keys in these cases:
1. When only the Airline distance method is used.
2. When the "default" value is used.
When either of the above occurs, the application attempts to adjust travel time using two methods:
• Generate “actual travel" data: The application submits the origin and destination addresses to the Oracle Spatial
and Graph Route Server, if the accuracy level of each activity = “address”. The application calculates the travel
time between the activities, adds the results to the temporary statistics, and recalculates the travel time on the
route using the updated statistics.
• Generate "street/post code level" estimate travel between post codes
◦ This method requires post or zip code to be configured as the travel key.

◦

The application submits the origin and destination post or zip codes to the Oracle Spatial and Graph
Route Server and the application calculates the travel time between them. The returned information is
used to improve the quality of the temporary statistics.
Note: When the post code is the same for both the activities, this method is not used.

Temporary statistical travel data is calculated and used until real data is accumulated. This is accumulated as resources
record travel between two locations based on the status of the activity. As soon as actual resources learned statistics
are obtained, the temporary record is deleted. The Daily Extract - Appt data set contains the ‘travel_estimation_method’
field, which identifies what travel method was used for the travel time estimation. This field is only available in the Daily
Extract file. These values can be present:
Value

Description

0 - travel is not calculated

Travel is not calculated. This is not calculated because the Activity Type feature = “Calculate travel” is
not selected.

1 - company default

Travel estimation uses the company default found in “Configuration - Statistics”

2 - statistics only

Travel estimation uses only the Statistical Learned estimation. This could be a result of an activity not
being geocoded or the Coordinated Calculation Weight parameter set to 0.

3 - expansion statistics only

Travel estimation is based on the expansion statistics. See 2A above for a definition.

4 - initial statistics only

Travel estimation is based on the temporary statistics that were generated based on the results
received from street level routing.

5 - coordinates only

Travel estimation only uses the Airline Distance Method. This could be a result of an activity not having
a physical address or the Coordinated Calculation Weight parameter set to 0.
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Value

Description

6 - statistics + coordinates

Travel estimation is based on a combination of the Statistical Learned estimation and Airline Distance
Method using the ‘Coordinate calculation weight’ setting.

7 - expansion statistics + coordinates

Travel estimation is based on a combination of expansion statistics and the Airline Distance Method
using the ‘Coordinate calculation weight’ setting.

8 - initial statistics + coordinates

Travel estimation is based on the statistics that were generated as part of the results received from
street level routing and the Airline Distance Method using the Coordinate calculation weight setting.

9 - "manual" adjustment

Travel estimation is based on the value that was updated using an API. This value can be set via Core
API (update activity). For this goal, “manual” should be passed as a value of the “setTravelTime/source”
field.

10 - "street level" adjustment

Travel estimation uses the street level estimations provided by Location Services between coordinates
of locations. This is used when you use SLR for Routing.

11 - "externally estimated value provided

Travel estimation is based on the value that was updated using an API. This value can be set via Core

via API" adjustment

API (update activity). For this goal, “manual” should be passed as a value of the “setTravelTime/source”
field.

12 - same location

Travel was not calculated because the location is the same based on address or geocode. (Travel = 0)

13 - statistics (not-ordered, bucket, not-

Travel estimation only used the Statistical Learned estimation. In this case the origin location of the

scheduled)

travel is still unknown and the application estimates an average traveling time value. A presence of
these estimations is important for capacity management.

14 - company default value (not-ordered,

Travel estimation used the company default found in “Configuration - Statistics”. In this case the origin

bucket, not-scheduled)

location of the travel is still unknown.

15 - GPS coordinates

Travel estimation uses the Airline Distance Method between the GPS based location of the resource
and the Activity location.

16 - Point to point adjustment

Travel estimation is adjusted using point to point estimations provided by location services based on
coordinates of locations.

17 - Real time traffic

Travel estimation is adjusted using the real-time traffic data estimations provided by the location
services, based on the activity coordinates or resource locations.

18 - Travel Key based Airline Distance

Travel estimation uses the Airline distance based estimation using the coordinates of the medians of
travel keys. This could be the result of a location not having valid coordinates and not having learned
statistics between the locations.
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2

Configure Resources, Activities, and
Inventories
Activity Types
An activity is any time-consuming task such as, installation, trouble call, lunch, or team meeting that a resource does.
Each activity type includes a set of features, which are yes/no flags and define the way the activity type is processed.
Examples for features include whether activities of a specific type can be moved, created in a bucket, rescheduled, and
so on. The Activity Types visibility controls the access to the Activity Types window. You must set the visibility for
each user type that you want to manage Activity Types. If you don't configure an action for a user type or if you don't
define the visibility, users of the user type cannot see the Activity Types. If you select ReadOnly, Activity Types is
available in a read-only mode. If you select Read/Write, users can manage Activity Types.
Here is the detailed description of the features that may influence the processing of activity from the back office
applications through Oracle Field Service.

Feature

If enabled, the activities of the type...

Allow to create from Incoming Interface

… can be created from external systems, including Oracle Field Service ETAWorkforce

Allow move between resources

… can be moved between resources

Allow creation in bucket

... can be created in bucket through routing plans and profiles

Allow reschedule

… can be moved to another day

Support of not-ordered activities

… can be not-ordered – such that can be started by the resource before/after any other activity within
the route

Allow non-scheduled

... can be activities without a date

Support of time slots

… can use time slots (time-period within which they are to be started can be defined)

Calculate activity duration using statistics

… are estimated using statistics that are gathered at the resource level and company level

Add an Activity Type
An activity type defines the properties based on which users can create activities. The properties could be whether the
activity is created for customers, internal activities, or team work, whether travel has to be calculated for the activity,
whether the activity can be rescheduled, and so on. You cannot modify some features after you start creating activities
for some activity types. Whether you change the features for existing activity types on the user interface or through
REST APIs, the application validates the features and displays warnings, as appropriate.
1. Click Configuration > Activity Types > Add activity type .
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2. Complete these fields:
Field

Action

Activity type info section
Label

Enter a unique identifier for the activity type.

Name

Enter a user-friendly name that appears in the interface. Enter the name in English and in all
the languages that are active in the application.

Active

Specify whether the activity type is active. Users cannot select inactive activity types while
creating activities.

Group

Select the activity type group this activity type belongs to, for example, Customer, Internal,
Teamwork, or Task.

Default duration

Enter the time taken to complete the activity. This is the default value and it will be used when
no statistics are available for the activity.

Color Scheme Section
Copy from

The color palette to be copied from an existing activity type. The color scheme of the selected
activity type is duplicated.

Pending through Cancelled

Define colors for each of activity statuses and for warning with standard RGB color codes and
palettes. The colors that you select here are used on all the application pages. For example,
let's say you select Green for the Started status. Whether you view the Time View, List View,
or Manage, activities with the Started status are displayed in Green. The colors Pending =
FFDE00, Completed = 79B6EB, Warning = FFAAAA, Suspended = 99FFFF, Not done = 60CECE,
Not ordered = FFCC99, Started = 5DBE3F, and Canceled = 80FF80 are not available in the
Supervisor Time View (Manage).

Available Time Slots Section
Available Time Slots

Select the times slots for this activity type. You must have set up time slots in Configuration >
Time Slots for them to be available on this page. Select the check box to activate the time slot.

Features Section- The features are yes/no flags, which define individual characteristics of the type processing. If the check box is
selected then the feature is enabled.
Allow mass activities

Select the check box to define that the activities of this type can be performed by multiple
resources simultaneously. For example, team meeting, or training. If you select this option
at the time of creating the Activity Type and save the Activity type, you cannot clear it later.
However, if you have cleared it at the time of creating the Activity Type, you can select it later.
But, you see a warning message.

◦
◦
◦
◦

This option cannot be enabled if Teamwork is selected.
This option cannot be enabled if Allow move between resources is selected.
This option cannot be enabled if Support of not-scheduled activities is selected.
This option cannot be enabled if Allow reschedule is selected.
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Field

Action

Teamwork

Select the check box to define that the activities of this type are allowed for teamwork.
Teamwork is an activity that is performed by minimum two resources: a team leader and an
assistant. You can select this option only while creating the Activity Type. After you select this
option and save the Activity type, you cannot clear it. Similarly, if you clear it at the time of
creating the Activity Type, you cannot select it later. When the Teamwork activity feature is
enabled, these activity type features are disabled:

◦
◦
◦
◦
◦
◦
◦
◦
◦
◦
◦
◦

Enable segmenting and extended duration
Allow move between resources
Allow creation in buckets
Allow reschedule
Allow non-scheduled
Enable 'day before' trigger
Enable 'reminder' and 'change' triggers
Support of work zones
Support of work skills
Support of inventory
Support of preferred resources
Allow mass activities

Enable segmenting and extended

Select the check box to define that the activities of this type are intended to be used for field

duration

work that must be split into segments, which can be scheduled and assigned to technicians.
You can select this option only while creating the Activity Type. When you select this option,
a new section, Enable segmenting and extended duration, appears in the Add activity
type window where you can set the duration for segments. After you select this option and
save the Activity type, you cannot clear it. Similarly, if you clear it at the time of creating the
Activity Type, you cannot select it later. These fields are displayed in the Enable segmenting
and extended duration section:

◦

Minimum segment duration for a single day: Defines the minimum length (in minutes)
of each segment the activity is to be split.
Maximum segment duration for a single day: Defines the maximum total duration (in
minutes) of the activity segments for any day.
When you select the Enable segmenting and extended duration feature, these activity type

◦

features are disabled:

◦
◦
◦
◦
◦
◦
◦

Teamwork
Allow mass activities
Allow repeating activities
Enable 'day before' trigger
Enable 'reminder' and 'change' triggers
Enable 'not started' trigger
Enable 'SW warning' trigger
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Field

Action

Allow move between resources

Select the check box to define that the activities of this type can be moved from one resource to
another. You cannot select this option if you have selected Teamwork.

Allow creation in buckets

Select the check box to define that the activities of this type can be created in a bucket. If
you select this option at the time of creating the Activity Type and save the Activity type, you
cannot clear it later. However, if you have cleared it at the time of creating the Activity Type, you
can select it later. But, you see a warning message.

◦
◦
Allow reschedule

You cannot select this option if you have selected Teamwork.
You can select this option only if you have selected Allow move between resources.

Select the check box to define that the activities of this type can be rescheduled to another
date.

Support of not-ordered activities

Select the check box to define that the activities of this type can be not-ordered activities. If
you select this option at the time of creating the Activity Type and save the Activity type, you
cannot clear it later. However, if you have cleared it at the time of creating the Activity Type, you
can select it later. But, you see a warning message.
Not-ordered activities are the ones for which the order of processing is not defined. Such
activities don't have an estimated time of arrival. The resource, dispatcher or routing may
define the order (for example, command change order in mobile interface or edit activity
command in web interface).

Allow non-scheduled activities

Select the check box to define that this activity type can have non-scheduled activities. You
cannot select this option if you have selected Teamwork. If you select this option at the time of
creating the Activity Type and save the Activity type, you cannot clear it later. However, if you
have cleared it at the time of creating the Activity Type, you can select it later. But, you see a
warning message.
Non-scheduled activities are the ones that don't have a specific day of completion assigned to
them.

Support of work zones

Select the check box to define that the resource work zone must be calculated for this type of
activities. This option cannot be enabled if Teamwork is selected. If this option is selected and a
work zone cannot be calculated, a warning is displayed when such an activity is moved; routing
will not assign such activities. If using work zones, Business rules must be configured to allow
support of work zones ( Configuration > Business Rules > GUI features > Enable work zones
support ).

Support of work skills

Select the check box to define that the work skills are calculated and assigned to the activities
of this type, based on any conditions met. Subsequently, only resources with matching work
skills are considered for assignment of the activity. If you don't select this check box, work skills
are not considered and the activity can be assigned to any available resource.

◦
◦

You cannot select this option if you have selected Teamwork.

This option does not depend on the Allow move between resources feature (as work
skills are used not only to move activities but to calculate capacity).
If you choose to use work skills, you must configure Business Rules to allow support of work
skills ( Configuration > Business Rules > GUI features > Enable work skills support ).
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Field

Action

Support of time slots

Select the check box to define that the activities of this type require time slots. This refers to
pre-configured time slots within which the activity can be performed. After you select this
option and save the Activity type, if you try to clear the option, you see the message, ‘Time Slot
values will not be preserved after the change of this feature.’
If you don't select this check box and the 'Time slot' field is added to the Edit/View activity
context layout, then it's replaced with the Service Window field.

Support of inventory

Select the check box to define that inventory can be used for activities of this type. For example,
lunch breaks and team meetings do not have inventory. You cannot select this option if you
have selected Teamwork. If you select this option at the time of creating the Activity Type and
save the Activity type, you cannot clear it later. However, if you have cleared it at the time of
creating the Activity Type, you can select it later. But, you see a warning message.

Support of links

Select the check box to define that the activities of this type can be linked with predecessor/
successor activity relationships. If you select this option at the time of creating the Activity Type
and save the Activity type, you cannot clear it later. However, if you have cleared it at the time of
creating the Activity Type, you can select it later. But, you see a warning message.

Support of preferred resources

Select the check box to define that the activities of this type can have preferred resources
(Preferred Resource tab). You cannot select this option if you have selected Teamwork. If
you select this option at the time of creating the Activity Type and save the Activity type, you
cannot clear it later. However, if you have cleared it at the time of creating the Activity Type, you
can select it later. But, you see a warning message.

Allow repeating activities

Select the check box to define that the activities of this type can be recurrent. If you select this
option at the time of creating the Activity Type and save the Activity type, you cannot clear it
later. However, if you have cleared it at the time of creating the Activity Type, you can select it
later. But, you see a warning message.

◦
◦
Calculate travel

You cannot select this option if you have selected Allow move between resources.
You cannot select this option if you have selected Support of not-scheduled activities.

Select the check box to define that the travel time to an activity must be calculated. If you have
selected Calculate travel for an activity and it has neither the travel key (that is, zip code) nor
coordinates, a company default value is used as a value of travel to and from the activity.

◦
◦

If the feature is selected, the algorithm implemented for activities is used for all activities
of the type.
If the feature is not selected, the travel time to activities of the type is always calculated as
zero (0) (as if location of activities of the type is the same as location of previous activity)
and travel to the next stop also starts from this previous location.

Calculate activity duration using

Select the check box to define that the activities are estimated using the statistics that are

statistics

gathered at the resource level and company level.

Allow to search

Select the check box to define that the Oracle Field Service Search Engine indexes activities of
this type.

Allow to create from Incoming interface

Select the check box to define that the activities of this type can be created from Inbound
Interface. Activities may originate from either Oracle Field Service or external systems.
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Field

Action

Enable ‘day before’ trigger

Select the check box to define that the day before trigger is invoked for activities of this type.
You cannot select this option if you have selected either Teamwork or Enable segmenting and
extended duration. You can select or clear this option at the time of creating the Activity Type,
or later.

Enable ‘reminder’ and ‘change’ triggers

Select the check box to define that the 'reminder' and ‘change’ triggers are invoked for activities
of this type. You cannot select this option if you have selected either Teamwork or Enable
segmenting and extended duration. You can select or clear this option at the time of creating
the Activity Type, or later.

Enable ‘not started’ trigger

Select the check box to define that the 'not started' trigger is invoked for activities of this type.
You cannot select this option if you have selected either Teamwork or Enable segmenting and
extended duration. You can select or clear this option at the time of creating the Activity Type,
or later.

Enable ‘SW warning’ trigger

Select the check box to define that the 'SW warning' trigger (Service Window warning) is
invoked for activities of this type. You cannot select this option if you have selected either
Teamwork or Enable segmenting and extended duration. You can select or clear this option
at the time of creating the Activity Type, or later.

Calculate delivery window

Select the check box to define that a delivery window can be calculated for activities of this
type.

SLA and Service window use customer

Select the check box to define that SLA/Service Window can be adjusted for the activities of

time zone (required for routing)

this type. You must select this feature if you have selected Support of time slots.

Support of required inventory

Select the check box to define that the required inventory is supported for activities of this type.

Disable resource tracking for this

Select the check box to define that the resource's geolocation is not tracked, if the activity

activity type

has the status ‘Started’. The message, ‘Your location is not tracked for this activity.’ appears
on the Landing page. Location tracking resumes after the activity status changes (that is,
the status changes to ‘Completed/End’, ‘Suspend’, or ‘Not Done’) and, the route is still active.
This functionality is supported in the Oracle Field Service Core Application (browser) and
installed applications (Android and iOS) and requires Oracle Field Service Smart Location,
Oracle Field Service Professional Cloud Service or Oracle Field Service Enterprise Cloud Service.
This message is not displayed if you have not selected Enable GPS Telemetry under the
Configuration > User Types > Permissions section.

3. Click Add.
Related Topics
• How Activity Duration Is Calculated

Find Activity Types
An activity type defines the specific parameters of the activity, such as which time slot the activity takes place. You may
want to find activity types to view, edit, or clone them.
1. Click Configuration.
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2. In the Resources, Activities, and Inventories section, click Activity types.
The Activity types page appears and displays these columns:
Column

Description

ID

System-generated number assigned to records in the database – not used by anyone except
the Support team.

Activity Type Name

The user-friendly name the end user sees in the drop-down list of choices on the Activity
page.

Status

Indicates if the activity type is being used.

◦
◦

Green check mark = Active and in use
Red X = Inactive and not used

Activity Type Label

A unique identifier for the activity type.

Actions

Links to the actions you can take on this activity.

3. Click View.
4. Type the activity type that you want to find in the Find field.
5. Click Apply.
The results appear in the work area with the search criteria in bold.

View Internal Activity Types
Internal activities are non-customer facing activities that a resource performs as part of their daily duties. External
activities are activities where resources are required to travel to perform some type of service.
For many resources, their first activity might be a warehouse visit. Around mid-way through the shift, there will be a
lunch activity. The last activity might also be a warehouse activity, completing their end-of-day tasks. This is an example
of how an internal activity is part of a resource’s daily duties.
1. Click Configuration.
2. In the Resources, Activities, Inventories section, click Activity Types.
The Activity Types page appears. The internal activities are listed under the heading Internal. The colors
indicate the colors used on the Time, List and Map view.
3. Scroll down to see the activities types of various groups.

Activity Alerts
You see alert messages when you move activities. These messages guide you through the process. These alerts are
available:
Overtime Alert: This alert notifies you that the estimated completion time of the activity extends beyond the end of a
resource’s working day.
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Soft Skill Mismatch Alert: This alert displays when you move an activity to a resource that does not have the preferable
qualification level of an activity skill.
Work skill Mismatch Alert: This alert displays when you move an activity to a resource that does not have the required
and preferred qualification level of an activity skill. Depending on your settings, the Work Skill Mismatch Alert either
prevents you from moving the activity, or gives you the option to move it or to cancel the move.
Don't Move Alert: This alert displays when you try to move an activity type that is not allowed to move between
resources. Activity types are configured in the Add activity type page.

Activate, Deactivate, or Delete Activity Types
If you don't want to use an activity type any more, you can either deactivate it, or delete it. Similarly, if you have an
existing deactivated activity type, you can activate it and start using it.
1. Select the check box next to an activity type.
Options appear at the top of the page.
2. Click the appropriate button, based on the action you want to perform.
Note: Deactivate does not delete the activity type; it just makes it inactive.

How Activity Duration Is Calculated
You can define the activity duration or the application can calculate it using statistics that it obtains from learned
durations.
Note: You can specify durations for specific activities and technicians through APIs. For more information, see the
REST API for Oracle Field Service guide.
The manually-defined and statistical methods work as follows:
• Manually-defined: If you have not selected the Calculate activity duration using statistics check box on the
Add activity type or Modify activity type dialog box, the duration specified at the time of creating the activity
is used. If you have not specified the duration in the activity, the default duration for that activity type is used.
• Statistical: If you have selected the Calculate activity duration using statistics check box on the Add activity
type or Modify activity type dialog box, the duration of the activity is calculated based on statistical methods.
If the history is not enough to calculate using statistics, the duration entered manually (if entered) at the time of
creating the activity is used. If neither history nor a manually entered value is present, then the default duration
for that activity type is used. The default duration is specified at the time of creating the activity type.
Calculation of activity duration using statistics
Activity duration estimations are calculated by the application based on the historical data of completed activities.
The application analyses new data, compares it against previous estimations, and corrects the previous estimations,
based on the new data, to obtain updated estimations for future usage. For this, the application uses two main statistics:
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company profile and personal profile. The application learns how each technician performs tasks and updates these
statistics daily.
• Company profile: The activity duration is calculated at the company level based on the Activity duration stats
fields configured on the Statistics page. All activities belonging to the same field value are grouped together
for calculating the duration. The key is typically something that identifies similar activities as a single entity
including fields such as Activity Type. When a technician performs tasks and reports the time against them,
the company level estimate is derived for each task type based on the stats field values. The application gives
more importance to more recent data for computation, rather than historic data. This increases the estimation
accuracy and allows the application to respond to changes in trends in a timely manner. The default duration
specified in the Add activity type dialog box is used as the starting point for estimating the duration. The
application:
◦ Refers to the previous experiences of similar tasks.

◦
◦
◦

Calculates the estimate based on the summary of experiences.
Learns from new experiences.
Updates and remembers the updated experiences for future use.

Every day the estimate is modified by a small amount, based on the durations reported on the previous day
for similar activities. The correction applied is controlled to ensure that there isn’t too much deviation from
the previous estimation and the estimated durations don't keep fluctuating on a daily basis; but is significant
enough to respond to any trend change within a few days.
The formula to calculate the new estimate is:

New estimate = Previous estimate +/- Correction

where correction is based on previous estimates and the differences between the estimated and reported
durations.
• Personal profile: The company level estimate and the estimated time for the activity for the technician are
computed in the form of a ratio. This ratio is calculated based on the company level estimate for the activity.
The final estimate at the technician level is the product of the personal profile ratio and the company level
estimate. Each technician may have different ratios for different types of activities, based on their performance.
Similar to the correction applied to the Company level estimates, the Personal profile ratio is also updated
by a small controlled amount every day, based on the durations reported by the particular technician on the
previous day for similar activities. When a technician performs an activity for the first time, the default ratio is
used. Ratios are also calculated for each bucket for each kind of activity, based on the durations reported by the
resources under the bucket. This ratio is used to estimate the duration when the activity is assigned to a bucket
and not yet assigned to a technician. This is also the duration that is used for Capacity and Quota calculations,
if the activity is assigned at the bucket level.
Overrides
You can override activity durations for each activity duration key value at either the Company level or the Technician
level, using REST APIs. The Override is stored in the application, in addition to the learned statistical value for the
currently active Activity key. For duration estimations, if an override is specified for the user, the overridden value is
used instead of the statistically learned value. However, the statistically learned value continues to be updated based on
the new reported durations as currently done.
Some more important points about activity durations:
• If the personal profile is not available for an activity key value, the default ratio for the technician is used.
• The default ratio has an initial value that is specified in the Initial Ratio for Activity Duration field. This value is
updated each time the technician performs a relatively new activity.
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• You can specify which type of resources use personal profile, using the Personalize the estimation of activity
duration field. If you do not select this option, such resource types do not use the personal profile and use only
the company wide estimations.
• You can specify whether a resource affects the company level estimates, using the Use durations reported to
enhance company-wide estimations field. If it does, you can also specify the number of days to be skipped to
avoid impacting the company estimates while the resource is new and still learning how to perform activities.
The duration reported by only those resources that satisfy these two conditions is used to modify the company
level estimates.
• You can set upper and lower limits for activity durations at the resource or bucket level, as a percentage of
the company wide estimations. You can use using the Lower/Upper limit for personal ratio for duration
calculation fields for this. The estimated Activity duration values always remain within the set limits.
The fields that affect activity duration are:

Field

Page

Description

Minimum and maximum relevant duration time in
minutes

Statistics

These specify the acceptable values for reported
durations to be considered for estimating Activity
Durations. If technicians report durations outside
of this range, the application does not consider
that value when estimating durations.

Lower/Upper limit for personal ratio for duration
calculation

Statistics

These specify the range within which the duration
estimation for technicians and buckets would lie
as a percentage of the company level estimation.
If the estimation at the technician or bucket level,
as a percentage of the company level estimation,
is lesser than the set lower limit, the estimation
is set to (Lower limit * company level estimation).
Similar modifications are done if the percentage
is more than the set upper limit.

Default duration

Add activity type and Modify
activity type

This is the duration used for estimation, if no
other estimation is available including override
or historical data for that kind of Activity to
estimate duration statistically. This value is also
used as the estimated duration, if Calculate
activity duration using statistics is cleared, or
no duration is specified on Activity creation.

Calculate activity duration using statistics

Add activity type and Modify
activity type

This parameter specifies whether the duration of
the activity must be estimated statistically using
historical data. If cleared, the duration specified
at the time of creating the activity, or the default
duration is used.

Personalize the estimation of activity duration

Add resource type

This parameter specifies whether the activity
duration estimation must be learnt for each
resource separately. If selected, the application
estimates personal profile ratios for each resource
for each kind of activity separately. If cleared, the
application uses the company wide estimations.

Use durations reported to enhance company-wide
estimations

Add resource type

This parameter specifies whether the durations
reported by the resource must be considered
while calculating activity or travel estimations.

Don't consider reported data of the first x working days

Add resource type

This parameter specifies the number of days
only after which the durations reported by a new
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Description
resource are considered for enhancing statistical
estimations. Till such time the durations reported
by a new resource are not considered for duration
calculation purposes. This field is editable, only if
the previous parameter is selected.

Initial ratio for Activity Duration

Resource Info

This is the default ratio that is used for the
resource, if there isn’t enough historical data for
the resource for a particular type of activity. For
such activities, the estimated duration of the
technician is the value of the Initial ratio
* company wide estimation (provided
“Personalize the estimation of activity duration” is
selected).

Working days left for reported data to start impacting
duration estimations

Resource Info

This parameter specifies the number of days
left before the reported duration of the resource
starts affecting the estimated duration. The initial
value is based on the value set in Don't consider
reported data of the first x working days.

Flowcharts
The following diagrams show how Oracle Field Service determines activity durations. The first flowchart is based on the
assumption that the Personalize the estimation of activity duration check box is not selected for the resource type,
and therefore the activity duration estimate is not adjusted by the resource’s personal profile or initial ratios.

The second flowchart is based on the assumption that the Personalize the estimation of activity duration check box
is selected for the resource type. This means, the activity duration estimate is adjusted by the resource’s personal profile
or initial ratio.

49

Oracle Field Service

Administering Oracle Field Service

Chapter 2

Configure Resources, Activities, and Inventories

Configuration examples
Example 1: Application uses the duration that is provided at the time of creating the activity
• Activity Type dialog box:

◦
◦

Default duration = 30
Calculate activity duration using statistics = not selected

If the activity created has a duration of 50 minutes, that value (50) is used. If no value is provided at the time of creating
the activity, 30 minutes is used.
Example 2: New resource in the application has no historic data. The administrator wants to provide 20% more time
than the estimated duration at the company level.
• Resource Type dialog box: Personalize the estimation of activity duration = selected
• Resource Info page: Initial Ratio for Activity Duration = 120%
• Activity Type dialog box: Calculate activity duration using statistics = selected
• Assume company-wide estimation for the activity to be 45 minutes
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Since the resource does not have previous records for this kind of activity the initial (default) ratio is used for
calculations. The estimated duration for the resource is: 45 * 120% = 54 minutes
Example 3: Application uses technician’s learned duration with limits. Resource has performed activities of this type in
the past and, hence, has a personal activity key ratio.
• Statistics page:

◦
◦

Lower limit for personal ratio to calculate duration = 50%
Upper limit for personal ratio to calculate duration = 200%

• Resource Type dialog box: Personalize the estimation of activity duration = selected
• Activity Type dialog box: Calculate activity duration using statistics = selected
• Assume personal profile to be 40% and company-wide estimation for the activity to be 50 minutes.
Since the personal activity key ratio is less than the lower limit of 50%, the application uses the lower limit value of 50%
for calculations instead of 40%. The estimated duration for the resource is 50 * 50% = 25 minutes.
Example 4: Application uses company duration without using personal profile
• Resource Type dialog box: Personalize the estimation of activity duration = not selected
• Activity Type dialog box: Calculate activity duration using statistics = selected
• Assume company-wide estimation for the activity to be 45 minutes
Since the personal profile is not configured, the estimated duration for the resource is same as the company wide
estimation = 45 minutes.
Example 5: Application uses overridden value at technician level instead of learned statistics
• Resource Type dialog box: Personalize the estimation of activity duration = not selected
• Activity Type dialog box: Calculate activity duration using statistics = selected
• Assume personal profile to be 80% and company-wide estimation for the activity to be 50 minutes
• Assume that the duration for the resource for the Activity key has been overridden by a value of 30 minutes
The overridden value takes precedence over the learned duration at the resource level. The estimated duration is 30
minutes and not 80% of 50 = 40 minutes.
Example 6: Reported durations outside the acceptable range are not used as input for Activity duration estimation
• Statistics page: Minimum relevant duration time in minutes = 5 mins
• Statistics page: Maximum relevant duration time in minutes = 1440 mins
• Assume that the estimated duration for the activity was 20 minutes and a resource starts and completes the
activity in 4 minutes. That is, the resource reports a duration of 4 minutes for a completed activity.
Since the reported duration lies outside the acceptable range of 5 to 1440 minutes, the duration of 4 minutes is not
considered to enhance the estimated duration of the activity key and the estimated duration remains unchanged at 20
minutes (assuming there weren’t any other reported activity that could have changed the estimated duration).

Activity Duration Statistics Fields
You can configure multiple activity duration statistics keys, so that you can compare the quality of keys. Data is collected
for all the keys, and the quality ratings of the keys are displayed on the Statistics page.
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With multiple activity duration statistics fields you can:
• Configure up to five keys and choose any one of them to be 'Active' at any point of time.
• View the quality of each key.
• View all the configured keys in the 'Work Statistics' report and view the report for specific keys as well.
Only the 'Active' key is used for estimating activity duration. Although the application collects data for all the configured
keys, the keys that are not 'Active' are not included in the calculation. The advantage of this feature is that before
making a new key 'Active', you can compare the performance of the new key with the existing one. This happens
without affecting the current calculations.
The quality of the key is displayed as stars next to each key. More number of stars indicates better quality of estimation.
Based on the quality of keys, you may choose to 'Activate' any of the currently inactive keys. When you activate an
inactive key, the currently active key becomes inactive. If another key has better quality than the currently active key, the
'Activate' button is displayed beside the key. For all other inactive keys, the Activate option is available within the options
menu. You cannot delete an active key; you can only delete inactive keys. To delete a key, first make it inactive, and then
delete it.
New or modified keys
Whether you add a new key or modify an existing one, the application considers both of these as new keys. When
the application gets a new key, the Activity duration estimation algorithm is run on the next day (or the next time the
recalculation process is run). This gives the estimated durations of all keys based on the new key. The application then
calculates the quality of the new key based on the historical durations and the calculated estimated durations. Further,
when an existing key is modified and the recalculation process is yet to run, the message, "Changes have not been
applied yet" is displayed. The key that is currently in effect (previously active key) is also displayed until the new key
takes effect.
Existing keys
The estimated durations for all key values and the quality of each key (Active and Inactive) is calculated every day. The
Activity durations that are actually used in the application are calculated based only on the Active key. Hence, if you
change the status of a key from Inactive to Active (or Active to Inactive), the quality of the keys is not affected. Similarly,
since the estimated duration is also calculated for inactive keys, the learning that is applied since the key is created, is
still in effect when an inactive key is activated. Similar to other keys, changes in an existing key or activation of a new
key comes into effect only when the recalculation process runs the next time (typically by the next day). Similarly, the
quality of a new or modified key is displayed only from the next day onward.
Calculating the quality of keys
The application calculates the quality of each key based on how accurate the estimation of Activity durations have been
or would have been, if the key was used for calculations. These steps are used:
• The estimated duration is calculated for each type of activity (Activity key value) using the key for which the
quality has to be found.
• Durations reported by technicians, for completed past activities are compared with the estimated duration for
that activity using the said key.
• If the difference between the estimated and reported duration is less, the estimation is considered to be good. If
the difference between the estimated and reported duration increases, the quality is considered to deteriorate.
• The final quality of the key is calculated based on the number of activities that showed good, satisfactory and
bad estimations, for that key.
Consider this example:
• Key 1 = Activity Type (2, case insensitive)
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• Key 2 = Plant Code (2, case insensitive), Problem Code (2, case insensitive)
This table shows the data to demonstrate how the quality of a key is calculated:
Activity ID

Activity

Activity

Estimated

Estimated

Reported

Quality of

Quality of

Duration Key

Duration Key

Duration based

Duration based

Duration

Estimation

Estimation

based on Key 1

based on Key 2

on Key 1

on Key 2

based on Key 1

based on Key 2

1

AA

PP11

50

90

52

Good

Poor

2

BB

PP22

75

70

68

Good

Good

3

BB

QQ22

75

95

100

Satisfactory

Good

4

CC

QQ22

100

95

125

Satisfactory

Satisfactory

5

AA

RR11

50

35

45

Good

Satisfactory

6

DD

PP11

150

90

135

Good

Poor

7

BB

RR22

75

45

30

Poor

Satisfactory

8

DD

PP11

150

90

140

Good

Poor

9

AA

RR22

50

30

20

Poor

Satisfactory

10

CC

QQ11

100

140

110

Good

Satisfactory

The quality of a key is calculated based on these formula: Quality
% of Satisfactory Estimations)

of Key = (0.06 * % of Good Estimations) + (0.04 *

Based on this formula:
• Quality of Key 1 = 4.4
• Quality of Key 2 = 3.2
Work Statistics report: All the configured keys appear on the Work Statistics report. The user can select any key (Active
or Inactive) and the report displays the updated values based on the selected key.
Activity duration stats fields: The formation of the keys (made up of fields) used for the grouping of work duration
values to find the averages. You can define up to five activity keys and have one active key at any time. Data is collected
for all the keys, and the keys are rated for their quality. Stars indicate the rating and more number of stars indicate better
quality. For more information, see the Activity duration statistics fields topic.
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Pre-Calculated Travel Statistics
Travel statistics are based on the actual durations reported by field resources. As such, new customers and existing
customers expanding into new operating areas will not have actual durations in the application. The application uses
pending and completed activities to derive estimated durations using point-to-point estimations. Using this method
improves travel durations at the time of optimizing routes and moving activities.
Oracle Field Service performs this process once a day:
• Get the list of activities and their locations.
• Estimate the probability of travel in future between each pair of ’Activity travel stats fields' (Travel Keys). The
travel probability is calculated for all Travel Key pairs, based on the relative distances between them.
• Sort Travel Key pairs in descending order, based on distance.
Note: Travel Keys that have existing learned travel are excluded from the estimation process.
• Estimate the travel duration using point-to-point estimations for a maximum of 12,000 pairs based on the
sorted list.
After performing the process, the application has additional travel duration data. The next time Routing runs, or a user
moves an activity, the application uses the pre-calculated travel values. Calculating probability and sorting Travel Key
combinations:
• Activities that have valid coordinates with an accuracy value of either 8, 9, or 0 are considered. Travel
coordinates with an accuracy value of ‘0’ are provided by customers.
• Travel Keys that have at least one activity with valid coordinates are considered for estimation.
To find out the relative distances between pairs of keys, the application calculates the median coordinates for each key.
This is done based on the median values of the latitudes and longitudes of all activities that belong to the travel key. The
median values of latitude and longitude are calculated separately.
The application also finds the coordinates of the two closest activity locations to the calculated median for each key. The
coordinates of these medoids are used when sending pairs of locations between keys.
Algorithm
The general rules of the algorithm are as follows:
• Travel keys are sorted based on the number of activities corresponding to the key. Pending Activities carry
higher weights than completed ones.
• The algorithm starts from the most popular key in the list that does not have learned duration to at least one
other key within 150 kms. After the request is started from that key, the algorithm moves to the next most
popular key and repeats the process.
• If there is no travel data from a key to itself, the application sends two pairs of coordinates within that key as a
part of the request.
• Between the keys, the application prioritizes the travel between nearest keys, based on the distances calculated
between the medians.
• The algorithm ensures that there is always at least two pairs of locations between any two keys. The final travel
estimation is the average of the two travels.
• Keys that are more than 150 kms apart are not considered as a part of the request.
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Example
Consider a geographical location, where each cell represents a Travel Key. Keys in lighter shades denote keys
that do not have travel estimations from that key to itself. The request starts from the most popular key that is
not connected to at least one key within 150 kms. The request traverses 13 unique keys and comes back to the
original key. Thus, each request contains 24 travels. The final request would be A-G-H-I-J-E-I-K-L-K-J-M-N-ON-M-J-K-I-E-J-I-H-G-A:

The request then moves on to the next most popular key, say V and repeats the same process. On the way if
there is a key that is not connected to itself, the application includes two travels within the key. Whenever such a
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case is encountered, the key is counted twice when counting 13 unique keys. The next request would be V-Q-PP-P-O-R-T-S-S-S-R-U-U-U-T-U-R-S-T-R-O-P-Q-V:

This process continues till 1000 requests are sent on that day or no more non-connected neighbouring
pairs are left to be sent. After the entire process completes for enough number of days, the learned travel
estimations from every key to every other key within 150 kms of itself will be available.

Capacity Categories
A Capacity Category is a predefined set of work skills and/or work skill groups and time slots visible to a user who is
booking the activities for customers.
Based on the number of minutes available (Capacity = Initial Quota allocation minus used minutes), the user decides
if enough time is available within a time slot to realistically promise a specific service window to the customer. This
information is sent to the CSR via Capacity API. Capacity Categories are visible only if you are using the Oracle Field
Service Capacity Service module.
Note: The Used Minutes value is calculated based on the exact time (in minutes) from start to end of a working day.
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You must enable the Capacity Categories visibility profile permission for each user to access the Capacity Categories
window:
• Read-Only: Select this option to display capacity categories in a view only mode.
• Read/Write: Select this option to let the user manage Capacity Categories in Oracle Field Service.
If the permissions are not configured for a user type, the activity types will not be visible to the users. Oracle Field
Service maps the work skills to assign incoming activities to the resources. In general, many companies define quota for
a work skill group rather than for an individual work skill. For example, separate skills are required for installation, uninstalling and maintenance of modems, but from a scheduling perspective, quota is defined for all the modem-related
works group.
A capacity category can also consist of a single work skill and the minimum required level of the skill level. For example,
a category can be created for all the customer-oriented work and a separate group for VIP customers or for highly
difficult tasks. The two categories would contain the same work skills but the minimal qualification level in the VIP group
is higher. Because of the categories and the multi-skill functionality, the same activity can match several rows in the
Quota table and can be added to the Used capacity several times. The duration of this activity will be taken into account
for all the capacity categories it matches.

Create a Capacity Category
You can create a capacity category to configure work skills, work skill groups, and time slots.
1. Click Configuration > Capacity Categories .
The Capacity categories page appears.
2. Click Add New.
The Add Capacity Category dialog box appears.
3. Enter the appropriate information in the following fields:
The following table describes the fields available on the Add Capacity Category dialog box.
Option

Description

Name

Enter the name of the capacity category. The name is displayed in the list and in the quota
matrix. If the application is configured for multiple languages, input boxes will appear for each
language.

Label

Specify a label. It is used in the context of APIs and it must conform to a standard naming
convention.

Active

Select the Active check box to mark this capacity category as active. Only active capacity
categories are used in the quota matrix.

4. Click Save.
Once you create the capacity category, you must add work skills, work skill groups and time slots to the
category.
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Edit a Capacity Category
Edit an existing capacity category to change the status, name, label, work skills, or time slots.
1. Click Configuration > Capacity Categories .
The Capacity categories page appears.
2. Select the check box next to the capacity category that you want to change.
3. Click the pencil icon in the Name column.
The Edit Capacity Category dialog box appears.
4. Change the Name, Label, or Active field. Similarly, click the pencil icon in the Work Skills or Time slots columns
and change the required values.
5. Click Save.

Delete a Capacity Category
You can delete a capacity category when you no longer need it.
1. Click Configuration > Capacity Categories .
The Capacity categories page appears.
2. Select the check boxes next to the capacity categories that you want to delete.
3. Click Delete.
4. Click OK.
The selected capacity categories are deleted.

Add or Edit Work Skills Within a Capacity Category
A Capacity Category can contain one or more work skills and each work skill must meet a minimum required level.
1. Click Configuration.
2. In the General section, click Capacity Categories.
The Capacity Categories page appears.
3. Click the pencil icon in the Work Skills column for the Capacity Category that you want to add or edit.
The Edit Work Skill dialog box appears.
4. Select a work skill and add the minimum level of the skill required in the corresponding text box.
The default value is 1. When the minimum level of a work skill is defined, an activity matches a Capacity
Category, only if a required skill level for the activity skill is equal to or more than the level of the Capacity
Category.
Note: If a capacity category contains a group of work skills, the activity matches the category, if it requires at
least one of work skills from the group.
Recalculate activities after any edits or updates have been made to apply changes to pending and future activities in the
system.
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Add or Edit Time Slots Within a Capacity Category
A time slot indicates that the work mentioned in the Capacity Category must be performed in the defined time of the
day. Capacity Categories can contain one or more time slot associations.
1. Click Configuration.
2. In the Resources, Activities, Inventories section, click Capacity Categories.
The Capacity Categories page appears.
3. Click the pencil icon in the Time Slots column for the Capacity Category you want to add or edit.
The Edit Time Slots dialog box appears.
4. Select a time slot.
5. Click Save.

Inventory Types
Inventory Type helps you distinguish between serialized and non-serialized inventory.
Access to the Inventory Type window is controlled by the Inventory Types visibility profile permission. You must set
this permission for each user type that you want to manage Inventory Types. If the action is not configured for the user
type or if no visibility is defined, Inventory Types will not be visible to the user. If you select ReadOnly, Inventory Types is
placed into a view only mode. If you select Read/Write for this setting, the user can manage Inventory Types.

Add an Inventory Type
You can create serialized inventory and non-serialized inventory types.
1. Click Configuration.
2. In the Resources, Activities and Inventories section, click Inventory Types.
3. Click Add new.
The Add inventory type dialog box appears.
4. Complete these fields:
Field

Description

Label

Enter a unique identifier for this inventory type.

Active

Select this check box to make the inventory type available in drop-down lists.

Non Serialized

Select this check box if the inventory type is non-serialized.

Decimal quantity

Select this check box if you want users to add decimal quantity of the inventory. For example,
1.5 liters. This check box is displayed only if you select the Non-serialized check box.

Quantity precision

Enter the number of digits you want to display after the decimal. This check box is displayed
only if you select the Decimal quantity check box.

Supports required inventory

Select this check box to make the inventory type required for selected activities.
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Field

Description

Model Property

If desired, select additional characteristics for this inventory type from the drop-down list.

Name

Enter a name for this inventory type in each appropriate language field.

Unit of measurement

If this inventory type is non-serialized, enter a unit of measure. Use a language and a unit of
measure appropriate for the country in which this inventory type will be used.

5. Click Save.

Activate or Deactivate an Inventory Type
Inventory Type helps you distinguish between serialized and non-serialized inventory. You can deactivate an Inventory
Type when you don’t use it any more.
1.
2.
3.
4.
5.

Click Configuration.
Select Inventory Types from the Resources, Activities and Inventories section of the menu.
Select the check box next to inventory type(s) that you want to activate or deactivate.
Click Activate or Deactivate.
Click OK.

Properties
Each entity (for example, activity, resource, inventory, and users) contains a set of associated attributes. For example,
resource records may contain attributes such as name and contact information as well as physical attributes such as
gender or a photograph. These attributes within Oracle Field Service are combinations of fields or custom properties.
Properties with the Type “Field” are the native system properties that are available for the specified entities. For
example, Name (property label, cname) is associated with an Activity, and Serial Number (property label, invsn) is
associated with Inventory. Field type of properties can be mapped with similar client properties.
Note:
• Multiple fields or properties with the same name can exist. For example, Name can refer to a customer’s name
(property label, cname) or a resource’s name (property label, pname). In this example, each Name property is
assigned to a different entity and has a different property label.
• When custom property values exceed 255 bytes, the entire value is shown in the activity details, API responses,
and Outbound Messages. However, only the first 255 bytes are used for search, visibility conditions, activity
inventory list columns and their sorting, travel, activity duration, visit, and Work Zone Keys. If you create a
condition with long values, only the first 255 bytes are used with historic data; all the long values that are added
after you create the new condition will use the full set of data.
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Custom properties are attributes of entities that are unique to each client. You can create them through the user
interface, import them, or create through an API. Once added, these properties are available for use in page
configurations, filters, and numerous configuration areas (for example, search fields, duration field, and so on). You can
create these types of properties:
• String: These are custom properties that require alphanumeric entries. These can include free text boxes, URLs,
phone numbers, or email addresses.
• Integer: These are custom properties that require numeric entries. This option can also be used for check
boxes.
• Enumeration: These are custom properties that require selections from fixed lists. Option buttons and combo
(drop-down lists) boxes are common examples of this property type.
• File: These are custom properties that require some type of file upload. These could include MIME types such
as .gif, .jpg, .pdf, .mpeg, .zip, html, .wav, or .doc. Examples of File properties could be customer signatures or
even technician photos.

Create a String Property
The string property includes free text boxes, URLs, phone numbers, and email addresses. Assume that resources
must enter remarks for an activity after the activity is closed. The Activity Details form must contain a text box, so the
resource can enter the remarks. The text box that you add here, is a string property.
1.
2.
3.
4.
5.

Click Configuration.
Click Properties in the Resources, Activities, Inventories section.
Click Add New.
Select String from theProperty Type drop-down list.
Complete these fields:

◦
◦
◦
◦
◦
◦
◦

◦

Property name(mandatory): Enter a name that you want to display to the end user in English and in all
the languages that are active in the application.
Property label(mandatory): Enter a Unique database identifier for the Oracle Field Service API.
Property hint(optional): Enter a hint that you want to display when a user hovers over the field name. For
example, Enter comments if any. Enter the text in English and in all the languages that are active in the
application.
Regular expression: Enter an expression to validate the values or format the values in a certain way.
Entity(mandatory): Select Activity since the property is associated with the Activity Details form.
Lines Count(mandatory): Enter the number of lines that you want the property to display in the Activity
Details form. For example, enter 3 to display a maximum of three lines.
GUI (optional): Select one of these options to define how the property displays to users:
- Text Element: Displays as a free text field. For our example, select this option.
- URL: Displays as a clickable URL.
- Phone: Displays as a clickable phone number.
- Email: Displays as a clickable email address.
- Geolocation Element: Displays a button to show the location on a map.
Regular expression (optional): Enter an expression to validate input or to force the data to display in a
certain way.
For example, if you want to display $23,540, then use this regular expression: /^/$?([1-9]{1}[0-9]{0,2}(/,
[0-9]{3})*(/.[0-9]{0,2})?|[1-9]{1}[0-9]{0,}(/.[0-9]{0,2})?|0(/.[0-9]{0,2})?|(/.[0-9]{1,2})?)$/
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Other examples:
- Ethernet ARP address: /^([0-9a-fA-F]{2}:){5}[0-9a-fA-F]{2}$/
- Phone number: (555)5555555: /[/(/)\d/-]{10}/
- 16-bit integer: (0-65535): /(^\d{0,4}$)|(^6553[0-5]$)|(^655[0-2][0-9]$)|(^65[0-4]\d{2}$)|
(^6[0-4]\d{3}$)|(^[0-5]\d{4}$)/
- 1 digit: (0-9): /^\d{1}$/
- 2 digits: (01-99): /^\d{2}$/
- Integer: (0-99): /^\d{1,2}$/
- Integer: (0-999): /^\d{1,3}$/
- Any 6 symbols(you can change 6 to any number): /^.{6}$/u
- Currency (USD with 2 decimal places): /^/$?([1-9]{1}[0-9]{0,2}(/,[0-9]{3})*(/.[0-9]{0,2})?|[1-9]{1}
[0-9]{0,}(/.[0-9]{0,2})?|0(/.[0-9]{0,2})?|(/.[0-9]{1,2})?)$/
- Date formatted as DD-MM-YYYY: /^((0[1-9])|([1-2][0-9])|30|31)-((0[1-9])|1[0-2])-2[0-9]{3}$/
Clone property on Reopen/Prework (optional): Enables you to duplicate the property while reopening
the activity or applying prework for a new activity.
Formatting (optional): If selected, displays these options:
- Regular expression
- XSL transformation (converts an XML file into a table format viewable in HTML that is read-only).
Note: Formatted properties are not available for presentation on the Inventory Grid context
layout structure.
Assume that you want to display this data from a client system within Oracle Field Service:
Group

Price

One Time Charges and Credits

$ 100.00

Programming Change

$ 5.00

Programming Change

$ 5.00

Programming Change

$ 5.00

Programming Change

$ 5.00

UNKNOWN

$ 0.00

Monthly Charges

$ 129.98
America’s Top 250

$ 69.99

HD/SD (2TV) Receiver

$ 14.00

HD/SD (2TV) Receiver

$ 14.00

DVR Service

$ 6.00

Protection Plan

$ 6.00
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Price
Israeli: The Israeli Network

Monthly Credits

$ 19.99
$ -10.00

Cr: Agent $ 10x24 Mo
Monthly Charges and Credits

$ -10.00
$ 119.98

Use this regular expression for the above data: /(/s+)?(.+/w)/s+(/$)/s+(.*)/n?/im = [item group="$1"]
[name]$2[/name][price]$4[/price][currency]$3[/currency][/item]
This XML file converts the data given earlier into a table format:
[xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform"]
[xsl:template match="/"]
[style]
.property_table
{
font-size:12px;
font-family: Arial;
border-collapse: collapse;
}
.property_table .property_name
{
padding-left:15px;
}
.property_table td
{
border: 1px solid grey;
padding: 4px;
}
.property_table .property_price
{
text-aligh:right;
}
.property_group
{
background-color:#ccc;
font-weight: bold;
}
.property_group .property_name
{
padding-left:5px;
font-weight: bold;
}
[/style]
[table class="property_table"]
[xsl:for-each select="root/item"]
[xsl:choose]
[xsl:when test="@group=' '"]
[tr class="property_group"]
[td class="property_name"] [xsl:value-of select="name"/] [/td]
[td class="property_price"]
[span] [xsl:value-of select="currency"/] [/span]
[xsl:value-of select="price"/]
[/td]
[/tr]
[/xsl:when]
[xsl:otherwise]
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[tr]
[td class="property_name"] [xsl:value-of select="name"/] [/td]
[td class="property_price"]
[span] [xsl:value-of select="currency"/] [/span]
[xsl:value-of select="price"/]
[/td]
[/tr]
[/xsl:otherwise]
[/xsl:choose]
[/xsl:for-each]
[/table]
[/xsl:template]
[/xsl:stylesheet]

Using XSL transformation, the above XML file is displayed in HTML as shown in this screenshot:

6. Click Add.
A system generated ID is assigned to the property. You can perform these actions:
◦ Click Export to export the properties to an XML file.

◦

Click Import, Browse, and select the XML file that you want to import.

Add a String Property to the Screen Configuration
After you create a property, you can assign it to a specific user type and determine where the property type displays on
the page.
You can define these visibility settings for the property type:
• Read only, read/write, or mandatory options.
• Conditions under which the property type displays.
Note: Not all conditions are available for every page context.
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Let’s assign the CSR Notes string property to the Administrator User Type, and add it to the Activity Details page. Also,
let us set the property type to Read-Only when the activity status is Completed and change the property type to Read
Write when the activity status is Pending. To add a string property:
1. Click Configuration, User Types in the Users and Security section.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.

The existing users display in the left pane.
Select Administrator from the left pane.
Select the Screen Configuration tab.
Expand Manage and click Add activity/Activity details.
Select a property from the Layout Structure pane and click Add property.
Select the property, CSR Notes and click OK.
The CSR Notes property displays in the Layout Structure pane.
Click Add New Visibility and select Read-Only.
Click Add New Condition.
Select Activity Status and in (equal) from the drop-down lists.
Click the Plus icon, select Completed, and clickSave.
Click Add New Visibility and selectRead-Write.
Click Add New Condition.
Select Activity Status and in (equal) from the drop-down lists.
Click the Plus icon, select Pending, and click Save.

You can view both the conditions in the Conditions column.

Create an Enumeration Property
Option buttons and drop-down lists are examples of the enumeration property. This means, you can have a set of valid
values and you can select only one value from the set. For example, you have four types of customers, Standard, Gold,
Silver, and Bronze and you want to indicate the customer type on each activity record.
This example creates an enumeration property, Customer level with four values, Standard, Gold, Silver, and Bronze, and
displays the property as a drop-down list in the user interface.
1. Click Properties in the Resources, Activities, Inventories section.
2. Click Add New.
3. Select Enumeration from the Property Type drop-down list.
4. Enter Customer level in the Property Name field. Enter the name in English and in all the languages that are
active in the application.
5. Enter Cust_level in the Property label field.
6. Select Activity from the Entity drop-down list.
7. Select Combobox from the GUI drop-down list.
8. Specify the value, Standard in the Enumeration Values field and click Add.
Note: The values display in alpha-numeric order. The system automatically applies an index value to each
specified value, and the index value is case sensitive. The APIs reference the index value. For example, if you
want to use a readable value for the value, customer not home, you can use the code CNH instead of the
default index value, 1 and map the code to the client system. You cannot edit the index value, after it is added.
9. Repeat step 6 for each value, that is, Gold, Silver, and Bronze.
The specified values display in the Values field.
10. Select a value from the Values field.
11. Clear the Active check box.
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12. Click Edit to make a value inactive and does not display in the user interface.
13. Click Add.

Create a File Property
The File property type supports transferring of files such as documents, photos, or signatures. This means, you can
upload MIME types such as .gif, .jpg, .pdf, .mpeg, .zip, html, .wav, or .doc files for activities.
1.
2.
3.
4.

5.
6.
7.
8.

Click Configuration > Properties .
Click Add New.
Select File from the Property Type drop-down list.
Enter a name for the property in the Property Name field. Enter the name in English and in all the languages
that are active in the application.
This is the name that is displayed on the context layout structure and any page to which the property is added.
Enter a label for the property in the Property label field.
Enter a hint that you want to display when a user hovers over the field name in the Property hint field. Enter
the hint in English and in all the languages that are active in the application.
Select the entity to which the property belongs, in the Entity field.
Select one of these options for the GUI field:
Option

Description

File element

Select this option to upload a file. When uploaded, the file displays as a text link in the user
interface. These fields are displayed:

◦
◦
◦

File size limit: Select the maximum file size you want to allow for File elements in Oracle
Field Service Mobile for Android and iOS and Oracle Field Service Core Application. This
field is displayed only for the File element option. The default and the maximum size
allowed is 5 MB. This limitation does not apply to the APIs.
Allowed MIME types delimiter: Select whether you want to display separate allowed
MIME types with commas, or you want to display each allowed MIME type on a new line.
Allowed MIME Types: Click the required types of files you want to allow for upload.

Signature element

Select this option to capture the resource’s signature.

Image element

Select this option to enable the user’s device to capture and upload the user’s photo, and to
display the image as a thumbnail. These fields are displayed:

◦
◦
◦
◦

Allow draw on image: Select this check box to let the user draw on the captured image
using a stylus.
Get geolocation: Select this option to save the location information on a map with the
captured image.
Maximum picture width (in pixels): Enter the maximum width the captured image can
have. The recommended width is 1000 pixels.
Maximum picture height (in pixels): Enter the maximum height the captured image
can have. The recommended height is 1000 pixels. Maximum resolution limits should be
exceed 5000x5000 pixels. The Minimal value is 10 pixels.

9. Select whether you want to copy the property data when an activity is reopened or has a pre-work activity in
the Clone property data on Reopen or Prework field.
10. Click Add.
The new property type is added. Add this property to the context layout of the page for the user profile for
which you want to display.
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Related Topics
• Supported MIME Types

Supported MIME Types
The full list of supported MIME-types and the matching file extensions is provided here.

MIME Type

Supported File Extensions

animation/narrative

'nml'

application/mspowerpoint

'pot', 'pps', 'ppt', 'ppz'

application/msword

'doc', 'dot'

application/oda

'oda'

application/onenote

'one', 'onetoc2', 'onetmp', 'onepkg'

application/pdf

'pdf'

application/rtf

'rtf'

application/vnd.ms-excel

'xls', 'xlt', 'xla'

application/vnd.ms-

'xlam'

excel.addin.macroEnabled.12
application/vnd.ms-

'xlsb'

excel.sheet.binary.macroEnabled.12
application/vnd.ms-

'xlsm'

excel.sheet.macroEnabled.12
application/vnd.ms-

'xltm'

excel.template.macroEnabled.12
application/vnd.ms-officetheme

'thmx'

application/vnd.ms-

'ppam'

powerpoint.addin.macroEnabled.12
application/vnd.ms-

'pptm'

powerpoint.presentation.macroEnabled.12
application/vnd.ms-

'sldm'

powerpoint.slide.macroEnabled.12
application/vnd.ms-

'ppsm'

powerpoint.slideshow.macroEnabled.12
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MIME Type

Supported File Extensions

application/vnd.ms-

'potm'

powerpoint.template.macroEnabled.12
application/vnd.ms-

'docm'

word.document.macroEnabled.12
application/vnd.ms-

'dotm'

word.template.macroEnabled.12
application/vnd.openxmlformats-

'pptx'

officedocument.presentationml.presentation
application/vnd.openxmlformats-

'sldx'

officedocument.presentationml.slide '
application/vnd.openxmlformats-

'ppsx'

officedocument.presentationml.slideshow
application/vnd.openxmlformats-

'potx'

officedocument.presentationml.template
application/vnd.openxmlformats-

'xlsx'

officedocument.spreadsheetml.sheet
application/vnd.openxmlformats-

'xltx'

officedocument.spreadsheetml.template
application/vnd.openxmlformats-

'docx'

officedocument.wordprocessingml.document
application/vnd.openxmlformats-

'dotx’

officedocument.wordprocessingml.template
application/x-excel

'xls'

application/x-gtar

'gtar'

application/x-gzip

'gz'

application/x-pointplus

'css'

application/x-shockwave-flash

'swf'

application/x-sprite

'spr', 'sprite'

application/x-tar

'tar', 'tgz'

application/zip

'zip'

audio/mpeg

'mp2', 'mp3', 'mpga'

audio/x-wav

'wav'
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MIME Type

Supported File Extensions

chemical/x-pdb

'pdb'

image/gif

'gif'

image/jpeg

'jpe', 'jpeg', 'jpg'

image/png

'png'

image/tiff

'tif', 'tiff'

image/x-ico

'ico'

text/html

'htm', 'html'

text/plain

'txt'

text/richtext

'rtx'

text/tab-separated-values

'tsv'

text/x-speech

'talk'

text/x-vcard

'vcf'

video/mp4

'mp4'

video/mpeg

'mpe', 'mpeg', 'mpg'

video/quicktime

'mov', 'qt'

video/x-msvideo

'avi'

Create an Integer Property
Check boxes and text fields are examples of the integer property. Use the integer property to enter numerical values
such as port number, or to select your decision such as whether an additional inventory has been approved by the
dispatcher [Yes/No].
This example creates an integer property, Customer confirmed, and displays the property as a check box in the user
interface.
1. Navigate to the Configuration page.
2. Click Properties in the Resources, Activities, Inventories section.
3. Click Add New.
4. Select Integer from the Property Type drop-down list.
5. Enter Customer confirmed in the Property Name field. Enter the name in English and in all the languages that
are active in the application.
6. Enter Cust_decision in the Property label field.
7. Select Activity from the Entity drop-down list.
8. Select Checkbox element for GUI.
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9. Enter an expression in the Regular expression field to validate input or to force the data to display in a certain
way.
10. Select whether you want to duplicate the property while reopening the activity or applying pre-work for a new
activity.
11. Click Add.
The newly added property appears on the Properties page.

Resource Types
A resource type helps you identify these differences:
• Account for cost differences between full time employees and contractors.
• Identify the resources that you want to track using geolocation.
• Manage quota and capacity for resources.
• Distinguish between team holder and team member.
• Share a resource’s inventory and work skills in a team.
You can create different resource types to differentiate the hierarchy of the Resource Tree. While creating a resource
type, each resource type is assigned to a role. The roles (Field Resource, Vehicle, Tool, Bucket, and Organization Unit)
enable you to differentiate the hierarchy of the Resource Tree. Each role is represented with the icons, Blue, Yellow, or
Grey.
By default, the Load Threshold section displays (unless the Organization Unit role is selected) on the Add Resource
Type dialog box and has the following options to determine how the icons display on the resource tree based on the
resource’s load (full, normal, or empty load):
• Number of Activities: Defined amount of activities, over which a resource is considered to have full load and
below which is considered an empty load.
• Hours: Defined amount of hours including travel, over which a resource is considered to have full load and
below which is considered an empty load.
• Time Percent: Defined % of a resource’s work schedule for the day that includes activities and travels among
them that is considered to be full, normal or empty. Travel time to and from work for the day is not included in
these calculations.
Note: Specify the number of activities, hours, percentages in the Full Load or Empty fields. The display of icons on
the resource tree depends on the specified values. For example, if 10 activities represent Full load, then the Blue icon
displays.

Add a Resource Type for the Field Resource Role
A Field Resource is a resource that performs work, has work skills and work zones associated, and has a related user
(actual person performing work or group of people). A Field Resource requires a user, can work, is shown with a Tech
icon, and does not include the Organization unit option.
Assume that you want to assign activities to a technician. You have to first create the resource type, Technician and then
select Field Resource from the Role drop-down list.
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Note: Some features are available only during the initial configuration. This will vary based on the options selected
during the configuration. Features that are not available for editing after the initial configuration will be greyed out.
To add a resource type for the Field Resource role:
1. Click Company Name > Configuration .
2. Click Resource Types in the Resources, Activities, Inventories section.
3. Click Add resource type.
4. Complete these fields:
Field

Description

Name (mandatory)

Enter a name for the resource type. All supported languages are listed.

Label (mandatory)

A unique identifier for the resource type that is mapped to the REST API.

Active

By default, the Active check box is selected and the resource type is activated.

Statistic Parameters section
Personalize the estimation of activity

When selected, the resource’s personal profile is used for duration calculations. Else, uses only

duration check box

company estimates. For more information, see How Activity Duration Is Calculated

Use durations reported to enhance

When selected, company-wide estimations are modified based on the data reported by the

company-wide estimations check box

resource. If not selected, the company-wide estimations are not changed. This applies to both
activity durations and travel estimations. don't select this check box, if you don't want the
durations reported by the resource to affect company level estimations.

Do not consider reported data for the

Data reported by the resource does not affect the company-wide estimations for the initial

first ____ working days, for statistic

number of days specified in this field. The date is considered from the time the user accesses

estimations

the system. Default value is 5 days. For example, if you enter 15 days, then the data reported
by the resource for activity and travel durations are ignored for the first 15 days and will not be
considered while calculating the company-wide estimates. This field is enabled only if the Use
data reported to enhance company-wide estimations field is selected.

5. Select Field Resource from the Role drop-down list.
6. Select the required features from this list:

◦
◦

Resource can participate in a team: Select the Resource can participate in a team check box to
determine whether the resource type is an assistant for teamwork activities. If deselected, then you
cannot add the resource type, technician as an assistant to a team.
Resource can be a teamholder: Select the Resource can be a teamholder check box to determine
whether the resource type is a primary team holder of an activity.
Note: An activity that requires a team is always assigned to the team holder whereas the assisting
teamwork activities are assigned to the assistants for the duration of the teamwork.

◦

Share inventory in teamwork: Determines whether the resource type shares inventory with other team
members after an activity is started. For example, if the team holder’s inventory has 5 items and the
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assistant’s inventory has 3 items, then when the activity is started, there are 8 items available for use at
the job site.
Share geolocation in teamwork: Select the check box to define whether a resource (team holder or
assistant) shares the geolocation in a teamwork assignment. Although, the application uses the GPS
device of each resource to predict the location of the resource, these situations can occur:
- Application is unable to obtain coordinates since the device of a resource has stopped to work.
- Application is unable to find the location of the resource due to some reasons.
In the above situations, the application uses an algorithm to predict the location of the resource using the
coordinates of other resources in the team. Therefore, you can view the location of each team resource in
the map view.
Share work skills in teamwork (team-member only): Enables the resource to share work skills with the
team holder. Sharing is defined on the work skill level according to the "Sharing of the skill in the team"
parameter configured in the Add work skill dialog box.
Used for Quota management: Enables you to consider the working time of each resource into the
overall workflow capacity calculation of the bucket.
For example, assume that each resource (Technician 1, Technician 2, and Technician 3 configured as
a Field Resource) has a capacity of 480 minutes per day and the Use as Capacity Area check box is
selected for each resource. Therefore, the Max Available field in the bucket has the overall workflow
capacity of 1440 minutes. Now, if a new resource type, Technician 4 is added and if the Use as Capacity
Area check box is selected, then the overall workflow capacity of the bucket changes to 1920 minutes.
Routing can assign activities: Select the check box if you want routing to assign activities to a resource.
If selected, these options enable you to specify the cost of the resource’s time that helps you to
differentiate between resources (for example, Full time resources versus Contractors):

◦

- Working hours cost: Actual working hours of the resource during the day based on activity
durations. Select an option (Low, Normal, High, Highest). The routing algorithm factors working
time cost differences between resource types for assignments.
- Overtime cost: Overtime refers to the minutes worked beyond the end of the resource’s working
hours for the day. Specify cost increases either as X minutes after the end of the shift or the time
beyond the X minutes threshold.
- Travel Time cost: Refers to the estimated time and the cost required for travelling between
activities.
Working time : Define the travel allowance for resources using these options:
- Start travel: Enables routing to consider travel time from the beginning of the resource’s working
time for the day and to the resource’s first activity. The application estimates the actual travel time
to the location of the first activity, when a resource’s Start location is defined. Note that when a
route includes activities that require travel and activities that don't need travel, the travel between
activities is split into two (or more) pieces by inserting non-travel activities in between. If there is
any idle time before an activity, it is considered as travel time for the next activity. Select one of
these options:
◦ Travel time to the first activity is not included from the Working Time Start – when selected,
travel time to the first activity will be calculated before the Working Time Start value. If an
activity has a Service Window of 8:00 am-10:00 am, the activity will have an ETA of 8:00 am
and the resource will have to leave their start location to arrive by 8:00 am.
◦ Travel time to the first activity is included from the Working Time Start – when selected,
travel time will be calculated to the first activity. If a resource has 30 minutes of travel and the
activity has a service window of 8:00 am-10:00 am the activity’s ETA will be 08:30 am.
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◦

Resource is allotted up to <number> minutes of travel time prior to the Working Time Start
– when selected, a portion of the travel time can occur prior to the start of the shift. If the
value is set to 30 minutes and the resource need 45 minutes of travel the first 30 minutes will
occur prior to the start of the shift and the ETA activity’s ETA will be 08:15 am.
- Final travel: Enables routing to consider travel time to a known end location. Select one of these
options:
◦ Travel time from the last activity to the Resources End Location is not included from the
Working Time End – when selected, travel time to the final location will be calculated after
the Working Time End value. If a resource’s shift ends at 6:00 pm with no overtime allowed,
routing can assign activities that can end at 6:00 pm.
◦ Travel time from the last activity to the Resources End Location is included from the Working
Time End – when selected, travel time to the final location will be calculated. If a resource’s
shift ends at 6:00 pm with no overtime allowed, routing cannot assign activities that can end
at 6:00 pm.
◦ Resource is allotted up to <number> minutes of travel time after the Working Time End
– when selected, a portion of the travel time will occur after the shift ends. Suppose that
the resource’s shift ends at 6:00 pm with no overtime allowed. When the value is set to
30 minutes and the resource needs 45 minutes of travel to the end location, the latest an
activity can end would be 5:45pm.
◦ Enable 'Not activated in time' alert and trigger: Represents an alert that the resource’s route is
not activated. For example, consider the resources, Technician 1 and Technician 2 configured as field
resources. If the Enable 'Not activated in time' alert and trigger check box is selected for the resource,
Technician 1 and not selected for Technician 2, then the notification messages are created only for
Technician 1.
7. Click Add.
Note: These features are available when a role, Vehicle or Tool is assigned to a resource type:
◦ Share inventory in teamwork

◦
◦
◦
◦
◦

Share geolocation in teamwork
Share work skills in teamwork (team-member only)
Working time includes travel to first activity
Working time includes travel from last activity
Enable 'Not activated in time' alert and trigger

The resource type, technician displays on the Resource Types page. If you click Modify and change a feature setting of
a resource type, the application automatically applies the changes to the resource type.

Example of a Travel Allowance Calculation
Roger’s assigned Resource Type has these Work Time configurations:
• Travel time to the first activity is included from the Working Time Start
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• Travel time from the last activity to the Resources End Location is included from the Working Time End
Jane and John’s assigned Resource Type has these Working Time configurations:
• Resource is allotted up to 30 minutes of travel time prior to the Working Time Start
• Resource is allotted up to 30 minutes of travel time after the Working Time End
Consider Roger, Jane, and John, who have their work shift from 9:00 am to 6:00 pm and these distances from work
place:
• Roger lives 30 minutes from his first and last job. So, for both jobs, 30 minutes of travel is included part of his
workday.
• Jane lives 45 minutes away from the first and last job. So, for both of her jobs only 15 minutes of the travel
should be counted as part of her workday and the additional 30 minutes is beyond her workday.
• John lives 20 minutes away from his first and last job. So, no travel is part of his workday and the 20 minutes
travel for the last job is done beyond his workday.
Using this example, if a new activity is created that is estimated to finish by 5:45 pm and overtime is no allowed, routing
will not assign this activity to Roger. If it was assigned, Roger would incur overtime, because his shift ends at 6:00 pm.
The routing engine would look for a more suitable resource.

Add a Resource Type for the Bucket Role
A bucket accumulates the work that has not yet been distributed to field resources. A bucket does not require a user,
cannot process work or activities, is shown with a Double Tech icon, includes the group option, and can have activities
assigned.
Note: Some features are available only during the initial configuration. This will vary based on the options selected
during the configuration. Features that are not available for editing after the initial configuration will be greyed out.

1.
2.
3.
4.
5.

Click Configuration.
Click Resource Types in the Resources, Activities, Inventories section.
Click Add resource type.
Select Bucket from the Role drop-down list.
Complete these fields:

◦
◦
◦

Name (Mandatory): Enter a name for the resource type. All supported languages are listed.
Label (Mandatory): A unique identifier for the resource type that is mapped to the REST API.
Active: Select the Active check box to activate the resource type.

6. Select the Use as Capacity Area check box.
This option is available only if you have purchased Capacity Cloud Service. For more details about Quota
Management in Bucket, see the Oracle Field Service Using Capacity Cloud Service Guide guide.
7. Select the Routing can assign activities check box if you want routing to assign activities to the bucket.
8. Click Add.
The Bucket resource type displays on the Resource Types page.
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Add a Resource Type for the Organization Unit Role
An organization unit aggregates field resources, vehicles, and tools in a hierarchical structure to simplify management
and reporting. An organization unit does not require a user, cannot process work or activities, is shown with a Double
Tech icon, includes the group option, and can have activities assigned.
Note: Some features are available only during the initial configuration. This will vary based on the options selected
during the configuration. Features that are not available for editing after the initial configuration will be greyed out.
1.
2.
3.
4.
5.

Click Company Name > Configuration .
Click Resource Types in the Resources, Activities, Inventories section.
Click Add resource type.
Select Organization unit from the Role drop-down list.
Complete these fields:

◦
◦
◦

Name (Mandatory): Enter a name for the resource type. All supported languages are listed.
Label (Mandatory): A unique identifier for the resource type that is mapped to the REST API.
Active: Select the Active check box to activate the resource type.

6. Select the Use as Capacity Area check box to aggregate the capacity across buckets.
For example, assume that the maximum available capacity for Bucket 1 is 1920 minutes and the Use as
Capacity Area check box is selected. Bucket 2 has a maximum available capacity of 2400 minutes and the
Use as Capacity Area check box is not selected. Now, if you select the Use as Capacity Area check box for
Bucket 2, then the Group resource type aggregates the capacity across Bucket 1 and Bucket 2 and changes the
maximum available capacity of the Group to 4320 minutes.
7. Click Add.
The Organization Unit resource type displays on the Resource Types page.

Add a Resource Type for Contingent Worker
Contingent (or Infrequent) Workforce is one where the workers don't work directly for the company. They are
contractors that may not have dedicated or assigned routes everyday. They will be assigned work infrequently on an adhoc basis.
Note: You must have selected the Contingent Worker service and it must be available as part of your Oracle Field
Service subscription.
1.
2.
3.
4.

Click Configuration.
Click Resource Types in the Resources, Activities, Inventories section.
Click Add resource type.
Complete these fields:
Field

Description

Name (mandatory)

Enter a name for the resource type. All supported languages are listed.
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Field

Description

Label (mandatory)

A unique identifier for the resource type that is mapped to the REST API.

Active

By default, the Active check box is selected and the resource type is activated.

5. Select Field Resource from the Role drop-down list.
6. Select the Resource is a contingent worker check box.
The remaining check boxes are grayed out. These rules apply to contingent worker resources:
◦ When the Resource is a contingent worker check box is selected, the Role cannot be anything other than
"Field Resource".
◦ This resource cannot participate in teamwork.

◦
◦
◦
◦
◦
◦

This resource cannot access resources other than themselves.
This resource cannot access the video chat service if provisioned.
Quota does not consider contingent workers while calculating the available capacity.
Bulk, urgent, and immediate routing don't assign activities to this resource.
The alert regarding route activation does not display for this resource.
Travel and activity duration from these resources are not included in the company-wide statistics.

Note: The Resource is a contingent worker check box is grayed out on the Edit resource type dialog
box. This means, after you create a contingent worker resource type, you cannot change it back to a normal
resource. Further, a contingent worker resource can only be a field resource and this resource must have
only one corresponding contingent worker user. Contingent workers are automatically removed from the
application, if they have not activated a route in 12 continuous months.

Activity Booking
When a technician performs an activity at the customer's premises, the customer may enquire about the possibility to
perform another job for them on a different day. The technician must be able to collect the information about the new
job, create an activity, and schedule it right away. To book an activity, the technician must also have the ability to check
the available capacity for that specific date and time. This situation is handled by the Activity Booking option. You must
configure the activity booking context properly to get the most accurate and precise capacity calculation. The Book new
activity option is configured in the Application screens section of the Screen Configuration page.
Note: The activity booking functionality, Quota management page, and the Capacity Area configuration functionality
are available only with the "Oracle Field Service Enterprise Cloud Service" subscription.
Technicians can book activities in three ways:
• Direct assignment booking
• Quota based booking:
◦ Time slot based

◦

Booking interval based (or availability based)
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Direct Assignment Booking
Activity booking uses the activity information and finds all the Capacity Areas that match the activity requirements. If a
Capacity Area is configured for booking using direct assignment, the activity is created (or reassigned) in a technician’s
route, provided the technician meets the activity requirements and has enough time to complete it. When there are
many available resources that can work on the activity for a particular date and time slot, Oracle Field Service assigns
the activity to one of them. The application typically finds a technician that has a smaller set of working skills than a
technician with a wider skillset. This way, resource selection is optimized, so that the following activities that require
booking have more available options. With this feature, technicians can control the booking strategy that is used on a
Capacity Area level. Technicians can also configure different capacity areas to use different booking strategies.
Availability-Based Booking
Technicians can book activities for Capacity Areas with booking interval based quota configuration. They can use the
booking interval based quota when the time slots overlap or, have a significant variation in the activity duration. When
technicians choose the booking interval based quota, they must select the booking intervals on the Quota Configuration
page. If they do not select the booking intervals, the application uses the default Capacity intervals that are configured
on the Business Rules page.
When you configure a Capacity Area for booking using Quota (time slot based or availability based), then the activity
is created (or reassigned) on the bucket that is associated with the Capacity Area. If there are multiple Capacity Areas,
the technician must select a Capacity Area, select the day and time slot on which they want to perform the activity, and
book it.
You can obtain the booking options from the application in two ways:
• Through the Activity Booking page.
• Through the new API function showBookingGrid. This API simplifies the process of integrating the Booking
functionality with external applications.
Regardless of the method, the application uses the activity information you have entered and provides you the list of
options where it may be booked.
As soon as you book an activity, Oracle Field Service subtracts the capacity required for its performance from the
available capacity and adds it to the used capacity. It compares the used capacity to the quota values to make sure that
orders for new activities are accepted only when the capacity is still available. Аs having capacity information up-to-date
is crucial for the functionality, Activity Booking is available only in the online mode.

Prerequisites for Using the Activity Booking Feature
If you want to use the Activity Booking feature, you must complete these tasks:
1. Configure the radius within which you want Oracle Field Service to consider the activities. You must configure
the Nearby Radius field on the Business Rules page for this. Go to Configuration > Business Rules to
specify the Nearby Radius value.
2. Add the fields required for booking activities to the Book new activity Visual Form Editor. Typically, you need
activity type, activity address, work skills for the activity, work zone it belongs to, activity duration, and the
coordinates of the activity. On the Schedule booked activity Visual Form Editor, configure the fields that
your technicians see when they reschedule an existing activity. Go to Configuration > User Types > Screen
configuration > Book new activity (or Schedule booked activity) to add the fields.
3. Add the Book (create) activity and Book (reschedule) activity buttons to the Edit/View activity and the
Activity hint Visual Form Editors. Technicians use these buttons to book and reschedule activities. Go to
Configuration > User Types > Screen configuration > Edit/View activity or Activity hint to add the buttons.
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4. Configure the Capacity Areas for booking activities. You can configure a different type of booking option for
each Capacity Area. For more information, see the Using Capacity guide.
5. Configure the booking recommendations. You can show or hide the booking recommendations for each
Capacity Area separately. For more information, see the Using Capacity guide.

Create a Layout for Booking an Activity
Use the Book new activity option in the Application screens section of the Screen Configuration page to create a
layout for booking an activity.
1.
2.
3.
4.

Click Configuration > User Types.
Select the user type for which you want to add a layout for booking a new activity.
In the Access settings section of the General tab, select the Allow access via web application check box.
Expand the Application screens section and click Book new activity.

The Visual Form Editor opens.
5. Drag-and-drop the fields that you want on the Book new activity page.
You must have Activity type (aworktype) field. However, you cannot add file type of fields or properties, tabs,
and the Time slot field.
6. Select the visibility settings for all the fields.
7. Click Submit.
The layout is saved.
8. Add the Book (create) activity button to the Edit/view activity Visual Form Editor:
a. Expand the Application screens section and click Edit/view activity.
b. Drag and drop the Button element.
c. Click the element and then click the pencil icon in the Standard action screen field.
d. Select Book (create) activity and click OK.
e. Click Save.
If you want technicians to reschedule existing activities, add the Book (reschedule) activity button.

Activity Type Constraints
The activity booking function applies a number of constraints on certain activity types.
Some activity types determine whether at all an activity can be booked, while others affect the configuration of different
properties on the context. The list of activity types is available in the Activity Types page. Click Configuration >
Activity Types to access the Activity Types page. Describe only those activity type constraints and conditions that
apply equally to all the activity types that you want to be available for booking.

Include Time Slot Support
By default, activity types do not have the Support of time slots option selected. You must select the Support of time
slots option for each activity type that is to be considered for booking.
1. Click Configuration > Activity Types .
2. On the Activity Types page, select the type of activity that you want to be considered for booking.
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3. Click Modify.
4. Select Support of time slots, and then click Update.

Time Slot Page Configuration
The Schedule booked activity context defines the layout of the Time Slot page. While the time slot selection widget is
pre-configured and cannot be changed, all other details of the booked activity can be specified in the Schedule booked
activity context.
These restrictions apply to the context configuration:
• You can add only read-only visibility condition for activities or properties on the context layout.
• You cannot create tabs in the Schedule booked activity context.
Otherwise, there are no special constraints, as opposed to the Book new activity context. The Schedule booked activity
context is available in the Application screens section of the Screen Configuration page.

Include the Calculate Travel Option
If you select the Calculate travel option for the activities to be booked, then the capacity calculation additionally
considers all fields and properties defined in the Activity travel stats fields section of Statistics.
1. Click Configuration > Activity Types .
2. Click Modify against the activity type for which you want to add the option.
3. Select the Calculate travel check box and then click Update.
When you select this feature, you must add all the fields that you have selected for the Activity travel stats
fields on the Statistics page to the Book new activity context layout and set the visibility as Mandatory.

Include the Calculate Activity Duration Using Statistics Option
If you select the Calculate activity duration using statistics option for the activities to be booked, then the capacity
calculation additionally considers all fields and properties in the Activity duration stats fields selected on the
Statistics page.
1. Click Configuration > Activity Types .
2. Click Modify against the activity type for which you want to add the option.
3. Select the Calculate activity duration using statistics check box and then click Update.
When you select this feature, you must add all the fields that you have selected for the Activity duration stats
fields field on the Statistics page to the Book new activity context layout and set the visibility as Mandatory.

Enable Work Zone Support
You must enable Work Zone Support for booking activities. If you have enabled Work Zone Support at both,
the company level and the activity level for the corresponding activity types, all fields from the work zone key are
considered for capacity calculation.
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1. To enable Work Zone Support at the company level:
a. Click Configuration > Business Rules .
b. Select Work Zone support in the General section.
2. To select this option at the activity level:
a. Click Configuration > Activity Types .
b. Click Modify against the type of activity that you want to be considered for booking.
c. Select Support of work zones, and then click Update.
3. Click Configuration > Work Zones and note down the field selected for Work Zone Key.
4. Add this field with a Mandatory visibility in the Book new activity context layout.

Enable Work Skill Support
You must enable Work Skill Support for booking activities. If you have enabled Work Skill Support at both, the
company level and the activity level for the corresponding activity types, all fields from the work skill conditions are
considered for capacity calculation.
1. To enable Work Skill Support at the company level:
a. Click Configuration > Business Rules .
b. Select Work Skill support in the General section.
2. To select this option at the activity level:
a. Click Configuration > Activity Types .
b. Click Modify against the type of activity that you want to be considered for booking.
c. Select Support of work skills, and then click Update.
3. Click Configuration > Work Skills > Work skill conditions .
4. Open the work skill that you want to be considered for booking and note down the work skill conditions.
5. Add this field with a Mandatory visibility in the Book new activity context layout.

Activity Booking Error Messages
This section provides the list of possible errors and the corresponding messages the user may encounter while booking
activities.

Missing Context Error
If at least one of the two contexts ('Book new activity', 'Schedule booked activity') is not added before using the Activity
Booking functionality, the message: Form is misconfigured. Context layout missing appears. Depending on which
context is missing, the error is shown so, you can access the corresponding pages.

Validation Errors
If any of the mandatory fields is empty on the booking activity contexts ('Book new activity', 'Schedule booked activity'),
the validation message, Validation failed, please review your form is shown. If a time slot has not been selected on the
Time Slot page, the activity is not booked and the message, Validation failed, please review your form. Time slot is not
selected is displayed.
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Capacity Calculation Errors
Capacity is not calculated in these cases:
• Data entered in the previous step (creating booked activity) is insufficient.
• A configuration has not been properly performed.
• There is no available capacity that matches with the activity parameters.
The possible error messages that may occur at the capacity calculation stage, that is after submitting information
entered in the booking activity form are as follows:
• Work skills support is disabled at the company level.
• Work skills are not supported by this type of activity.
• Capacity category cannot be determined using the given activity fields.
• The selected activity type is inactive.
• Work zone cannot be determined by the given activity fields.
• Field or property that is required for work zone 'location' value calculation is missing.
• Time slots are not supported by this type of activity.
• Field or property that is required for the duration estimation is missing.
• Field or property required for travel estimation is missing.
• The matching buckets found don't have the required quota for booking this activity.
• Unable to find appropriate quota bucket for this activity.
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Glossary Entries
Use the Glossary to configure the default names of UI elements to your business needs. For example, instead of the
default term for the Activity Status, Completed, you can use the glossary to configure the term to display as Done.
You can configure the description of a user-interface element, only if the element corresponds to a glossary item in the
Oracle Field Service glossary.
The changes made to glossary references are global, that is, the change is consistent for all users. However, the same
glossary entry might belong to different categories or sub categories. For example, the glossary entry, Not Done belongs
to the categories, Activity Status, Activity History Operation, Notification Trigger Name, and Action Link. If you modify
the glossary entry, Not Done that belongs to the category, Activity Status, then the change does not affect other
categories.
Note: The glossary entries for the Screen Configuration (Application screens and Collaboration and Identifiers)
categories are configured for the selected user types.

The Glossary Visibility Profile permission that controls the access to the Glossary page for a User Type is set using the
Company Configuration context in the Screen Configuration, Application screens section. Only User Types that have
Read/Write access can modify the glossary.
These columns display on the Glossary page:
• Category: Displays the category and the sub category, if available, in the format, <Category:Subcategory>. For
example, Activity: First Manual Operation.
• Label/ID: The label/ID of the glossary entry displays. If label is not available, the ID displays. You cannot change
labels in the glossary.
• Columns for each language: The selected languages are displayed. See Add an Active Language.
You can click the text highlighted in red on any of the Language column to view the number of missing glossary entries.
When you update one of the missing glossary entries, the red highlight on the text box disappears and the count in the
Language column is updated. If no entry is missing, the warning text on the column header disappears.
Click the Search icon in the search field to list the glossary entries. You can select a specific category from the dropdown list next to the search box and enter a term in the Search field to search for the required glossary entries.
By default, the original text for all glossary entries is displayed. When you modify the original text of a glossary entry
and click Save, the modified text is overwritten. However, the original text is still visible, when you hover the mouse over
the modified text.

Modify a Glossary Entry
Oracle Field Service glossary items have a unique identifier referred to as placeholder IDs. The Placeholder ID that
displays next to an UI element lets you identify the correct glossary item that you want to edit in the Glossary page. For
example, you can use Show instead of View.
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You can also modify the description of an UI element using an in-context editor, so that you need not access the
Glossary page. This example explains how to modify the description of a UI element, View, using placeholders and incontext editor. To modify a glossary entry:
1. Select your user name (for example, Admin) at the top right corner.
2. To modify the description of each UI element using placeholders:
a. Select My Display.
b. Select the Show Placeholder ID check box.
c. Click OK and refresh the page.

d.
e.
f.
g.
h.

Each UI element that corresponds to an Oracle Field Service glossary item in the application displays an
ID next to them.
Select Dispatch,Activities.
Make a note of the placeholder ID (for example, 8047) for the UI element, View.
Click Configuration.
Click Displays, Glossary.
Enter the Placeholder ID in the search field and click the Search icon.

The glossary entry displays.
i. Select English as the language and enter the term, Show in the field.
j. Click Save.
The glossary entry is modified and you can view the original text, View when you hover the mouse over
the modified term, Show.
3. To modify the description of each UI element using the in-context editor:
a. Repeat steps 1 to 2.c from the above procedure.
b. Select your user name (for example, Admin) and select Glossary Editor is Off.
The in-context glossary editor is turned on.
c. Select Dispatch, Activities.
d. Select View.
e.
f.
g.
h.

An on-screen glossary editor displays.
Enter the term, View in the English field.
Click Save.
Deselect Glossary Editor is Off and the Show Placeholder ID check box from the My Display page.
Refresh the page.
The modified description displays.

Export and Import Glossary Items
You can export the glossary entries to a .csv file to achieve these goals:
• Translate a list of glossary entries to one of the selected languages that is set using the Languages button.
• Modify a list of glossary entries.
Note: It is recommended that you use a text editor to update the glossary terms. don't use Microsoft Excel,
as it converts the .csv file from a comma-delimited file with quote qualifiers to a comma-delimited file
without quote qualifiers.
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You can simultaneously update a list of glossary entries and import the updated list into the application. This example
explains how to export a list of glossary entries related to the Activity Hint Category, and import the modified entries
into the application. To export glossary entries:
1. Click Configuration.
2. Click Displays, Glossary.
3. Select Activity Hint as the Category from the drop-down list.
The entries related to Activity Hint display.
4. Click Export.

5.
6.
7.
8.
9.
10.

The Export dialog displays and by default, the languages that display on the Glossary page are selected. You
can also export the entries to any of the deselected languages. To add a language, see Add an Active Language.
Select the Filtered option to only export the entries related to the Category, Activity Hint. Or, select the All
option to export all the glossary entries.
Click Export.
Save the file in the .csv format, for example, test.csv.
Open test.csv, modify the required entries in the English (en-US) and Spanish (es-ES) columns, and save the
file.
Click Import on the Glossary page, select test.csv, and click Import.
Click Save.
The modified entries display in the English and Spanish columns.

Add an Active Language
You can select the active languages, that is, the languages that you want to display on the Glossary page without
accessing the Company Language setting. Based on your selections, the Language columns (drop-down lists that let
you toggle among the selected languages) are updated.
Note: You can only view two columns on the Glossary page.
To add an active language:
1. Select Languages from the Glossary page.
2. Click the Plus icon.
3. Select the language, for example, Spanish and click Add.
The selected language displays in the Languages list.
4. Click OK.
The selected language, Spanish displays as an option in both the Language columns.

Edit Property Descriptions
You can edit the description for properties for each user type and for each page separately using these categories:
• Screen Configuration - Application screens
• Screen Configuration - Collaboration and Identifiers
Each category has a sub category that is associated with the respective page within Screen configuration. For example,
the Activity fields sub category for export that belongs to the Screen Configuration – Manage category is associated
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with the Activity fields for Export page that belongs to the Screen Configuration – Manage category within the
Configuration, User Types page.
Note: If you share a page configuration across multiple user types, then the properties of that page configuration are
also shared. So, any change to the description of a property of that page configuration, affects all user types.
Let's say you share the page configuration that belongs to the Administrator user type across the Technician and Field
Engineer user types. The properties of the page configuration that belongs to the Administrator user type are also
shared.
Assume that the Activity fields for Export page that belongs to the Administrator user type has a property named
Work Order and the page is shared across the Technician and Field Engineer user types. When you edit the glossary
entry for the Work Order property, the changes are also applied for the Technician and Field Engineer user types.
By default, the Glossary page displays all properties for each page within Screen configuration. If there are custom
names for any of the user types, then the original and custom names for the property are displayed in a commaseparated format for each language.

Example of Editing a Property Description
This example shows how to add a custom name, Job Code for the Work Order property to the Technician user type. You
can do this on the Activity fields for export page that belongs to the Screen Configuration – Manage category.
1. Click Configuration > Glossary .
2. Select Screen Configuration – Manage from the drop-down list and click the Search icon.
The properties related to Screen Configuration – Manage display.
3. Click the Edit icon in the language column that is displayed for the Work Order property for the Screen
Configuration - Manage: Activity fields for export category.
If you have edited the property before, the original name and the user types to which the current name applies
are displayed. If you have not edited the property so far, all the user types are displayed.
4. Click the Plus icon and select the user type, Technician.
The Edit Custom Names for User Types page and the Plus icon display when there are custom names for user
types. If there are no custom names for user types, the Add page displays when you click the Edit icon.
5. Click Add.
6. Enter the custom name, Job Code in the field.
7. Click OK.
The custom name Job code displays with the original name Work Order, in a comma-separated format for each
language.

Configure the Display Page
You configure the Display page to change the way the user interface appears to the end user. While you may retain
the default settings for most of these settings, you can change a few settings during implementation based on your
business needs.
The Display visibility profile permission controls the access to the Display page. You must set this permission for each
user type that manages the Display settings. If you don’t configure the permission or the visibility, the Display page is
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not visible to the user. If you select ReadOnly, Display is placed into a view only mode. If you select Read/Write for this
setting, the user can manage Display. To configure the display settings:
1. Click Configuration.
2. In the Displays section, click Display.
The Display page appears.
3. Complete these fields:
Field

Description

General
First day of the week

The week that the working week begins.

Time input

The way time is entered in the application-whether it is chosen from a drop-down with fixed
increments or is entered manually.

Allow application to be launched inside

Lets you launch the application in an iFrame.

iframe
Remember User Name on Login Screen

The control to display the Remember my username check box on the Login page. Selecting
the Remember my username check box saves the user name and populates it automatically,
when a user uses the same device and browser to log in to the application. This feature is
available only for users who have the Internal and LDAP login policies, and not for users who
have the SAML or OpenID Connect policies. If a user’s authentication fails, the user name is not
populated when the user logs in the next time.

Enable password reset on Login screen

Displays the Can’t sign in link on the Login page, which helps users reset their passwords.
Resetting the password is a global feature and is available only for users assigned to an Internal
Login Policy. This is not available for users assigned to LDAP, SAML, and OpenID Login Policies.
Selecting this check box displays the Email for password reset field.

Email for password reset

The source from which you want to get the email address of the user, who wants to reset their
password. This field includes custom properties that can be chosen as the source of the email
address to which the recovery email is sent. The custom properties are displayed only if these
conditions are satisfied:

◦
◦
◦

Entity = User
Type = String
GUI = Text or Email

Company time zones
Time zones

The globally available times zones. Use the Edit icon to add the required timezones.

Company language
Languages

The globally available languages. Use the Edit icon to add the required languages.

Login screen language

The language used on the Login page when accessing the application.

Mobile settings
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Field

Description

Number of activities per page

The number of activities or resources to appear on one page on the mobile device. Default
value is 5.

Number of inventory per page

The number of equipment records to appear on one page on the mobile device. Default value is
10.

Number of days to view on the

The number of days to appear on the mobile device at a time. Default value is 14.

Calendar screen
Idle time minimum

The threshold under which idle time is not displayed on the Time View.

Quota settings
Major Capacity Usage

On the Quota grid, quota and minutes used display in brown once used = X% (major) of initial
quota. Enter the percent of quota that indicates major capacity usage.
Expected duration comprises [……] % of quota.

Critical Capacity Usage

On the Quota grid, quota and minutes used display in bright red once used = X% (critical) of
initial quota. Enter percent of quota that indicates critical capacity usage.
Expected duration comprises [……] % of quota.

Enable Plan column that shows data set Whether a plan created in forecasting is available in the quota management page.
in Forecasting
Alert settings
Activity has not been started x minutes

The activity turns red and a Resource Tree warning appears based on the value set in this field.

before the end of Service Window

Enter the number of minutes preferred.

Activity has not been completed x

The activity turns red and a Resource Tree warning appears based on the value set in this field.

minutes before the end of SLA Window

Enter the number of minutes preferred.

Route has not been started x minutes

A warning appears on the resource’s record within the Resource Tree. Enter the number of

after the start time of resource work

minutes.

day
Activity has not been started x minutes

A warning appears on the resource’s record within the Resource Tree. Enter the number of

after ETA

minutes.

Activity list settings
Travel time representation

The color for travel time, if a visual of travel time is desired on the Time and List views.

Resource tree visualization
Show assistants

Shows assistants on the Resource Tree.

Show teams

Shows teams on the Resource Tree.

Show activity/teamwork counters

Shows the count of activities or teamwork on the Resource Tree.
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Description

Map
Fade resources

Whether a resource becomes transparent after geolocation data update.

Fade resource time

The number of minutes after geolocation data update after which a resource’s time becomes
transparent.

Hide resource time

The number of minutes after geolocation data update after which a resource’s time is hidden.

Activity history
Monitored activity fields

The list of activity fields to be monitored. If one of these fields (or properties) is changed, a
record is inserted into a corresponding history table. Use the Edit icon to add the required
activity fields.

Monitored inventory fields

The list of inventory fields to be monitored. If one of these fields (or properties) is changed,
a record is inserted into a corresponding history table. Use the Edit icon to add the required
inventory fields.

History user type

The user type to be used to build the identifiers of objects (activities, inventory, and service
requests) that are to be logged into the history.

4. Click Save.
The settings are saved.

Set Your Language
Oracle Field Service has 29 languages available to be set up as your preferred language. Manage the language setting
specific to your company requirements.
Note: A few terms (such as words used in report headers) may not get translated to the language selected as the
company's preferred language. The languages Afrikaans, Arabic, French (Canada), Hebrew, Persian, and Spanish
(Mexico) are not translated by Oracle and the login pages are in shown in English.
1. Click Configuration > Display
2. Under Company Language, click the pencil icon in the Languages field.
3. On the Languages page, click the plus icon and then select the languages that you want to add as preferred
languages.
These languages are supported:
◦ English

◦
◦
◦
◦
◦

Afrikaans
Arabic
Chinese (Simplified)
Chinese (Taiwan/Mandarin)
Czech
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Danish
Dutch
Finnish
French (Canada)
French (European)
German
Greek
Hindi
Hebrew
Hungarian
Italian
Japanese
Korean
Norwegian
Persian
Polish
Portuguese (Brazil)
Romanian
Russian
Spanish
Spanish (Mexico)
Swedish
Turkish

The remark, '* Oracle doesn't provide glossary translation.' indicates that the translations are not
available for this language and you must add the translations by yourself.
4. Click Add and then click OK.
5. From the Login Screen Language drop-down list, select the language in which you want to display the login
page.
6. Click Save.
The selected language is set.

Themes
A theme defines the look and feel of the user interface. You can use the standard themes namely Classic, Vanilla, and
Redwood. Or, you can create a theme based on your organization's branding colors.
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View Themes
You can create custom Themes that use your own logos as headers in the user interface, including the Login page. In
addition, you can define a custom theme color, which appears as the header. The Themes visibility controls the access
to Themes. For each user type that manages Themes, set the Read/Write permissions. When you set the visibility to
ReadOnly, the Themes page is grayed, and when you don’t grant the visibility, the Themes page is not visible at all.
1. Click Configuration.
2. In the Displays section, click Themes.
The Themes page appears and displays these fields:
Field

Description

Name

The name of the theme.

Default

Displays whether the theme is selected as the default theme. The default theme has a check
mark next to it. When you click Select default, you can set whether all users or only new users
will have this theme set as the default.

Active

Displays whether the theme is active. An active theme has a check mark next to it. The Set
enable or Set disable actions determine whether the theme is active or not.

Actions

Displays the actions available for the Theme. These actions are available:

◦
◦
◦
◦
◦
◦

Edit – Allows editing the options for the selected theme. See the Add a Theme section for
an explanation of the options.
Set default - Sets this theme as the default theme. You can set whether all users or only
new users will have this theme set as the default.
Set enable - Enables a currently disabled theme.
Set disable - Disables a currently enabled theme.
Export – Exports the details of the theme to a zip file. The zip file can be used to import
the theme into another Oracle Field Service instance.
Delete – Deletes the theme.

Add a Theme
You can create custom Themes to use your own logos as headers in the user interface and use your branding colors
for the application page background, header, and the Submit button. The Themes visibility controls the access to the
Themes. For each user type that manages Themes, set the Read/Write permissions. When you set the visibility to
ReadOnly, the Themes page is grayed, and when you don’t grant the visibility, the Themes page is not visible at all.
1. Click Configuration.
2. In the Displays section, click Themes.
The Themes page appears.
3. Click Add new.
The Add theme dialog box appears.
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4. Complete these fields:
Field

Action

Name

Enter a name by which you want to identify the theme.

Copyright

Enter the Copyright information. The text must contain placeholders for {YEAR} and {VERSION}
that will be automatically replaced with the current year and the major version. Example: ©
2003-{YEAR} Oracle Corporation. All rights reserved. Version {VERSION}. The maximum length
of this string is 255 characters.

Logo tab
Logo

Select the logo in .png format. This logo is used with pages of width 1024 and more, or between
320 and 768.

Logo for Login page

Select the logo in .png format. This logo is used in the login portal.

Color scheme
Header color

Select the color for the application header. Click this field and select a color from the color
editor. Or, enter the hexadecimal code for the color. The selected color is displayed in the
preview section.

Page background color

Select the color for the application page. Click this field and select a color from the color editor.
Or, enter the hexadecimal code for the color. The selected color is displayed in the preview
section.

Submit button color

Select the color for the Submit button. Submit buttons across the application are displayed in
this color. Click this field and select a color from the color editor. Or, enter the hexadecimal code
for the color. The selected color is displayed in the preview section.

5. To reset the colors, click Set default.
6. Click Save.
The page background and the Submit button colors are applied to the pages that are mainly used by field resources,
such as Activity details, Inventory details, Activity list, and forms. The colors won't be shown on these groups of
pages:
• Pages on which the content takes the entire screen width, for example, Dispatch console, Manage, Maps, and
Calendars.
• Configuration pages.
• Pages that have their own specific background, for example, About, Dashboard.
• Hints and context-menus.

Where is My Technician
Where is My Technician lets you send a URL to your customers, through which they track the status of their ordered
service. Where is My Technician is available as a theme on the Configuration > Themes page. You can configure the
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Where is My Technician pages with your organization’s branding and set whether your customer can track a technician
on the map, see the technician’s details, and provide feedback when the technician completes the job.
Note: Where’s My Technician functionality is not available for Contingent Workers.
You can perform these tasks with the Where is My Technician feature:
• Send a tracking URL in the appointment confirmation and reminder emails
• Show the details of the appointment, service address, and day/time of arrival
• Show a custom name for technicians, for example, Mr. William or Will
• Show or hide the technician’s photo
• Show or hide the technician’s position on the map
• Show custom technician and customer location markers on the map
• Show the estimated arrival time of the technician
• Let customers track the technician’s location in near real-time
• Allow or block providing feedback after a technician’s visit
• Allow chatting through the Smart Chatbot
• Configure branding for the tracking web page
• Customize the text for the tracking page

How to Use the Feature?
The Where is My Technician feature is available if you have an Oracle Field Service Professional or an Oracle Field
Service Enterprise subscription with Google Maps. The feature is not yet available for your subscriptions with Oracle
Maps.
Where is My Technician is a theme that is available on the Configuration > Themes page. When you configure this
theme, you can send a URL to your customers, which they can use to track the technician. When your customers open
the tracking URL, the page refreshes automatically every five seconds to display the latest information. If you change
the fields on the theme, the new fields display when the customer refreshes the tracking page. Your customers can view
the technician’s details from the time the technician is assigned to the activity, but they track the technician’s route only
when the technician is on the way to the activity. To track the technician’s location on the map, we recommend that your
customers use the Oracle Field Service Installed Application with location sharing enabled.
Although the Where is My Technician theme supports all types of activities, we recommend that you do not use it for
segmentable activities. The Where is My Technician theme includes the Scheduled, Days before, On the way, Arrived,
and Feedback pages. However, for your customers it is just one page and the information on the page corresponds to
the status of the activity at that time:
• Scheduled: The activity is created in a bucket and the Service window/Delivery window is set.
• Days Before: A technician is assigned (and can be also changed) and the Service Window is known.
• On the Way: The technician has started the day (activated the route) or has finished (Completed, Not done,
Suspended, or activity reordered) the previous activity and the time of arrival (ETA) is available. Be aware that
when the 'En route' feature is enabled, the 'On the Way' status shows only for those activities that are in 'En
route' status.
• Arrived: The technician has arrived and started the activity.
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• Feedback: The technician has changed the activity to Complete or Not done.
After the feedback is submitted, the final message 'Thank you!' is displayed (you can configure the text on the
'Localization' tab). 'Thank you' is also displayed if an activity is canceled. Your customers can see the Where is My
Technician page for non-scheduled activities as well, but without the date and time of service.
High-Level Steps to Use The Feature
To use the Where is My Technician feature, you must:
• Create a theme for Where is My Technician.
• Configure the theme with the required branding and other settings.
• Add a placeholder for the URL on your message text.
• Specify the theme label in the URL to determine the theme that you want to be accessed through the tracking
link.

Related Topics
• Configure a Color for the En Route Status

Create a Theme for Where is My Technician
You must create a theme for Where is My Technician to add the details that you want to show your customers. You
can create multiple themes such as themes according to the services you provide (for example, telephone services,
computer repair services), themes based on regional languages, or themes based on the preferences (such as location
tracking enabled, feedback enabled). Users with the Oracle Field Service Professional subscription can create a
maximum of five themes. And, users with the Oracle Field Service Enterprise subscription can create a maximum of 25
themes.
1. Click Configuration > Themes .
2. Under Where is My Technician, click Add new.
3. On the Add WMT Theme page, enter a label for the theme.
Later, you have to add this label to a message scenario to get the URL, so enter a meaningful label.
4. Enter a description for the theme.
5. Click Add.
The Edit theme page appears. You can continue with creating the theme, or you can click Save and edit it later.

Configure the Where is My Technician Theme
You must configure a theme after you create it. You configure a theme to select a template, specify your branding
details, select the tracking details, and decide whether you want to let customers provide feedback for the technician
and the service.
Before you add the Feedback page, ensure that you have created the custom properties to store the feedback
comments and rating. You can create the custom properties on the Configuration > Properties page.
1. Click Configuration > Themes .
2. Under Where is My Technician, click Edit on the stack icon for the Where is My Technician theme of your
choice.
3. To add branding to the theme, click Branding and complete these fields:

94

Oracle Field Service

Chapter 3

Administering Oracle Field Service

Configure the Display Settings

Field Name

Action or Description

Theme description

Enter a description for the theme that helps you identify its purpose.

Template

Select the template that you want to use from Bright, Hero, and Minimal templates. Notice that
the Scheduled, Days before, On the way, Arrived, and Feedback pages refresh with each detail
that you add to the theme.

Main color

Click the hexadecimal number and select a color of your choice. This is the color in which the
text is displayed.

Background color

Click the hexadecimal number and select a color of your choice. This is the background color
of the page. Your customers may access this page from their mobile phones and the screen
width is limited, so choose the colors carefully. If you have selected the Hero template, then the
Background picture field becomes available and you can upload a custom picture.

Company logo

Click Browse and select a file with the extension JPEG, PNG, GIF, TIFF, or SVG. You can select a
file of maximum size 100 KB. This logo is displayed at the top of the page.

Company favicon

Click Browse and select a file with the extension ICO or PNG. You can select a file of maximum
size 30 KB. This is the small icon is displayed on the web page header. It is typically a smaller
image of your organization or product logo.
You can configure the browser tab name in the Company field on the Localization tab. It will be
shown next to the favicon.

Custom domain name

Enter the domain name that you want to use in the Where is My Technician URL. For example,
https://wmt.example.com/k694jg. Here, k694g is the unique token.
Note: If the Custom domain name field is empty, then the Where is My Technician URL
cannot be opened in an iFrame.
You must perform these additional tasks to use the custom domain name:

◦
◦
◦

Configure the HTTPS web server with the proxy page.
Configure your web server to route all the requests to an index page.
Add the index.html page to the root of the web server.
For more information on how to configure a custom domain name, see Example of NGINX
Configuration and Example of How You Can Open a Where Is My Technician URL With a
Custom Domain in iFrame.

4. To specify attributes such as arrival time and technician's photo, click Attributes and complete these fields:
Field Name

Action or Description

Arrival time

Select one of these values to define the technician's time of arrival:

◦

Do not display: Select this option to hide the arrival time on the Where is My Technician
page.
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◦
-

◦
◦
◦
◦

-

◦
-

◦
◦
◦

Time notified, Delivery window, Service window: Select this option to let the application
choose the available value according to the activity status, value availability, and their
priority:
Time notified:
Delivery Window
ETA
Service Window
Value returned through an outbound response message
Delivery Window
Service Window
You can configure the arrival time further using the {ARRIVAL_TIME_RANGE} place holder.
For more information on the {ARRIVAL_TIME_RANGE} place holder on the Localication
tab, see the Available Placeholders on the Localization Tab topic.
Time notified: Select this option to display the time you have informed your customer that
the technician would arrive. The application does not update this value automatically. The
options are:
Delivery Window
ETA
Service Window
Value returned through an outbound response message
Delivery window
Service window
ETA

You can configure the 'ARRIVAL_TIME_RANGE' placeholder to configure the value that you
want to use for Time notified. If the Delivery Window, Service window, or ETA is empty, then the
arrival time is not shown on the page.

Type of service

Select one of these values:

◦
◦
Customer address

Select one of these values:

◦
◦

Technician name

Do not display: Select this option to hide the type of service that the technician is going to
perform.
Activity type: Select this option to display the activity type as the type of service.

Do not display: Select this option to hide the customer’s address.
Customer address: Select this option to display the customer’s address on the Where is My
Technician page. This field comprises the Address, City, ZIP/Postal Code, and State fields.
If any of these values is empty, then it is not shown on the page.

Select whether you want to display the technician’s name or the credence. You can choose any
custom resource property that has the GUI set as Text element.
Note: The Where is My Technician functionality is not available for Contingent Workers.
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Field Name

Action or Description

Show technician photo

Select the check box if you want to display the technician’s photo. If you don’t select the check
box, no photo is shown. Be aware that the photo available in the Avatar field of the Resource
Info page is used as the technician’s photo.

5. To add the map details, click Map and complete these fields:
Field Name

Action or Description

Customer position

Select one of these values:

◦
◦
◦
Customer icon

Do not display: Select this option to hide the customer’s coordinates on the map. When
you select this option, the technician’s position is also hidden. Use the Customer address
field on Attribute tab to hide the customer’s address on the page.
Exact: Select this option to display the exact position of the customer on the map.
Approximate: Select this option to display a bubble around the customer’s location on the
map.

Select an icon from the drop-down list or, click Browse and select a custom icon. This icon
indicates the location of the activity. If you select an icon from the drop-down list, its color
changes according to the color you have selected in the Branding tab. If you select a custom
icon, you can also select the position of the icon on the map.

Technician position

Select one of these values:

◦
◦

Do not display: Select this option to hide the technician’s coordinates on the map.

Show with driving track: Select this option to display the technician’s driving track, while
showing the exact position of the customer on the map.
Show without driving track: Select this option to display the technician icon without the
driving track, when you have selected the customer position as 'Exact' or 'Approximate'.
When you have selected the customer’s position as Approximate, the technician icon is
available till the technician hits the bubble on the map. After that the technician icon is
hidden.
If Google sends the navigation details and the technician has shared their location, Oracle Field

◦

Service uses that data. If the technician has not shared their location, or if Google has not sent
the navigation details, Oracle Field Service uses the ETA (Start Time - Current-Time) to derive
the estimated duration. The behavior is further clarified here:

◦
◦
◦

Do not show position

Shows the ETA (expected time of arrival) from Oracle Field Service (StartTime - Current
time), if Google has not yet sent the navigation details and ETA. In this case, only the
customer icon shows on the map and ETA from Oracle Field Service.
Shows Google ETA as soon as it's available, then the route is available on the map, with
the ETA from Google. In this case, the technician icon with route displays on map and ETA
updates to Google's ETA.
If the technician becomes offline, the last position is remembered and shown. In this
case, the user who opens the link sees the ETA to the technician’s last position and as
soon as the technician becomes online, the ETA is updated. This means that the ETA may
be 4 hours approximately and may suddenly become about 20 minutes, because the
technician’s actual position is updated.

Enter the number of minutes for which you want to hide the technician’s position after they
complete the previous appointment or after they activate the route. The activity status of
the previous activity can be Complete, Note done, Canceled, Suspended, or the activity is
reordered. As soon as the set time is over, the technician icon is shown on the map. This helps
you hide the coordinates of the previous customer or the technician's home location. This field
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Action or Description
is set to 0 (zero) by default, which means, the technician’s position is shown immediately after
the technician completes the previous appointment.

Technician icon

Select an icon from the drop-down list or, click Browse and select a custom icon. This icon
indicates the technician’s location. If you select an icon from the drop-down list, its color
changes according to the color you have selected in the Branding tab. If you select a custom
icon, you can also select the position of the icon on the map. You can use real car icons and
show the car changing direction according to the route. Be aware that the anchor for these
icons is in the center. If a technician doesn’t share the location, or is offline for a long time, then
only the customer’s location is displayed on the map. If neither the technician's location nor the
customer's location is available, only a blue map is displayed.

6. To customize the text that is displayed on the Where is My Technician page, click Localization and complete
these steps:
a. Click Locale and select the locale based on which you want to display the date and time. For more
information on the languages and locales supported, see Default Translations and Date-Time Format.
b. In each field, enter the text that you want to display, based on your business requirements. These values
are always displayed in English.
c. Click the question mark icon to view the description and default text of the field.
d. Place the cursor at the required position, click the question mark, and then click Available placeholders.
The data field is inserted at the selected location. Let’s say you want to change ‘{TECHNICIAN_NAME}
is your technician.’ to ‘Your technician is ‘{TECHNICIAN_NAME}’. Delete the existing text and
add ‘Your technician is’. Place the cursor after ‘is’. Click the question mark icon and then click
‘{TECHNICIAN_NAME}’ under Available placeholders.
e. Optionally, clear the custom text to view the default text.
7. To add the Feedback page, click Feedback and complete these fields:
Field Name

Action or Description

Enable feedback

Select this check box to let your customers send feedback. If the customer does not provide the
feedback on the day the activity is completed, then they will see the Thank You page, instead
of the Feedback page.

Feedback mode

Select how you want to receive the feedback. You can choose from Comment and Rating,
Comment, and Rating.

Property for saving comments

Select the property that you want to use to store the comments. Use only string type of custom
activity properties for comments.

Property for saving rating

Select the property that you want to use to store the ratings. Use only integer type custom
activity properties that have the GUI as Text for ratings.

Localization

Customize the text that you want to display on the Feedback page. For more information on
this, see Step 6.
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8. To provide more options to your customers on the Where is My Technician page, click Interaction and
complete these fields:
Field Name

Action or Description

Enable Cancel

Select this check box to let your customers cancel the activity. Then, add the text for the
confirmation page. Cancel is available for an activity that is in Pending status. Cancel is hidden
as soon as the activity status changes to Started.

Enable chatbot

Select this check box to let your customers chat with a chatbot. Ensure that you have a license
for Oracle Digital Assistant. Verify that your administrator has created a web channel and
configured the chatbot flow in Oracle Digital Assistant. Get the values of Channel URI and
Channel ID from Oracle Digital Assistant.

9. Click Save.
Your settings are saved and the Where is My Technician theme is created.
Related Topics
• Available Placeholders on the Localization Tab
• Default Translations and Date-Time Format
• Example of NGINX Configuration
• Example of How You Can Open a Where Is My Technician URL With a Custom Domain in iFrame

Add a Tracking URL to a Message Scenario
When your customers order a service, you notify them through a message that the service they have ordered is
accepted. You add a URL to this message, using which your customers can view the details and track the technician
assigned to the activity. For that, you must add a placeholder to the 'Body' of the message step and specify the ‘Where
is My Technician’ theme label.
1.
2.
3.
4.

Go to Configuration > Message Scenarios .
Click Modify on an existing message step or create a new step.
Click Patterns and go to the Body section.
Add the placeholder {{WMT_URL:label_theme}} (including the double braces) to the required position in the
message body.

Here, label_theme is the label of the Where is My Technician theme that you want to use. The default Where is
My Technician theme is used if you have configured a message step with a nonexistent theme label. There can
only be one theme used per activity. So, if you have used more then one theme label for the same activity in
different message steps, the theme in the last delivered message is used.
5. Click Save.
The WMT_URL placeholder is replaced with a unique tracking URL, when the message step is launched.
The URL consists of the domain and a secure token that is specific for the activity. For example, https://
w.etadirect.com/a784hk596 where https://w.etadirect.com/ is the domain and a784hk596 is the secure token.
This URL is available till the activity date and three days after. If your end-customer opens the URL after it
expires, then they get the message, 'Oops. Seems that this URL is no longer valid and details are not available.'
on the page. However, if the customer clicks an active URL for an activity in the past, 'Thank you!' is displayed.
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Use Cases and their Launch Conditions
This table gives the launch conditions that you can use, when you create Message Scenarios to add the tracking URL for
Where is My Technician.

Scenario

Launch Condition

Confirm a scheduled appointment

'Activity created' when an activity is scheduled on a bucket and is not yet assigned to a field resource.

Introduce a technician assigned to an

'Activity created' when a Field resource is assigned to an activity or when an activity is re-assigned to

appointment

another resource.

Remind about a service days before

'There is a specified number of days prior to activity' or other from the Reminders section to notify that
the scheduled service date is approaching.

Notify if the technician has changed

'Activity created' if the activity is re-assigned to another field resource.

Notify if the service has moved to a future

'Activity is moved' if the activity is rescheduled to a future date.

date
Notify that the technician will arrive soon

'Next activity is about to start' if the technician has completed the previous activity and is on the way to
the end-customer.

Request feedback when the technician has

'Activity completed', 'Activity not done', and 'Activity suspended' when you want to ask for feedback.

finished a service and left
Resend message if the service or gateway

"Sending will time out in" and/or "Number of attempts on 'failed' status"

fails
Cancel an activity

Activity is canceled. You must add a new Blocking Condition, Activity Type [aworktype].

Available Placeholders on the Localization Tab
This table gives the placeholders that you can add to the text on the Localization tab of the Where is My Technician
theme.

Placeholder

When You Can Use

Values

{TECHNICIAN_NAME}

Available in all activity statuses except "notAssigned". Can

Holm, Billy

be used for translations:

Mr. Billy

• First line of status text shown when the activity is
already assigned to a technician Default value: Will
arrive between

Billy

• Second line of status text shown when the activity
is already assigned to a technician Default value:
{ARRIVAL_TIME_RANGE}
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When You Can Use

Values

• First line of status text shown when the technician is
on the way Default value: Arriving in about
• Second line of status text shown when the technician
is on the way Default value: {ETA}
• Technician info text when the appointment is
assigned Default value: {TECHNICIAN_NAME} is your
technician
• Technician info text when the technician is on the
way Default value: {TECHNICIAN_NAME} is on the
way
• Technician info text when the technician has arrived
Default value: {TECHNICIAN_NAME} has arrived
• Feedback form ratio field title Default value: How was
{TECHNICIAN_NAME}'s service?
{ETA}

Available for "onTheWay" activity status. ETA is calculated

2 hours

based on Google data. If Google data is not available,

42 minutes

then Oracle Field Service ETA is used. Can be used for
translations:
• First line of status text shown when the technician is
on the way Default value: Arriving in about

less than 1 minute
The ETA is always displayed in English.

• Second line of status text shown when the technician
is on the way Default value: {ETA}
{ARRIVAL_TIME_RANGE}

This place holder is applicable only if you select the 'Time

8:15 AM - 8:45 AM

notified, Delivery window, Service window' option for
Arrival time on the Attributes tab.
Available for "notAssigned" and "assigned" activity
statuses and when delivery window or service window are
not empty. Can be used for translations:
• For "notAssigned" activities the arrival window is
used according to the availability of these values and
their priority:
a. Time Notified:
i. Service window
ii. Value returned via Outbound response message
b. Service Window
Default value of the first line of the status text shown
when the activity is ordered and isn't assigned to
a technician yet: A technician will arrive between.
Default value of the second line of the status
text shown when the activity is ordered and isn't
assigned to a technician yet: {ARRIVAL_TIME_
RANGE}
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When You Can Use

Values

• For the activities assigned to a technician, the arrival
window is used according to the availability of these
values and their priority:
a. Time Notified:
i. Delivery Window
ii. ETA
iii. Service Window
iv. Value returned via Outbound response message
b. Delivery Window
c. Service Window
Default value of the first line of the status text shown
when the activity is already assigned to a technician:
Will arrive between
Default value of the second line of the status text
shown when the activity is already assigned to a
technician Default value: {ARRIVAL_TIME_RANGE}
For more information about how to use 'Time
Notified', see the How to Use 'Time Notified' topic.

Related Topics
• Configure the Where is My Technician Theme
• How to Use 'Time Notified'

How to Use 'Time Notified'
You can show Time Notified on the {ARRIVAL TIME RANGE} placeholder. You can set the value for Time Notified
through a Message Step with the Outbound API using 'send_message'. If you set the value, it will be used on the
Where's My Technician page, instead of the Delivery Window or Service window. If Time Notified is not populated,
then Delivery Window or Service window is shown. You can choose to use ETA, Delivery Window, or Service Window
as Time Notified. For example, you can save the ETA, which you communicated to your customer the Where is My
Technician page shows this time, even if the technician adjusts the previous activity. This way, the feature also prevents
the application from updating the agreed time automatically.
1. Navigate to Configuration, Message Scenarios.
2. Open the message scenario that you have configured for Where is My Technician.
If not configured, set the Recipient to Customer in the Settings Tab.
3. Select the Customer notification time field and select the value that you want to display for Time Notified.
You can select either Service window, Delivery Window, or ETA. You can set a custom window using the
Outbound API ‘send_message’. For using ‘send_message’, see the Outbound API documentation.
4. Open the Where is My Technician theme and go to the Localization tab. Click the {ARRIVAL TIME RANGE}
placeholder.
{ARRIVAL TIME RANGE} is available only for "Not Assigned" and "assigned" activity statuses. The value you
have selected for Customer notification time in the message scenario is shown on the Where is My Technician
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page. If you have configured the Time Notified field to receive the value from an outbound API response using
‘send_message’, it is displayed.
The {ARRIVAL TIME RANGE} shows the arrival window according to availability of these values and their
priority:
Note: If ‘Time Notified’ is set with a custom window, this value is not removed or changed if the activity
is moved to another resource or bucket. You must consider this behavior in your design and make any
necessary updates to the window according to your business process.

Page
Days before screen

Activity on the Bucket (Not Assigned)
a. Time Notified:
- Service window

-

Value returned via Outbound response
message
b. Service Window

Activity Assigned to a Technician (Assigned)
a. Time Notified
- Delivery window

-

ETA
Service window
Value returned via Outbound response message

b. Delivery Window
c. Service window

Use Notification Channels
You can send the Where is My Technician tracking details through emails that are generated using Message Scenarios,
through email and SMS through gateway services, and through custom delivery channels. The custom delivery
channels can be email or web-services that accept SOAP API requests.
1. To use the email notification channel with Message Scenarios:
a. Click Configuration > Message Scenarios .
b. Create or modify a message step.
c. On the Settings tab, select Email for Delivery Channel.
d. Select Customer for Recipient.
e. Click Patterns and go to the Body section.
f. Add the placeholder {{WMT_URL: theme_label}} (with double braces) at the point where you want to add
the link.
If you have created a separate theme to enable the Cancel option, remember to use it when required.
g. If you are using a theme created for the Cancel option, then add a blocking condition for Activity Type
[aworktype] in the Blocking Conditions tab.
This excludes the required types of activities.
h. Continue with creating or modifying the step.
i. Click Save. When the Message Scenario is launched, the email is sent to the user.
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2. To send an SMS using a third-party gateway service through Oracle Integration Cloud:
a. Define a custom property (for example, X_WMT_MESSAGE) to store the tracking URL.
b. Configure Oracle Integration Cloud to read the custom property for tracking URL and the customer’s
phone property. Configure it to send messages using third-party tools, such as, Twilio OIC Adapter or
Oracle Cloud Integration.
c. Click Configuration > Message Scenarios .
d. Create or modify a message step.
e. On the Settings tab, select Set Property for Delivery Channel.
f. Select Customer for Recipient.
g. Click Patterns and go to the Body section.
h. Specify the property label (for example, X_WMT_MESSAGE) in the Subject section.
i. Click Save. When the Message Scenario is launched, the SMS is sent to the phone number.

Verify Whether the URL is Generated for the Message Step
Sometimes, you may want to verify whether a message was generated with the tracking URL and sent to the customer.
You can use the Messages button on the Activity details page to verify.
1.
2.
3.
4.

Configure the Messages button for the Activity details page.
Open the Activity details page for the activity for which the customer has to get the tracking URL.
Click Messages.
Use the Status, Delivery channel, Recipient, or Any filters.

The messages that match the criteria appear.
5. Find the message step for which you want to verify the URL.
6. Click a line of the message step and verify the Body text of the message.
The URL must be present.

View Activities Canceled Through the Where is My Technician
Page
When your customer cancels an activity through the Where is My Technician page, you can determine that it is canceled
by your customer, on the Activity details page.
1. Open the Activity details page for the activity that is canceled by your customer.
2. Go to the History tab.
3. Look for the line item that has WMT(customer) in the User column.

Default Translations and Date-Time Format
Where is My Technician supports the default translations and date and time format for these languages:
Arabic locales:
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Czech, Danish, German, Greek, and English locales:
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Finnish, French, Hindi, Hungarian, Italian, and Japanese locales:

Korean, Dutch, Norwegian, Polish, Romanian, Russian, Swedish, and Turkish locales:
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Spanish locales:
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Hebrew, Chinese, and Portuguese locales:

Example of NGINX Configuration
Use the sample code provided here to configure your web server to route all requests to the index page.
server {
listen 80;
server_name wmt.example.com;
location / {
root /usr/share/nginx/html;
try_files $uri /index.html;
}

}

Example of How You Can Open a Where Is My Technician URL
With a Custom Domain in iFrame
Use the sample code provided here to configure the Where is My Technician URL with a custom domain name to open
in iFrame.
<!DOCTYPE html>
<html>
<head>
<title>WMT within iframe</title>
<style type="text/css">
html {
overflow: auto;
}
html,
body,
div,
iframe {
margin: 0px;
padding: 0px;
height: 100%;
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border: none;
}
iframe {
display: block;
width: 100%;
border: none;
overflow-y: auto;
overflow-x: hidden;
}
</style>
</head>
<body>
<iframe id="wmt-chrome"
src="#"
frameborder="0"
marginheight="0"
marginwidth="0"
width="100%"
height="100%"
scrolling="auto">
</iframe>
</body>
<script type="text/javascript">
document.getElementById('wmt-chrome').setAttribute('src', 'https://{custom_domain_name}' +
window.location.pathname);
</script>
</html>

Overview of Using Oracle Digital Assistant with Where is My
Technician
You can integrate the Where is My Technician page with Oracle Digital Assistant to perform a variety of tasks in natural
language conversations.
Some of the business scenarios you can cover are:
• Reschedule an appointment: Oracle Digital Assistant suggests the available time, asks the user for a reason,
and confirms the rescheduling.
• Cancel an appointment: Oracle Digital Assistant asks a user for the reason of and confirms the cancellation.
• Leave Feedback: Oracle Digital Assistant thanks for a good rating and asks the reason for bad feedback.
• Share the good Feedback on company sites: Oracle Digital Assistant asks for posting good feedback on your
organization's profiles such on Google, Twitter, Amazon, and so on.
• Notify a technician about the details: Oracle Digital Assistant can send a message from the user. This is saved
as a note for the technician.
Note: The Sample skill is sample code and demonstrates how Oracle Digital Assistant can help users on the Where is
My Technician page. It's neither maintained nor supported by Oracle as a licensed product.
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Before You Begin with Oracle Digital Assistant
Before continuing with the next steps, you need:
• An Oracle Field Service instance that has the 'Where is My Technician' feature and the Enable Oracle Digital
Assistant setting enabled for the feature.
• An Oracle Digital Assistant instance platform version 20.06 or higher.

Define the Skills You want to Use
Before you start configuring Oracle Digital Assistant, you must have a clear idea of the skills that you want to provide
through the assistant.
This table provides the list of skills and their descriptions:
Skill

Description

Reschedule

The assistant suggests the available time, asks the user for a reason, and confirms the rescheduling.
This Oracle Digital Assistant skill uses the time slots that are configured in Oracle Field Service. After
the user (your customer) confirms, the activity moves to the technician's parent bucket with the
selected time slot. It will be further routed.

Save reschedule reason

You can save the reason for reschedule to an activity property.

Cancel

The Assistant suggests to cancel an appointment and asks for the cancellation reason. After the user
(your customer) confirms, the activity is cancelled.

Save cancel reason

You can save the reason for canceling an activity to an activity property.

Notification to Technician

If the user (your customer) sends a note to the technician through the assistant, it can be added as a
note for the activity.

Feedback

If the activity status is completed, the user (your customer) can rate the service and share the feedback.
If the user rates the service with stars on the Where is My Technician feedback page, the assistant can
understand whether it is positive or negative based on the number of stars set.

Save Feedback in Oracle Field Service

You can save the feedback to an activity property in the application, regardless of whether the
feedback is negative or positive.

Share Feedback on external site

You can share the positive feedback on external sites. You can store the external link at the parent
organization unit or the bucket level of the technician who performed the activity.
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Configuration Steps
Here are the steps to configure Oracle Field Service to use Oracle Digital Assistant.
1. Configure Oracle Digital Assistant in the Where is My Technician theme.
a. Pull the Skill from the Skill Store.
b. Create a Web Channel in Oracle Digital Assistant.
c. Add the Channel URI and ID to the Where is My Technician theme.
2. Configure Oracle Field Service API and permissions.
3. Configure the Oracle Digital Assistant skills.
4. Validate the integration.

Pull the Skill from the Skill Store
The first step to integrate Oracle Digital Assistant with the Where is My Technician page is to pull the OFS Assistant:
Where’s My Technician (WMT) skill from the Skill Store.
1. Open the Skill Store in the Development section of Oracle Digital Assistant.
2. Select the "OFS Assistant: Where’s My Technician (WMT)" skill and pull it.
You can pull the skill either from the context menu or the skill details.
3. Find the required skill in the Development section of Oracle Digital Assistant.
It is ready to be configured now.

Create a Web Channel
A channel is the one on which you deploy a skill. It carries the chat back and forth from users on various messaging
platforms to the digital assistant and its various skill bots. For Oracle Field Service you create a channel using Oracle
Web. Oracle Web is a widget that comes with the Digital Assistant Client SDK and lets you run a skill in a web page.
1. Create an Oracle Web channel.
For more information, see the Using Oracle Digital Assistant guide.
2. Use the values given in this table to configure the channel:
Field

Value

Channel Enabled

Yes

Route to

OFS Assistant: Where’s My Technician (WMT) or the skill you have imported when you pulled it
from the Skill Store.

Channel Type

Oracle Web

Allowed Domains

The domain name of your Where is My Technician page. Or, enter an asterisk (*) to allow all
domains.

Client Authentication Enabled

No

3. Note down the Secret Key and the Channel ID generated on this page.
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Add the Channel URI and ID on the Where is My Technician Theme
You must enable Oracle Digital Assistant on the Where is My Technician theme to integrate and use it.
1.
2.
3.
4.
5.
6.

Log in as an administrator user.
Navigate to Configuration > Themes .
Click Add New to create a theme or select a theme from the Where is My Technician section.
Click the Interaction tab.
Select the Enable Oracle Digital Assistant check box.
Enter the Channel URI and the Channel ID.
The Where is My Technician page supports several parameters that are used for skill configuration in Oracle
Digital Assistant. The values of these parameters are passed to the chatbot while opening a Where is My
Technician URL.
WMT Page

Parameters passed to the ODA chat during chat initialization

Scheduled, Assigned, On the Way,

activityId

Arrived or Feedback
activityType
Send if the 'Show Activity type' feature is enabled for the Where is My Technician theme
resourceName
customerName

Feedback

Value from 1 to 5 is sent to the chat while submitting the feedback if the Rating is set up for
Feedback.

Example of how to use the customerName and resourceName parameters to implement Oracle Digital
Assistant skills:
component: "System.CommonResponse"
properties:
metadata:
responseItems:
- type: "text"
text: "Hi ${profile.customerName}! Your technician is ${profile.resourceName}"

Configure the APIs and Activity Permissions
You must create an Application to add the details of the APIs that you want to access from the OFS Assistant: Where’s
My Technician (WMT) skill. You must also ensure that some specific features are selected for the activity types for which
you create the skills.
1. Click Configuration > Applications .
2. Click the plus icon, add these details, and then click Submit:
Field Name

Description

Application Name

Name of the bot that you want to register.
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Field Name

Description

Application ID

A unique ID of the application.

3. On the Applications page, click the application that you want to register on the left pane and complete these
fields:
Field Name

Description

Application general info section
Application Name

Name of the third-party application that you want to register. This field is populated
automatically.

Application ID

A unique ID for the application. This field is populated automatically.

Active

Status of the Application. Inactive Applications don't authenticate or authorize anyone. When
you make an active Application inactive, previously-issued access tokens don't work.

Token Service

Type of token service or identity provider the Application uses. Default is OFSC.

4. Select Authenticate using Client ID/ Client Secret under Authentication settings. Note down the Client ID and
Client Secret that are generated.
5. Click Add new next to API access. Select Core API and Metadata API and click Submit.
6. Click the stack icon next to Core API and then click Available entities. Select these visibilities for these entities:

◦
◦
◦

Select Read-Write for the Activity entity.
Select Read-Only for the Resource entity.
Select Read-only for the User entity.

7. Click the stack icon next to Metadata API and then click Available entities. Select these visibilities for these
entities:

◦
◦

Select Read-Only for the Activity type entity.
Select Read-only for the Property entity.

8. Click Save.
9. To enable permissions for the activity types:
a. Click Configuration > Activity Types. .
b. Click Modify against the type of activity for which you want to modify the permissions.
For example, if you want users to cancel or reschedule only free maintenance activities, select the
corresponding activity type.
c. Select the Support of time slots, Allow reschedule, Allow move between resources features.
d. Click Update.
e. Repeat this for all the activity types that you want to use with the OFS Assistant: Where’s My Technician
(WMT) skill.

Create Custom Properties to use with Oracle Digital Assistant
To integrate with Oracle Digital Assistant and store data in Oracle Field Service from a conversation, you must create
several activity and resource properties. These properties are also configured as default for all the flows in the skill.
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These properties are mapped to the skill custom parameters that are used for all the features. Your data will not be
saved if you do not create these properties.
1. Click Configuration > Properties .
2. Click Add new.
3. Create these string properties:
Label

Entity

Type

GUI

Description

XA_ODA_CANCEL_

activity

string

text

Used to save the reason for cancelation provided by

REASON
XA_ODA_RESCHEDULE_

the user
activity

string

text

REASON

XA_ODA_FEEDBACK_

the user

activity

string

text

COMMENT
XA_ODA_MESSAGE_

Used to save the Feedback Comment provided by the
user

activity

string

text

2TECH
XR_ODA_EXT_REVIEW_

Used to save the reason for rescheduling provided by

Used to save a notification message from the User to
the Technician

resource

string

text

URL

Property defined for the resource. If you set this
for the resource's parent (following the resource's
hierarchy), the URL will be provided to the user to
leave a review.

Configure the Authentication
You must add a Client credentials service to confgure the authentication between Oracle Digital Assistant and Oracle
Field Service.
For more information on how to add a new authentication service, see the Using Oracle Digital Assistant guide.
1. Add a new authentication service in Oracle Digital Assistant.
2. Use the values in this table to create the service:
Field Name

Value

Grant Type

Client Credentials.

Identity Provider

Oracle Identity Cloud Service.

Name

A name by which you want to identify the authentication service.

Token Endpoint URL

The Identity Provider's URL for requesting access tokens in Oracle Field Service. For example
<OFS API endpoint>/rest/oauthTokenService/v2/token.

Client ID

Client ID of Oracle Field Service of the application configured on the Configuration >
Applications page for Oracle Digital Assistant and the Oracle Field Service instance name
concatenated with '@'. For example. 'assistant@OFSinstance'.

116

Oracle Field Service

Chapter 3

Administering Oracle Field Service

Configure the Display Settings

Field Name

Value

Client Secret

Client Secret of the Oracle Field Service application configured on the Configuration >
Applications page for Oracle Digital Assistant.

Scopes

The scopes that must be included when Oracle Digital Assistant requests an access token from
the provider. Add all the scopes that are required to access the resources. For example: '/rest'.

Feature Selection in the Skill
You can select or deselect the features with some restrictions configured for each customer. This helps to support
business flows, restrict, and switch flows easily. The names of the skill custom parameters and their predefined values
are provided in the table later in the topic. You can change the predefined values. This functionality is implemented as
a pair of parameters for each feature. The Property parameter can contain the value of property or field in Oracle Field
Service and the PropertyValue represents the value of this property or field.
For example, let's say an organization wants to provide cancellation only for troubleshooting activities, so the customer
can undo their request easily, if the issue is resolved. The configurator must specify the activity type 'troubleshooting' as
a value of the Oracle Digital Assistant parameter. The configurator can use these values:
• Use 'aworktype' as the value for allowCancelProperty. This means that an activity type defined in Oracle Field
Service is used to validate the access.
• Use a value of 'troubleshooting' for allowCancelPropertyValues. This means that the assistant can help with
canceling, only if the activity type is 'troubleshooting'.
In this case, the cancel option is unavailable in the chat for activities other the 'troubleshooting' type of activity. This
table provides the custom parameters and their predefined values:
Feature

Oracle Digital Assistant

Predefined Values

Parameter Name
Reschedule

Cancel

Send Message to Technician

Share Feedback on external site

Supported Oracle Field Service
Property Type

allowRescheduleProperty

aworktype

string/enum/int/field

allowReschedulePropertyValue

ac_installation, furnace_repair, GS

string/enum/int/field

allowCancelProperty

aworktype

string/enum/int/field

allowCancelPropertyValues

ac_installation, furnace_repair, GS

string/enum/int/field

allowSaveMessageProperty

aworktype

string/enum/int/field

allowSaveMessagePropertyValues

ac_installation, furnace_repair, GS

string/enum/int/field

allowExternalReviewProperty

aworktype

string/enum/int/field

allowExternalReviewPropertyValues ac_installation, furnace_repair, GS

string/enum/int/field

To disable a feature, add 'N/A' for both the parameters. Oracle Digital Assistant doesn't allow empty values in custom
parameters.
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The Feedback feature does not have a configured option to switch. You can deselect it in the configuration on the
Where is My Technician theme page.
Other parameters that the skill uses:
Feature

Oracle Digital Assistant

Predefined Values

Description

Support assistant

Name used when Oracle Digital Assistant

Parameter Name
All

DAName

introduces itself in the conversations with
the user.
All

dateFormat

EEE d MMM

Format of the dates used by the Skill when
mentioning any dates in the conversations
with the user. The format is based on this
specification.

All

endPoint

Your Oracle Field Service REST

You must configure the Oracle Field

API endpoint

Service REST API endpoint to allow
integration with an Oracle Field Service
instance. For example
<OFS API endpoint>/rest

Cancel

reasonDefaultValue

DEFAULT

The value that is set into the
property configured for the
"cancelReasonProperty" parameter, if
the user doesn't provide a reason for
cancellation.

Feedback

maxNegativeThresh

3

Integer value that is used to treat the
rating provided by the user as Negative,
if the rating is equal to or less than the
value of this parameter. If not, the value is
treated as Positive.

authenticationServiceName

authenticationServiceName

WMTAssistantService

Authentication service name provided at
the time of configuring the service. Default
value is given as an example.

Related Topics
• Before You Begin with Oracle Digital Assistant

Configure your Welcome Message
You can implement a welcome message in your ODA skill to avoid providing an empty chat window when the user clicks
on the chat icon. Use a hidden message ‘Hi’ which is auto-generated by Where is My Technician and sent to ODA to
imitate the first message by end-user.
The hidden message is not visible on the page and matches the user's first message. The hidden message is sent only
once in the 'Where is my technician' session and it doesn’t matter whether the message is changed during the session
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or to which page ( Scheduled, Days before, On the way, Arrived or Feedback) it is sent. The message can be sent twice in
the Feedback flow page. Refresh the browser page or open the 'Where is my technician' link on a new page to interrupt
a session. If it is true, and the user opens the chat with the same 'Where is my technician' link, and a hidden message
is sent again. You can configure the ODA skill with intents that can understand the message (that is, Hi) and perform
actions.
1. Add intent to your skill.
2. Add some utterances and 'Hi' among them to the intent so that the 'Hi' message is understood.
3. Initiate your intent in Dialog flow and set an action.
metadata: Version: "1.0" main: true name: "YourName" context: variables: ... states: ... getIntent:
component: "System.Intent" properties: variable: "iResult" transitions: actions: Greeting: "YourAction"

4. Train your skill.

How to identify the hidden message sent by WMT
Since WMT sends different parameters used for Skill configuration in ODA (which is described in the Add the Channel
URI and ID on the Where is My Technician Theme topic), you must add a condition based on the 'activityId' value to the
Dialog flow before OBotML part known as 'states' to identify the source of the hidden message (in our case, WMT).
metadata:
Version: "1.0"
main: true
name: "YourName"
context:
variables:
...
checkActivityId:
component: "System.ConditionEquals"
properties:
variable: "profile.activityId"
value: "null"
transitions:
actions:
equal: "NonWhereIsMyTechnician"
notequal: "IntegrationWithWhereIsMyTechnician"
states:
...
IntegrationWithWhereIsMyTechnician:
component: "System.Output"
properties:
text: "Hi ${profile.customerName}! Your technician is ${profile.resourceName}"
keepTurn: true
transitions:
next: "done"
NonWhereIsMyTechnician:
component: "System.Output"
properties:
text: "Hello! I am not Where Is My Technician assistant."
keepTurn: true
transitions:
next: "done"

Chat Notifications to Users
The Where is My Technician page allows you to initiate a chat with end-users. A notification badge is shown on the
chat icon to the end-users. You can develop ODA skill which can send messages to end-user to suggest any help with
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the order (additional order details, promo codes, etc.) or ask for the feedback (if a customer does not want to enable
feedback for the Where is My Technician page and wants to implement their custom survey).
Example of chat initiation skill

Response:
component: "System.Text"
properties:
prompt: "Hi, I'm your assistant. Do you need help with the appointment scheduled
for ${activity.value.date.date?number_to_date?string[dateFormat]}?"

Related Topics
• Add the Channel URI and ID on the Where is My Technician Theme

Validate the Integration
After you integrate Oracle Field Service with Oracle Digital Assistant, you must validate that the integration is working
correctly. If your goal is only to get the integration with Where is My Technician working, you can skip validating in
Oracle Digital Assistant. Use the procedure to validate in Oracle Digital Assistant for debugging purposes.
1. To validate in Oracle Field Service and Where is My Technician, perform these steps after you configure the
Where is My Technician theme and include the Message Scenarios:
a. Initiate the change that triggers the message notification with a URL to Where is My Technician.
b. Find the Where is My Technician URL (for example, from the email or the Messages tab of the Activity
details) and navigate to it.
c. On the Where is My Technician page, click the chat icon in the lower right corner.
d. Notice the message sent by Oracle Field Service, with the options (skills) you have configured. You will
not find the message if the integration is not successful.
2. To validate in Oracle Digital Assistant:
a. Create an activity and assign it to a technician.
b. Add the Activity ID in the Skill's Custom Parameter "aid".
c. Run "Skill Tester" (play button on the top right corner on the Skill's details page).
d. Send a test message.
e. Notice that the test message is received. You will not receive the message if the integration is not
successful.

Assistant View for the Where is My Technician Page
You can change the default Where is My Technician theme or settings and apply the modified Where is My Technician
theme to the Oracle Digital Assistant chat page. See Configure the Where is My Technician Theme.

Feedback Flow
The assistant opens automatically on the Where is My Technician page if the Oracle Digital Assistant and Feedback flow
are enabled for a Theme and the Rating set up is configured for the Feedback page.
You can develop ODA skills to implement a custom feedback scenario on the Where is My Technician page based on the
rating. You can implement the following feedback scenarios:
• Give thanks for the good feedback.
• Ask for confirmation to post their feedback on the company site.
• Define a reason for the low score for a technician.
• Suggest scheduling another follow up to handle an issue.
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• Connect a dispatcher to the chat to handle a situation directly.
Example of skill with positive and negative feedback
#Variable can be set as:
context:
variables:
rate: "string"
setRate:
component: "System.SetVariable"
properties:
variable: "rate"
value: ${profile.rate}

#Example of how to switch depending on number of stars
completedActivityResponse:
component: "System.Switch"
properties:
variable: "rate"
source:
values:
- "1"
- "2"
- "3"
- "4"
- "5"
transitions:
actions:
1: "negativefeedback"
2: "negativefeedback"
3: "negativefeedback"
4: "positivefeedback"
5: "positivefeedback"
#Positive feedback
positivefeedback:
component: "System.CommonResponse"
properties:
metadata:
responseItems:
- type: "text"
text: "Thank you for rating us high! Do you wish to provide additional feedback?"
separateBubbles: true
actions:
- label: "Sure"
type: "postback"
payload:
action: "Agree"
- label: "Nothing to add more"
type: "postback"
payload:
action: "SuccessBye"
#Negative feedback
negativefeedback:
component: "System.CommonResponse"
properties:
metadata:
responseItems:
- type: "text"
text: "Thank you for your feedback. We are always looking to improve the way we do business with our
customers. Do you willing to provide additional details?"
separateBubbles: true
actions:
- label: "Problem remains unsolved"
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type: "postback"
payload:
action: "unsolvedProblem"
- label: "Service was unappropriate"
type: "postback"
payload:
action: "unappropriateService"
- label: "Other"
type: "postback"
payload:
action: "system.textReceived"
variables:
system.text: "Other"

Migration Rules
If the Enable Oracle Digital Assistant check box is enabled and the Application ID field is set before the 20B release
for the Where Is My Technician theme on the Configuration page, then these fields are available on the Theme
Configuration page after you upgrade to Update 20B:
• Application ID
• Channel URI
• Channel ID
You can set the new values of configured ODA channel in the Channel URI and Channel ID fields and delete the old
Application ID value to apply the support of the Oracle Web Channel to the theme.

Create a Filter
Filters have two primary uses—first, filters narrow down lists of activities or resources within the workspace area, based
on defined fields and values. These filters are used within the Time, List, and Map views, providing an ad hoc reporting
capability. Second, filters within routing plans predefine the information that determines how routing distributes
activities across available resources. These filters are commonly set up to differentiate the cost, or value of assigning
certain jobs to certain resources, as well as determining the priority of certain types of activities.
The Filters visibility profile permission controls the access to the Filters window. You must set this permission for each
user type that manages Filters. If you don’t configure this permission or don’t define the visibility for a user type, users
of this user type cannot view the filters that you create. If you select ReadOnly, Filters is placed into a view only mode. If
you select Read/Write for this setting, the user can manage Filters. To create a filter:
1. Click Configuration.
2. In the Displays section, click Filters.
The filters listing appears.
3. Click Add New.
The Add filter dialog box appears.
4. Complete these fields:
Field

Description

Filter

The filter name that the users see. Enter the name in English and in all the languages that are
active in the application.

122

Oracle Field Service

Chapter 3

Administering Oracle Field Service

Configure the Display Settings

Field

Description

Applicable for

The entity type (activity or resource) that the filter pertains to. The entity determines the table
fields that can be selected when applying the filter conditions.

List/Time/Map/Daily

The views within which the filter is available.

Routing

Whether the filter is used within routing plans.

Restriction of Visible Activities

Whether you want to restrict filter activities from appearing if resource routes have not been
activated or a working day has not yet begun. This configuration is related to the User Type.
Once the filter is configured, apply the filter as a visibility restriction filter for user type.

User Types

The user types that the filter is available for. This field is displayed if you select the List/Time/
Map/Daily check box. Use the arrow buttons to move the user types between the Available
and Selected columns.

5. Click Add.
The filter is saved.
You must add conditions for the filter. If no conditions are added, the filter does not work.

Add a Filter Condition
Filter conditions help you further narrow down the activity you want to search for. For example, you can have a
condition to select activities based on work zones.
1. Click Configuration, Filters.
The Filters page is displayed.
2. Locate the filter you want to add a condition to.
3. Click Conditions in the Actions column.
4. Click Add New at the top of the page.
The Add filter condition dialog box appears.
5. Complete these fields:
Field name

Action

Field

Choose one or more activity or resource-based criteria on which to base the filter.

Dynamic

Select the box if you want the user to type a value for the field that the condition is for.

Conditions

Select one or more options to represent how the field selected above relates to the Value entry.

Value

These are the options that can be associated with the Field chosen for this condition. If multiple
values are applicable for this condition to be met, then add them to the Selected column. From
the list of available values, click to select and then click the >> button. The selected item moves
to the Selected column. These rules apply to enumeration fields:

◦
◦

Any field and property used in the application can serve as a filter condition.
You must populate the value for the field and property other than enumerated fields
manually.
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Action

◦

The condition value supports CSV format, such as 1, 2, 3, 4,, "1,1,1", "2,s", and "(""test"")".

6. Click Add.
7. Navigate to the Work Area and verify that the filter is listed in the View drop-down menu.
8. Test the filter to ensure that it meets your requirements.

Delete a Filter Condition
When a filter condition is no longer needed, you can remove it from the application.
1.
2.
3.
4.
5.

Click Configuration. Click Filters from the Displays section.
Find the filter that has the condition you want to delete from and click the Conditions link.
Select the check boxes next to the condition that you want to delete.
Click Delete above the list of conditions.
Click OK.

Delete a Filter
When you don't need a filter anymore, you can remove it from the application.
1.
2.
3.
4.

Click Configuration. Click Filters from the Displays section.
Select the check boxes next to the filters that you want to delete.
Click Delete.
Click OK.

Custom Forms and Plug-Ins
From a business perspective, Forms are paper documents that Field Resources fill in, while performing their work. From
Oracle Field Service perspective, a Form is a pre-configured page that can be configured using data elements that exist
only in the context of a Form.
Features of Forms:
• Administrators may create as many Forms as needed for the business.
• Forms are not User Type specific; they are independent pages that are connected to User Types pages through
links that are configured on context layouts.
• After the Form is configured, all users see the same Form and capture the same data regardless of their User
Type.
• The Form Field data elements, which can be added to forms are not associated or “bound” to a specific field or
custom property.
• Forms are available only in Core Application, iOS and Android apps.
• Contents of a submitted Form cannot be changed, even if a related entity or Form configuration changes later.
• When a Form is submitted, all Form field elements, except those that have auto-calculated default values or
values filled through predefined parameters are blank.
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• Forms don't support links to any types of pages such as standard actions, plug-ins, or other forms.
Forms are represented in three ways in Oracle Field Service:
• A configuration page where all the required elements are added.
• A page on a mobile device or a computer where technicians and dispatchers fill in data.
• A submitted Form result that represents every sample of the completed Form. These results are available to
users on separate pages and can be retrieved through APIs.

Provide Access to the Forms & Plugins Page
Users with access to the Forms & Plugins page can add and modify custom Forms and plug-ins.
1.
2.
3.
4.
5.
6.
7.
8.
9.

Click Configuration > User Types .
Select the type of user for which you want to provide access.
Go to the Screen configuration tab.
In the Main menu tree, click Configuration.
Click Click to Add and select the Forms & Plugins check box.
Click OK.
Click Forms & Plugins and then click Add new visibility.
Select Read-write and click Save.
Click Close.
All the users of the selected User Type now have access to the Forms & Plugins page.

How a Form is Configured
Here are the high-level steps to configure a Form.
1. Create the Form.
2. Configure the Form elements.
3. Add the Form to a page.

View the Forms and Plug-Ins in the Application
You can view the Forms & Plugins page to add a custom Form or a plug-in, and to export and import plug-ins.
1. Click Configuration > Forms & Plugins .
The Forms and Plugins page opens and displays the default plug-ins and the custom plug-ins and Forms. The
page shows the number of action links that are configured for each Form and plug-in.
2. To see the list of buttons configured for a Form or plug-in, click the number.
A context menu appears and displays the buttons that are grouped by the context layout structure name in
which it is configured. Within every context layout structure name, the buttons are grouped by the user type
name. You can click a button to open the appropriate editor and navigate to the position on the editor. The
button is also highlighted the button in the Visual Form Editor or Context Layout Editor.
3. To add a new custom Form, click Add Form.
4. To add a new plug-in, click Add Plugin.
5. To export and import plug-ins, click Export Plugins and Import Plugins respectively.
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6. To search for a specific Form or a plug-in, click View and select the required options.

Create a Form
You create a Form so that Field Resources can fill it to capture statutory or business data required for an activity.
1. Click Configuration > Forms & Plugins .
2. Click Add Form.
3.
4.
5.
6.

The Add Form dialog box appears.
In the English field, add a name for the Form in English.
Add the names in other required languages.
In the Label field, add a label for the Form.
Click OK.
The Form is saved. The next step is to add elements to the Form.

Configure the Form Elements
After you create a Form, you must add elements to it. Form elements are the fields in which a Field Resource can display
and capture the required data.
1. Click Configuration > Forms & Plugins .
2. Click the stack icon and click Modify content for the Form that you want to edit.
The Visual Form Editor page appears and displays an accordion type panel with these options to help you add,
edit, and search for elements:
◦ Available elements: All the element types that you can use in this context are listed here. To add a new
element, drag it from this section and drop it to the desired location on the form. You can also use the
search option to search for an element within this section.
◦ Data fields: All the data fields that you can use in this context across all element types are listed in
this section. Drag an element from this section and drop it to the form, to add the data field with a preconfigured binding to the data source. You can also use the search option to search for a data field within
this section.
◦ Fields in this layout: All the fields you have used in the layout. Each field has an icon representing the
GUI type of the element that is defined when you bind the field to a data source. The features of this
section are:
- Clicking an item scrolls the content to the appropriate item in the layout and highlights it without
opening the context menu editor.
- Clicking an item in the layout focuses the list to the appropriate item, if the panel is active (not
collapsed).
- If a field is present more then once in the content, you see a marker in a format (n / m). For
example, (1 / 3) means first of the three occurrences. Clicking the marker takes you to the item on
the layout.
- The order in the list is according to the appearance on the configured form, top to bottom, left to
right.
- The search option lets you search for a field within this section.
Another way to open this page is when you add the Form to a page. If you are configuring a page and there is
a button that is configured to open a Form, then you can use the Modify Form content option. In this case, a
new editor session is opened with the specified Form content. Ensure that you have saved all the changes to
the page configuration before you click Modify Form content.
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3. Drag and drop the element that you want to add to the Form. For example, add a section, a text box, a check
box, or a file element.
Here are some special elements that you can add:
◦ Form Field: Adds a field such as text box, list, check box and so on, to the Form. This type of fields exist
on the Form only for presenting and gathering information. The data entered in Form fields will only
be captured in a screenshot of the Form when the Form is Submitted. This data is not stored in the
application. However, data for other fields and properties is captured as normal.
◦ Barcode/QR Code Scanner: Adds an icon to the Form, using which users can scan a barcode or a QR
code. The embedded scanning functionality (that is, camera) on the resource's mobile device is used to
scan the code. The results of the scan is populated automatically in the associated field. This option is
available as part of the Input element. You can add the Barcode/QR Code Scanner any number of times
on a form. Before using the scan option, users must ensure that the Android and iOS app that is installed
on their devices has access to the device’s camera. In Core Application, Barcode/QR scanner is displayed
as a text box.
Note: When you add multiple Barcode/QR code scanner check boxes on a form or page, ensure that
the section contains only the Barcode/QR code scanner check boxes and Text elements. If the section
contains any other type of element, the barcode scanner is not triggered.

◦

Date and Time: Adds a date, time, or date and time field to the Form. The format of data in the data
and time field is controlled by user settings. Specifically 'Time' (sudate_fid) and 'Date' (sudate_fid) user
fields. The data captured from 'Date', 'Time', and 'DateTime' components is stored and exposed through
the 'formSubmitted' event of Events API in a predefined format. Date and Time are form fields and not
available for binding to a custom property. The formats are:
- yyyy-mm-dd for 'Date'
- HH:mm for 'Time'
- yyyy-mm-dd HH:mm for 'DateTime'
Integrators must convert data into other formats, if required.
◦ Hidden value: Adds a field to:
- Include calculated values, which are not required to be displayed when the Form is filled.
- Include pre-populated values by open parameters. The values for these parameters are configured
on the Form button. When the user opens the Form, these values are populated on the Form.
- Use in other expressions, whose values will be included into the submitted Form data with the
values of all other Form elements.
4. In the Data binding section, bind the elements to appropriate entities and fields:
a. Click the Form field drop-down list and select the entity and start entering the entity name that defines
the data source.
The application displays only those fields that contain the entered text in their label or caption.
b. Select the field that you want to define as the data source.
The application populates the Type field automatically, based on the field you select as the data source. If
you do not bind your field to any entity, then you can use the text as a form field label.
c. Optionally, click the pencil icon. In the Data field list, select the specific field that you want to associate
with the selected element.
If the Show only fields appropriate for element type check box is selected, only the fields that are
appropriate for the selected entity and the element type are displayed. If the check box is not selected
and a different type of field is selected, the element type is changed accordingly. For example, if your
element type is Input and you select Activity Type [aworktype], then the element type is changed to the
one that the Activity Type belongs to.
d. Click OK.
5. In the Visibility section, configure the visibility settings.
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a. To change the visibility, click Add new. In the Access mode section, select the required visibility.
b. If you want to add any conditions to make the element visible, click the plus icon.
c. Add the required condition and click Save.
The visibility is Read-write (RW) by default.
6. In the Translations section, add the labels for the field in the required languages.
The number of languages in this section is same as the number of languages you have configured on the
Configuration > Display page. The application adds a label by default and you can change it here. You can use
this label in default expressions and in the visibility conditions of other Form items. Further, you can use this
label to refer to the submitted values in APIs. Here is the screenshot that shows Form elements:

7. Click Save on the Visual Form Editor page.
The Form elements are saved. The next step is to add the Form to a context layout through a User Type page
configuration.

Fields that Cannot have the Barcode/QR Code Scanner Option
You cannot have the Barcode/QR code scanner check box for these fields on the Visual Form Editor:
Activity fields
These auto-calculated fields:
• Access Schedule [access_schedule]
• Access Hours [access_hours]
• Compliance Alerts [activity_compliance]
• Alerts [activity_alerts]
• SLA End [sla_window_end]
• SLA Start [sla_window_start]
• Traveling Time [travel]
• Resource ID [pid]
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• Time Slot [time_slot]
These fields are not auto-calculated (but contain specific data):
• Points [apoints]
• Coordinate X [acoord_x]
• Coordinate Y [acoord_y]
• Duration [length]
These fields are not auto-calculated:
• Name [cname]
• Work Order [appt_number]
• Cellular Phone [ccell]
• Email [cemail]
• Phone [cphone]
• Account Number [customer_number]
• State [cstate]
• ZIP/Postal Code [czip]
• City [ccity]
• Address [caddress]
These auto-calculated fields:
• First Manual Operation [first_manual_operation]
• First Manual Operation Interface [first_manual_operation_interface]
• First Manual Operation Performed by User [first_manual_operation_user_id]
• First Manual Operation Performed by User (Login) [first_manual_operation_user_login]
• First Manual Operation Performed by User (Name) [first_manual_operation_user_name]
• Auto-Routed to Date [auto_routed_to_date]
• Auto-Routed to Resource [auto_routed_to_provider_id]
• Auto-Routed to Resource (Name) [auto_routed_to_provider_name]
• Activity Time of Assignment [atime_of_assignment]
• Activity Time of Booking [atime_of_booking]
• Capacity Categories [activity_capacity_categories]
• Coordinate Status [acoord_status]
• Date [date]
• Start - End [eta_end_time]
• Delivery Window [delivery_window]
• End [end_time]
• Time Notified [time_delivered]
• Work Zone [aworkzone]
• Activity ID [aid]
• Activity status [astatus]
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• Start [ETA]
• Service Window [service_window] [service_window]
• Travel estimation method [travel_estimation_method]
Inventory fields
These auto-calculated fields:
• Changed Inventory ID [inv_change_invid]
• Resource Id [inv_pid]
• Activity Id [inv_aid]
• Inventory Id [invid]
• Inventory pool [invpool]
These fields are not auto-calculated (but contain specific data):
• Quantity [quantity]
Resource fields
These auto-calculated fields:
• ID [pid]
• Working days left for reported data to start impacting duration estimations [skip_days_for_stats]
• Reactivated [reactivated]
• On-call Calendar [oncall_calendar]
• Work Zones [resource_workzones]
• Effective Work Skills [resource_effective_workskills]
• Time slots [resource_time_slots]
• Capacity Categories [resource_capacity_categories]
• Work Skills [resource_workskills]
• Calendar [calendar]
• Queue status [queue_status]
• Total [total]
• Pending [pending]
• Alerts [alerts]
These fields are not auto-calculated:
• Name [pname]
• External ID [external_id]
• Email address [email]
• Phone [pphone]
Service request fields
These auto-calculated fields:
• Created [srcreated]
• Activity [appt_ident]
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• Request Id [srid]
• User Id [sr_uid]
• Resource Id [sr_pid]
• Activity Id [sr_aid]
• Inventory Id [sr_invid]
These possibly auto-calculated fields:
• User [uname]
• Date [srdate]
User fields
These auto-calculated fields:
• User ID [uid]
• Registered [sucreated]
• Failed login attempts [login_attempts]
• Blocked to [login_blocked_to]
• Last login [last_login]
• Last password change [last_password_change]
• Updated [suupdated]
• Main Resource [main_resource_id]
These fields are not auto-calculated (but contain specific data):
• Refresh Rate [refresh_rate]
• Mobile Resource Count [mobile_provider_count]
• Mobile Activity Count [mobile_activity_count]
• Mobile Inventory Count [mobile_inventory_count]
• Collaboration Group [collab_assigned_user_group]
• Operator of Helpdesk [collab_operator_helpdesk]
These fields are not auto-calculated:
• User name [uname]
• Login [ulogin]
• Password [password]

Where Can Forms Be Used
You can open Forms from these pages:
• Activity details and Inventory details: You can open Forms from the links in the action bar and buttons inside
the content.
• Activity list, Inventory list, Forms history, User options, Print route: You can call Forms from the links in the
action bar.
• Dispatch console: You can open Forms from the links on the activity hint.
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• Pages containing resource tree: You can call Forms from the links on the resource hint.
• Time view, List view: You can add Forms to the action menu.
Forms relate to the entities from which they are opened and submitted. In other words, if a Form is submitted in the
context of an activity, then it remains connected to the activity. Users can view Form submission results from this
specific activity. The same idea applies to inventory and resources contexts.
Note: You cannot add buttons to context layout structures that are responsible for changing the state of an activity,
simultaneously with submitting data. Some of the context layout structures where you cannot add buttons are Add
activity, Not done activity, Install inventory, and End activity. Further, you cannot remove or change the visibility of the
two predefined buttons on these pages: Dismiss and Submit. This is to preserve the data integrity within transitions
between states.

Add the Form to a Page
You add a Form to a context layout page, so that Field Resources can open and fill it.
1.
2.
3.
4.

Click Configuration > User Types .
Select the type of user for which you want to add the Form.
Click Screen configuration.
Find and click the page to which you want to add the Form.

5.
6.
7.
8.

The Visual Form Editor page appears.
Drag-and-drop the Button element to the section from where you want to invoke the Form.
Click the button.
In the Standard action screen field, click the pencil icon and then select Custom Forms.
In the Screens list, select the name of the Form that you want to open and click OK.
The label of the Form is displayed in the Custom Forms field, as shown in this screenshot:

By default all Forms have a visibility of Read-only.
9. In the Visibility section, add the conditions based on which the Form is visible.
10. In the Parameters section, add the values that you want the Form to be populated with:
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a. Click Add new.
The Add parameter dialog box appears.
b. Click Entity and select Form data.
The Hidden value, Date, Time, and Date and Time elements added to the Form appear in the Field name
list.
c. Select an element in the Field name list.
d. In the Value field, add the value that you want to be populated for the element.
For example, let’s say you have a field by name City and you want to populate it with New York. Select
City in the Filed name list and enter New York in the Value field. Whenever a Field Resource opens the
Form, New York is populated for City. In another example, let’s say you want to populate today’s date in
a Date field. Select the Date field in the Field name list and enter ‘today’ in the Value field. Whenever a
Field Resource opens the Form, today’s date is displayed. Similarly, enter ‘current time’ in the Value field
to display the current time in the Time field.
e. Click Save.
11. In the Translations section, add a name for the Form.
This name is displayed on the page from which the Form is invoked.
12. Click Save on the Visual Form Editor page.
The Form is added to the selected page.

Call a Form From a Button or Link
Apart from adding a link to a Form on a page, you can add a link to open a Form from read-only pages such as the
activity hint. This serves as a short cut to open the Form.
1. Follow the procedure described in the Add the Form to a Page topic.
Note: You can configure the fields in the Form to populate values when Field Resources open the Form.
You can use the Parameters section of the Button configuration page to pass the values that need to be
populated. Further, using the Parameters section, you can also configure all the entities to populate values,
although they are not present on the Form explicitly.

View Form Submission Results
The Forms history page (Formerly 'Requests history') collects all the Form submission results. The Forms history page
for an activity gives all the Form submissions for the activity. The Forms history page for an inventory item provides
all the Forms submitted for an inventory item. Similarly, Forms history available from the Activity list and User options
provides a list of Form submission results for a specific resource.
1. Click Forms history for an activity, an inventory, or a resource.
2. Click any record.
The specific form is displayed with the values that were entered at the time of submission.
When a user submits a Form, the application stores a snapshot of the values that the user has entered. The
snapshot data remains unchanged, even if the corresponding entities and fields change later. In addition,
except for the auto-calculated default values, or values filled through predefined parameters, the remaining
field values are erased. Further, every time a user submits a Form, the application creates a formSubmitted type
of event. You can retrieve the details of individual submissions by subscribing to this event. See the REST API
guide for more information.
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Lifecycle of a Form
From the time a user opens a Form on a mobile device to the time a Dispatcher views its submission results, a Form is
viewed and processed in different ways.
The lifecycle of a Form is as described here:
• A user opens a Form on a device.

◦
◦

All Form field elements, except those that have auto-calculated default values or values filled through
predefined parameters are blank.
Form elements bound to fields and properties inherit their values.

• The user fills in data and submits the Form.
• Data is stored:

◦
◦

All submitted data is stored as a Form snapshot.
Values of fields and properties bound to page elements are populated and saved separately.

• Data is available to customers:

◦
◦
◦

On the user interface.
In an event of Events API.
As a Service request, if conditions match.

• User goes to step 1 if there is a need to fill the Form again.

◦
◦

All Form field elements, except those that have auto-calculated default values or values filled through
predefined parameters are blank.
Form elements bound to fields and properties inherit actual values.

Export and Import Forms
You export the contents of a Form, so that you can import it and create a similar Form. The best practice is to import
the configuration (properties, activity types, resource types, inventory types, user types, and so on) before you export or
import a form.
1.
2.
3.
4.

Click Configuration > Forms & Plugins .
Find the Form that you want to export.
Click the stack icon and then click Export.
Click Save and save the file the required location.

The Form is saved in .json format.
5. To import a Form:
a. Click Add Form and add the Form details.
b. Click the stack icon and then click Import.
c. On the Import form content dialog, click Browse and select a .json file.
The file is validated and the contents of the Form are saved.
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How Plug-Ins are Configured
This topic describes the high-level steps to configure and use a plug-in in Oracle Field Service.
1. Determine whether you want to host the plug-in in Oracle Field Service. If yes, prepare your plug-in for upload.
2. Configure the plug-in.
a. Upload the hosted plug-in.
b. Add the available properties.
3. Add the plug-in to the required page.

Configure a Plug-In
To use a plug-in in Oracle Field Service, you must configure it first.
1. Click Configuration > Forms & Plugins .
The Forms & Plugins page appears and displays the existing forms and plug-ins.
2. Click Add Plugin.
The Add Plugin page appears.
3. Complete these fields:
Field Name

Description

General Information section
Name (English)

A mandatory field defining the plug-in name in the English language. The action or plug-in
appears under this name in the actual context.

Name (other languages)

Plug-in name translations to other languages, if used.

Label

A mandatory field defining a unique action or plug-in label.

Entity

Entity (activity, inventory, required inventory, resource, service request, user) to which the
action or plug-in is to be related. For example, if you select Inventory, the action will appear
only in the contexts related to inventory. Leave the field blank for the action to be available in all
contexts of all the entities.

Visibility rules similar to

The base action from which the plug-in is to be derived, if needed. When a base action is
selected, the resulting plug-in functions per the same rules as the base action. The base action
affects only the visibility of buttons and not the functioning of the plug-in. It appears only in
the contexts in which the base action appears and is shown or hidden according to the same
visibility conditions. For example, if start_activity is selected as the base action for a plug-in, the
plug-in is only be shown in the context of a pending activity when there is no started activity in
the same route, similar to the Start action. The list of available base actions is filtered according
to the Entity that is selected.

Type

The type of plug-in you want to use. Here are the options:

◦
◦

Native application: This means, the plug-in opens another application on the same
device.
HTML5 application: This means, the plug-in uses an external application to extend
the functionality. An HTML5 application plug-in can be used in one of these Mobility
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Description
contexts - Activity List, Edit., View Activity, Inventory Grid or Add/Details Inventory. This
restriction applies only for plug-ins that use the Plugin API. If this option isn’t selected, the
HTML5 plugin is just a URL of an external resource that is opened in a new window or in
an iframe.

Fields for the HTML 5 Application Option
Use Plug-in API

Determines whether you want the plug-in to communicate with Oracle Field Service using the
Plug-in API. If you clear this check box, the URL is just opened in a new tab/window/iframe. To
interact with Oracle Field Service you must pass some data (such as activity id, resource name)
to the plug-in using the placeholders in the "POST Data" and "URL" fields.

URL

The path to a URL (for external plug-ins). This URL processes the HTML5 application and it runs
the plug-in in the entire browser window. The URL must start with the protocol (https). This
field is hidden, if Hosted plugin is selected. The URL must point to the main file of the plug-in,
if the “Use Plug-in API” option is selected. If “Use Plug-in API” is cleared, the URL must point to
an external resource, which is opened either in a new window or inside Oracle Field Service in
an iframe (if the “Tab or iframe layout” option is selected).

POST Data

The data that you want to be sent to the external plug-in. This field is hidden, if Use plugin API
is selected.

Disable plug-in in offline

Determines whether you want to disable the plug-in when Oracle Field Service is offline. Clear
this check box for the plug-in to work in offline mode. This field is hidden, if Hosted plugin is
selected.

Main menu items

Determines whether the plug-in can be set as a Main Menu item through the Main menu
context layout. This field is hidden, if Use plugin API is selected.

Tab or iframe layout

Determines whether the plug-in uses the iframe layout. If the field is cleared, the plug-in’s URL
is opened in a new browser tab or window. This field is hidden, if Use plugin API is selected.

Show scrollbars

Determines whether the window in which the plug-in runs has scroll bars. This setting is
applicable to the Legacy Manage application. This field is hidden, if Use plugin API is selected.

Width in pixels/ Height in pixels

The width and height of the plug-in window in pixels. This setting is applicable to the Legacy
Manage application. This field is hidden, if Use plugin API is selected.

These fields are displayed when you select the Use Plug-in API check box.
Hosted plugin

Determines whether you want to use a hosted plug-in. The fields that are displayed when you
select this check box are displayed in the Host a Plug-in topic.

URL

The path to a URL (for external plug-ins). This URL processes the HTML5 application and it runs
the plug-in in the entire browser window. The URL must start with the protocol (https). The
URL must point to the main file of the plug-in, if the “Use Plug-in API” option is selected. If “Use
Plug-in API” is cleared, the URL must point to an external resource, which is opened either in
a new window or inside Oracle Field Service in an iframe (if the “Tab or iframe layout” option is
selected).

Disable plug-in in offline

Determines whether you want to disable the plug-in when Oracle Field Service is offline. Clear
this check box for the plug-in to work in offline mode.
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Field Name

Description

Authentication

The type of authentication used by the external server hosting the plug-in source to verify
access to the plug-in. This field is hidden when Native application is selected as the plug-in
type. These choices are available:

◦
◦

Basic HTTP: The Basic Access Authentication method working over HTTP or HTTPS. The
Basic HTTP authentication method requires a valid login and password. When the entered
login and password are verified by the server, the server returns the plug-in content.
HMAC: Hash-based message authentication code verifying that the data is received from
an authorized source. HMAC authentication method requires a secret key configured for
each plug-in. This field is hidden, if Hosted plugin is selected.

Note: The best practice is to use HMAC authentication instead of basic HTTP
authentication. This is because, Google Chrome doesn't support the use of Basic HTTP
authentication in sub-resources starting from release 59.

Login/Password

The user name and password to log in to the plug-in. These fields are displayed only when
Basic HTTP is selected for Authentication.

Secret key

Displayed when HMAC authentication is selected. All parameters of the plug-in URL with
replaced placeholders will be encrypted on the basis of the SHA-256 hash of the Secret Key
value using the HMAC algorithm. The resulting string will be appended to the URL as the HMAC
parameter.

Secure parameters

The section where secure information such as user name and password used to access external
sites is entered. This section is available only when Use Plugin API is selected. The data entered
here is encrypted and stored. Use the plus icon to add a new key-value pair. You can add a
maximum of 20 key-value textbox pairs, after which the icon is hidden. The maximum size
of the parameters allowed is 5 KB. This size includes the data structure overhead and doesn't
correspond to the length of keys and values of strings. Changes to the secure data are sent to
Oracle Field Service during the next synchronization. The data is sent to the plug-in when the
next message is sent.

Fields for the Native Application Option
Native application name

The name of the application to be launched by the plug-in.

Browser user agents mask

The browser in which the application is to be launched. The Native application link will be
available in GUI, if the browser user agent matches the specified mask. For example, Safari,
Android, iPad, iPhone.

URL template

The template for building the external application URL from properties. The URL
template contains parameters key and placeholders for parameters value. Properties are
interpolated with placeholders, surrounded with braces "{" and "}". For example: http://
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www.example.com/android? type=LOCATION'&'action=View'&'alt={acoord_y}'&'long=|
{acoord_x}'&'address={caddress|url}'&'city={ccity|url}'&'state={cstate}'&'zip={czip}

This screenshot shows the Add plugin page:

4. To add the details for another native application, click Add.
5. To reorder the applications, click the stack icon and move the application up or down.
6. To add the properties that are available to the plug-in through the plug-in API, click the pencil icon in the
Available properties section.
The Select properties page appears.
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7. Select the check boxes for all the properties that you want to be passed to the plug-in or updated by the plugin. Click OK.
The properties are saved. Unlike earlier, now you don’t have to define the visibility for the properties explicitly.
You can add these properties to the list of Available properties as read-only. This means, these properties can't
be updated through the Plug-in API:
◦ activity_capacity_categories

◦
◦
◦
◦
◦

auto_routed_to_date
auto_routed_to_provider_id
aworkzone
date
time_delivered

You cannot add these properties to the list of Available properties:

◦
◦
◦
◦
◦
◦
◦
◦
◦

activity_alerts
access_hours
activity_compliance
atravelarea
travel_estimation_method
service_window_end
service_window_start
eta_end_time
pid (it's still available for the Resource entity)

8. Click Save on the Add plugin page.

How Plug-Ins are Hosted
If your plug-in consists only of HTML, CSS, and JavaScript files and doesn't contain server-side files, then you can
upload it in Oracle Field Service. No additional hosting is required. The plug-in framework handles the communication
between the hosted plug-in and Oracle Field Service. You can host a maximum of 25 plug-ins per instance.
The steps to host a plug-in are:
• Complete the prerequisites to upload the plug-in.
• Upload the plug-in.
After hosting a plug-in, you can:
• Use it on a page
• Move between instances
• Modify
• Rollback to a previous version
• Delete
Note: A hosted plug-in works only with Oracle Field Service Mobility Cloud Service.
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Prerequisites to Upload a Plug-In
The plug-in must be in a specific format to be uploaded. If not, you cannot upload it, you must host it elsewhere.
The plug-in files must meet these requirements:
• You must upload a ZIP archive of the plug-in files.
• You can upload only the files of following types:
◦ .html

◦
◦
◦
◦
◦
◦
◦
◦

.css
.js
.jpg
.jpeg
.png
.gif
.svg
appcache

• You can organize files in sub-directories, but you must have the "index.html" file in the root folder.
• Each file can be a maximum of 1 MB and the total size of the compressed archive must be less than 500 KB.
• You can have a maximum of 10 files or directories in the archive.
Note: The plug-in files uploaded in Oracle Field Service are available by unique URLs on the Internet. The URLs are
generated automatically and contain a long string. There is no authentication to access these files, so anyone who has
the direct link to the file can download the file. Therefore, don't store any sensitive information such as passwords or
login names in the plug-in archive. If you don't want your code to be available without authentication, we recommend
that you don't use the hosted plug-in functionality. Be aware that the communication between the plug-in and Oracle
Field Service starts only when a user successfully logs in to Oracle Field Service.

Working Offline
You can create the plug-in to work offline using two possible approaches, or a combination of them.
The approaches are:
• Using Service Worker API (See https://developer.mozilla.org/en-US/docs/Web/API/Service_Worker_API): This
is the preferred way to implement the offline functionality for the plugin. It is supported by most browsers,
except Internet Explorer 11.
• Using Application Cache API (deprecated) (See https://developer.mozilla.org/en-US/docs/Web/HTML/
Using_the_application_cache): This is deprecated and will be removed in the future versions of modern
browsers, but it's supported by Internet Explorer 11. The WHATWG (Web Hypertext Application Technology
Working Group) notifies that Application Cache API feature is being removed from the web platform. Using any
of the offline web application features at this time is highly discouraged. Use service workers instead.
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• Combination approach: Use the Service Worker API for modern browsers and Application Cache API as a
fallback mechanism for Internet Explorer 11. The basic principles of this solution are:
a. Create the mainfest.appcache file and link it with the index.html by adding the "manifest" attribute to
main html tag:
<html manifest="manifest.appcache">

The manifest.appcache must contain the list of cached files in the "CACHE" section.
Tip: Do not add "index.html" to the CACHE section to enable possible future updates of the plug-in's
resources.
b. Create the Service Worker javascript file (for example, service-worker.js). This file must implement the
network behavior of your plug-in using ServiceWorker API. It may load "manifest.appcache" file on
the "install" event, parse the Application Cache file and add all the files from the "CACHE" section to
browser's cache using the CacheStorage interface. After that you can implement any network behavior
strategies to handle the "fetch" event: "network first then cache", "cache first then network", or "network
only".
c. Register your Service Worker file at the JS part of your plug-in, before sending the "ready" post message,
for example:
if (navigator.serviceWorker) {
navigator.serviceWorker.register('service-worker.js').then(function (registration) {
this.startApplication();
}.bind(this), function (error) {
console.error('Service Worker registration failed: ', error);
startApplication();
}.bind(this));
} else {
startApplication();
}

In this code example, the `startApplication()` function sends the "ready" post message. It's important to postpone
sending the "ready" message until the "install" event is handled properly and all files from the CACHE section of
manifest.appcache are loaded to the browser's cache.

Upload a Plug-In
You must upload the plug-in archive to use it as a hosted plug-in.
1. Click Configuration > Forms & Plugins .
2. Locate the plug-in for which you want to upload the archive. Click the stack icon and then click Modify.
The Modify plugin page appears.
3. In the Plugin settings section, ensure that the Hosted plugin check box is selected.
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4. Click Browse and select the ZIP archive that is ready for upload.
The archive is uploaded only if these conditions are met:
◦ The archive is a ZIP archive and has the extension .zip.

◦
◦

◦
◦
◦

The size of the archive is less than 500 KB.
The archive includes only directories and files of these types:
- .html files
- .css files
- .js files
- .appcache files
- .jpg, .jpeg, .png, .gif, .svg files
- Directories
Files are less than 1 MB.
The "index.html" file is located in the root of the archive.
The archive includes a maximum of 10 entries, including empty directories.

If any of these conditions is not met, an error message is displayed and the archive is not uploaded.
5. Click Save.
The plug-in details are saved and the Version history section is populated with:
◦ The user name of the user that uploaded the files.

◦
◦

The date on which the archive is uploaded.
A link to download the archive.

To be able to use the plug-in, you must add it to a button or a link. See the Add the Plug-in to a Page topic.

Modify, Download, or Delete an Archive
After uploading a plug-in archive, you might want to modify it, download it, or delete it.
1. To modify a hosted plug-in, you upload a newer version. To upload a newer version of the archive, click Browse
on the Modify plugin page and upload it again.
You can have only two versions of the plug-in at any time. Whenever you upload a newer version of a plug-in:
◦ The current version becomes a historical one.

◦
◦
◦

The newly uploaded version becomes the current one.
The newly uploaded version is displayed in the first row of the Version history table.
The previous version is moved to the second row of the Version history table.

2. To download a plug-in, click Download in the Version history section. Save it to the desired location.
3. To rollback to a previous version, download the version that you want to rollback to. Click Browse and upload it
again.
4. To delete a plug-in, first unassign it from all the buttons it is added to. Then, click Delete on the Forms &
Plugins page.
The plug-in is deleted with all its historical versions.
5. To move all the uploaded plug-ins between instances, export from the required instance using the Export
function on the Forms & Plugins page. Import the exported files using the Import function in the target
instance.
6. To move a single plug-in between instances, download it from the required instance. Upload it in the target
instance. You can use the Export option here as well.
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Add the Plug-In to a Page
You add a plug-in to a context layout page, so that Field Resources can open it. You can configure the parameters for a
button to send the parameters to the plug-in, or to open a specific page, or another plug-in.
1.
2.
3.
4.

1. Click Configuration > User Types .
Select the type of user for which you want to add the plug-in.
Click Screen configuration.
Find and click the page to which you want to add the plug-in.

The Visual Form Editor page appears. Plug-ins are available not only on the Visual Form Editor, but on old
context layout structures such as Parts Details as well. On such pages, add an action and select a plug-in from
the list.
5. Drag-and-drop the Button element to the section from where you want to invoke the plug-in.
Note: You cannot add buttons to context layout structures that are responsible for changing the state of
an activity, simultaneously with submitting data. Some of the context layout structures where you cannot
add buttons are Add activity, Not done activity, Install inventory, End activity. Further, you cannot remove or
change the visibility of the two predefined buttons on these pages: Dismiss and Submit. This is to preserve
the data integrity within transitions between states.
6.
7.
8.
9.

Click the button.
In the Standard action screen field, click the pencil icon.
Select Plug-ins.
In the Screens list, select the name of the plug-in that you want to open and click OK.

The label of the plug-in is displayed in the Plug-in field. By default all plug-ins have a visibility of Read-only.
10. In the Visibility section, add the conditions based on which the plug-in is visible.
11. In the Translations section, add a name for the plug-in.
This name is displayed on the page from which the plug-in will be invoked. This screenshot shows the Visual
Form Editor page where a plug-in is added to the Button element:

12. To configure the parameters:
a. Click Add new in the Parameters section.
b. Enter a name for the parameter in the Name field.
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For example, enter defaultScreen to define a page as the default page in the plug-in. The maximum
length of the name that you can enter is 248 characters.
c. Enter a value for the parameter.
For example, enter part_order to display the Part order page as the default page in the plug-in. The
maximum length of the value that you can enter is 4000 characters.
d. Click Save.
e. Repeat the procedure for all the parameters that you want to configure.
The total combined length of all parameter names and values must not exceed 5000 characters. These
parameters are not encrypted when sent to the plug-in.
13. Click Save on the Visual Form Editor page.
The plug-in is added to the selected page.

The Navigate Action
The Navigate action is a pre-configured link that opens a native navigation app on mobile devices. The Navigate link
appears only when the user is online, offline, and when activities have resolved coordinates.
These links are pre-configured:
• Android devices (browser user agent mask = *Android*) open a navigation application by geo: protocol for
Android browsers.
• iOS devices (browser user agent mask = *(?:iPad|iPod|iPhone)*) open Apple Maps.
• All other devices (Browser user agent mask = *) open maps.google.com.

Modify the Navigate Action
You can modify the Navigate action, but note that changing this configuration could impact the users in the field. We
recommend that you test the application properly before changing.
1. Click Configuration > Forms & Plugins .
2. Locate Navigate and click Modify in the stack menu.
The Modify plugin dialog box appears.
3. Enter the Native application name, Browser user agents mask and URL.
4. Click Save.
The new Navigate action is saved.

Workflows and How to Configure a Workflow
A workflow helps resources visualize the flow of steps while performing an activity. It guides resources through their
work, and lets them see what steps are completed and what steps remain to be completed. You can use workflows with
all type of activities, such as regular activities, mass and repeating activities, segmentable activities, and teamwork. You
can create workflows through the Workflow Manager page. You can set the workflow for an activity through the user
interface or through APIs. For more information about setting workflows for activities through APIs, see the REST API
for Oracle Field Service guide.
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To enable the feature, you must configure Workflow Manager as Read/Write on the Configuration context layout for
the required User Types. The Workflow Manager page is added automatically to all User Types that can access the
Forms & Plugins page.
Follow these steps to configure a workflow:
1. Add a workflow.
2. Add the steps to the workflow.
3. Add the workflow conditions and activate the workflow.
You do not need to associate a workflow with an activity manually. After you configure a workflow either through the
Workflow Manager page or through the APIs and activate it, Oracle Field Service attaches it to the relevant activities
dynamically.
Related Topics
• Associate a Workflow with an Activity

Add a Workflow
You can create a workflow to help resources visualize the flow of steps of an activity.
1.
2.
3.
4.
5.
6.

Click Configuration > Workflow Manager .
Click the plus icon (Add new button) in the left pane.
In the Add workflow dialog box, type a label for the workflow, in the Workflow label field.
In the English field, type a name for the workflow in the English language.
Add the name for the workflow in the other required language fields.
Click Add.
The workflow is saved. All new flows are set as Inactive by default. This means that they are not available for
resources until you change their status to Active. You can create a workflow and set it to Active right away, but
the best practice is to review the workflow thoroughly, check its configuration, and only then enable it.

Add a Workflow Step
A workflow step is the page that you want to display at that step. This can be either a custom form or a plug-in. A step
includes conditions that determine when a step is started or completed.
1. Click Configuration > Workflow Manager .
The existing workflows are displayed.
2. Click the workflow for which you want to add a step.
3. Click the plus icon (Add new button) in the right pane.
4. Complete these fields on the Add step dialog box:
Field

Action

This step will open

Select whether this step opens a custom form or a plug-in. The next drop-down list is
populated based on this selection. Select the name of the custom form or the plug-in that you
want to open at this step.
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Field

Action

Position in workflow

Select the position of the step within the workflow. If you are adding the first step, ‘First’ is
automatically populated. You can change the order of the steps on the Workflow page as well.

Name translations

Add the name of the step in the languages that you prefer. This name is displayed on the
workflow panel.

Show available when

Select the visibility condition for the step. The condition can be based on a field or property,
or a step in the workflow. This step is visible for end users only when the condition is satisfied.
'Always available (no conditions)' means that a step is displayed for end users initially.
Click the plus icon and select one of these options:

◦
◦

Fields and Properties: Click the plus icon. Select the field name and then select the
condition it must satisfy. This is similar to adding the visibility conditions for user types.
Workflow Step: Click the plus icon. Select the custom form that you have selected for
the current or an earlier step. Add the condition. This option lets you specify whether you
want to display a step when a form selected in an earlier step is completed.
Default: Form <form name> in (equal) submitted
The Submitted option is not available if you have selected a plug-in in the This step will
open field.

Show completed when

Select the condition that determines a step as completed. The condition can be based on a field
or property, or a step in the workflow. The step is marked as completed only when the condition
is satisfied.
Click the plus icon and select one of these options:

◦
◦

Fields and Properties: Click the plus icon. Select the field name and then select the
condition it must satisfy. This is similar to adding the visibility conditions for user types.
Workflow Step: Click the plus icon. Select the custom form that you have selected for
the current or an earlier step. Add the condition. This option lets you specify whether you
want to mark a step as completed when the current form is submitted.
Default: Form <form name> in (equal) submitted
The Submitted option is not available if you have selected a plug-in in the This step will
open field.

Parameters

Use the Parameters section to prepopulate the fields on the form you are using with this step.
This option is similar to the Parameters option when you configure a custom form using the
Visual Form Editor.

5. Click Add.
The step is added.
6. Click Save.
The workflow is saved.

Add a Workflow Condition and Activate the Workflow
A workflow condition associates a workflow with an activity. In other words, you can add a workflow condition to define
the types of activities for which the workflow applies. If you do not add any condition, it implies that the workflow
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applies to all activities. Oracle Field Service does not associate a workflow with any activity until you activate the
workflow.
1. Click Configuration > Workflow Manager .
The existing workflows are displayed.
2. Click the workflow for which you want to add a condition or activate.
3. Click Actions > Modify .
The Workflow Details dialog box appears.
4. Add the workflow condition as a formula in the Conditions field.
The workflow is applied to all the activities that satisfy the condition. For example, if you add 'activity.aworktype
IN ('trouble_call')', the workflow is applied to all activities of type trouble_call.
5. To activate the workflow, click Active.
The application applies the workflow to activities and resources only after you activate it.
6. Click Modify.
The workflow condition is saved.
7. Click Save.
The workflow is saved.

Edit a Custom Form within a Workflow
Sometimes, while working with a workflow you may notice that a custom form needs to be edited. You can edit a
custom form through the Workflow page, without opening the Forms & Plugins page.
1. Click Configuration > Workflow Manager .
The existing workflows are displayed.
2. Click the workflow to which the form is attached.
3. Click the context menu for the step to which the form is attached. Click Edit Form.
The Visual Form Editor opens for the form.
4. Edit as required and click Save.

Tips to Configure Activity Pages for Workflows
There are some best practices that you can use to configure the Activity details page (Edit/View activity Visual Form
Editor) when using workflows.
Here are the best practices:
• You must build this page from the information perspective, which means it should contain all the useful
information that a resource might require in the field. That is, information about the environment, technical
limitations, neighbors, links to useful knowledge on external resources, and so on.
• You must present all of the forms and plug-ins required for an activity within the workflow.
• Buttons on Activity details must lead to those pages that aren't a part of a workflow (that is, Inventory list,
History).
• There is no strict relation between the visibility of the Start activity and End activity page and the completion
of the workflow steps. You must configure the visibility conditions for these buttons separately on the Edit/
View activity Visual Form Editor.
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• You can add inventory into a workflow as a plug-in that manages equipment. Workflow Manager doesn’t
support the standard inventory pages. Therefore, you must configure the inventory-related pages as buttons
on the Activity details page.
• Keep the Start activity and End activity pages as simple as possible, so that resources spend very little time to
perform these actions.
This helps the resource view the majority of pages they interact with while working on an activity within the workflow.
This way, the workflow navigates the resource throughout the process of the activity. Everything else is side information
that might be important, but cannot be considered as tasks that must be performed to finish an activity.

Associate a Workflow with an Activity
You can associate a workflow with an activity in two ways:
• Using API: The Oracle Field Service REST API supports the Activity workflow field within the POST activities
and PATCH activities requests. For more information on how to use APIs for workflows, see the REST API for
Oracle Field Service guide.
• Based on workflow conditions: Oracle Field Service calculates the activity workflows dynamically based on
the workflow conditions you have created. This calculation works for only those activities in the Pending and En
route status, where the workflows aren’t specified using APIs. When a resource changes the activity status from
Pending or En route, the application associates the workflow with the activity, saves the workflow label into the
Activity workflow field and stops recalculation. Dynamic calculation works the same even when a workflow
step is configured with default values and when the workflow is empty. You cannot change the workflow after a
resource starts the activity.

Export and Import Workflows
You can migrate workflows from one instance to another to reduce the time taken to create it manually. When you
export a workflow, only the steps are exported. You must first create the workflow name in the target instance manually,
before importing the steps.
Prerequisites:
• Create all the required forms and plug-ins in the target instance.
• Create the custom properties used within the step conditions in the target instance.
• Configure the required enumeration values for fields such as 'Activity type' and 'Resource type'.
1. Click Configuration > Workflow Manager .
The existing workflows are displayed.
2. Click the workflow that you want to export.
3. Click Actions > Export .
4.
5.
6.
7.

The workflow is exported as a .json file.
Create the workflow in the target instance manually, as described in the Add a Workflow topic.
Click Actions > Import .
Browse and select the .json file that was created in Step 3.
Click Import and Validate.
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The workflow is imported and a log is displayed. If there are critical errors, the import is rejected. You can edit
the workflow based on the errors and warnings and try importing again.

Use Cases to Configure a Workflow
Here are a couple of examples of how you can configure linear and non-linear workflows.
Example 1: Configure a non-linear workflow for an activity type
This use case shows how to configure a workflow where the order of the steps doesn't matter. This workflow is available
for a specific activity type.
Preconditions:
• The workflow uses only forms, and you have configured all the forms.
• The workflow must work only for the 'Trouble Call' activity type.
Actions:
1. Add a new workflow and configure a condition using 'activity.aworktype IN ('trouble_call')'.
2. Add the workflow steps and point them to the forms that must be used within this workflow.
3. Accept the default conditions for all the steps.
Results: The workflow is displayed only for the activities of Trouble Call activity type. All the steps are displayed as
available for technicians when they open the activities, and the technicians can complete the steps in any order.
Tip: You can implement a new workflow based on the current configuration of the Activity Details page. For that,
you must use the same forms that are configured on this page.

Example 2: Configure a linear workflow for a user type
This use case describes how to configure a workflow where the steps become available one after the other. This
workflow is available only for a specific group of users.
Preconditions:
• The workflow uses only forms, and you have configured all the forms.
• There are four steps within the workflow called Safety checklist, Verify Order, Debrief, and Agreement.
• The workflow must work for the Technician user type.
Actions:
1. Add the new workflow and configure a condition using 'user.type IN ('technician')'.
2. Add 'Safety checklist' as the first step and accept the default conditions.
3. Add 'Verify Order' as the next step and specify the ''Safety checklist is completed' condition in the Show
available when section.
4. Add 'Debrief' as the next step and specify the 'Verify Order is completed' condition in the Show available when
section.
5. Add 'Agreement' as the next step and specify the 'Debrief is completed' condition in the Show available when
section.
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Result: This workflow will appear to users assigned with the 'Technician' user type, and the steps will become available
one by one:
1.
2.
3.
4.

The first step is available from the beginning.
The second step becomes available when the first one is completed.
The third step becomes visible when the second step is completed.
The last step becomes available when the third step is completed.
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Organizations
An organization is an entity comprising multiple people, tools, and vehicles that collectively operate as a unit toward
a common goal. In other words, an organization is either a main company, a subdivision (Line of Business of an
organization), or a third-party company that has a contract with the main company. An organization can have buckets,
organization units, field resources, tools or vehicle associations.
An Organization can have buckets, organization units (Org Units), field resources, tools or vehicle associations. You
must create an organization before adding any type of resource. There is one default organization and you can create
additional organizations (in-house and contractor) to meet your operational needs. For example, if XYZ Inc., is the main
organization, XYZ East Coast and XYZ West Coast could be subdivisions. The resources that are directly employed with
the organization are known as in-house resources. The resources that are employed by a third-party company that
subcontracts work are known as contractors. It is recommended that you create an organization for each contractor
company. If the main organization cannot directly assign activities to contractor resources for legal reasons, it can
assign activities to a bucket that contains contractors. Further, a field resource, tool or vehicle will automatically inherit
the parent’s Organization, while a bucket or organization unit can be changed to any defined Organization in the
system.

Create, Edit, or Delete Organizations
An Organization is a main company, a subdivision (Line of Business of an Organization), or a third-party company that
has a contract with the main company. An Organization can have buckets, Organization units, field resources, tools, or
vehicle associations. You can create, edit, or delete Organizations.
1. Click Configuration > Organization .
The Organizations page appears.
2. Click Add New.
The Add Organization dialog box appears.
3. Enter the name of the Organization in the Name field. Enter the names in the corresponding language fields for
languages other than English.
4. Enter a label for the Organization in the Label field.
This label will be used as the Organization identifier in APIs.
5. Select the type of Organization from the Type drop-down list.
The Organization type can be in-house or contractor.
6. Click OK.
The Organization is added to the list of Organizations.
Note: You cannot add a new organization with the same label as an existing one, even if such an
organization is deleted.
7. To edit an Organization, click the Organization on the Organizations page.
The Edit Organization dialog box appears. Edit as required and click Submit.
8. To delete an Organization, click Remove on the Organizations page.
You can remove only those Organizations that don't have field resources, tools, or vehicles assigned to them.

151

Oracle Field Service

Chapter 4

Administering Oracle Field Service

Configure Users and Security

Login Policies
Login Policies determine the authentication method and options for users to access the application.
There are five types of authentication methods:
Authentication Method

Description

Internal

The internal authentication method (BasicHTTP) is a good solution for small companies with relatively
few user credentials, which can be stored in the application database.

LDAP

The LDAP (Lightweight Directory Access Protocol) authentication method is similar to the internal
method. The only difference is that the users' credentials are stored outside Oracle Field Service in an
external LDAP server. This method can be used by companies that prefer to store their user data in
an external server to increase security. When the LDAP authentication is used, the user enters their
credentials into Oracle Field Service, which then passes them to the LDAP server for verification. To
enable LDAP authentication, a software that supports LDAP v3 must be installed and configured on the
customer's back-end server. Examples of such software are: Active Directory, OpenLDAP.

SAML

The SAML (Security Assertion Mark-Up Language) authentication method is an SSO method, involving
authentication data exchange between the user, the service provider (SP) and the identity provider
(IdP). The user wishing to access the services of the service provider has to pass the authentication
by the identity provider, which asserts the user's identity to the service provider. The user's data is
stored with the identity provider and is verified by the user's credentials. If the user authentication is
successful, the service provider verifies the user's login policy and grants access to the application. One
user can be associated with only one login policy and, therefore, its data can be stored with only one
identity provider. The application supports SAML 2.0 protocol, therefore, you can use any SAML 2.0
identity provider. The identity provider details must be used in configuring the SAML Login Policy.

IDCS for Web SSO

You can use Oracle Identity Cloud Service (IDCS) as an identity provider for web SSO. This option helps
customers store user credentials in a different store instead of Oracle Field Service. This option is part
of the SAML authentication option, and you can upload the metadata as an XML file.

OpenID Connect

With the OpenID Connect authentication method, a user uses the account created with an OpenID
Connect Identity Provider to log in to any website supporting the OpenID Connect authentication. The
user registers the OpenID Connect URL with the OpenID Provider, which becomes the user's identifier.
OpenID Connect can be a method of choice for companies preferring cloud data storage and using the
same credentials to access multiple websites.

Generally, the authentication method used depends on the company's business principles and requirements. In most
cases, a company uses one authentication method, although, use of several authentication methods within the same
company is technically possible.
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Add a Login Policy for LDAP, SAML, or OpenID Connect
Authentication Method
Login policies determine the authentication method and options for users to access Oracle Field Service. The
application includes a default login policy; you can add login policies for LDAP, SAML, and OpenID Connect
authentication methods. You can also add multiple policies with multiple authentication methods.
Before you implement OpenID Connect: Create or register Oracle Field Service as an application in your identity
provider. Get the Configuration URL, Logout URL, Client ID, and Client secret from the identity provider. Further, define
an attribute that will be used for the username.
1. Click Configuration.
2. In the Users and Security section, click Login Policies.
3. Click Add new.
The Add Policy dialog box appears.
4. Complete these fields:
Field

Action

Label

Enter a unique identifier label. For SAML login policy, enter only alphabets, numbers, and
undersrores ( _ ).

Policy name

Enter a name for this policy. Enter the name in English and in all the languages that are active in
the application.

Authenticate using

Select the type of authentication method used for this login policy.

These fields are displayed for Internal authentication method:
Max login attempts

Enter the number of invalid login attempts after which the user is blocked. When this field is
set to 0 (zero), the feature is disabled. However, disabling this feature is not recommended for
security reasons.

Login block timer

Enter the number of minutes during which the user remains blocked after reaching the
maximum number of invalid login attempts.

Force password change after

Enter the number of days after which the user must change their password to access the
application. When this field is set to 0 (zero), the feature is disabled.
Note: If the customer's LDAP server allows setting the period of forced password change,
it is recommended that the period set in the application is shorter than the one set on the
LDAP server. This way, the password changes initiated by the application occur earlier than
those initiated by the LDAP server which ensures correct and reliable performance.

User activity relogin time

Enter the duration of the idle time after which the user is prompted to re-enter the password
upon an attempt of any action in the application.

Relogin timeout

Enter the period after which the user is prompted to re-enter the password regardless of
whether the user was active or not.

Max sessions

Enter the maximum number of simultaneous sessions allowed to the user.
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Field

Action

Min password length

Enter the minimum number of characters in the password. Default is 8.

Password must contain uppercase and

Select whether the password must contain alphabets. This option is selected by default.

lowercase letters
Password must contain digits

Select whether the password must contain numbers. This option is selected by default.

Password must contain special symbols

Select whether the password must contain special characters and symbols. This option is
selected by default.

Password must not contain personal

Select whether the password must not contain personal details such as the user’s first name or

details

last name. This option is selected by default.

Password must differ from old

Select whether the password must be different from a previous password. This option is

password

selected by default.

Allow access only for certain IP

Select whether you want to restrict access to specific IP addresses. By default, a login policy is

addresses

created without any restrictions to the IP addresses from which the user may log in. Select the
check box to enable the restriction. When this check box selected, the Allowed IP address list
field appears, where you can enter the IP addresses that can access the application.

These fields are displayed for the LDAP authentication method, along with the fields listed earlier:
LDAP server URL

Enter the actual host name or IP address of the LDAP server.

LDAP DN pattern

If you want to select the LDAP server is MS Active Directory check box, enter the part of
the UPN (User Principal Name) common among the users. In this case the LDAP DN pattern
must always contain the UPN pattern. UPN (User Principal Name) is a string of characters used
to represent a resource available in Active Directory. It should be used when communicating
with MS Active Directory servers. An example of this field value is %s@test.corp, where %s is
a special placeholder to be substituted with the user's login. If the LDAP server is MS Active
Directory check box is not selected, this field contains the common path to the LDAP tree
for the users, their DN pattern. DN (Distinguished Name) is a string of characters used to
represent a resource available in the LDAP directory. An example of this field value is cn=%s,
dc=example,dc=com, where %s is a special placeholder to be substituted with the user's login in
the application.

LDAP server is MS Active Directory

Select whether the LDAP server is a MS Active Directory.

These fields are displayed for the SAML authentication method:
Specify SAML IdP

Select the way in which you want to select the SAML identity provider. The options are:

◦
◦
◦
◦
IdP Metadata XML

Upload metadata XML
Specify metadata URL
Oracle IDCS
Manual populate

This field is displayed if you select Upload metadata XML in the Specify SAML IdP field. Click
Upload to upload the XML file that contains the metadata details for the identity provider.
If the uploaded file is incomplete, or does not contain the details in the proper format, the
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Action
message, Cannot download metadata from the specified XML: XML parser error is displayed.
Contact your Identity Service Provider to get this metadata XML. Ensure that the XML includes
or conforms to this information:

◦
◦
◦
IdP Metadata URL

Metadata XML must be in accordance with SAML 2.0 specifications.
The file contains "SAML Issuer" (parameter "entityID" of the node "EntityDescriptor").
The file provides identity provider certificate (nodes "md:EntityDescriptor/
md:IDPSSODescriptor/KeyDescriptor/KeyInfo/X509Data/X509Certificate/").

This field is displayed if you select Specify metadata URL in the Specify SAML IdP field. Type
the URL from which you want to take the SAML metadata details for the identity provider. If the
URL is unresolved, the message, Cannot download metadata from the specified URL: no route
to host is displayed.

IDCS Metadata XML

This field is displayed if you select Oracle IDCS in the Specify SAML IdP field. Click Upload
to upload the XML file that contains the metadata details for Oracle IDCS. Contact your
implementation consultant for more details on Oracle IDCS.

OFS Metadata XML

Click to download the Oracle Field Service metadata XML. You must pair your identity provider
with Oracle Field Service. Use the downloaded XML file to register Oracle Field Service with your
identity provider.

Max sessions

Enter the maximum number of simultaneous sessions allowed to the user.

SAML issuer

Enter the identifier used to identify asserts from the Identity provider (IdP). It can be any string
provided by IdP, not only URL. It is used for IdP and Service provider (SP) initiated connections.

SAML identity provider certificate

Enter the IdP public key used to sign requests.

SAML identity provider login URL

Enter the IdP URL to redirect to for login. It is needed only for SP initiated logins.

SAML identity provider logout URL

Enter the IdP URL to redirect to for logout. It is needed only for SP initiated logins.

SAML attribute containing username

Enter the SAML assertion attribute name where IdP must store the user name (login name for
Oracle Field Service). Example:
[saml:Attribute Name="uid"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrnameformat:
basic"]
[saml:AttributeValue xsi:type="xs:string"]dispatcher[/
saml:AttributeValue]
[/saml:Attribute]
If it is empty then Oracle Field Service gets the user name from the Name Identifier element of
Subject statement. Example:
[saml:Subject]
[saml:NameID
SPNameQualifier="https://sp.com/sp/module.php/ saml/sp/metadata.php/
default-sp"
Format="urn:oasis:names:tc:SAML:2.0:nameidformat:
persistent"]dispatcher[/saml:NameID]
[/saml:Subject]
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Field

Action

Generate metadata using instance URL

Select this option to construct the URL to log in using the instance URL. This is the
recommended way and is the default option for all new SAML Login Policies. The URL for your
organization is based on your instance name and is displayed under this field in the application.

Generate metadata using

[Not Recommended] Select this option to construct the URL to log in as login.etadirect.com.

login.etadirect.com

This is the non-recommended way and the option selected for existing SAML Login Policies.

These fields are displayed for the OpenID authentication method:
Max sessions

Enter the maximum number of simultaneous sessions allowed to the user.

OpenId identity provider login URL

Enter the Identity Provider URL to start authentication.

OpenId logout URL

Enter the URL to which the user is redirected after logout. It may be the URL for logout from the
Identity Provider.

OpenId attribute containing username

Enter the name of the OpenId attribute where the Identity Provider should store the user's
name (login name for Oracle Field Service). Example:
http://axschema.org/contact/email (This attribute returns the user's email). The attribute must
have a unique value for each user.

These fields are displayed for the Open ID Connect authentication method:
Max sessions

Enter the maximum number of simultaneous sessions allowed to the user.

Configuration login URL

Enter the Identity Provider URL to start authentication.

Logout URL

Enter the URL to which the user is redirected after logout. It may be the URL for logout from the
Identity Provider.

Attribute containing username

Enter the name of the OpenId attribute where the Identity Provider must store the user's name
(login name for Oracle Field Service). Example: email.

Client ID

Enter the value of the field containing data from registered OpenID provider (for example,
Client ID).

Client secret

Enter the value of the field containing data from registered OpenID provider (for example,
Client Secret).

Use instance URL for redirect to OFS

Select this option to construct the URL to be redirected to the application using the instance
URL. This is the recommended way and is the default option for all new OpenID Connect Login
Policies. The URL for your organization is based on your instance name and is displayed under
this field in the application.

Use login.etadirect.com for redirect to

[Not Recommended] Select this option to construct the URL as login.etadirect.com. This is the

OFS

non-recommended way and the option selected for existing OpenID Connect Login Policies.

5. In your OpenID application, configure a link back URL. Use the URL displayed in this dialog box for the option
that you have selected.
Your Identity Provider uses this link to redirect users to Oracle Field Service upon successful login.
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6. Click Add.
The application generates the metadata based on the options you have selected. Use this metadata to link your
identity provider with the instance. Note down the instance URL that you must use when setting up an external
identity provider.
Related Topics
• Sample Metadata XML File for SAML Identity Provider

Sample Metadata XML File for SAML Identity Provider
Sample metadata XML file for SAML identity provider:

<?xml version="1.0"?>
<md:EntityDescriptor xmlns:md="urn:oasis:names:tc:SAML:2.0:metadata" xmlns:ds="http://www.w3.org/2000/09/
xmldsig#" entityID="https://idp-saml.ua3.int/simplesaml/saml2/idp/metadata.php">
<md:IDPSSODescriptor protocolSupportEnumeration="urn:oasis:names:tc:SAML:2.0:protocol">
<md:KeyDescriptor use="signing">
<ds:KeyInfo xmlns:ds="http://www.w3.org/2000/09/xmldsig#">
<ds:X509Data>
<ds:X509Certificate>MIID7TCCAtWgAwIBAgIJANn3qP9lF7M3MA0GCSqGSIb3DQEBCwUAMIGMMQswCQYDVQQGEwJVQTEXMBUGA1UE
CAwOS2hhcmtpdiBSZWdpb24xEDAOBgNVBAcMB0toYXJrb3YxDzANBgNVBAoMBk9yYWNsZTEYMBYGA1UEAwwPc3RzeWJvdi12bTEudWEzMScw
JQYJKoZIhvcNAQkBFhhzZXJnaWkudHN5Ym92QG9yYWNsZS5jb20wHhcNMTUxMjI1MTIyMjU5WhcNMjUxMjI0MTIyMjU5WjCBjDELMAkGA1UE
BhMCVUExFzAVBgNVBAgMDktoYXJraXYgUmVnaW9uMRAwDgYDVQQHDAdLaGFya292MQ8wDQYDVQQKDAZPcmFjbGUxGDAWBgNVBAMMD3N0c3lib
3Ytdm0xLnVhMzEnMCUGCSqGSIb3DQEJARYYc2VyZ2lpLnRzeWJvdkBvcmFjbGUuY29tMIIBIjANBgkqhkiG9w0BAQEFAAOCAQ8AMIIBCgKCA
QEAw4OFwuUNjn6xxb/OuAnmQA6mCWPY2hKMoOz0cAajUHjNZZMwGnuEeUyPtEcULfz2MYo1yKQLxVj3pY0HTIQAzpY8o+xCqJFQmdMiakb
PFHlh4z/qqiS5jHng6JCeUpCIxeiTG9JXVwF1ErBEZbwZYjVxa6S+0grVkS3YxuH4uTyqxskuGnHK/
AviTHLBrLfSrbFKYuQUrXyy6X22wpzo
bQ3Z+4bhEE8SXQtVbQdy7K0MKWYopNhX05SMTv7yMfUGp8EkGNyJ5Km8AuQt6ZCbVao6cHL2hSujQiN6aMjKbdzHeA1QEicppnnoG/
Zefyi/
okWdlLAaLjcpYrjUSWQJZQIDAQABo1AwTjAdBgNVHQ4EFgQUIKa0zeXmAJsCuNhJjhU0o7KiQgYwHwYDVR0jBBgwFoAUIKa0zeXmAJsCuNhJj
hU0o7KiQgYwDAYDVR0TBAUwAwEB/zANBgkqhkiG9w0BAQsFAAOCAQEAJawU5WRXqkW4emm+djpJAxZ0076qPgEsaaog6ng4MLAlU7RmfIY/
l0VhXQegvhIBfG4OfduuzGaqd9y4IsQZFJ0yuotl96iEVcqg7hJ1LEY6UT6u6dZyGj1a9I6IlwJm/9CXFZHuVqGJkMfQZ4gaunE4c5gjbQA5/
+PEJwPorKn48w8bojymV8hriqzrmaP8eQNuZUJsJdnKENOE5/asGyj+R2YfP6bmlOX3q0ozLcyJbXeZ6IvDFdRiDH5wO4JqW/ujvdvC553y
CO3xxsorB4xCupuHu/c7vkzNpaKjYdmGRkqhEqBcCqYSxdwIFc1xhOwYPWKJzgn7pGQsT7yNJg==</ds:X509Certificate>
</ds:X509Data>
</ds:KeyInfo>
</md:KeyDescriptor>
<md:KeyDescriptor use="encryption">
<ds:KeyInfo xmlns:ds="http://www.w3.org/2000/09/xmldsig#">
<ds:X509Data>
<ds:X509Certificate>MIID7TCCAtWgAwIBAgIJANn3qP9lF7M3MA0GCSqGSIb3DQEBCwUAMIGMMQswCQYDVQQGEwJVQTEXMBUGA1
UECAwOS2hhcmtpdiBSZWdpb24xEDAOBgNVBAcMB0toYXJrb3YxDzANBgNVBAoMBk9yYWNsZTEYMBYGA1UEAwwPc3RzeWJvdi12bTEud
WEzMScwJQYJKoZIhvcNAQkBFhhzZXJnaWkudHN5Ym92QG9yYWNsZS5jb20wHhcNMTUxMjI1MTIyMjU5WhcNMjUxMjI0MTIyMjU5WjCB
jDELMAkGA1UEBhMCVUExFzAVBgNVBAgMDktoYXJraXYgUmVnaW9uMRAwDgYDVQQHDAdLaGFya292MQ8wDQYDVQQKDAZPcmFjbGUxGDA
WBgNVBAMMD3N0c3lib3Ytdm0xLnVhMzEnMCUGCSqGSIb3DQEJARYYc2VyZ2lpLnRzeWJvdkBvcmFjbGUuY29tMIIBIjANBgkqhkiG9w0B
AQEFAAOCAQ8AMIIBCgKCAQEAw4OFwuUNjn6xxb/OuAnmQA6mCWPY2hKMoOz0cAajUHjNZZMwGnuEeUyPtEcULfz2MYo1yKQLxVj3pY0HT
IQAzpY8o+xCqJFQmdMiakbPFHlh4z/qqiS5jHng6JCeUpCIxeiTG9JXVwF1ErBEZbwZYjVxa6S+0grVkS3YxuH4uTyqxskuGnHK/
AviTHLBrLfSrbFKYuQUrXyy6X22wpzobQ3Z+4bhEE8SXQtVbQdy7K0MKWYopNhX05SMTv7yMfUGp8EkGNyJ5Km8AuQt6ZCbVao6cHL2h
SujQiN6aMjKbdzHeA1QEicppnnoG/Zefyi/okWdlLAaLjcpYrjUSWQJZQIDAQABo1AwTjAdBgNVHQ4EFgQUIKa0zeXmAJsCuNhJjhU0o
7KiQgYwHwYDVR0jBBgwFoAUIKa0zeXmAJsCuNhJjhU0o7KiQgYwDAYDVR0TBAUwAwEB/zANBgkqhkiG9w0BAQsFAAOCAQEAJawU5WRXq
kW4emm+djpJAxZ0076qPgEsaaog6ng4MLAlU7RmfIY/l0VhXQegvhIBfG4OfduuzGaqd9y4IsQZFJ0yuotl96iEVcqg7hJ1LEY6UT6u6d
ZyGj1a9I6IlwJm/9CXFZHuVqGJkMfQZ4gaunE4c5gjbQA5/+PEJwPorKn48w8bojymV8hriqzrmaP8eQNuZUJsJdnKENOE5/
asGyj+R2YfP6bmlOX3q0ozLcyJbXeZ6IvDFdRiDH5wO4JqW/ujvdvC553yCO3xxsorB4xCupuHu/c7vkzNpaKjYdmGRkqhEqBcCqYSxd
wIFc1xhOwYPWKJzgn7pGQsT7yNJg==</ds:X509Certificate>
</ds:X509Data>
</ds:KeyInfo>
</md:KeyDescriptor>
<md:SingleLogoutService Binding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-Redirect" Location="https://idpsaml.ua3.int/simplesaml/saml2/idp/SingleLogoutService.php"/>
<md:NameIDFormat>urn:oasis:names:tc:SAML:2.0:nameid-format:transient</md:NameIDFormat>
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<md:SingleSignOnService Binding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-Redirect" Location="https://idpsaml.ua3.int/simplesaml/saml2/idp/SSOService.php"/>
</md:IDPSSODescriptor>
<md:ContactPerson contactType="technical">
<md:SurName>Administrator</md:SurName>
<md:EmailAddress>name@emailprovider.com</md:EmailAddress>
</md:ContactPerson>
</md:EntityDescriptor>

Configure User Types
Use user types to manage permissions and restrictions for all users. You can create user types for your business that
correspond to your existing business roles. Each user type has a profile that defines security and display permissions,
such as the user’s login method, the ability to use certain functions, and access to menu items and properties. They
may also include custom context layouts.
You assign each user exactly one user type. You can add or change user types at any time, and delete those which are
no longer needed. You can also copy existing user type configurations to make new ones. This makes it easy to create
multiple user types that share similar configuration settings.
For each page or function that you want to make available for a given user type, you set the visibility to Read-only or
Read-write. If you don't define a visibility value, that page or function is hidden for that user type. Access to a page or
tab automatically includes access to the actions on that page.

User-Type Settings
If your organization adds a new business role, you must create and configure a new user type for it. Similarly, if a
business role is altered, you may have to modify the corresponding user type settings.
Changes to a user type assigned to Oracle Field Service Core Application users are applied shortly after they are saved
on the User Types page. Changes to a user type assigned to Oracle Field Service Mobile for Android and iOS users are
applied after the next synchronization.
User type settings fall into these categories, which appear as tabs:
• General
These basic settings define the user type options with respect to resource types and other users, as well as the
user type access to the application and to its functions.
• Screen configuration
These settings define the pages, windows, context menus, and other elements visible to a certain user type and
supports the context layout editor where the content, arrangement, and visibilities of each context are set.
• Restrictions and Filters
These settings define the restrictions on the activities and fields that are visible to the users of the current type.
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General Tab
The first step in creating a user type is to define the general settings such as, user type name, access, and permissions.
This table describes the fields available on the General tab:

Setting

Description

Notes

Label

A unique identifier of the user type.

Required. No spaces are allowed.

Name

A user-friendly name that describes the user

Required. Spaces are allowed.

User Type Info

type.
Active

Indicates whether the user type is active.

Activating a user type simply makes it
assignable to users. Inactive user types still
apply to users that are assigned to them.

Login Policy

Defines the user authentication method to

None

Oracle Field Service
Assigned resource types

Shows the resource types available for this user

To change the assigned resource types, click

type.

the pencil icon. You cannot remove a resource
type if any users are currently assigned to this
user type.

Can create users of these user types

Lists the user types that this user type can

Inactive user types are greyed out and cannot

create.

be created by this user type.
Permission to create user types is reciprocal.
For example, if user type Manager can create
user type Dispatcher, user type Dispatcher can
create user type Manager.
To change the user types this user type can
create, click the pencil icon.

Can be created by users of following user types

Lists the user types that can create the current

Inactive user types are greyed out.

user type.
Permission to create user types is reciprocal.
For example, if user type Manager can create
user type Dispatcher, user type Dispatcher can
create user type Manager.

Access Settings
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Setting

Description

Notes

Allow access to web application

When enabled, users of the current type can

None

use the unified Core Application to manage
dispatch operations.
Allow access via installed application for

When enabled, users can access the application

Android

through the Oracle Field Service Mobile for

None

Android application.
Allow access via installed application for iOS

When enabled, users can access the application

None

through the Oracle Field Service Mobile for iOS
application.
Permissions
Maps

When enabled, the user can access the Map

None

View on the Activities, Quota, and Resource
Work Zones pages.
Display Inventory using a table format

When selected, inventory is displayed in a
tabular format. When not selected, inventory is
displayed as a list, grouped by Inventory Type.

Use real-time traffic data

When enabled, the check box, Show Traffic is

This option is not available for Contingent

shown on the Map view. Users can select the

Workers (set as ‘Resource is a Contingent

Show Traffic check box to view the current

Worker’ parameter in Manage, under

traffic data in the selected route.

Configuration, and Resource Types).
The real-time update is available to users of
Oracle Field Service Enterprise when Oracle
Field Service Standard Map Cloud Service with
Google Maps or Baidu Maps is part of your
subscription.

Allow access to required inventory

When enabled, the user is able to access the

The Required Inventory permission for

Required inventory functionality and perform

Manage is implemented as visibility for the

all related actions.

Required Inventory tab in the Add activity or
Activity details context.

Parts Catalog

When enabled, the user can search for

None

particular spare parts in the catalog using the
standard search function.
Enable Smart Location alerts

When enabled, the user can receive alerts on

None

their mobile device whenever any compliance
issues have occurred and have been identified
by the SmartLocation module.
Enable GPS Telemetry

When enabled, the user's geopositioning

None

information can be collected directly from the
user's device.
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Description

Disable route activation when geolocation is not When selected, users cannot activate the route
enabled on device

Notes
None

if they have not enabled the location settings
on their device.

Limit location gathering to installed Android or

When selected, Oracle Field Service collects

iOS applications

the location details only for the installed

Be aware that even if you select this option,
resource positions can still be sent through

applications. If you don’t select this permission,

APIs.

the application collects the location details from
all the interfaces that the field resource has
logged in to.
Collaboration
Collaboration

Select the check box to view the collaboration

None

settings.
Allow inventory move via chat

In addition to chat functions, allows the user to

None

transfer inventory via chat.
Allow image sharing via chat

In addition to chat functions, allows the user to

None

share images via chat.
Allow activity move via chat

In addition to chat functions, allows the user to

None

transfer activities via chat.
Allow Video Call

When enabled, the setting allows the user type
to access the Video Chat functionality.

• Requires a subscription to Oracle Field
Service Enterprise.
• If the resource type is a Contingent worker,
then the Video Chat is not available even if
the setting is selected.

Allow Video Call Feedback

When enabled, a user can provide feedback for

None

the Video Call service.
Activity Management
Allow activity move between resources

When enabled, the user can move an activity

None

from one resource to another
Allow activity move from non-scheduled pool

When enabled, the user can convert a non-

to scheduled one

scheduled activity to one that is scheduled.

Allow access to non-scheduled pool

When enabled, the user can access the pool of

None

None

non-scheduled activities and perform actions
to them.
Allow activity reorder inside the route

When enabled, the user can change the

None

position of an activity in the route.
Allow activity reschedule/move to non-

When enabled, the user can move an activity to

scheduled pool

a different date or make it non-scheduled.

None
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Setting

Description

Notes

Allow activity deletion

When enabled, the user can delete an activity

None

together with canceling it. Otherwise, a
canceled activity remains in the application.
Ignore work zones/work skills mismatch on

When enabled, the user can move activities to

activity move

resources with work zones and/or work skills

None

not matching those of the activity.
Allow repeating/mass activity creation

When enabled, the user can create mass and

None

repeating activities.
Set action time

When enabled, the user can manually adjust

None

the time of activity actions. Otherwise, the
action time is logged as the current time.
Display the remaining Activity Time

When enabled, the activity work progress

None

countdown is displayed.
Allow next activity selection on Complete

When enabled, the user completing an activity

None

can select the next activity to start. Otherwise,
only the next activity in the route can be
started.
Display and allow adjustment of remaining

When enabled, the Travel Time Countdown is

Travel Time

displayed and the user can adjust travel time.

None

Available values are: 5, 10, 15, 30, 45 minutes, 1
hour, 1 hour and 30 minutes, 2, 3, 4 and 8 hours.
Suggest activity by location

When enabled, displays the number of activities The distance within which a location falls is
that are assigned in the same location for a

determined by the Resource is considered

technician. This information is displayed above

to be at the activity location if the distance

the Start button on the Resource Info page.

to it is less than X meters setting in the
SmartLocation/GPS section on the Business
Rules page.

Resource Management
Allow changes in working calendar

When enabled, the user can modify the working None
calendar of the resource.

Allow to move resources between Organization

When enabled, the user can move the resources None

Units

to different organizations in the resource tree.

Screen Configuration Tab
This table describes the fields available on the Screen Configuration tab:
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Setting

Description

Notes

Application screens

Includes the contexts used in the Core
Application.

None

Collaboration and Identifiers

Includes the contexts used in Collaboration and
the entity identifier contexts.

None

Plugin API

Includes the plug-ins used with activity,
None
inventory, and resource properties. This context
layout is deprecated with release 19A. Use the
Forms & Plugins page to configure new plugins and migrate the existing plug-ins. When you
finish migrating all the plug-ins, the Plugin API
section will be removed.

Restrictions and Filters Tab
these table describes the fields available on the Restrictions and Filters tab:
Setting

Description

Notes

Hide all activities

Determines if the users will or will not be able
to access any activities in the system after a
certain time. When enabled, the administrator
also has to set the time after which the
activities are to be hidden.

None

Hide activity fields

Determines if the users will or will not be able
to access certain activity fields after a certain
time. The fields to be hidden are defined in
the Field restrictions context accessible by
clicking the Activity fields link. When enabled,
the administrator also has to set the time after
which the activity fields are to be hidden.

None

Filters restricting visible activities

Defines whether the users of the current type
will be able to view the entire routes or only
some activities. Setting the visibility restrictions
requires proper configuration of the applicable
filters.

None

Screen Configuration Settings
Screen configuration settings define the page, dialog boxes, context menus and other elements visible to a certain user
type. They also support the context layout editor, in which the content, arrangement, and visibilities of each context are
set.
The Screen configuration tab contains the list of all contexts available in Oracle Field Service. All contexts are split into
three sections that correspond to their location in the application:
• Application screens: The contexts used in Core Application.
• Collaboration and Identifiers: The contexts used in Oracle Field Service Collaboration Service and the entity
identifier contexts.
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The Screen configuration tab is active when the Allow access to web application option is selected for the user type.
The same settings also influence the availability of the configuration sections. If the Allow access to web application
option is deselected for the user type, the Application screens section is collapsed and inactive.
The list of settings is organized hierarchically and shows the relationships between different contexts. All context names
are links to the context layout editor pages. This screenshot shows the Screen configuration tab:

Note: Any settings configured in the Application screens section are retained if the Allow access to web
application option is deselected afterward for the user type. If the access is allowed again, the same configuration
settings apply again for the user type.
Links to new (not edited) or empty contexts are shown in red, while links to edited contexts are shown in blue. If
you remove all elements from a context, its link color changes from blue to red to indicate that the context is now
empty. If you create a user type without copying the settings of another user type, all contexts are shown in red. When
configuring pages for a user type, the Context layout structure page provides an indicator to show that a property is
configured. When you add an item to the Layout structure column of the page, it appears in red until you add visibility
to the field. After you define a visibility for the item, it is no longer highlighted in the Layout structure column.
Note: You can add or remove the Collaboration Group and Operator of Helpdesk properties from the context layout
structure of the Add/Edit User context for each user type. After you update the properties in the Add/Edit User
context, select a user from the Resource Settings, Users page and click Modify to view the updated properties.
The hierarchy of contexts starts from the Main menu items context defining the main menu items available or
unavailable for the current user type. The configuration of the Main menu items context defines the menu bar
elements visible or hidden for a particular user type. Each menu bar element opens a certain page and, therefore,
provides access to its functionality. If a certain page has been made available for a user type, all users of such type have
access to the entire functionality implemented on that page. Similarly, if a page has been made unavailable for a user
type, all users of such type cannot use the functionality implemented on that page.

164

Oracle Field Service

Administering Oracle Field Service

Chapter 4

Configure Users and Security

Changing the visibility of the Message Scenarios menu item to Read-write allows the user to view and edit all
elements of a message scenario. With the Read-only visibility, they can only view them. This screenshot shows the
Settings tab of the View scenarios step, which was set as read-only in the Screen Configuration page:

The links to contexts are connected with arrows showing the relation between the contexts. Hovering the mouse
over an arrow highlights it in red for better visibility. This screenshot shows a highlighted arrow, which means you are
hovering the mouse over that arrow:

Click a link to open the Context layout structure page and define the fields and actions of the context, and their
visibilities for the user type. You can copy a context layout to another user type if the other user type uses the same or
slightly modified layout of the same page or window. For this purpose, the Context layout structure page has the Copy
to button, which opens the list of all user types in the application.
For the form type contexts, the link leads to the Visual Form Editor page, where you can edit context layouts in an
easier and more transparent manner. You can delete the default Read/Write visibility on the sections and tabs in the
Visual Form Editor. Additionally, Read/Write visibility is not added after migration. When the visibility condition for a
property is mandatory and the property value is cleared, the value is set to null and the visibility is selected.
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If you have shared the configuration for the current user type with one or more other user types, such user types are
preselected in the Copy to list. If the user type selected in the list shares its configuration with other user types, such
user types are automatically selected as well. The current context layout is applied to the selected user types. In this
case it replaces the previous context layout settings, if any.
When a context layout is copied for another user type, only the current context is copied, while the rest of the
configuration remains unchanged. When a context layout is copied, two separate identical context layouts are created.
You can edit each layout independently without affecting the other one. However, if the destination configuration is
shared with other user types, the current context layout is copied to all user types sharing the same configuration.
Context layout copying is confirmed with the message, Layout has been successfully copied. Closing the Context
layout structure page returns the user to the User types page.
The Collaboration and Identifiers section contains the contexts falling under two groups:
• Identifiers: Includes the identifier contexts for activity, inventory and service request
• Collaboration: Includes all contexts related to the Collaboration module, as shown in this screenshot:

Note: Text formatting such as modifying the text size, bold/non-bold, italic, or coloring or properties is not
supported.

Restrictions and Filters Page
The last step in creating a user type is to define whether you want to hide or show activities, activity fields, and activity
filters.
This table describes the fields available on the Restrictions and Filters page:

Setting

Description

Notes

Hide all activities

Determines whether the users can or cannot

None

access any activities in the system after a
certain time. When selected, the administrator
also has to set the time after which the
activities are to be hidden.
Hide activity fields

Determines if the users can or cannot access

None

certain activity fields after a certain time. The
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Description

Notes

fields to be hidden are defined in the Field
restrictions context. You can click the Activity
fields link to access it. When selected, the
administrator also has to set the time after
which the activity fields are to be hidden.
Filters restricting visible activities

Defines whether the users of the current

None

type can view the entire routes or only some
activities. Setting the visibility restrictions
requires proper configuration of the applicable
filters.

Copy or Share a Page Configuration
When you want to create a user type that is similar to an existing user type, you can use the Copy or share screen
configuration option. When you use this option, you select a different source of the page configuration for the current
user type. In this case the current user type is dissociated from the shared page configuration.
1.
2.
3.
4.

Click Configuration > User Types .
Select an existing user type, which you want to be based on another user type.
Click Screen configuration > Copy or share screen configuration .
Select one of these options:
Option

Action

Use Screen configuration of {User

Select this option to share the page configuration with one or more user types. Only one set

Type}

of configuration settings exists, and any changes of the page configuration of one of the user
types causes similar changes of the page configuration of other user types. In this case, sharing
is inherited. That is, if the user type selected for sharing has been sharing its page configuration
with other user types, the same page configuration will be used for all of them. The note
underneath advises the user about the user types sharing the same page configuration.

Create Screen configuration as copy of

Select this option to copy the page configuration from another user type. In this case, two

{User Type}

independent sets of settings are created, and any changes apply only to the user type for
which they are made. The note underneath advises the user about the user type whose page
configuration will be copied.

Create empty Screen configuration

Select this option to clear the current page configuration. Only the settings of the current user
type are cleared. If the page configuration had been shared with or copied from another user
type previously, it is disconnected and a new independent page configuration is created. The
note underneath advises the user that only the page configuration of the current user type will
be cleared.

If you have created a user type as a copy of another user type and then shared the page configuration, the
message, Screen configuration shared with: {User type} displays on the Screen configuration tab. When you
share the page configuration with another user type, the same set of settings is used for both user types, and
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both user types refer to them simultaneously. A shared page configuration means that all context layouts and
their visibilities are similar for all user types sharing them. If you modify the page configuration for one of the
user types, the same changes are applied immediately to all other user types sharing it.
If a user type has an independent page configuration, you can replace with another by sharing or copying
the page configuration of another user type. All user types with page configurations not related to those
of other user types have the Copy/share screen configuration link. This link leads to the same page
configuration options as are offered for changing the current page configuration. However, as the current
screen configuration is not used elsewhere in the system, selecting any option removes it permanently. The
note warns the administrator that the current configuration will be lost.

Configure Header Icons
The application includes two distinct themes—a classic style and a modern style. The modern style theme is called
Vanilla and it displays icons in the header region for the most frequently accessed pages. It has a menu to the left of the
page, which provides access to the remaining pages. The classic style theme displays tabs with text. This screenshot
shows the Vanilla theme user interface with the left pane, hamburger icon, and the header regions marked 1, 2, and 3
respectively:

This topic describes how to configure the header.
1.
2.
3.
4.

Click Configuration > Themes. .
Click Set default in the Vanilla theme row.
Click Configuration > User Types .
Select the user type that you want to modify (you can also select the one that you are using). Click Screen
configuration.
5. Click Main menu items.

The Context layout structure page appears.
6. In the Dispatch section, reorder the menu items as required.
The first item in the list becomes the Home page and gets the Home icon. The application displays only four
icons before the ‘|’ marker, regardless of the number of items you place in the Dispatch section.
7. Click Close and refresh the browser.
The newly configured theme and the icons appear.
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Configure the Main Menu
You can configure the main menu using the Main Menu context layout structure. The configuration affects the
Supervisor view. The Manage, Maps, Calendars, and Resources menus are pre-configured for this layout and are
available by default.
1.
2.
3.
4.
5.

Log in to the application.
Click Configuration > User Types .
Select a User Type for which you want to add the main menu. Click Screen configuration.
Click Application screens > Main menu .
Click the Click to add button and add any item that you want to display on the main menu.

New layout items are available as Read-Only.
6. Click X at the top-right corner.
7. Sign out and sign in to the application.
The newly configured main menu appears.

Edit the Context Layout Page
Use the Context Layout Structure to configure the fields that appear on the application pages.
1. Click Configuration > User Types .
2.
3.
4.
5.

The User Types page appears.
In the left pane, select the user type for which you want to edit the context layout.
Click Screen Configuration.
Expand Application screens or Collaboration and Identifiers. For example, click Application screens.
Click the page for which you want to edit the context layout. For example, click Activity hint.

The Context layout structure for the selected page and the selected user type opens. On this page, you can
add or edit properties, actions, tabs, columns, and sections. Properties appear as fields and actions appear as
buttons. Tabs, columns, and sections define the structure of the layout. You can also configure visibilities to
properties and define the conditions under which the visibility settings are effective.
6. Follow these steps to add a property:
a. Click the Click to add button.
The Add property dialog box appears.
b. Select the property that you want to add and click OK.
7. Follow these steps to configure the visibility for the newly added property:
a. Click Add new visibility.
The [property name] visibility dialog box appears.
b. Select the access mode.
c. To add a condition for visibility, click Add new condition.
The corresponding fields appear.
d. Select a property, select the condition, select the additional condition if available, and then click the tick
mark.
For example, the condition can be equal, not in, empty, and so on. If you have selected the property as
activity status and the condition as equal, the additional condition can be suspended and pending.
8. Follow these steps to add an action:
a. Click the Click to add button under Actions.
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The Add action dialog box appears.
b. Select the action that you want to add and click OK.
After adding the action, set visibility for it. Visibility is not set by default, so you must configure it for
every field and action that you add.
9. Follow these steps to add a tab:
a. Click a property and click Group.
The Add to group dialog box appears.
b. Enter the name of the group.
c. Select one of these options and then click OK:
Option

Description

Section

Select this option to start a new section or block.

Tab

Select this option to start a new tab with the name provided earlier.

Predefined tab

Select this option to include a predefined tab. Select the tab from the Tab type drop-down
list. Predefined tabs are the tabs available in the application by default.

10. Follow these steps to add a column or section:
a. Select a property or an action and click Add marker.
b. In the Add marker dialog, select End of column or End of section.
c. Click OK.

Visual Form Editor
The Visual Form Editor is used to configure context layouts. After configuring a context layout, you must select the
Allow access to web application check box for each user type to view the context in the application.
The Visual Form Editor includes an accordion type panel with these options to help you add, edit, and search for
elements:
• Available elements: All the element types that you can use in this context are listed here. To add a new
element, drag it from this section and drop it to the desired location on the form. You can also use the search
option to search for an element within this section. When you want a Button to set a custom enumeration
field or property (that is, a combobox), you must ensure that the enumeration value is 'active'. You can set the
enumeration property as active on the Modify Property page. For example: Let's say you want to set a value
= '10' through a button for the 'Level' property. You must first configure the corresponding value = '10' in the
parameters section of the corresponding Visual Form Editor. You must ensure that the enumeration value of
'10' is active.
• Data fields: All the data fields that you can use in this context across all element types are listed in this section.
Drag an element from this section and drop it to the form, to add the data field with a pre-configured binding to
the data source. You can also use the search option to search for a data field within this section.
• Fields in this layout: All the fields you have used in the layout. Each field has an icon representing the GUI type
of the element that is defined when you bind the field to a data source. The features of this section are:
◦ Clicking an item scrolls the content to the appropriate item in the layout and highlights it without opening
the context menu editor.
◦ Clicking an item in the layout focuses the list to the appropriate item, if the panel is active (not collapsed).
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If a field is present more then once in the content, you see a marker in a format (n / m). For example, (1 /
3) means first occurrence of 3 in total. Clicking the marker takes you to the item on the layout.
The order in the list is according to the appearance on the configured form, top to bottom, left to right.
The search option lets you search for a field within this section.

You can define Visibility settings for each object of the form. Values with identical visibility settings are grouped and
the grouping happens after the settings are saved. Also, using the Translations section, you can translate the text that
displays on each object to any of the supported languages. By default, the Visual form editor displays these elements:
• Header: Displays the selected actions from the Actions object.
• Footer: Contains the default Dismiss and Submit buttons for a form. You can only define visibility settings for
the Submit button.
• Submit and Dismiss buttons: Indicates the button that is visible for all forms.

Default Values and Validation Rules
You can configure string and integer fields to include default values and validation rules. This helps when your business
needs some fields to be populated by default and some fields to be calculated automatically, based on the value of
another field. Further, this function is allowed only for `string`, `int` and `enum` custom properties.
You can configure the fields and properties in these ways:
• Add a default value: A default value is an auto-calculated value of a field or property. This value is based on
certain business rules and is dependent on the values of other fields and properties. The default value is
represented as formula filled in the corresponding configuration field. For example, when a property is filled
with a specific value, another property is filled with the current date or time.
• Add a validation rule: A validation rule is a restriction based on certain business rules and is dependent on the
values of other fields and properties. A validation rule is represented as a formula filled in the corresponding
configuration field. For example, the value entered for a property (property A) falls within a specific range
(between values of property B and property C).
• Use a formula for configuring the visibility and the value visibility: The formula is based on certain business
rules and is dependent on the values of other fields and properties. The formula for the visibility of the field and
its value must be filled in the corresponding configuration field. It's possible to transform an existing visibility
configured through a constructor to a formula. The application uses this formula for calculating visibility as the
primary path and visibility from the constructor as the secondary path.
Note:
• If a default expression is configured with an empty value for a read-only field or property, it will NOT be hidden
on the page. This means, the user will see the field or property name on the page, but it will not have any value.
• For read-only fields, default values take priority over calculated values.

Auto-Generated and Auto-Calculated Fields
Auto-generated and auto-calculated fields can have a visibility of Read-Only. Regardless of the configured visibility, the
application displays such fields as Read-Only. Further, such fields are not available for selection on the Context Layout
Structure page of add pages such as, 'Add activity' and 'Add inventory'. The fields that can be set only as read-only are
as given in this table:
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Entity

Field

Description

ACTIVITY

ETA

Estimated time of arrival

acoord_status

Coordinate status

acoord_x

Coordinate X

acoord_y

Coordinate Y

activity_alerts

Activity alert

activity_capacity_categories

Activity capacity categories

activity_compliance

Activity compliance

activity_workskills

Activity work skills

aid

Activity ID

astatus

Activity status

atravelarea

Travel area

atype

Activity Type

auto_routed_to_date

Auto-routed to date

auto_routed_to_provider_id

Auto-routed to Provider ID

auto_routed_to_provider_name

Auto-routed to Provider name

aworkzone

Work Zone

date

Date

delivery_window

Delivery window

end_time eta_end_time

Estimated end time

first_manual_operation

First manual operation after the automatic
operation

first_manual_operation_interface

First manual operation done through the
interface after the automatic operation

first_manual_operation_user_id

First manual operation done by (user ID) after
the automatic operation

first_manual_operation_user_login

First manual operation done by (user's login)
after the automatic operation

first_manual_operation_user_name

First manual operation done by (user name)
after the automatic operation
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Field

Description

service_window

Service window

time_delivered

Time of delivery

inv_aid

Activity Id

inv_change_invid

Changed Inventory ID

inv_pid

Resource Id

invid

Inventory Id

invpool

Inventory pool

required_available_quantity

Quantity in Resource Pool

required_model

Model

required_quantity

Quantity

required_type

Type

appt_ident

Activity

srcreated

Created

srdate

Date

srid Id

Request Id

sr_aid

Activity

sr_invid

Inventory Id

sr_pid

Resource Id

sr_uid

User Id

uname

User

alerts

(always hidden)

calendar

Calendar

oncall_calendar

On-call calendar

pcapacity_bucket

Capacity area

pending

Pending activity

pid

ID

pinitial_ratio

Initial ratio for activity duration
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Field

Description

p_rprid

Routing profile ID

queue_status

Queue status

reactivated

Reactivated

resource_capacity_categories

Capacity categories

resource_effective_workskills

Effective work skills

resource_time_slots

Time slots

resource_workskills

Work skills

resource_workzones

Work zones

skip_days_for_stats

Working days left for reported data to start
impacting duration estimation

USER

total

Total

pcolor

(always hidden)

last_login

Last login

last_password_change

Last password change

login_attempts

Login attempts

login_blocked_to

Login blocked to

main_resource_id

Main resource ID

mobile_activity_count

Mobile activity count

mobile_inventory_count

Mobile inventory count

mobile_provider_count

Mobile provider count

show_placeholder_id

Show placeholder ID

sucreated

Registered

sustatus

Status

suupdated

Updated

uid

User ID
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Limitations
These limitations exist for default values and validation rules:
• Work skills and work zones are not supported for default values and validation rules.
• Custom properties with the "Geolocation element" GUI is not supported for default values and validation rules.
• These limitations are applied to the configuration of expressions:
◦ 2000 characters for configuring default values

◦
◦

2000 characters for configuring validation rules
4950 characters for configuring visibility as an expression

Supported Pages
You can configure default values and validation rules only on these Activity and Inventory pages:
Page

Label

Edit/View activity

mobile_activity_details

Cancel activity

mobile_cancel_activity

Delay activity

mobile_delay_activity

End activity

mobile_end_activity

End prework

mobile_end_prework

Not done activity

mobile_notdone_activity

Add activity

mobile_set_activity

Start activity

mobile_start_activity

Start prework

mobile_start_prework

Suspend activity

mobile_suspend_activity

Add/Details inventory

mobile_add_details_inventory

Deinstall inventory

mobile_deinstall_inventory

Install inventory

mobile_install_inventory

Send/View activity request

mobile_activity_request

Add/View inventory request

mobile_inventory_request

Add/View resource request

mobile_provider_request

Edit Required Inventory

mobile_add_edit_required_inventory
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Supported Fields
You can configure default values and validation rules only on these fields:
Property name

Property label

Type

Entity

GUI

Account Number

customer_number

field

activity

text

Activity Type

aworktype

field

activity

combobox

Address

caddress

field

activity

text

Appointment Number

appt_number

field

activity

text

City

ccity

field

activity

text

Customer Email

cemail

field

activity

email

Customer Mobile Number

ccell

field

activity

phone

Customer Phone Number

cphone

field

activity

phone

Duration

length

field

activity

text

Inventory Type

invtype

field

inventory

combobox

Name

cname

field

activity

text

Points

apoints

field

activity

text

Quantity

quantity

field

inventory

text

Serial Number

invsn

field

inventory

text

Service Request Type

srtype

field

service request

combobox

State

cstate

field

activity

text

ZIP/Postal Code

czip

field

activity

text

Calculation Order
The result of a configured expression is calculated in this order:
1.
2.
3.
4.
5.
6.
7.
8.

Value (Number, String, variable, function, expressing in round brackets)
Special operators (BETWEEN, IN, CONTAINS)
Unary operators (NOT, -)
Multiplicative operators (*, /)
Additive operators (+, -)
Comparison operators (=, <>, <, >, <=, >=)
Logical operator AND
Logical operator OR
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Configure Default Values and Validation Rules
When you configure fields on the Visual Form Editor, you can add a default value or a validation rule for fields and
properties. You can also use formulas to configure visibility and visibility value.
1.
2.
3.
4.
5.

Click Configuration.
Click User Types in the Users, Security, Integration section.
Click Screen configuration.
Expand the Application screens section and click the page that you want to modify.
Select the field for which you want to add a default value or a validation rule. If the field is not added to the
context layout, drag it from the left pane and drop it in the right pane.

By default, the field is assigned with a visibility of Read-Write (RW).
6. Follow these steps to change the default visibility:
a. Click Add New in the Visibility section.
The Visibility settings dialog appears.
b. Select the required option in the Access mode section.
c. If you want to change the visibility based on a condition, add it in the Conditions section.
You can add a formula to determine the condition for visibility. The conditions entered here are given
priority over the visibility inherited by the field or property.
Note: When setting up the visibility for a specific property, you cannot create a visibility condition
based on the property itself. For example, suppose that you want to set up the visibility of the property
"City" as Read Write. You cannot set up a condition such as "City contains New York". Further, ensure
that there are no circular dependencies. For example, the Customer Name field is displayed if the
Customer Address field is filled and the Customer Address field is displayed if the Customer Name field
is filled. Although the application does not display an error message when you configure such fields,
the page on which the fields appear may not work properly.
d. Click Show conditions as formula to view the conditions as a formula.
These rules apply to showing conditions as formula:
- If you click Show conditions as formula, the standard conditions constructor hides and a text area
appears containing the auto-generated formula of the conditions.
- If you don’t change the auto-generated formula, the formula is not saved. Show conditions as list
is shown, so you can switch back.
- If you change the formula and it differs from the auto-generated content, Show conditions as list
is disabled.
- If you change the formula and save the changes, the next time this dialog opens with the formula
without the Show conditions as list link.
7. Follow these steps to add a default value or a validation rule:
a. Expand the Default value and validation section.
b. Enter a value in the Default value field.
c. Enter a validation for the value in the Validation field.
You can use arithmetic operators, comparison operators, or functions to form the validation rule.
8. Click Save.
The details are saved and enforced when a user edits the corresponding page the next time.

Language Expressions
The language containing operators and functions is used for configuring default values, validation rules, and visibility of
fields and properties.
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The language is described in this table:
Argument

Description

Use in

Usage Pattern
Default rules

Validation

Visibility

rules
Variables, entities, and properties
this

Value of current element

this > 100

No

Yes

No

entity.property

Value of property of entity. Use for

activity.aworktype = 1

Yes

Yes

Yes

entity.`label`

wrapping labels with spaces.

this + 100

Yes

Yes

Yes

Assuming comment block as single

activity.PROP_A1 > 77 /* 77 -

Yes

Yes

Yes

white space.

is predefined parameter */

White spaces and comments
[space], [tab], [line

Assuming multiple white spaces as

break]

single space. Assuming white space
as separator.

/* Any comment */

Logical operators (case sensitive, operands will be converted to Boolean)
OR

Logical disjunction

a OR b

Yes

Yes

Yes

AND

Logical conjunction

a AND b

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Unary operators
NOT

Logical not (operand will be converted NOT (a AND b)
to Boolean)

—

Arithmetic inversion (operand will be

- activity.PROP_A1

converted to Number)

this * (- activity.PROP_A2)

Equal Comparison Operators (case sensitive for Strings). Operands will be converted to String
=

Equal to

a=b

Yes

Yes

Yes

<>

Not equal

a <> b

Yes

Yes

Yes

Comparison Operators (case sensitive for Strings). Use toNumber() for arguments if number comparison is needed.
<

Less than

a<b

Yes

Yes

Yes

>

Greater than

a>b

Yes

Yes

Yes

<=

Less than or equal to

a <= b

Yes

Yes

Yes

>=

Greater than or equal to

a >= b

Yes

Yes

Yes

Arithmetic Operators (all operands will be converted to Number, any arithmetic operation with Infinity/NaN returns Infinity/NaN)
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Description

Use in

Usage Pattern

+

Addition

a+b

Yes

Yes

Yes

-

Subtraction

a—b

Yes

Yes

Yes

*

Multiplication

a*b

Yes

Yes

Yes

/

Division

a/b

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

if(activity.PROP_A1 > 0, 1, 0)

Yes

No

No

Returns current date in required

now("yyyy-MM-dd

Yes

No

No

format. View corresponding section

HH:mm:ss")

Yes

Yes

Yes

Division by zero: Division by
zero returns infinity, which will be
converted to "" (empty string).

Additional Operators (case sensitive)
string CONTAINS

Return true if `string` contains `needle`

this CONTAINS "A0"

needle

(operands will be converted to String)

activity.PROP_A1 CONTAINS
concat("-", this)
NOT activity.PROP_A2
CONTAINS activity.PROP_A3

value IN (value1[,

Returns true if `value` is equal to

this IN (1, 2, 3, 4)

value2, [, valueN]])

any `value1`...`valueN` (value will be

activity.PROP_A1 IN ("value1",

maximum 1000

converted to String)

"value2")

arguments
NOT activity.PROP_A2 IN
("value1")

value BETWEEN (min,

Returns true if `value` is equal to `min`,

1 BETWEEN (0, 100)

max)

equal to `max` or between them. The

NOT 200 BETWEEN (99, 100)

same as: value >= min AND value <=
max (operands will be converted to
Number)
Functions (case sensitive)
if(condition, value1,

Function which returns value1

value2)

argument if condition is true and
value2 argument if condition is
false (condition will be converted to
Boolean)

now(string)

for details
toNumber(value)

Formatting object to required number toNumber(activity.PROP_A1)
format

toNumber("123.45")
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Description

toString(value)

Formatting object to string

Use in

Usage Pattern
toString(activity.PROP_A1)

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

toString(123.45)

concat(string1, string2

Concatenate strings (all operands will

[... ,stringN]]) maximum be converted to String)

concat(this, "#",
activity.PROP_A1)

20 arguments
toLowerCase(string)

toUpperCase(string)

empty(value)

String to lower case (operand will be

toLowerCase(activity.PROP_

converted to String)

A1)

String to upper case (operand will be

toUpperCase(activity.PROP_

converted to String)

A1)

Returns true if `value` is undefined or

empty(activity.PROP_A1)

empty string or NaN or Boolean, false

NOT empty(activity.PROP_A2)

in all other cases

Data Type Conversion
This table describes the types of data used for validation rules and the way the application converts them:

Number

Number

String

Boolean

NaN

Infinity

Undefined

NA

123 = “123”

1 = True

NA

NA

NA

1.5 >= “1.5”

0 = True

NA

NA

NA

NA

NA

NA

NA

-10 = True

String

Boolean

“”—0

NA

“ ” = False

“1asda” = 0

”anything” = True

“1.5” = 1.5

“0” = True

“2,3” = 0

“False” = True

True = 1

True = “True”

False = 0

False = “ ”

NaN

NaN

“”

False

NA

NA

NA

Infinity

Infinity

“”

False

NA

NA

NA

Undefined

0

“”

False

NA

NA

NA
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Examples of Validation Rules
Scenario 1: Report Gas Consumption
Let's say an activity contains information about gas consumption. There are three of types of consumption: predicted,
actual, and removed. The 'predicted' amount of consumed gas is saved in the activity. When a Field Technician chooses
to report the actual information about the consumed gas, then the difference between 'actual' and 'predicted' data
must be calculated automatically. If the actual consumption exceeds the predicted consumption by more than 20 cubic
meters and the conditions of the gas counter are good, then the 'Reporting notes' property is displayed.
Prerequisites: Let us assume that 'Predicted gas consumption', 'Actual gas consumption', 'Difference', 'Counter is not
broken' and 'Reporting notes' string-type properties are configured in the application. And, there is the 'Counter is not
broken' integer property with a check box on the GUI.
Configuration: Configure the expressions in the 'Default' field for the 'Difference' property. For example:
activity.real_consumption-activity.predicted_consumption
Visibility: Set the visibility for 'Reporting notes' as Read/Write with the same formula as the condition:
(activity.real_consumption-activity.predicted_consumption) >20 AND activity.counter_conditions=1

Scenario 2: Checking Ratio
A Field Technician has to enter the Upstream Signal-to-Noise ratio to complete an activity (it is mandatory). The range
must not be seen and it has to be anywhere between +32 to 52 dBmV. When the Field Technician enters a value of
55dBmV, which is not in the range then the Field Technician must know that is not the range and has to try again. The
Field Technician measures again and enters 51dBmV, which is in the range allowing to complete the activity.
Prerequisites: Let's assume that the Upstream Signal-to-Noise' property is configured in the application. The
'Upstream Signal-to-Noise' property is configured on the 'Complete activity' page as mandatory.
Configuration: Configure the expression in the 'Validation' field for the 'Upstream Signal-to-Noise' property. For
example: this BETWEEN (32,52).
Configure the custom error message in the corresponding field to be displayed to the techician.

Processing Rules
This topic describes the rules based on which default values and validation rules are calculated.
Default value rules
For read-only fields and properties:
• Default value is always calculated for empty fields and properties.
• Default value is not calculated for not-empty fields and properties.
• Default value is recalculated every time a dependent field is changed, where dependent fields are fields used in
the formula of the rule.
For read-write or mandatory fields and properties:
• Default value is always calculated for empty fields and properties.
• Default value is not calculated for not-empty fields and properties.
• Default value is recalculated every time a dependent field is changed, when the dependent fields are used in the
formula of the rule.
• Default value stops calculated once it's manually changed on the open form.
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• Default value stops calculated once it's submitted with not-empty value.
• Default value is not calculated for fields and properties with pre-filled values defined on the Properties
configuration page.
Validation rules
For read-only fields and properties: Not applicable to read-only fields
For read-write fields and properties:
• Are used for read-write fields and properties.
• If a value of certain field or property does not match with the configured validation rule, then the form can be
submitted.
For Mandatory fields and properties:
• Are applicable to mandatory fields and properties.
• If a value of certain field or property does not match with the configured validation rule, then the form cannot
be submitted.
• For fields and properties where validation rules are not configured, the 'NOT empty' rule is automatically
applied (current logic).
• For fields and properties where validation rules are configured, the system uses that rules on the submission
of the form. That is, if a validation rule states that a mandatory field 'IS empty' then it will be submitted without
value.

Conflict Resolution
If a configured visibility rule contradicts with a configured default value, these rules are applied to resolve the conflict:
• for read-only fields and properties, the form is submitted and warning a message is displayed
• for mandatory fields and properties, the form is not submitted and an error message is displayed

Syntax for Default Values and Validation Rules
This topic describes the syntax to configure the default values and validation rules.
Naming of entities: Use these names to relate custom properties and product fields to required entities:
• activity - prefix for activity properties/fields. Example: activity.PROP_A1
• inventory - prefix for inventory properties/fields. Example: inventory.PROP_I1
• resource - prefix for resource properties/fields. Example: resource.PROP_R1
• user - prefix for user properties/fields. Example: user.PROP_U1
• request - prefix for service request properties/fields. Example: sr.PROP_SR1
Operators: All operators are case sensitive and must be used in the configuration as described in the "Language
expression" section. Examples:
• activity.PROP_A1 = 100 OR activity.PROP_A1 = 200 - is correct
• activity.PROP_A1 = 100 or activity.PROP_A1 = 200 - is incorrect

182

Oracle Field Service

Administering Oracle Field Service

Chapter 4

Configure Users and Security

Numbers and Strings: String-type values must be used in expressions in double or single quotes. For example:
• "string expression"
• "12345"
• 'single'
Escape sequences: The allowed string escape sequences are:
• \' – To escape ‘ within single quoted string
• \" – To escape “ within double quoted string
• \\ – To escape the backslash
• \n – To add line breaks between string
• \t – To add tab space
To ignore other escape sequences:
• \radasd => radasd
• \x123 => x123
To use integers in expressions, use them without of quotes. For example:
• 12345
• 6
Use float numbers with a dot as delimiter and without quotes. For example: 2.86954.
Properties and Fields
For properties and fields, the entity is given first followed by the label, and separated by a dot. If the label contains
anything other than a to z, A to Z, 0 to 9, or underscore, wrap it with backticks. Examples:
• activity.PROP_A1 = 25
• activity.PROP_A1 <> activity.PROP_A2
• inventory.`LABEL WITH SPACE`

Functions in Language Expressions
Use functions in expressions in the format where the function's name is given first followed by the expression in
brackets. Separate arguments by comma. All functions are case sensitive and must be used in the configuration as
described in the "Language expression" topic.
Examples for functions are:
• toNumber("string expression")
• if(activity.PROP_A1 > 10, 15, activity.PROP_A2 + 200)
• toLowerCase(activity.PROP_A1) - is correct
• tolowercase(activity.PROP_A1) - is incorrect

‘if’ function
The function consists of three attributes separated by comma. The function represents this logic: if attribute 1 is <some
value> then set <some value> else set <other value>. Example: if (activity.PROP_A1 > 0,15, activity.PROP_A2+200)
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`now` function
The function can be set as now("format") where the format can be DATE, DATETIME, TIMESTAMP. Include the value of
the format between double quotes, similar to strings. Examples:
• DATE - now("yyyy/MM/dd")
• DATETIME - now("yyyy/MM/dd hh:mm:ss tt")
• TIME - now("HH:mm:ss")

`toNumber` and `toString` functions
The rules described in the "Numbers and Strings" and "Properties and Fields" sections are applicable to the toNumber
and toString functions. Examples:
• toNumber("12345")
• toNumber(activity.PROP_A1)
• toString(1245)
• toString(activity.PROP_A2)

'concat' function
The function can contain any number of operands separated by comma and placed in between brackets. Examples:
• concat("abc", 15,"cde")
• concat(activity.PROP_A1,activity_PROP_A2)

`toLowerCase` and `toUpperCase` functions
The functions are used to convert strings to lower or upper case. The functions contain only one operand placed in
brackets. Examples:
• toLowerCase("ABCD")
• toLowerCase(activity.PROP_A1)
• toUpperCase("abcd")
• toUpperCase(activity.PROP_A1)

'empty' function
The function can be set with some field or property defined in brackets followed by the function. Examples:
• empty(activity.PROP_A1)
• if(empty(activity.PROP_A1),1000,activity.PROP_A2 +200)
• NOT empty(activity.PROP_A1)

Activity type groups
You can configure a group of activity types for default values, validation rules, and visibility fields and properties. It
is configured in the format of activity.awortype_group = "LABEL", where the value defining a label of an activity type
group is included in double or single quotes. Examples:
• activity.awortype_group = "internal"
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• activity.aworktype_group IN ('customer', 'maintenance')

The now Function
The 'now' function returns the date and time in the resource time zone.
You can configure the function according to the format given in this table:
Format Character

Description

Example

d

Day of the month, 2 digits

1 to 31

dd

Day of the month, 2 digits, with leading zeros

01 to 31

H

24-hour format of an hour

0 through 23

h

12-hour format of an hour

1 through 12

HH

24-hour format of an hour, with leading zeros

00 through 23

hh

12-hour format of an hour, with leading zeros

01 through 12

M

Numeric representation of a month

1 through 12

m

Minutes

0 to 59

MM

Numeric representation of a month, with leading zeros

01 through 12

mm

Minutes, with leading zeros

00 to 59

s

Seconds

0 through 59

ss

Seconds, with leading zeros

00 through 59

t

Short uppercase Ante meridiem and Post meridiem

A or P

tt

Uppercase Ante meridiem and Post meridiem

AM or PM

yy

A two digit representation of a year, with leading zeros

17

yyyy

A full numeric representation of a year, 4 digits

2017

z

The time zone offset

+0 to ±11

zz

The time zone offset, with a leading zero

+00 to ±11

zzz

The full timezone offset, with a leading zero

+00:00 to ±11:30

Configure a Context Layout Page
You can configure the Context layout structure for a page, when you want to change the visibility of fields, add
conditions for visibility, or add more fields and buttons.
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Let’s say you want to create an Edit/View Activity form for the Edit/View Activity context, that belongs to the
Administrator user type, with these objects:
• Start action.
• Special element, Section
• Name field.
This example explains how to configure the entities, namely, fields, actions, and special elements for the form.
Note: Properties configured on the Edit/View Activity context (also known as Activity Details page) are ReadOnly,
even if the property visibility is set to ReadWrite. To set the property visibility to ReadWrite, you must add the
properties to a tab.

1. Click Configuration, User Types in the Users and Security section.
The existing users display in the left pane.
2. Select Administrator from the left pane.
3. Select the Screen Configuration tab.
4. Expand Application screens and select Edit/View Activity.
5.

6.

7.
8.

9.

The Visual Form Editor displays.
To add the special element Section to the grid:
a. Expand New element.
b. Drag and drop Section to the grid to add a section to the form.
To add the Name field to the section:
a. Expand New element.
b. Drag and drop the Input element to the required position on the form.
c. Click the element and in the Activity field drop-down list, select Address.
Click Save.
To add the Start action:
a. Expand New element.
b. Drag and drop Button to the required position on the form.
c. Click the button and in the Standard screen action drop-down list, select start_activity.
Click Save at the top of the form editor.

After you configure the entities for a form, log in to the application and view the configured form. If you add multiple
Barcode/QR code scanner check boxes on a form or page, ensure that the section contains only the Barcode/QR code
scanner check boxes and Text elements. If the section contains any other type of element, the barcode scanner is not
triggered.

186

Oracle Field Service

Administering Oracle Field Service

Chapter 4

Configure Users and Security

Note: Visibility of tabs is the aggregated result of the configured visibility conditions for the child elements (for
example, property, text). these rules apply:
• The tab is visible and accessible, if at least one element is configured to be visible (for example, Read-write or
Mandatory) or a Read-only element contains data.
• The tab is not visible or accessible, if none of the configured elements is visible (for example, no Read-write or
Mandatory property or Read-only element without data).
• If a tab has all Read-Only elements, then the buttons are shown. If at least one element in the tab is Read-Write
or Mandatory, then the buttons are not shown.
• If a tab has been configured with visibility conditions, it will be displayed in accordance with those conditions
ignoring inner elements.

Related Topics
• Fields that Cannot have the Barcode/QR Code Scanner Option

Restrictions and Filters
The Restrictions and Filters tab sets the restrictions on activities and fields visible to the users of the current type.
The Restrictions and Filters tab has two sections:
• Field restrictions
• Filters restricting visible activities
The Restrictions and Filters tab is shown in this screenshot:
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In the Field restrictions section, you define whether all activities and/or certain activity fields are to be hidden from the
users of the current user type. There are two options in this section:
• Hide all activities: Determines whether the users can access any activities in the application after a certain
time. When you select the Hide all activities option, you must set the time after which the activities are to be
hidden. Two options are available:

◦
◦

starting tomorrow: If you select this option, all users of the current type can only access today's
activities.
starting day after tomorrow: If you select this option, all users of the current type can access today's
and tomorrow's activities. The users cannot see any activities beyond the selected time.

• Hide activity fields: Determines whether the users can access certain activity fields after a certain time. The
fields to be hidden are defined in the Field restrictions context layout structure. You can click the activity
fields link to access it. When you select the Hide activity fields option, you must set the time after which the
activity fields are to be hidden. Two Hide all activity fields menu options are available:

◦
◦

starting tomorrow: If you select this option, all users of the current type can only access the selected
fields of today's activities.
starting day after tomorrow: If you select this option, all users of the current type can only access the
selected fields of today's and tomorrow's activities. The users cannot see the restricted activity fields
beyond the selected time.

Options in the Filters restricting visible activities section define whether the users of the current type can view the
entire routes, or only some activities. Before you set the visibility restrictions, ensure that you have configured the
applicable filters correctly.
You must define a filter as applicable for the activity in the Add Filter window, to use it as a restriction on the visible
activities. In addition, you must select the Restriction on visible activities option. Clicking Add displays the User
Types page, where you can apply the current filter as a visibility restriction filter for the user type. This screenshot shows
the Add filter dialog box with the Applicable for, Restriction on visible activities and the Go to User Types screen to
apply the current filter as visibility restriction filter for user type fields highlighted:
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The filters you add then display in the list of available filters in the Restrictions and Filters tab of the user type
configuration.
When you set a filter for a user type, all users of such type see only the activities defined in the filter settings, according
to the conditions set in the filter configuration.
The User Types section of the filter does not apply when setting restrictions on the visible activities. The User Types
section is inactive only when you select the Restriction on visible activities option. However, it is used in configuring
the filter to be used on List/Time/Map/Daily pages. This screenshot shows the Filters menu:

When you select the List/Time/Map/Daily option, the User Types section becomes active. The note in the User
Types section suggests that the List/Time/Map/Daily filter is applied for the selected user types.
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When you define a filter as a filter for List/Time/Map/Daily for a user type, it appears in the View menu on the
Activities and Daily pages for the users of such type. The list includes only the filters configured as described earlier.
Note: If you define a filter as applicable for both List/Time/Map/Daily and as a Restriction on visible activities,
it works for two different groups of user types. The List/Time/Map/Daily filtering is available for the user types
selected in the same filter configuration dialog box. However, the Restriction on visible activities is set for the user
types for which this filter is selected in the Restrictions and Filters settings.

Add Access Schedule Fields
You add the Access Schedule fields to an activity to define the time or date range between which your technicians can
access the equipment used for the activity, or the facility in which the activity must be performed.
To access the Access Schedule fields, add the Access Schedule (access_schedule) and/or Access Hours (access_hours)
fields to the appropriate display context. While Access Schedule can be added in Read-Only and Read-Write mode,
Access Hours can only have the Read-Only visibility. In most of the contexts (including activity-related pages, lists and
hints, with the only exception of Activity details) the Access Schedule field also includes Access Hours if it is calculated.
Related Topics
• Add the Access Schedule Fields to a Page

User Management
How you configure and manage user types and individual users is dependent upon user-type settings.
User type settings affect the user management process. You should consider these points when configuring user types
and individual users:
• These settings allow the user logging in under this user type to open the Users page and manage users.
• A user having access to the Users page can see the list of all users existing in the system. However, the user can
modify only the users of types defined under Can create users of these user types. Users of other types have
no buttons and cannot be included in group actions (that is, no check boxes are available to them).
• If no user types have been defined in the Can create users of these user types section, the user can see the
users list but cannot modify existing user settings or add new users.
• A user is always related to one or more resources. The choice of resources for creating a new user is affected,
on one hand, by the Assigned resource types setting in the User Type configuration and, on the other hand,
by the Users can be created at the level of this resource feature of the resource type.
• When creating a new user type, the User Type field contains the list of user types defined in the Can create
users of these user types field of the current user type.

Create a User Type
A user type is a template that specifies permissions and page configurations. These settings are applicable to all the
users of the user type.
You must be logged into Oracle Field Service as an administrator.
When you create a user type that is not copied from an existing one, most of the options are disabled, and you must
define the settings manually. When you use a copy, the new user type inherits all the settings from the copy.
1. Access the User Types page.
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2. Click the + icon at the upper left corner of the page.
The Add User Type dialog box appears.
3. Enter a Label for the user type.
This is a unique string identifier of the user type.
4. Enter a Name for the user type.
This is a human-friendly name.
5. Optionally, choose an existing user type to copy settings from.
a. Choose an existing user type from the available list.
b. Optionally, click Share screen configuration.
Choose this option if you want the new user type to have the same page configuration options as the
copied user type. If you change a shared page configuration, the change will apply to all user types that
use the configuration.
6. Click OK
The User Type Settings page appears.
7. Edit the user type values as necessary.
8. Click Save.
Changes to a user type assigned to manage users are applied shortly after they are saved. Changes to
a user type assigned to Oracle Field Service Mobile for Android and iOS users are applied after the next
synchronization.

Delete a User Type
You can delete a user type only if there are no users assigned to it.
You must be logged into Oracle Field Service as an administrator.
1. Access the User Types page.
2. Select the user type you want to delete from the list.
3. Click the - icon at the upper left corner of the page.
The Confirm dialog box opens.
4. Click OK.
If the selected user type is assigned to any users, an error message displays indicating that the user type cannot
be deleted. Else, the user type is deleted.

Export User Types
You export user types from one instance to another, to create users with all their settings, such as associated resource
types, permissions, context layouts, and filters.
1. Click Configuration > User Types > Export .
2. Use the search option to search for the user types that you want to export. Or, click Select All to select all the
users.
3. Click Export.
An XML file containing the data of the user types you selected is generated. You can open or save this file. If
you click Export without selecting any user type, the error message, ‘Nothing to export’ displays.

Import User Types
You can import user types from an XML file and the imported user types replace the existing user types, if any. However,
be aware that you can import only the file that is exported from the same major version of Oracle Field Service. For
example, if you are using Update 20D SU16, you can import a file that was exported from any release of Update 20D.
1. Click Configuration > User Types > Import .
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2. Click Browse and choose the XML file that you want to import.
You can import only XML files.
3. Click Validate.
If you have selected a file of any other format other than XML, an error message appears. If you have selected
an XML file, the application checks to ensure that its entities (such as resource types, permissions, and context
layout items) are valid.
Note: You cannot import your own user type. Your user type must be imported by a user of a different
user type. For example, if your user type is Admin1, you cannot import it. You can create another user type
Admin2, and Admin2 can import Admin1.
During the import process, a progress window displays this information:

◦

The number in the Import column means that the number of imported items differs from the number of
validated items.
◦ A green check mark means that the number of validated items is identical to the number of imported
items.
The User type import details window displays the details of all successfully imported user types, user types
imported with warnings, and user types that were not imported. Validation messages are as follows:
◦ Successfully imported: The user type is imported successfully.

◦

Imported with warnings:

◦

One or more entities is invalid, but the user type is imported.
Not imported: The user type is missing critical data and has not been imported.

Manage Users
You must first configure several user-type settings, so that a user type can create and manage other users.
1. On the General tab, do these:
a. In Can create users of these user types, select all the user types from which users can be created.
b. In Access settings, ensure that the Allow access via web application option is selected.
2. On the Screen configuration tab, do these:
a. Ensure that the Main menu context includes the Users page with the read-write visibility.
b. Ensure that the Company Configuration context includes the User Types page with the read-write
visibility.

User Groups and User Permissions
User Groups and User Permissions are part of the tools used to manage Oracle Field Service Collaboration Cloud Service
functionality settings.
User Groups are used to create roles, structure, and assign permissions. The user group list displays name and
membership information, group description, and status. The User Permissions section provides a list of users that
have access to Oracle Field Service Collaboration Cloud Service. For more information about User Groups and User
Permissions, see the Oracle Field Service Collaboration Cloud Service User Guide.
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Configure the Integrations

Integrate with Other Applications
Your organization may have different software applications to take care of different business aspects. You can
integrate those applications so that when an event occurs in one application, the appropriate changes are performed
automatically in the other application. You can integrate applications in two ways: through Integration Cloud Service
(ICS) and through REST APIs.
Integrating using ICS
When you use ICS, you create an integration point in Oracle Field Service. When an event occurs in Oracle Field Service,
it is sent to the appropriate application through ICS. For example, a company in the manufacturing sector may have an
ERP application to take care of their stocks. The company can integrate the ERP application with Oracle Field Service,
so that when a field technician installs or deinstalls an equipment, the stock is updated in both, Oracle Field Service and
the ERP application.
Integrating using REST APIs
Use REST APIs to integrate third-party applications such as mobile apps. To let a mobile app access REST APIs on
behalf of a user, you use the OAuth 2.0 authentication. To use OAuth 2.0 authentication, you must register the client
application with Oracle Field Service. Then, your client application requests an access token from Oracle Field Service or
other external token service providers such as, Oracle Identity Cloud Service. The client application then sends the token
to the API that you want to access.

Integrate with ICS
Your organization may have different software applications to take care of different business aspects. You can
integrate those applications, so that when an event occurs in one application, the appropriate changes are performed
automatically in the other application. For example, a company in the manufacturing sector may have an ERP
application to take care of their stocks. The company can integrate the ERP application with Oracle Field Service, so that
when a field technician installs or deinstalls an equipment, the stock is updated in both, Oracle Field Service and the
ERP application. One of the ways with which you can integrate the applications is through Integration Cloud Service
(ICS). When you use ICS, you create an integration point in Oracle Field Service. When an event occurs in Oracle Field
Service, it is sent to the appropriate application through ICS.
Note: Configure this integration only if you want to send events or data from Oracle Field Service to ICS.
1. Log in to Oracle Field Service.
2. Click Configuration > Integration Cloud Service (ICS) .
The Integration Cloud Service (ICS) page appears.
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3. To add a new integration, follow these steps:
a. Click Add new.
The Add Integration Cloud Service (ICS) Access dialog box appears.
b. Add a name or description for the application for which you are creating the integration in the End Point
Label field.
If you are using multiple instances of an application, such as Production and Testing, you can create
multiple access points for the application.
c. Add the host name of the application for which you are creating the integration in the ICS Domain field.
For example, if the URL is “https://integration-a12345.integration.us2.oraclecloud.com/
integration/flowsvc/ofsccloudadapter/NAME/v01/" then ICS Domain is: “integrationa12345.integration.us2.oraclecloud.com”.
d. Add the user name of the ICS user in the ICS Username field.
This user must exist in ICS and have permissions to access the integration endpoint.
e. Add the password for the user name in the ICS Password and Confirm Password fields.
The user name and the password are used to authenticate with ICS when Oracle Field Service starts
sending events to ICS.
f. Click Add.
The integration details appear on the Integration Cloud Service (ICS) page. Next, you must log in to ICS
to add the connection details and map the required fields.
4. To modify an integration, follow these steps:
a. On the Integration Cloud Service (ICS) page, click Modify for the end-point that you want to modify.
The Edit Integration Cloud Service (ICS) Access dialog box appears.
b. Edit the fields as required.
You can edit all the fields, except for ICS Domain.
c. Click Submit.
5. To delete an integration, on the Integration Cloud Service (ICS) page, click Delete.
The application stops sending events and updates to ICS.

Navigate to Internal Pages and Plug-Ins
You can directly access internal pages such as Activity details, List view, or Inventory details within the Oracle Field
Service Mobile for Android or iOS apps or Core Application, using specific direct URLs.
Based on the page that is accessed and the user type accessing the page, you can send the following parameters with
the URL:

Name

Type

Description

Constraints

screen

String

Specifies the page that

The following labels are supported:

you want to access.

• activity_list
• activity_by_id
• start_activity
• end_activity
• cancel_activity
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Type

Description

Constraints
• notdone_activity
• suspend_activity
• delay_activity
• inventory_list
• inventory_by_id
• install_inventory
• deinstall_inventory

date

Date

Specifies the date for the

Date format is YYYY-MM-DD.

page that you want to
access.

activityId

Number

Specifies the activity for

Valid activity ID is required.

the page that you want to
access.

resourceInternalId

Number

Specifies the resource for

A valid resourceInternalId is required.

the page that you want to
access.

Mandatory, if you are navigating from the
Supervisor page.

inventoryId

Number

Specifies the inventory

Valid Inventory ID is required.

for the page that you
want to access.

The order of the parameters is not important. Also, any unsupported parameters are ignored. The supported
parameters, URLs, and accessible pages might differ based on whether the logged-in user has access to other users
(such as supervisor, technician). In case, there are missing or invalid params or if the user doesn't have access to the
page, then an error message is displayed.
<OFS_CORE_APP_URL> is the URL to access the following OFS Core App pages:

Activity List
The activity_list label allows you to access the Activity List page.
Supported Parameters

Name

Mandatory for Technician

Mandatory for Supervisor

date

No

No
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Name

Mandatory for Technician

Mandatory for Supervisor

resourceInternalId

No

Yes

Possible URLs

URL

Description

https://<OFS_CORE_APP_URL>/#screen=activity_list

Displays the Activity

Applicable for

Applicable for

Technician

Supervisor

Yes

No

Yes

No

Yes

Yes

Yes

Yes

List page for today’s
date.

https://<OFS_CORE_APP_URL>/#screen=activity_list&date=2020-02-19

Displays the Activity
List page for the
date, 2020-02-19.

https://<OFS_CORE_APP_URL>/#screen=activity_

Displays the Activity
List page of the

list&resourceInternalId=3000001

technician with
resourceInternalId
3000001 for today’s
date.

https://<OFS_CORE_APP_URL>/

Displays the Activity

#screen=activity_list&date=2020-02-19&resourceInternalId=3000001

List page of the
technician with
resourceInternalId
3000001 for the
date, 2020-02-19.

Activity Details
The activity_by_id label allows you to access the Activity Details page.
Supported Parameters

Name

Mandatory for Technician

Mandatory for Supervisor

activityId

Yes

Yes

date

Yes

Yes
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Name

Mandatory for Technician

Mandatory for Supervisor

resourceInternalId

No

Yes

Possible URLs

URL

Description

https://<OFS_CORE_APP_URL>/

Displays the details

#screen=activity_by_id&activityId=4225435&date=2020-02-20

for activity with id

Applicable for

Applicable for

Technician

Supervisor

Yes

No

Yes

Yes

4225435.

https://<OFS_CORE_APP_URL>/

Displays the details

#screen=activity_by_id&activityId=4225435&date=2020-02-20&resourceInternalId=3000001
for activity with id
4225435.

Constraints
• The specified date must be the route date of the specified activity.
• For technicians, the activity must be assigned to the technician.
• For supervisors, the specified resourceInternalId must be assigned to the activity and the supervisor must have
access to the technician.

Activity Actions
Page Label

Description

start_activity

Access the Start Activity page.

end_activity

Access the End Activity page.

cancel_activity

Access the Cancel Activity page.

notdone_activity

Access the Not Done Activity page.

suspend_activity

Access the Suspend Activity page.
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Page Label

Description

delay_activity

Access the Delay Activity page.

Supported Parameters

Name

Mandatory for Technician

Mandatory for Supervisor

activityId

yes

yes

date

yes

yes

resourceInternalId

No

yes

Possible URLs

URL

Description

https://<OFS_CORE_APP_URL>/

Displays the

#screen=<SCREEN_LABEL>&activityId=4225435&date=2020-02-20

specified Activity

Applicable for

Applicable for

Technician

Supervisor

yes

No

yes

yes

Action page for
the Activity ID,
4225435.

https://<OFS_CORE_APP_URL>/#screen=

Displays the

<SCREEN_LABEL>&activityId=4225435&date=2020-02-20&resourceInternalId=3000001

specified activity
action page for
activity with id
4225435.

Constraints
• The specified Activity Action page must be visible for the specified activity.
• The specified date must be the route date of the specified activity.
• For technicians, the activity must be assigned to the technician.
• For supervisors, the specified resourceInternalId must be assigned to the activity and the supervisor must have
access to the technician.
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Inventory List
The inventory_list page label allows you to access the Inventory List page.
Supported Parameters

Name

Mandatory for Technician

Mandatory for Supervisor

activityId

No

No

date

No

No

resourceInternalId

No

yes

Possible URLs

URL

https://<OFS_CORE_APP_URL>/#screen=inventory_list

Description

Displays the

Applicable for

Applicable for

Technician

Supervisor

yes

No

yes

No

No

No

yes

No

Inventory List page.

https://<OFS_CORE_APP_URL>/

Displays the

#screen=inventory_list&activityId=4225435&date=2020-02-19

Inventory List page
for the Activity ID,
4225435.

https://<OFS_CORE_APP_URL>/#screen=inventory_list&resourceInternalId=3000001

Displays the
Inventory List
page of the
technician with
resourceInternalId,
3000001.

https://<OFS_CORE_APP_URL>/

Displays the

#screen=inventory_list&activityId=4225435&date=2020-02-19&resourceInternalId=3000001 Inventory List page
for the Activity
ID, 4225435.
resourceInternalId
is required for
supervisors.
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Constraints
• Inventory list action link should be visible from the activity.
• The specified date must be the route date of the specified activity.
• For technicians, the activity should be assigned to the technician.
• For supervisors, the specified resourceInternalId must be assigned to the activity and the supervisor must have
access to the technician.

Inventory Details
The inventory_by_id label allows you to access the Inventory Details page with the specified Inventory ID.
Supported Parameters

Name

Mandatory for Technician

Mandatory for Supervisor

inventoryId

yes

yes

activityId

No

No

date

No

No

resourceInternalId

No

yes

Possible URLs

URL

https://<OFS_CORE_APP_URL>/#screen=inventory_by_id&inventoryId=21229417

Description

Displays the

Applicable

Applicable

for

for

Technician

Supervisor

yes

No

No

No

inventory details
for the inventory
ID, 21229417.

https://<OFS_CORE_APP_URL>/#screen=inventory_by_

Displays the

id&inventoryId=21229417&activityId=4225435&date=2020-02-19

inventory details
for the inventory
ID, 21229417
and activity ID,
4225435.
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URL

Description

https://<OFS_CORE_APP_URL>/#screen=inventory_by_

Displays the

id&inventoryId=21229417&resourceInternalId=3000001

inventory

Applicable

Applicable

for

for

Technician

Supervisor

yes

yes

yes

yes

details for the
inventory ID,
21229417 for the
technician with
resourceInternalId
3000001.

https://<OFS_CORE_APP_URL>/#screen=inventory_by_id&inventoryId=21229417&activityId=4225435 Displays the
inventory details
&date=2020-02-19&resourceInternalId=3000001

for the inventory
ID, 21229417 and
the activity ID,
4225435 for the
technician with
resourceInternalId
3000001.

Constraints
• For technicians, the technician must have the inventory with the specified ID.
• For supervisors, the specified resourceInternalId must belong to a technician with the inventory specified by
inventory ID.
• The specified date must be the route date of the specified activity.
• For technicians, the activity must be assigned to the technician.
• For supervisors, the specified resourceInternalId must be assigned to the activity and the supervisor must have
access to the technician.

Inventory Actions
Page Label

Description

deinstall_inventory

Accesses the Add to Deinstalled page with the selected inventory.

install_inventory

Accesses the Add to Installed page with the selected inventory.

Supported Parameters

201

Oracle Field Service

Chapter 5

Administering Oracle Field Service

Configure the Integrations

Name

Mandatory for Technician

Mandatory for Supervisor

inventoryId

yes

yes

activityId

yes

yes

date

yes

yes

resourceInternalId

no

yes

Possible URLs

URL

Description

ApplicableApplicable
for

for

TechnicianSupervisor
Displays the

yes

no

no

yes

specified
Activity Action
https://<OFS_CORE_APP_URL>/#screen=<SCREEN_

page for the

LABEL>&activityId=4225435&date=2020-02-19&inventoryId=21229417

activity ID,
4225435 and for
the inventory ID,
21229417.

Displays the
specified
Inventory
https://<OFS_CORE_APP_URL>/#screen= <SCREEN_LABEL>

Action page for

&activityId=4225435&date=2020-02-19&resourceInternalId=3000001&inventoryId=21229417

the activity ID,
4225435 and
inventory ID,
21229417.

Constraints
• The specified Inventory Action page must be visible for the specified activity and inventory.
• For technicians, the technician must have the inventory with the specified ID.
• For supervisors, the specified resourceInternalId must belong to a technician with the inventory specified by
inventory ID.
• The specified date must be the route date of the specified activity.
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• For technicians, the activity must be assigned to the technician.
• For supervisors, the specified resourceInternalId must be assigned to the activity and the supervisor must have
access to the technician.

Access to Custom Plug-Ins
You can directly access custom plug-ins within the Oracle Field Service Mobile Application for Android or iOS or the
Core Application. You can access such pages from any custom Android or iOS app or through specific direct URLs.
Based on the page from where the plugin is accessed and the user type accessing the plugin, you can send the
following parameters with the URL:

Name

Type

Description

Constraints

plugin

String

Specifies the plugin to access.

The label must belong to a valid plugin. The
plugin must be configured on one of the
pages for the logged in user.

contextScreen

String

Specifies the context page from which

The following Context Screen labels are

the plugin is accessed.

supported:
• activity_list
• activity_by_id
• inventory_list
• inventory_by_id
Context pages have the same validations
as page navigation. The order of the
parameters is not important.

date

Date

Specifies the date for the context page.

Date format must be YYYY-MM-DD.

activityId

Number

Specifies the activity for the context

A valid Activity ID is required.

page.

resourceInternalId

Number

Specifies the resource for the context

Must be a valid resourceInternalId.

page.

Mandatory if you access the ID from the
Supervisor page.

inventoryId

Number

Specifies the inventory for the context

A valid Inventory ID is required.

page.
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Note:
• External data: Except for the above parameters, all the passed parameters are sent to the plugin with the
externalData key. If the same key is provided multiple times then the data is sent to the plugin as an array with
the specified key.
• Encoding data: If the data that you want to send has special characters then it must be URL encoded.

Passing Single Key Data
URL: https://<OFS_CORE_APP_URL>/
#plugin=<PLUGIN_LABEL>&contextScreen=activity_list&speed=44.5&distance=11&model=V1
{
"apiVersion": 1,
"method": "open",
"entity": "activityList",
"resource": {},
"activityList": {
"4225438": {
"aid": "4225438"
},
"4225439": {
"aid": "4225439"
}
},
"inventoryList": {
"21064417": {
"invid": "21064417"
},
"21064418": {
"invid": "21064418"
}
},
"openParams": {},
"externalData": {
"speed": "44.5",
"distance": "11",
"model": "V1"
}
}

Passing Array Data
URL: https://<OFS_CORE_APP_URL>/
#plugin=<PLUGIN_LABEL>&contextScreen=activity_list&zipcodes=35801&zipcodes=06101&zipcodes=62701status=completed
{
"apiVersion": 1,
"method": "open",
"entity": "activityList",
"resource": {},
"activityList": {
"4225438": {
"aid": "4225438"
},
"4225439": {
"aid": "4225439"
}
},
"inventoryList": {
"21064417": {
"invid": "21064417"
},
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"21064418": {
"invid": "21064418"
}
},
"openParams": {},
"externalData": {
"zipcodes": ["35801", "06101", "62701"],
"status": "completed"
}

}

Passing data with special characters
Original Data: "https://www.oracle.com/index?q=encoding"
Encoded Data: "https%3A%2F%2Fwww.oracle.com%2Findex%3Fq%3Dencoding"
URL: https://<OFS_CORE_APP_URL>/#plugin=<PLUGIN_LABEL>&contextScreen=activity_list&targetURL=https%3A%2F
%2Fwww.oracle.com%2Findex%3Fq%3Dencoding
{
"apiVersion": 1,
"method": "open",
"entity": "activityList",
"resource": {},
"activityList": {
"4225438": {
"aid": "4225438"
},
"4225439": {
"aid": "4225439"
}
},
"inventoryList": {
"21064417": {
"invid": "21064417"
},
"21064418": {
"invid": "21064418"
}
},
"openParams": {},
"externalData": {
"targetURL": "https://www.oracle.com/index?q=encoding"
}
}

Passing JSON Data
Original JSON String: {"street":"479 South Manor Station
Drive","city":"Glenview","state":"IL","zipcode":"60025"}
Encoded JSON String: %7B%22street%22%3A%22479%20South%20Manor%20Station%20Drive%22%2C%22city%22%3A
%22Glenview%22%2C%22state%22%3A%22IL%22%2C%22zipcode%22%3A%2260025%22%7D
URL: https://<OFS_CORE_APP_URL>/#plugin=<PLUGIN_LABEL>&contextScreen=activity_list&address=%7B%22street
%22%3A%22479%20South%20Manor%20Station%20Drive%22%2C%22city%22%3A%22Glenview%22%2C%22state%22%3A%22IL%22%2C
%22zipcode%22%3A%2260025%22%7D
{

"apiVersion": 1,
"method": "open",
"entity": "activityList",
"resource": {},
"activityList": {
"4225438": {
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"aid": "4225438"
},
"4225439": {
"aid": "4225439"
}
},
"inventoryList": {
"21064417": {
"invid": "21064417"
},
"21064418": {
"invid": "21064418"
}
},
"openParams": {},
"externalData": {
"address": "{\"street\":\"479 South Manor Station Drive\",\"city\":\"Glenview\",\"state\":\"IL\",\"zipcode
\":\"60025\"}"
}
}

Open Plugin from Activity List page
URL: https://<OFS_CORE_APP_URL>/#plugin=<PLUGIN_LABEL>&contextScreen=activity_list&serialNo=49126
{
"apiVersion": 1,
"method": "open",
"entity": "activityList",
"resource": {},
"activityList": {
"4225438": {
"aid": "4225438"
},
"4225439": {
"aid": "4225439"
}
},
"inventoryList": {
"21064417": {
"invid": "21064417"
},
"21064418": {
"invid": "21064418"
}
},
"openParams": {},
"externalData": {
"serialNo": "49126"
}
}

Open Plugin from Activity Details page
URL: https://<OFS_CORE_APP_URL>/
#plugin=<PLUGIN_LABEL>&contextScreen=activity_by_id&activityId=4225439&date=2020-02-27&serialNo=49126
{

"apiVersion": 1,
"method": "open",
"entity": "activity",
"resource": {},
"activity": {
"aid": "4225439"
},
"inventoryList": {
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"21064417": {
"invid": "21064417"
},
"21064418": {
"invid": "21064418"
}
},
"openParams": {},
"externalData": {
"serialNo": "49126"
}

}

Open Plugin from Inventory List page
URL: https://<OFS_CORE_APP_URL>/
#plugin=<PLUGIN_LABEL>&contextScreen=activity_by_id&activityId=4225439&date=2020-02-27&serialNo=49126
{
"apiVersion": 1,
"method": "open",
"entity": "inventoryList",
"resource": {},
"activityList": {
"4225438": {
"aid": "4225438"
},
"4225439": {
"aid": "4225439"
}
},
"inventoryList": {
"21064417": {
"invid": "21064417"
},
"21064418": {
"invid": "21064418"
}
},
"openParams": {},
"externalData": {
"serialNo": "49126"
}
}

Open Plugin from Inventory Details page
URL: https://<OFS_CORE_APP_URL>/
#plugin=<PLUGIN_LABEL>&contextScreen=inventory_by_id&inventoryId=21229417&serialNo=49126
{
"apiVersion": 1,
"method": "open",
"entity": "inventory",
"resource": {},
"activityList": {
"4225438": {
"aid": "4225438"
},
"4225439": {
"aid": "4225439"
}
},
"inventory": {
"invid": "21229417"
},
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"openParams": {},
"externalData": {
"serialNo": "49126"
}

}

Access OFS native app from other Android or iOS native apps
Accessing any of the URL formats and examples listed earlier from an Android or iOS device prompts you to open the
link in a native app (if installed) or the web app using a browser.
However, if you don’t have the option to open the native app in the browser and you must open the OFS native app
from another native app, then replace the link "https://<OFS_CORE_APP_URL>" with "com.oracle.OFS://", (everything
else the same) in each of the above links.

Access to Pages and Plug-Ins in Offline Mode
To access the pages and plug-ins related to the activities of past or future dates, if the application (native app or web
app) can access the specified activity in the Offline mode, then the links to inner pages also work for those activities.

Integrate with REST APIs
Oracle Field Service supports OAuth 2.0 authentication for API access. Use OAuth 2.0 authentication to let thirdparty applications such as a mobile app access REST APIs on behalf of a user. To use OAuth 2.0 authentication, you
must register the client application with Oracle Field Service. Then, your client application requests an access token
from Oracle Field Service or other external token service providers such as, Oracle Identity Cloud Service. The client
application then sends the token to the API that you want to access.
Oracle Field Service supports these types of token service:
• Oracle Field Service Token Service: The client application uses Oracle Field Service Token service to obtain an
OAuth2 access token and authenticate with the APIs. Oracle Field Service token service supports two types of
authentication:

◦
◦

Client Credentials: Authentication using client credentials is primarily used for back-end to back-end
integration. For example, an application that requires pushing data to Oracle Field Service.
JWT Assertion: JWT assertion authentication can be used for back-end to back-end integration or for
mobile applications. The Access Token generated using assertion flow may include the user identity, and
Oracle Field Service performs actions as that user. The advantage of using assertion flow is that user's
password is not shared with Oracle Field Service. When you use this type of authentication, the public key
of the third-party application is imported into the Application entity and the third-party application can
make API calls using its private key.

• External Token Service: The client application uses an external token service such as Oracle Identity Cloud
Service to obtain an OAuth 2.0 access token and authenticate with the APIs.
• Oracle Identity Cloud Service: The client application uses Oracle Identity Cloud Service to obtain an OAuth
2.0 access token and authenticate with the REST APIs. You can upload the signing certificate for Oracle Identity
Cloud Service and then configure Oracle Identity Cloud Service to issue OAuth2 Access Tokens. See the Oracle
Identity Cloud Service documentation for information about where to get the signing certificate: https://
docs.oracle.com/en/cloud/paas/identity-cloud/index.html.
Use these details to configure Oracle Identity Cloud Service:
• Primary audience: <your Oracle Field Service instance name>. For example, ‘ofs-x1111'
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• Scope: The scope name must begin with a slash ( / ), followed by the application ID that you created in Oracle
Field Service. For example, if the application ID is 'new_app' then the Scope is '/new_app'.
After filling in these details, note down the client_id and client_secret of the application.
Integrating applications using REST APIs includes these steps:
1. Register the OAuth client application.
2. Configure the authentication.
3. Enable access to specific APIs for your application.
For more information about calling REST APIs from third-party applications, see the REST API for Field Service guide.

Create an Application
If you want to call REST or SOAP APIs from a third-party application, you must register the third-party application by
adding it on the Application page in Oracle Field Service.
1. Click Configuration > Applications .
The Applications page appears.
2. Click the plus icon, add these details, and then click Submit:
Field Name

Description

Application Name

Name of the third-party application that you want to register.

Application ID

A unique ID of the application.

3. On the Applications page, click the application that you want to register on the left pane and complete these
fields:
Field Name

Description

Application general info section
Application Name

Name of the third-party application that you want to register. This field is populated
automatically.

Application ID

A unique ID for the application. This field is populated automatically.

Active

Status of the Application. Inactive Applications don't authenticate or authorize anyone. When
you make an active Application inactive, previously-issued access tokens don't work.

Token Service

Type of token service or identity provider the Application uses. Default is OFSC.

4. Select the authentication service using these fields:
Field name

Description

Authentication settings section
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Field name

Description

Authenticate using Client ID/ Client

Select this check box to authenticate the application using client ID and client secret. Click Show

Secret

Client ID/Client secret to view the client ID and client secret.

Client ID

The client ID for the third-party application. This ID is automatically generated.

Client Secret/Show Secret

The client secret for the third-party application. This information is automatically generated.

Authenticate using JWT assertion

Select this check box to authenticate the application using JWT assertion.

Authenticate using external access

Select this check box to authenticate the application using an external access token. This field is

token

displayed if you select External for Token service.

Client Certificate/Upload

The certificate signed by the private key of the Application. If this is absent, you cannot use
OAuth2 JWT Assertion authentication. Click Upload to upload the certificate.

5. Select specific APIs for your application using these fields:
Field name

Description

API Access section
Add new

Click to add new APIs. The Add API access dialog appears. Select the APIs you want to add and
click Submit.

Available methods

The list of the API methods available for the corresponding API. Click the menu to modify the
fields or methods and to remove access to the API.

Available entities

The list of entities that the users of the current Application have access to. This option is
available only for Core API and Metadata API fields.

Available resource fields/ Available

The list of the fields available for the corresponding API. Clicking this opens the layout

activity fields/ Available inventory

structure, where you can select the fields that the users of the current Application will be able to

fields/ Available service requests

use to set or update using the API. This page functions as a context layout structure where the

fields/ Available user fields

fields and their visibilities are set.

Remove access

Removes access to this API. Users that have access to this Application cannot use the
corresponding APIs anymore.

6. Add any access restrictions using these fields:
Field name

Description

Additional restrictions section:
Visible resources

The resources that are visible to the Application. The Application performs actions only on
the resource tree nodes that are included in this setting. If no resources are specified, the
Application has access to entire resource tree. Click the pencil icon to select the resources that
are visible to this Application.
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Field name

Description

Allow access only for certain IP

The IP addresses that can access the current application. Add the IP address in the box.

addresses
Allow Cross-origin resource sharing

The white-list of domains from which you can make AJAX requests to Oracle Field Service REST

(CORS) from these web domains

API. Enter each domain name on a separate line. These rules apply:

◦
◦
◦
◦
◦
◦

The maximum length of a domain names is 253 characters.
The maximum number of domain names you can add is 100.
No leading or trailing white space must be present in a domain name.
Wildcards or special characters are not supported.
A single asterisk “*” indicates that all domains are allowed.
Domain names that are added or modified take a few minutes to be populated across the
application.

This table describes how the Visible resources field works:
Visibility restrictions

Behavior

Empty

When a user is authenticated on behalf of this Application, their location in the resource tree
is used for visibility restrictions. The Application cannot authorize itself, it can only authorize
users.

Present

When a user is authenticated on behalf of this Application, an intersection (not union) of their
location in the resource tree and the application visibility restrictions are used for visibility
restrictions.

Integrate with Oracle Knowledge Cloud
About the Integration
Customer field personnel, such as dispatchers and technicians, can enable integration between Oracle B2C Service,
Knowledge Advanced for B2C Service, and Oracle Field Service to access the Knowledge Advanced for B2C Service
knowledge base content in Oracle Field Service.
Quick answers to customer questions or other information on activity-related topics can then be found without having
to leave Oracle Field Service.
Prerequisites
Complete these prerequisites:
• You must have Knowledge Advanced for B2C Service configured in Oracle B2C Service and Oracle Field Service
installed and configured.
• The administrator or web developer must first complete the steps found in: Administration Steps to Configure
Oracle Service Customer Portal for Oracle Knowledge Advanced Integration with Oracle Field Service . For more
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information, see the Knowledge Base article Configuring Oracle Service Customer Portal for Oracle Knowledge
Advanced Integration with Oracle Field Service .

Related Topics
• Access Knowledge Advanced
• Configure Access Settings
• Enable Access

Configure Access Settings
Before using Knowledge Advanced for B2C Service, you must configure several basic settings in Oracle Field Service
Core Application.
To complete the setup process, you need a user name and password. Contact your Oracle Support representative for
assistance.
1. In Oracle Field Service Core Application, go to Configuration > User Types .
2. Select a user type, and then select the Screen configuration tab.
3. Select Company Configuration from the list of contexts.
4. In the Actions pane, select Oracle Knowledge. If Oracle Knowledge does not appear in the list of actions, click
Click to add to find and add it.
5. On the Add action dialog box, add a new Oracle Knowledge read/write visibility.
6. Click Close.
7. Click Configuration to return to the Configuration page.
The Oracle Knowledge icon now displays in the Subsystems and Integrations section.
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8. Click the Oracle Knowledge icon.
The Oracle Knowledge configuration page displays, as shown in this screenshot:

The page contains two sections:
◦ Knowledge access— complete these fields:
- URL: The URL to access the knowledge base.
- User Name: User name is a concatenation of your Oracle Field Service user name
and the string &p_li_passwd followed by the value of PTA_SECRET_KEY. For example,
'john.smith&p_li_passwd=ThisIsASecret'.
- Password: Your Oracle Field Service password.
◦ Knowledge fields mapping— provides the possibility to сonfigure the parameters of the context search
and filtering, based on activity properties.
Note: By default, the fields in this section are not used, and configuring these properties is optional.
If you don't select anything, no context search is processed. You can, however, specify your search
criteria manually on the Oracle Knowledge page.
9. Select the desired search, category, and product properties from the drop-down lists.
10. Click Save.
The search engine uses the value of the selected search activity property as an initial search query to scour the Oracle
knowledge base. The results of the search are then filtered by the selected category and product activity properties.
Subsequently, the Oracle Knowledge page will show those information articles relevant to the parameters of the current
activity when opened.
Related Topics
• About the Integration
• Access Knowledge Advanced
• Enable Access
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Configure Pass-Through Authentication
The PTA option helps track the actual usage of users accessing Knowledge Advanced for B2C Service from Oracle
Field Service. When you select PTA as the security policy in Oracle Field Service, Oracle B2C Service acts as an IDP. This
security policy uses PTA in Oracle B2C Service to create the contact and provide access to Knowledge Advanced for B2C
Service.
You can configure Pass-through authentication (PTA) for Knowledge Advanced for B2C Service. Follow these steps:
1. Click Configuration, Oracle Knowledge.
Oracle Knowledge is displayed on the Configuration screen, only if you have a license for it:
This figure shows the Configure PTA dialog.

2. Complete these fields:
Field

Description

Security policy

The security policy that you want to use to connect to Knowledge Advanced for B2C Service.
Select Pass-Through Authentication.

URL

The URL to access the knowledge base.
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Field

Description

User Name

User name is a concatenation of your Oracle Field Service user name and the string &p_
li_passwd followed by the value of PTA_SECRET_KEY. For example, 'john.smith&p_li_
passwd=ThisIsASecret'.

Password

Your Oracle Field Service password.

Knowledge fields mapping

Provides the possibility to configure the parameters of the context search and filtering, based
on activity properties. Select the desired search, category, and product properties from the
drop-down lists.

3. Click Save.
See the PTA guide for more information about the configuration settings.
PTA Fields and Values
Note: Connectivity must be available to integrate Oracle Field Service with Knowledge Advanced for B2C Service.
Oracle Field Service must be able to reach the Knowledge Advanced for B2C Service URL.

Name

Value

Description

PTA_ENABLED

Yes

Enables the use of PTA login integration.

PTA_ENCRYPTION_KEYGEN

3

Specifies the type of keygen method to use for
PTA encryption. 3 ? RSSL_KEYGEN_NONE

PTA_ENCRYPTION_METHOD

aes256

Specifies the encryption scheme PTA logins
should use. aes256 ? 256 bit AES in CBC mode

PTA_ENCRYPTION_PADDING

1

Specifies the type of padding method to use for
PTA encryption. 1 ? RSSL_PAD_PKCS7

PTA_IGNORE_CONTACT_PASSWORD

Yes

Specifies whether contact passwords are
honored during PTA logins. If enabled, contact
passwords are ignored and users can log in
through PTA with just a username.

PTA_SECRET_KEY

< User defined value >

Specifies the secret key used to validate login
integration parameters, when encryption is
disabled, or to decode the PTA string when
encryption is enabled. If encryption is disabled,
you must pass this value as a p_li_passwd
parameter encoded within the PTA login string.
If encryption is enabled, you must not include
this value within the PTA string and use only to
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encrypt the value sent. Requests that send an
invalid value are rejected.
This key used as the "Secret Key" in the new
configuration page of Oracle Knowledge.

NOTE: As part of the new user authentication process, Oracle B2C Service expects an email address as a mandatory
field. Oracle Field Service uses the user email address configured in a custom property selected as "Email for
password reset" on the "Display" screen for this purpose. If you have not enabled this email address, or you have
provided an invalid email address, Oracle Field Service generates a dummy email address in the format " <Oracle Field
Service_login>@<Oracle Field Service_instance_id >. invalid". If a domain is not available in the email address field, the
application does not create a contact. So, make sure that you have configured a valid email id in Oracle Field Service.
Security Policy as a Basic Authentication
This policy supports the existing single user-based access to Knowledge Advanced for B2C Service.

Name

Value

Description

PTA_ENABLED

Yes

Enables the use of PTA login integration.

PTA_ENCRYPTION_KEYGEN

Empty value

Specifies the keygen method used for PTA
encryption.

PTA_ENCRYPTION_METHOD

Empty value

Specifies the encryption method you want to
use.

PTA_ENCRYPTION_PADDING

Empty value

Specifies the padding method used for PTA
encryption.

PTA_IGNORE_CONTACT_PASSWORD

No

Specifies whether contact passwords are
honored during PTA logins. If enabled, contact
passwords are ignored and users can log in
through PTA with just a username.

PTA_SECRET_KEY

Empty value

Specifies the secret key used to validate login
integration parameters when encryption is
disabled, or to decode the PTA string when
encryption is enabled.

Oracle Field Service - Knowledge Advanced for B2C Service Authentication Workflow
1. When a user initiates Knowledge Advanced for B2C Service pages from Oracle Field Service, Oracle Field
Service initiates a request to Oracle B2C Service for authentication.
2. It validates whether a user that is present in Oracle B2C Service is using the user id.
3. If a valid user id is present in Oracle B2C Service, the user is authorized to access the Knowledge Advanced for
B2C Service pages.
4. If there is no user present in Oracle B2C Service, Oracle Field Service creates a new contact in Oracle B2C
Service with User login, user last name, and email. The user login and user last name are taken from the Oracle
Field Service login details. The email is taken from restore password (if email id is defined there) and updated in
Oracle B2C Service.
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5. If there is no valid email available in Oracle Field Service, a dummy email is created in Oracle B2C Service with
the format, <Oracle Field Service_login>@<Oracle Field Service_instance_id>.invalid. Make sure that you have a
valid email id in Oracle Field Service, before you create a new request in Knowledge Advanced for B2C Service,
so that the contact in Oracle B2C Service is created with a valid email id.

Access Knowledge Advanced
You access Knowledge Advanced for B2C Service in Oracle Field Service Core Application by clicking the Knowledge tab
on the Activity details page, as shown in this screenshot:

When you click Knowledge, the Knowledge Advanced for B2C Service page displays the knowledge articles relevant to
the activity from which you accessed them.
These articles are a result of the context search that is based on the activity-related search parameters and filters
configured on the Oracle Knowledge configuration page. The search field located on the top of the page displays the
search query that was used for the current search, based on the configuration settings. You can enter a new query or
change the filter parameters to refine the search.
If you have not searched for anything so far, the page displays an empty search field without any search results.
Related Topics
• About the Integration
• Configure Access Settings
• Enable Access

Enable Access
After you configure Knowledge Advanced for B2C Service in Oracle Field Service Core Application, create the
Knowledge tab on the Activity details page to provide access to the feature in Oracle Field Service Core Application.
1. In Oracle Field Service Core Application, go to Configuration > User Types .
2. Select a user type, and then select the Screen configuration tab.
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3. Do these to add the Knowledge tab to Oracle Field Service Core Application:
a. In the Application screens section, click Add activity/Activity details.
b. In the Layout structure pane, first click Activity status, and then click Group.
c. On the Add to group window that displays, enter a name for the tab.
d. Select Predefined Tab as the type, and then select Knowledge as the tab type.
e. Click Submit.
f. On the new activity page that displays, add a new read-write visibility and click Save.
Your changes are saved and all current activities are automatically recalculated.
Related Topics
• About the Integration
• Access Knowledge Advanced
• Configure Access Settings
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Statistics
Oracle Field Service uses collected statistical data on actual activity and travel duration for calculating a resource’s
estimated time arrival for the pending activities and the delivery window. In addition, the Routing module uses the
collected statistics to assign activities to a resource in the most effective manner, according to the specified routing
parameters. Statistical parameters are calculated separately for each resource, group/bucket, and whole company. If the
data is not enough to predict the duration or travel for a resource, then the group/bucket or company values are used.
Finally, if the data is not enough at the company level, then the default values are used.

View Statistical Parameters
You can view the settings based on which Oracle Field Service collects statistical data. Be aware that if you try to adjust
the settings, it may significantly change the workload for each resource, and significantly impact the logic of gathering
statistics for the work done.
1. Click Configuration.
2. In the Subsystems and Integrations section, click Statistics.
The Statistics page appears.
Field

Description

Duration parameters
Minimum relevant duration time in

To ensure that outlier activity durations (sometimes due to non-compliance) don't adversely

minutes

affect statistical calculations, durations with values less than or more than the minutes entered

Maximum relevant duration time in

in these fields will be ignored by the statistics engine.

minutes

Lower limit for personal ratio to

The lower and upper limit percentages are with respect to the company level duration for an

calculate duration (%)

activity. If the duration estimated for a resource’s assigned activity is beyond the lower or upper
limit, the estimate is corrected so that it lies within the set limits. The Lower limit default value

Upper limit for personal ratio to

is 50 with an available range from 0-100. The Upper limit default value is 200 with an available

calculate duration (%)

range from 100-999. If the preference is always to use the personal learned duration without
any lower or upper limits applied, the ranges must be set for the outer extremes with the lower
limit set to 0 and the upper limit set to 999.
Example: Suppose the company-level estimation for an activity is 50 minutes and the
lower limit percentage is set to 80%. If the estimation for a resource is 30 minutes, the final
estimation for the activity will be calculated as the maximum of 30 minutes and 80% of 50
minutes, which will be 40 minutes. The lower limit would be in effect and 40 minutes would be
assigned to the activity.

Travel time parameters
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Field

Description

Default travel average time

The average value and standard deviation (in minutes) used for travel time prediction when
there isn't statistical data for travel between two specific travel statistics keys.

Minimum relevant travel time in

In an effort to ensure that outlier travel durations (sometimes due to non-compliance) will

minutes

not adversely affect statistical calculations, durations with values less than or more than the

Maximum relevant travel time in

minutes entered in these fields will be ignored by the statistics engine.

minutes

Airline distance method weight

This parameter defines the weighting proportion between the statistic (average travel time) and
coordinate methods (straight line/airline) of calculating/predicting travel time between two
locations. The options are as follows:

◦
◦
◦
◦
◦

0 = Use only travel key based estimation
0.001 = Prefer travel key based estimation
0.5 = Use both estimations evenly
0.999 = Prefer Airline distance method based estimation
1 = Use only Airline distance method based estimation

Calculate airline distance based travel

If this check box is selected, travel key parameters are used to calculate the airline distance

at key level

based travel estimation. The application behaves as before if this check box is deselected.

Default airline distance speed in km/h

The speed used to determine airline (straight line) distance time.

Default departure/parking time in

The amount of time that is allowed for parking and departure from one activity to another.

minutes
Delivery Window Parameters
Delivery window factor

Determines how much deviation should affect the calculation of future delivery windows based
on their ETAs.

Delivery window granularity

This defines the number of minutes to which delivery window values will be rounded.

Delivery window minimal size

When delivery window is calculated, this is the smallest value (in minutes) that will be provided.

Delivery window maximal size

When delivery window is calculated, this is the largest value (in minutes) that will be provided.

Delivery window should not start earlier Prevents the delivery window from starting outside the previously agreed service window.
than [ ] minutes prior to start of service

When the option is enabled, the statistically calculated delivery window cannot start earlier than

or SLA window

the specified number of minutes before the service window or SLA window start.

Stats Fields
Activity duration stats fields

This group represents the formation of the keys (made up of fields) used for the grouping of

Activity travel stats fields

work duration and travel duration values to find the averages.
The user-defined activity keys make it possible to sort the collected statistical data according to

Resource travel stats fields

various activity characteristics, such as work order type, activity properties, activity postcode,
etc.

220

Oracle Field Service

Chapter 6

Administering Oracle Field Service

Field

Configure the Subsystems

Description

Note: You can specify durations for specific activities and technicians through APIs. For more information,
see the REST API for Oracle Field Service guide.

Related Topics
• How Activity Duration Is Calculated
• Pre-Calculated Travel Statistics

Update Travel Statistics
Travel statistics are updated when the not-assigned activities with default travel time are assigned to a resource. Oracle
Spatial and Graph Route Server, which sends the travel time, updates the travel statistics in real-time.
1. Open Configuration > Statistics.
The Statistics page appears.
2. Set up the Default Travel Time and Minimal Statistical Travel Time to ensure there is no statistical
information for the travel time between these activities.
The setup time is applied to the activities of the bucket.
3. To assign the activities in the bucket to a resource, select the appropriate activities and click Move.
The travel time value is received from street level route service and set up as per this value.

Create a Collaboration Group or Help Desk
You can communicate with other users in your organization and organize help desk activities using Oracle Field Service
Collaboration. You can use the chat window to access data from the application, instead of using the Core Application
interface. For example, you can share details about a resource, an activity, or an inventory item, or you can move
activities and inventory. Oracle Field Service Collaboration is visible only if it is configured. This procedure describes how
to create a group or help desk.
The Collaboration page shows settings that affect the way the user interface appears to the end user. While you may
retain the default settings for most of these settings, you can change a few settings during implementation based on
your business needs. Access to the Collaboration page is controlled by the Collaboration visibility profile permission.
You must set this permission for each user type that manages Collaboration. If you don’t configure the permission
or define the visibility for a user type, users of this user type cannot access Collaboration. If you select ReadOnly,
Collaboration is placed into a view only mode. If you select Read/Write for this setting, users can manage Collaboration.
To create a group or help desk:
1. Click Configuration.
2. In the Subsystems section, click Collaboration.
The Collaboration page appears.
3. Click the + icon.
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The New group page appears.
4. Fill up these fields:
Field

Description

Name

Name of the group or help desk you are creating.

Type

Type of group you are creating—options are group and help desk.

Active

Specifies whether the group or help desk is active.

Description

A description for the group or help desk.

5. If applicable, click the pencil icon in the Groups to collaborate with section to select the groups that the newly
created group can collaborate with.
The Select Groups dialog box appears.
6. Select the required groups and click OK.
7. If applicable, click the pencil icon in the Assisting Helpdesks section to select the help desks the newly created
group can be assisted by.
8. Select the help desks and click OK.
9. Click Save.

Edit or Delete a Group or Help Desk
You can communicate with other users in your organization and organize help desk activities using Oracle Field Service
Collaboration. You can use the chat window of Oracle Field Service Collaboration to access data from the application,
instead of using the Core Application interface. For example, you can share details about a resource, activity, or
inventory item, or you can move activities and inventory. This procedure describes how to edit an existing group or help
desk.
1. Click Configuration.
2. In the Subsystems And Integrations section, click Collaboration.
The Collaboration page appears.
3. Select an existing group or help desk.
4. To delete, click Delete.
5. If applicable, click the pencil icon in the Groups to collaborate with section to select the groups that the newly
created group can collaborate with.
The Select Groups window appears.
6. Select the required groups and click OK.
7. If applicable, click the pencil icon in the Assisting Helpdesks section to select the help desks the newly created
group can be assisted by.
8. Select the help desks and click OK.
9. Click Save.
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Message Scenarios
A Message Scenario consists of one or more scenario steps, which determine the message content, recipients, delivery
channels, and business rules. While each Message Scenario has at least one start step, you can configure multiple inner
steps to run different actions based on the results of the preceding steps. The intent is to ensure that the right people or
systems receive the expected notifications, while considering all potential circumstances.
When you want to use Message Scenarios for time-based notifications (for example, notifications to customers) the
recommendation is to use Reminders, Alerts, or Visit selections in the Launch Conditions. For other Launch Conditions
(for example, Route, Activity, Inventory, and Service Requests) the recommendation is to use the Core API/Events REST
API for integration with Oracle Field Service.
Note: Because the messages go to your customers, you must test them carefully and thoroughly to ensure that the
launch conditions, scenarios, steps, and channels are set up correctly. For more information about Launch conditions
warnings and notes, Scenario Steps elements, Channel errors, Supported variables within the body of the message,
refer to Oracle Field Service Message Scenario Configuration Guide.

Create a Message Scenario
A message scenario is a set of rules that specify how to process a message to an external application, or to customers
when a launch condition occurs. A launch condition is triggered by a predefined event, for example, when a reminder
notification must be sent to a customer 60 minutes prior to a resource’s estimated arrival time.
1. Click Configuration.
2. Click Message Scenarios in the Subsystems And Integrations section.
The Message Scenarios page displays.
3. Click the Plus icon in the left pane.
The Add Message Scenario dialog box displays.
4. Enter Route Not Activated in the Name field.
5. Select a date from the Active From field.
6. Click OK.
The Route Not Activated message scenario displays on the left pane.

Define the Settings for a Scenario Step
The Settings tab enables you to define the general settings for a message step which includes these settings:
• Step Info section: Define the type of the message step, intended recipient, and the delivery method.
• Notification Time section: Define when to send the message (for example, day of event or for how many days)
and the time interval when the messages are sent.
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Step Info section
Name

Enter the name of the step that displays in the Scenario steps section.

Type

Select the type of step, Start or Inner. Start steps are the first steps that occur when a scenario is
initiated. An inner step is run after a preceding step is completed.

Delivery Channel

Select the message agent for delivering the message. Options: Email, Set Property, user-defined
channel, Collaboration.
Note: If you select collaboration as the delivery channel, see Use Collaboration as a Delivery
Channel

Recipient

The options available varies based on the selected delivery channel (Email, Set Property, user-defined
channel, or Collaboration).
Select the intended recipient (Customer, Resource, Dispatcher, or use static address) of the message.
By default, the recipient address is fetched from the activity or resource fields for the options,
Customer, Resource, or Dispatcher.
However, if you select Use static address, then you must enter a static recipient address in the format,
notify@etadirect.com.

Recipients (Add new)

You can control the delivery of a message to a helpdesk group or to helpdesk operators based on this
setting. This option is visible only if you select Use static address in the Recipient field.
Click Add new and select the email address of a helpdesk. These options are displayed:
• Deliver to helpdesk: The message is broadcast to the helpdesk; it is available in the helpdesk as
a system message. Any operator in the helpdesk can take this chat and it will be moved to the
operator's active chat list where they can take action. Other operators will not see the message
in the helpdesk queue, but they can view this message from the chats in progress menu to know
who is working on this message.
• Deliver to helpdesk operators: The message is delivered to all the operators within the helpdesk.

These drop-down lists display based on your selections in the Recipient and Delivery Channel drop-down lists.
Customer Notification Time

Select the time for notifying customers. For example, ETA, Service window, or Delivery window.

Reply Address

Enter the e-mail address (for example, notify@etadirect.com) for sending notifications when you select
Email as the Delivery channel and Customer, Dispatcher, or Resource as the Recipient.

Time Zone and Language

Select the time zone and language for the email content when you select Email as the Delivery channel
and use static address as the Recipient.

Static address

Enter the email address or distribution group to which you want to send emails when you select Email
as the Delivery channel and use static address as the Recipient.

Email address source

Refers to the resource property that contains e-mail information when Dispatcher or Resource is
selected as a recipient or refers to the user-defined property that contains e-mail information when
Customer is selected as a recipient.

Notification time section
Sending time

Select one of following options:
• Day of event
• Time of event
• Day of route
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For example, if you select Day of event, select +, and enter 2 in the Days field, then the messages are
sent after two days from the Day of event.

from

Select the starting time for the messages.
For example, if you select 8 AM from the drop-down list, then the messages are sent from 8 AM.
Available when either Day of event or Day of route is selected in the Sending time field.

Sending will time out in

Specify the interval in hours and minutes. The messages are sent during the specified interval.

Number of Attempts On ‘failed’ status

Indicates the maximum number of resend attempts. For example, if you enter 3 in the Interval field and
10 in the Minutes field, then the message is resent for 3 times after every 10 minutes.

Number of Attempts On ‘sent’ status

Available only for External Systems.
Indicates the maximum number of attempts to resend the notification status received.
For example, if you enter 3 in the Interval field and 10 in the Minutes field, then the notification status is
resent for 3 times after every 10 minutes.

Sending delay

Specify the time in minutes if you want some time to elapse after an event.

Block messages for specific days

Select the days for which you don't want to send messages.

Block messages for holidays

Select the option, if you don't want to send messages during holidays. You must set up holidays using
Configuration, Holidays.

Blocked messages sending

Indicates the number of days before the holiday. For example, if you select 2, then the messages are
stopped before two days.

For our example, enter these details:
1. Click Add New in the Scenario steps section.
The Add scenario step dialog box displays.
2.
3.
4.
5.
6.
7.
8.
9.

Enter Start test in the Name field.
Select Start from the Type drop-down list.
Select Email from the Delivery Channel drop-down list.
Select day of event and + from the Sending time drop-down list.
Enter 2 in the days field.
Enter 5 in the hours field and 30 in the minutes field in the Sending will time out in field.
Select Service Window from the Customer notification time drop-down list.
Click Add.
The Start test message step displays in the Scenario steps section. The Scenario steps section also displays
other details such as sending time, the number of messages that are being sent today, and a graph of the
progress. The graph and the queue details are hidden if the screen size is not enough to display the details.

Related Topics
• Send Notification Messages
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Define the Message Content
The Patterns tab defines the content of the message that you want to send to your customers or systems. You can use
variables within the body of the message to substitute the property value within the content of the message.
Based on the delivery channel, the template for the message differs as follows:
• If the selected Delivery Channel is Email or External System, then the template for the message is defined
using the Subject and Body fields.
• If the selected Delivery Channel is Set Property, then the template for the message is defined using the
property field and property value.
For example, assume that Cancellation Reason property is associated with the entity, Activity. When a customer cancels
an activity, you need to set the Cancellation Reason property field for the activity to the value, 14. Using the Set Property
delivery channel, you can use the Cancellation Reason property in the Subject field and define the required value in the
Body field. So when the step is run, the application changes the value in the Cancellation Reason property to 14.
Also, you can determine when you want to generate the content of the message using the Generate content on
message creation or Generate content on message sending options. Although the message is created when the
message step is run, the property values may change after 40 minutes. Hence, select the Generate content on
message sending option so that you receive the latest changes. For example, if you want to display the customer
address in the content of the message, enter the label name of the property field using { }. For example, {caddress}.
1.
2.
3.
4.
5.

Select the Start test message step from the Scenario steps section.
Select the Patterns tab.
Enter test start in the Subject field.
Enter start test activity started at {caddress} in the Body field.
Select Generate content on message sending option and click Update.

Define Conditions
The Next Steps tab identifies the relation between different steps of a scenario and defines the conditions to run the
subsequent steps.
For example, assume that the start step (that is, the start test activity) fails due to some reason and you want to inform
a resource in the Helpdesk department that the activity has failed. To handle the above condition, you must create an
inner step and define the message that you want to send to the Helpdesk department.
Note: By default, the Next Step drop-down list in the Start test, Next Steps tab is empty. Since the inner step
handles a specific condition when the Start Step fails, it is required to create an inner step and link the Start step with
the Inner step.
To create an inner step, follow the steps in the Define the settings for a scenario step using the Settings tab section, but
modify these settings:
• Enter test inner in the Name field, select Inner, Resource, and Email from the Type, Recipient, and Delivery
Channel drop-down lists.
• Enter the email address of the Helpdesk department in the Reply address field.
• Select the Patterns tab and enter the message that you want to send in the Subject and Body fields.
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For our example, let us configure the Start step so that when the Start step fails, the inner step (that is, test inner) runs
and sends the failure message to the Helpdesk department.
1.
2.
3.
4.
5.
6.

Select the Start test message step from the Scenario steps section.
Select the Next Steps tab.
Select Failed from the Status drop-down list.
Select the check box and enter the required description.
Select test inner from the Next Step drop-down list.
Click Add.
The configured condition displays in the list.

7. Click Update.
The test inner step is updated with the latest settings.

Block Message Steps
The Conditions tab enables you to define conditions to block the messages in a step. The application checks for any
blocking conditions, and if the conditions are met, then the messages in the step are not processed.
Assume a scenario where you want to block the messages that are sent to the customer if the customer cancels an
activity. To handle the above scenario, define a condition to verify whether the value in the Activity Status field is
Cancelled as follows:
1. Select the Start test message step from the Scenario steps section.
2. Select the Conditions tab.
3. Select Activity Status from the Field drop-down list.
4. Select In from the Condition drop-down list.
5. Enter Cancelled in the Value field.
6. Select Failed from the Result drop-down list.
7. Enter activity is cancelled in the Description field.
8. Select Check on message sending option.
9. Click Add.
The configured condition displays in the list. If an activity is cancelled, then the customer receives a notification
that is configured in the Conditions tab, that is, “failed, activity is cancelled.”

Add Launch Conditions
Launch conditions are trigger events that invoke message scenarios and scenario steps to deliver configured messages
to client systems.
Assume that you want to invoke the message scenario that you have created, that is, Route Not Activated when a
resource’s route is not activated. Therefore, you need to add a launch condition to invoke the scenario as follows:
1. Click Configuration > Message Scenarios .
2. Click Add New in the Launch Conditions section.
3. Select Route is not Activated from the The scenario will be launched when drop-down list.
4. Enter the number of minutes in the minutes after shift starts according to calendar field.
5. Click OK.

227

Oracle Field Service

Administering Oracle Field Service

Chapter 6

Configure the Subsystems

The launch condition displays in the Launch Conditions section of the Message Scenarios page. For each
launch condition of the scenario, the Launch Conditions section also displays the number of messages that are
in the queue. If the number of messages is greater than 999, then the numbers are displayed as follows:
◦ Range 1000-999999 - "k". For example, 1000 messages are displayed as "1k"; 10000 messages are
displayed as "10k".
◦ Range 1000000 and greater - "m". For example, 1000000 messages are displayed as "1m"; 123000000
messages are displayed as "123m"
Note: When the user selects a message scenario in the routing plan as a Fallback option, a read-only launch
condition, Routing fallback is automatically populated in the message scenario. When the user removes
the message scenarios from all associated routing plans, the launch condition is removed from the message
scenario. The launch condition has a count of routing plans to which it is associated. You can click the count
of routing plans in the launch condition UI to view the routing plans.

Send Notification Messages
Channels define a mechanism to communicate notification triggers to external systems. The Email agent is used for
sending messages when the Email delivery channel is selected.
However, if you want to send messages to an external system (for example, client system), then you must define
the details of the client system (such as Host, Port number, URL, Connection method, and so on) using the Delivery
Channels page. For example, let us create a delivery channel, external sys 1 as follows:
1. Click Channels.
The Delivery Channels page displays.
2. Click the Plus icon on the left pane.
3. Enter external sys 1 in the Name field.
4. Select the required option from the Status drop-down list.
Note: If notification scenarios contain at least one message step that uses an internal delivery channel (email or voice) then that channel is accessible in the list of channels. A user with appropriate permissions
can select Active or Inactive to resume or stop the message delivery for any external or internal channel.
For example, you can block a channel using the Inactive option in Test instances to disallow test messages
to reach real customers. Messages that are not delivered due to inactivated delivery channel get the status
'obsolete' with the description, EXTERNAL_NOTIFICATION_ARE_DISABLED. Note that the 'set property'
messages don't have a delivery channel and cannot be handled this way.
5. Enter agent.com in the Host field and 8080 in the Port number field.
Note: Enter one of these values (20, 21, 22, 25, 80, 290, 389, 443, 587, 873, 2401, 3668, 4011, 4142, 5308, 5666,
5900, 5901, 6666, 6460, 7800, 8080 8443, 14861 and 20106) in the Port field.
6. Enter the URL Path of the server (optional).
7. Enter the name and password of the user for authorization purpose.
8. Select the Allow basic access authentication check box if you want to implement HTTP basic authentication
while integrating with external systems.
When you select the check box, the outbound methods (such as send_message, drop_message,
get_message_status methods) send the standard HTTP header "Authorization" with base64-encoded user
credentials (standard basic access authentication). Also, the <user> SOAP structure is sent in the body of the
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request. The client application can either use the standard HTTP header "Authorization" or the <user> SOAP
structure to send user credentials in the request.
Note: When the check box is not selected, the standard HTTP header is not used in the request and the
client application can use the <user> SOAP structure for authentication. For more information, see the
Integrating with Outbound API Guide.
9. Select a connection from the Connection drop-down list to denote the encryption protocol type.
Note: By default, Not Encrypted option is selected. If you select default encryption or any other encryption
type, then complete the necessary fields in the Advanced Settings section.
10. Click Add.
The channel displays in the Delivery Channel drop-down list in the Add scenario step and Modify scenario
step dialog boxes. The delivery channel, external sys 1 also displays on the left pane on the Delivery Channels
page. The channel details are displayed in:
◦ Green if there are no warnings and the channel is active

◦
◦

Gray if there are no warnings and channel is inactive
Red if there are warnings, or count of message scenarios is greater than 0 and the channel is inactive

Active and Inactive are also displayed on active and inactive channels respectively.

Use Collaboration as a Delivery Channel
You can use collaboration as a delivery channel to send alerts of different types of events or situations in Oracle Field
Service to collaboration users (for example, technicians, help desk operators, and resources). Also, you can broadcast
notifications or alerts to collaboration user groups or help desk groups on occurrence of an event or when a predefined
condition is met in Oracle Field Service.
• Subscribe to Collaboration to view the Collaboration option as a delivery channel in the message scenario. View
the About page in your instance to verify whether the service is enabled.
• Create collaboration users, user groups, or help desk groups.
Note: For more information on configuration settings, see the Configuring Collaboration section in the
Oracle Field Service Collaboration Service Guide.
For example, assume that you want to notify the resource using collaboration as a delivery channel when a activity is
created in Oracle Field Service. Assume that the message scenario, new appt is associated with the Activity is Created
launch condition and has a scenario step, Collab Alert.
1.
2.
3.
4.
5.

Log in to Oracle Field Service as a Administrator.
Click Configuration, Message Scenarios.
Select the Collab Alert scenario step.
Select Collaboration from the Delivery Channel drop-down list in the Settings tab.
Select one of these options from the Recipient drop-down list:
◦ Resource: Delivers message to the resource associated with the launch condition. By default, Oracle
Field Service considers the language and time zone of the user associated with the resource. If the
collaboration permission is not configured for the resource, then the message scenario displays a False
Method status in the Messages tab of the Activity Details page for the scenario step.
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◦

use static address: Enables you to send the message to specific users, user groups, and helpdesks. Click
Add New and search for the required users, user groups, and helpdesks. Select the required users, user
groups, and helpdesks to add them to the Recipients section. You must enter at least three letters in the
Search field to search for the required users, user groups, and helpdesks.
6. Enter the message content in the Subject and Body fields of the Patterns tab.
The default language of the company is configured from the My Display, Language drop-down list and is
selected as the language for the message content. To add more languages, see Configure the Display Page. For
example, if English is configured as the default language and if the Subject and Body fields in the Patterns tab
are populated is English, then regardless of the user’s language, the message is sent to the recipient in English.
However, you can use the Pattern tab to specify another language for the message content. You can specify
any one of the languages selected from the My Display setting as the language for the message content. For
example, if English is configured as the default language and the Subject and Body fields in the Patterns
tab is populated is Spanish, then the message is sent to the recipient user in Spanish. However, be aware
that the placeholders are not translated; they are always in English. For example if there is a placeholder
{activity_status}, it will not be translated; it will be in English.
If the default language is not configured then English is considered as the default language of the recipient and
the message is sent to the recipient in English.
7. Configure the required fields and click Save.
The details such as sending time and the selected delivery channel are updated for the Scenario step.
Assume that a new activity is assigned to the resource, Phillip. The message scenario is triggered and the Collab Alert
scenario step is displayed with the New status in the Messages tab of the Activity Details page.
When the message alert is sent to the resource, the status in the Messages tab of the Activity Details page changes to
Sent.
Note: If the scenario step is not configured properly or if the message alert is not sent to the resource, the status in
the Messages tab of the Activity Details page changes to Failed. However, if a message is invalidated because of an
activity-related operation in Oracle Field Service (such as delete, move, suspend activity), the status in the Messages
tab of the Activity Details page changes to Obsolete.
To view the message alert, log in to Oracle Field Service using resource’s login credentials.
For more information, see the About Collaboration Window section in the Oracle Field Service Collaboration Service
Guide.
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Daily Extract
Daily Extract is used to report on the main Oracle Field Service entities, such as activities, inventory, and messages, for
storage and further analysis. Extracted data is stored in the Daily Extract Database as a package of XML files. You can
create or update a Daily Extract configuration by importing the configuration from an external source.
Configure Daily Extract
You can configure the set of files to be extracted by Daily Extract at the implementation stage. At a later stage, you can
also modify them when necessary. In addition, you can also configure custom Daily Extract file sets in the Manage
Application page. Access to the Daily Extract configuration functionality is controlled by adding a read-write visibility to
the User Type that requires access to the Daily Extract report.

Daily Extraction Files
Daily Extract files are the result of data processing by the application and contain the details such as activities,
inventory, and messages. As part of the Daily Extract, you can receive only the data structures that are described in this
document. To get access to other data elements of the application, you must use different interfaces such as, the REST
API. The extracted files are intended for reporting and historical analysis of the events in the application.
Extraction Period
Daily Extract files are typically generated once a day and contain all data the processing of which has been finished
since the previous extraction. If the company does not support overnight shifts, the extraction period covers time since
the previous extraction and till the end of the previous day. If the company supports overnight shifts, the daily extract
data for the previous day are available for extraction after the overnight expiration, that is, at 00:00 AM + overnight. If
the data is extracted before that time, the resulting files contain data of two days before.
A company can operate in several time zones, however, the Daily Extract functionality extracts data according to the
time zone defined for the company in Business Rules. Only these files are extracted in GMT:
• General Message Details
• Message Text Details
• PAS Answer Details
• Gpstracks Details
Upon the first extraction all available data is collected. The maximum Daily Extract archive file size supported is:
• For archive with .xml files - 5 GB
• For archive with property files - 5 GB
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Create Daily Extract Files
You use the Daily Extract files to extract data from Oracle Field Service to store, analyze, and report on events. You can
extract data related to activities, inventory, and messages. The Daily Extract function can only receive data structures
that are described in this document. To get access to other data elements of the application, you must use different
interfaces such as, the REST API. You can use the extracted files for reporting and historical analysis of the events in the
application. You can configure the files to be extracted by the Daily Extract report manually at the time of implementing
the application. The daily extract files are always created in XML format.
1.
2.
3.
4.

Log in to Oracle Field Service Manage interface.
Select the Navigation button.
Click Configuration.
In the Outbound Integration section, click Daily Extract.

The Daily Extract page appears. The page displays the list of files for extraction organized as a grid. For each
file name the list shows the entity to which the extraction file is related (the Entity column) and the fields
exported in the file (the Exported field column).
5. Click Add new.
The Add configuration file dialog box appears.
6. Enter the Table Name.
The table name must be in the {COMPANY_NAME}-company identifier format. The place holder
{COMPANY_NAME} is mandatory. If you specify an incorrect format, the file is not created.
7. Select the fields that you want to export from the Entity drop-down list.
8. Click Submit.
The new file configuration is saved. When you edit the configuration, you can only edit the file name and not
the entity.

Choose Daily Extract Fields to Export
A new daily extract file is created empty and for the export to work, you must specify a minimum of two fields.
1. Click Configuration.
2. In the Outbound Integration section, click Daily Extract.
The Daily Extract page appears.
3. Click the stack menu to the right and click Fields to add fields to the entity.
4. Click the plus icon and select the required field that you want to add to the entity.
5. Select a field to view its properties. Change the Name if required.
You can arrange the list of properties by dragging and dropping. You cannot change property names for the
GPS Track Fields, Type List Fields and Property File Fields entities. If a custom property is deleted from the
application, you must also delete it from the field list of any daily extract files; otherwise the extraction returns
an error.
6. Click OK.

Extraction Files and Extraction Data Sets
Data of different entities processed during the extraction period or available by the end of extraction period can be
collected and extracted in the files. (In this document, 'during the extraction period' means that if at any time during
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the extraction period the entity was available in the application. Such entity is extracted. 'By the end of extraction
period' means that if an entity was created at some time during the extraction period and was deleted before the end of
extraction period. Such entities are not extracted).
This data can be divided into data sets, that is, groups of details related to one and the same entity in the application. In
some cases, data related to one entity is divided into several different data sets.
Note: Data from several data sets cannot be extracted in one file but data from one data set can be divided to be
extracted in any number of files. For example, the file created for the Activity Fields entity cannot also include data for
the Resource Fields entity. At the same time, one file can refer to several database tables according to the exported
field’s configuration. For example, an Activity Fields file may include data from the queue table, when configured so.

These data sets are available for export. The actual list of data sets to be exported can be configured according to your
company preferences.
• Activity Fields – Data on all fields and properties assigned to activities that were to be performed or were
performed.
• Activity Link Fields – Details of all links between activities defined in the application.
• Activity Work Skill Fields – Details of work skills per activity.
• GPS Details – Details of all GPS data gathered.
• Inventory Fields – Data on all fields and properties assigned to all inventory items available in the application.
• Message Details – Data on all messages generated during the extraction period divided into two data sets:
◦ Message Fields – Details on the messages excluding the actual text of the message.

◦

Message Text Fields – The text of each specific message.

• Property Fields – Details of all fields and custom properties available in the application.
• Property File Fields – Contents of file properties (such as images) available in the application.
• Property Lookup Fields – Sets of values that can be used to identify a field or custom property for all fields, and
custom properties available in the application.
• Queue Fields – Data on all fields and properties assigned to routes that were to be processed during the
extraction period, including all fields and properties assigned to resources, to which a route is directly assigned.
• Resource Fields – Details of the properties of all resources available in the application (including inactive
resources) and their position in the Resource Tree.
• Resource Location Fields – Details of locations defined for each resource in the application.
• Resource Property Fields – Details of all properties defined for each resource in the application.
• Resource Work Skill Fields – Details of work skills per resource.
• Service Request Fields – Details of service requests created in the application.
• Time Slots Fields – Details of time slots defined in the application.
• Type List Fields – Sets of values used to identify the type of entity by its ID for all types available in the
application.
• User List Fields – Details of all users existing in the application.
• User-Resource Relation Fields – Details of the resources visible to each user as defined in the application.
Note: Daily Extract processes property labels regardless of whether any special symbols or capital letters are used.
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Configure a DBaaS Integration
You can use the Applications page to create a channel for DBaaS to transfer data in near real time to a DBaaS instance.
The data is transferred to the DBaaS instance when the events corresponding to the entities are triggered in Oracle Field
Service. Oracle Rest Data Service (ORDS) is used to standardize the data flow between Oracle Field Service and DBaaS.
1. Click Configuration, Applications.
2. In the Applications page, click Add Application to configure a new channel.
The Add Application dialog box displays.
3. Select Database as a Service Access from the Application Type drop-down list and fill up these fields:
a. Application Name: Enter a name for the channel.
b. Host: Enter the host name for ORDS. It can be an IP address or a domain name, and must start with
https.
c. Schema Alias: Enter the schema alias configured for the target schema, which is used for generating the
ORDS end point. The value is same as the parameter p_object_alias in ORDS.enable_object. For PDBs,
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add the PDB name (<PDB_Name>/<object_alias> ) <host_name>/ords/<schemaAlias>. For example,
PDB1/pdbadmin (For PDB).
d. User Name: Name of the user used for basic authentication. Make sure that the user has two roles, "SQL
Loader" and "oracle.dbtools.autorest.any.schema".
e. Password: Enter the password of the user used for basic authentication.
f. Confirm Password: Re-enter the password.
The dialog box now looks like this screenshot:

A new DBaaS channel is created.
4. Click the DBaaS channel and click Add New to create an entity.
5. Specify the required details in these fields:
a. Entity: Select a list of Oracle Field Service fields that you want to view in the DBaaS instance.
b. Table Name: Enter the table name that you want to create in the DBaaS instance.
c. Data Transfer: Select one of these options:
- Once Daily: Data is transferred to the DBaaS instance once in a day as per the daily extraction
period configured in the system.
- Real-time: Data transfer from Oracle Field Service to DBaaS occurs in near real time.
6. Click Submit.
The entity is added to the channel with the specified details.
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Modify an Existing DBaaS Integration
DBaaS connectivity is now available only through Oracle Rest Data Service (ORDS), so all new integrations connect
through ORDS. However, if you have an existing DBaaS integration, the application displays a note in the DBaaS
connection widget and on the Modify Channel page to change the configuration settings. Use this topic to understand
how to modify your existing integration to implement ORDS connection details.
1. Click Configuration, Applications.
2. In the Applications page, click the properties icon for the DBaaS channel that you want to modify and click
Modify.
The Modify Channel page displays, with a note at the Connection Method field, as shown in this screenshot:
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3. Edit these fields:
Field Name

Description

Application Type

The type of the channel you are modifying. The application populates this field and it cannot be
edited.

Application Name

The name of the DBaaS connection.

Connection Method

The connection method with which you want to connect to the database. Select Oracle Rest
Data Services.

Host

The host name for ORDS, which can be an IP address or a domain name. The host name must
start with https.

Schema Alias

The schema alias configured for the target schema, which is used for generating the ORDS end
point. The value is same as the parameter p_object_alias in ORDS.enable_object. For PDBs,
add the PDB name (<PDB_Name>/<object_alias> ) <host_name>/ords/<schemaAlias>. For
example, PDB1/pdbadmin (For PDB).

User Name

The name of the user used for basic authentication. Make sure that user has two roles, "SQL
Loader" and "oracle.dbtools.autorest.any.schema".

Password

Password of the user mentioned earlier.

Confirm Password

Retype the password.

4. Click OK.
The channel details are modified to use ORDS.
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The Administrator Role
The Administrator plays an essential role in the application. The Administrator user type is assigned to an individual
or group of individuals who oversee the regular maintenance and updating of users, resources, calendars, and the
Resource Tree.
The Administrator is responsible for a combination of functions that can include:
• Managing users—Adding new users and deactivating users.
• Assigning user types to users. Resetting passwords.
• Managing the Resource Tree.
• Managing the resource calendars, shifts, and teamwork.
• Working with work zones, work skills, work conditions, and work skills groups.
The Administrator user type is unique to each company and includes any combination of the responsibilities mentioned
earlier, depending upon the visibilities assigned to the user type. As a general rule, the administrator user:
• Has read-write access to the interface.
• Can manage user and resource related information.
• Can manage own account (password).
Note: This document covers all aspects of an administrator’s role. Based on your company’s configuration and
modules purchased, some of the functionality described in this document may not apply.

As an administrator, one of your key responsibilities is to manage user information. There are two primary types of
users:
• Users who use the manage aspect, for example, dispatchers and field managers.
• Field service resources who use the mobile app, for example, field service personnel.
In either case, a user is someone who requires access to some part of the application’s interface.

Manage Users
You can set up users and maintain their accounts through the Resources page that opens from the Resources option
on the hamburger menu. Much of the information that you enter is standard, based on your company’s login and
password policies, but some are unique to the user and role they play in your configuration. This section describes onetime activities as well as periodic activities that are performed to conform to changes in the user’s role and company
policy. For example, if users persist in attempting to log in with an incorrect password, they are locked out of their
accounts. This section describes how to unlock the account and reset the password.
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Access User Details
You can access user information to view the details and modify them.
1. Click the hamburger menu and then click Resources.
The users that belong to the organization level that you have access to are displayed.
2. If you have access to multiple levels of the organization, click Change in the Org Unit/Bucket section. Search for
and select the appropriate organization level for which you want to view the users. If you want to view all users,
select the highest level of the organization.
3. In the Resource Type section, select the type of resource you want to view.
The resources that satisfy the criteria you have selected are displayed.
4. Sort the list of resources using the Status, Collaboration, and Last Login options.

Add an Organization Unit or a Bucket
Use organization units to sort and organize the items in the Resource tree. You can use buckets to hold the activities
that are not yet assigned to field resources.
Difference between resource, user, and child resource: A resource can be a field resource (a human being), a
dispatcher, an administrator, a vehicle, or a tool. All resources are elements of the Resource tree. A user is a field
resource or any other user that has access to Oracle Field Service. A child resource is a resource that is added to a bucket
or an organization unit element of the resource tree. In the hierarchy of the resource tree, the bucket or the organization
unit appears at a higher level than the child resource. A child resource can be a field resource (a human being), a vehicle,
or a tool.
Organization units are typically used to group resources by location. Organization units cannot be route owners and
you cannot assign activities to them. Buckets can have activities. However, dispatchers can assign activities to buckets
manually and Routing can assign activities to buckets automatically. To add an organization unit or a bucket:
1. Click the hamburger icon and then click Resources.
2. Click the plus icon.
3. Complete these fields:
Field name

Action

Resource Type

Select Group or Bucket. The fields on the page change based on the option you select.

Name

Enter the name of the organization unit or bucket the way you want it to appear in the resource
tree.

External ID

Enter a unique ID for the organization unit or bucket. These IDs are optional.

Org Unit/Bucket

Select the organization unit or bucket under which you want to create the organization or
bucket.

Status

Select whetner the organization unit or bucket is active or inactive. An inactive organization unit
or bucket is not listed in the resource tree.

Message Language

Select the language in which dispatchers and technicians see the error messages.
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Field name

Action

Time zone

Your (currently logged in user) time zone is populated, change it if required. This is the time
zone in which the organization is located.

Time format

Your (currently logged in user) time format is populated, change it if required. This is the time
format that your resources see and use in the interface. This can be either 12-hour or 24-hour.

Date format

Your (currently logged in user) date format is populated, change it if required. This is the date
format that your resources see and use in the interface. This can be either month-day-year or
day-month-year.
The date format controls the display of dates in numeric format.

4. Click Submit.
The new active organization unit or bucket is added to the resource tree, in the selected hierarchy.

Add a Dispatcher, a Manager, or an Administrator
You use the Add Resource page to add a dispatcher, a manager, or an administrator user. This is also the user without a
resource; in other words, this user does not perform the duties of a field resource.
1. Click the hamburger icon and then click Resources.
2. Click the plus icon.
The Add Resource page appears.
3. Complete these fields:
Field name

Action

Resource Type

Select Manager/Dispatcher/Admin. The fields on the page change based on the option you
select.

Name

Enter the resource name the way you want it to appear in the resource tree.

Org Unit/Bucket

Click the field and select the organization unit or bucket with which you want to associate the
resource. Let’s say you want to add a dispatcher who manages a bucket and the resources
under the bucket. Select the bucket to place the dispatcher so that the user can see only the
bucket and the resources under that bucket. If you want to create a manager who may see
the entire enterprise, select the parent level of the organization structure to add the manager.
The options available for you are configured by your administrator. If you don't select any
organization unit or bucket, the resource is treated as unassigned to any organization.

Status

Select whether the resource is active or inactive. Inactive resources cannot log in to the
application.

User Type

Select the user type for the resource. The permissions assigned to the selected user type
applies to this resource. In other words, the user type selected here determines the pages and
the options the resource can see.
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Field name

Action

Visible resources

Select the resources the current resource can view, from the organization structure. The
resource can see the resources belonging to the selected organization, organization unit, or
bucket.

Self assignment

If you are assigning this resource to a bucket, select this check box to determine the availability
of activities and resources for this resource. For more information, see the How SelfAssignment Works topic.

Login

Enter the user name with which the resource can log in to Oracle Field Service.

Password, Confirm Password

Enter the password that you want to set for the resource.

Force password change at next login

Select this check box, if you want the resource to change their password when they log in for
the first time.

Collaboration group

Click and select the collaboration group that you want to add the resource to.

Message Language

Select the language in which you want the resource to see the error messages.

Time zone

Your (currently logged in user) time zone is populated, change it if required. This is the time
zone that the resource sees and uses in the interface.

Time format

Your (currently logged in user) time format is populated, change it if required. This is the time
format that the resource sees and uses in the interface. This can be either 12-hour or 24-hour.

Date format

Your (currently logged in user) date format is populated, change it if required. This is the date
format that the resource sees and uses in the interface. This can be either month-day-year or
day-month-year.
The date format controls the display of dates in numeric format.

Long date format

Select the long date format that the resource views in the application. A long date is a date that
includes words. For example, Wednesday, May 6, 2020.

4. Click Submit.
The new resource is added. If you have configured the Refresh Rate (refresh_rate) field for the user, it will not be
used in Core Application.

How Self-Assignment Works
The Self-Assignment feature influences the availability of activities and resources for a user who is assigned to a
bucket. By default, Self-Assignment is disabled. This setting is mostly used by dispatchers, who allocate activities to
resources and usually do not perform any activities.
If a user is assigned to a bucket and Self-Assignment is cleared:
• All child resources of the bucket are available to the user.
• All activities in the bucket are available to the user (regardless of their work zones and work skills).
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• The user can move all activities between all available resources (for example, from the bucket to any of the
assigned resources, between resources, from a resource back to a bucket).
• Self-Assignment must be selected, if a technician is granted permission to assign tasks. (For example, the user
is a crew chief, assigning activities to members of the crew, or a single technician allowed to choose activities to
perform.)
If a user is assigned to a bucket and Self-Assignment is selected:
• Only the resources explicitly assigned to the user are available to such a user (for example, the bucket, the user
themselves and members of the crew). No other child resources of the bucket are available to the user.
• Only those activities in the bucket that can be performed by at least one of available resources (subject to the
work zone and work skill requirements) are available to the user.
• The user can move only the available activities and only between the available resources.

Add a Field Resource
You must add a field resource, before you can assign activities to them.
1. Click the hamburger icon and then click Resources.
2. Click the plus icon.
The Add Resource page appears.
3. Complete these fields:
Field name

Action

Resource Type

Select Technician. The fields on the page change based on the option you select.

Initial Ratio for Activity Duration

Select the default ratio that is used for the resource, if there isn’t enough historical data for
the resource for a particular type of activity. For such activities, the estimated duration of the
technician is the value of the Initial ratio * company wide estimation (provided “Personalize the
estimation of activity duration” is selected). After the technician completes at least one activity,
the default ratio shows for the technician based on the reported duration.

Type

Select whether the resource is an in-house resource, or a contractor.

Name

Enter the resource name the way you want it to appear in the resource tree.

External ID

Enter the ID number from an external system, such as the employee ID number. These IDs are
optional. If you use them, each resource must have a unique ID.

Org Unit/Bucket

Click the field and select the organization unit or bucket with which you want to associate the
resource. The options available for you are configured by your administrator. If you don't select
any organization unit or bucket, the resource is treated as unassigned to any organization.

Status

Select whether the resource is active or inactive. Inactive resources cannot log in to the
application.

Personal Info

Enter the personal information of the resource.
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Field name

Action

User Type

Select the user type for the resource. The permissions assigned to the selected user type
applies to this resource. In other words, the user type selected here determines the pages and
the options the resource can see.

Visible resources

When you create a Field Resource, the Visible Resources field is prepopulated with the current
resource's name. So, it means that technicians can see themselves. Select more resources the
current resource can view, from the organization structure. The resource can see the resources
belonging to the selected organization, organization unit, or bucket.

Self assignment

If you are assigning this resource to a bucket, select this check box to determine the availability
of activities and resources for this resource. For more information, see the How SelfAssignment Works topic.

Login

Enter the user name with which the resource can log in to Oracle Field Service.

Password, Confirm Password

Enter the password that you want to set for the resource.

Force password change at next login

Select this check box, if you want the resource to change their password when they log in for
the first time.

Collaboration group

Click and select the collaboration group that you want to add the resource to.

Message Language

Select the language in which the resource sees the error messages.

Time zone

Your (currently logged in user) time zone is populated, change it if required. This is the time
zone that the resource sees and uses in the interface.

Time format

Your (currently logged in user) time format is populated, change it if required. This is the time
format that the resource sees and uses in the interface. This can be either 12-hour or 24-hour.

Date format

Your (currently logged in user) date format is populated, change it if required. This is the date
format that the resource sees and uses in the interface. This can be either month-day-year or
day-month-year.
The date format controls the display of dates in numeric format.

Long date format

Select the long date format that the resource views in the application. A long date is a date that
includes words. For example, Wednesday, May 6, 2020.

4. Click Submit.
The new resource is added.

Change the Resource Type of a Field Resource
Sometimes, you may have to change a field resource to a dispatcher or manager. When you do this, the resource
becomes inactive and a user is created.
1. Click the hamburger icon and then click Resources.
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2. Type the resource name for which you want to change the Resource Type in the Search field.
The matching results appear.
3. Click the required resource name.
The Resource Info page appears, with all the details of the resource.
4. Click the stack icon and then click Edit.
The Edit Resource page appears.
5. In the Resource Type field, select Manager/Dispatcher/Admin.
6. Click Submit.
The resource becomes inactive, and a user is created.

Change the Resource Type of a Manager, a Dispatcher, or an
Administrator
Sometimes, you may have to change a Manager, a Dispatcher, or an Administrator to a field resource. When you do this,
the field resource is created and the Manager, Dispatcher, or Administrator is not available anymore.
1.
2.
3.
4.
5.
6.

Click the hamburger icon and then click Resources.
Type the resource name for which you want to change the Resource Type in the Search field.
In the search results, click the required resource name.
On the Resource Info page, click the stack icon and then click Edit.
In the Resource Type field, select a field resource.
Click Submit.
The field resource is created and the Manager, Dispatcher, or Administrator is not available anymore on the
Resources page.

Activate, Deactivate, or Delete a User
You can control users’ access to the application by activating or deactivating them. Active users can log in and use the
application. Deactivated uses can be re-activated when needed. Deleted users are no longer available in the resource
tree.
1. Use one of the following ways to access the user that you want to activate or deactivate:
a. In the resource tree, click the user for which you want to change the status. Click the Info icon for the
resource. On the Resource Info page, click the stack icon and then click Edit. The Edit Resource page
appears.
b. Click the hamburger menu and then click Resources. Search for the resource for which you want to
change the status. In the search result, click the resource name. On the Resource Info page, click the
stack icon and then click Edit. The Edit Resource page appears.
2. In the Status drop-down list, select active or inactive, depending on whether you are activating or deactivating
the resource.
3. Click Submit.
4. If you want to activate, deactivate, or delete multiple users, click the hamburger menu and then click
Resources. Search for the resources for which you want to change the status. In the search result, select the
check box against resource names and click the appropriate check box in the header. However, note that your
administrator must first configure these group actions for the Resources context layout structure, before you
can use them.
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Unlock a User Account
When a user makes too many unsuccessful attempts to log in, the account is locked.
1.
2.
3.
4.

Click the hamburger menu and then click Resources.
Select Blocked under Status.
Select the check box next to the resource whose account you want to unlock.
Click Unlock above the list of resources.

Unlock appreas as an option, only if you have configured it on the Resources context layout structure.
5. Click Unlock in the confirmation diaog.

Reset a User’s Password
As a user administrator, one of the most common jobs you do is reset passwords. If a user is locked out, it is most often
because the user exceeded the maximum number of password attempts. Sometimes in addition to unlocking a user’s
account, you may also have to change their password.
1. Click the hamburger menu and then click Resources.
2. Search for the resource for which you want to reset the password. In the search result, click the resource name.
3. Click the stack icon and then click Edit.
The Edit Resource page appears.
4. Type in the new password in both the Password field and the Confirm Password field.
You can select the Force password change at next login check box to force the user to change the password
when they log in the next time.
5. Click Submit.
The password is reset.

The Resource Tree
The resource tree provides a hierarchical view of your organization’s resources, typically sorted by geographical region.
It displays on the left of the page.
You can click the toggle button to show or hide the resource tree. When you select a resource from the resource tree, the
resource’s activities display in the work area on the right. Click the plus sign (+) next to an entity in the resource tree to
expand and view the entities under that group or bucket. Click the minus (-) sign to collapse that view.
The resource types and the overview of the roles performed by each item in the resource tree are:
• Field resource: This resource can perform work, has work skills, work zones associated, and has a related user
that is an actual person performing work or a crew or people.
• Vehicle: This resource can have work skills, inventory, and geolocation tracking enabled. When assigned to a
team it may add the required work skills and inventory to be used by the team.
• Tool: This resource represents specific tools such as 30-feet ladder and excavator. This resource can have work
skills, inventory, and geolocation tracking enabled. When assigned to a team it may add the required work skills
and inventory to be used by the team.
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• Bucket: This resource is used to accumulate work that is not yet distributed to field resources. Only the
application can assign activities to this resource. This resource is used for Quota Management.
• Organization unit: This resource aggregates field resources, vehicles, and tools in the tree-like hierarchy to
simplify management and reporting. This resource is used for Quota Management.

Designate Buckets for Capacity or Quota Management
After adding a bucket, you must select whether you want to use it for Capacity Management or Quota Management.
1. Click the bucket name in the Resource Tree.
2. Select the Use as Capacity Area check box.
The Routing profile, Capacity categories, and the Time slots fields appear.
Note: When you select the "Used for Quota management" option for a bucket, you cannot change the
resource type and deselect this option. Similarly, if you have deselected Use as Capacity Area the option
initially, you cannot change the resource type and select the option.

Add Capacity Categories and Time Slots
If you designate a bucket as a capacity bucket used for quota calculation, then the page displays the capacity categories
and time slots fields. The selections you make here determine how the Quota section appears. Configuring capacity
categories and time slots on a bucket-by-bucket basis is helpful when different regions and types of resources within
these buckets require different skills and time slots.
1. Click the bucket name in the Resource Tree.
2. Select the Use as Capacity Area check box.
The Routing profile, Capacity categories, and the Time slots fields appear.
3. Select the Time Slots that will be used for Quota Management in this bucket. Click the pencil icon next to the
Time Slots field.
The Edit Time Slots field appears.
4. Select the time slots that will be used for quota management for this bucket then click Save.
5. Select the Capacity Categories that will be used for Quota Management in this bucket. Click the pencil icon
next to the Capacity Categories field.
The Edit Capacity Categories field appears.
6. Select the capacity categories that will be used for quota management for this bucket. Click Save.
7. Select the level at which quota is defined in this bucket (i.e., day, time slot, capacity category).
This determines the visibility of the Day, Time slot, and Capacity category tables in the Quota view.
8. Select the levels on which quota can be closed in this bucket.
Note that quota can also be closed by work zone.
9. Select the levels for which maximum capacity should be estimated.
Maximum capacity is the maximum number of minutes for activities booking. The application checks that the
total duration of booked activities plus the total duration of other activities does not exceed maximum capacity.
10. Click OK to save the bucket information.
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Rules for Removing Inactive Resources
Resources that have an inactive status for more than 12 months are automatically removed from the application to
improve performance and remove clutter from the resource tree.
These rules are applied to remove the resource:
1. Resource Type Role = ‘Field Resource’, ‘Vehicle’, or ‘Tool’ is deleted and removed if the resource:
◦ Has an inactive status

◦
◦
◦
◦
◦
◦

Was last updated more than 12 months ago
Does not have activities in future days (non-scheduled activities, teamwork, and so on)
Is not used in visibility conditions in User types configuration (via ‘pid’ or ‘external_id’)
Is not used in blocking conditions of Message steps (via ‘external_id’)
Is not used in conditions of Filters (via ‘external_id’)
Does not have a related user whose ‘uid’ is used in visibility conditions in User Types configuration

2. Resource Type Role = ‘Bucket’ or ‘Organizational Unit’ is deleted and removed if the resource:
◦ Has an inactive status

◦

◦
◦
◦
◦
◦
◦

Was last updated more than 365 days ago, where:
- Any field or property for the resource was changed
- Resource calendars were changed
- Resource work zones were changed
- Resource locations were changed
- Resource inventories were changed
- Resource time slots were changed
- Resource capacity categories were changed
- Resource routing profiles were changed
- Visibilities between users and this resource were changed
Resource does not have any child resources
Resource does not have activities in future days
Resource is not used in visibility conditions in User types configuration (via ‘pid’ or ‘external_id’)
Resource is not used in blocking conditions of Message steps (via ‘external_id’)
Resource is not used in conditions of Filters (via ‘external_id’)
Resource does not have a related user whose ‘uid’ is used in visibility conditions in User Types
configuration

Update means:
• Any field or property for the resource was changed
• Resource calendars were changed
• Resource locations were changed
• Resource work zones were changed
• Resource inventories were changed
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• Resource associated as Field Resource for some user
• Visibilities between users and this resource were changed

Configure the Activity Labels
You must configure the activity labels that you want to see on the Month view.
1.
2.
3.
4.
5.
6.
7.

Click Configuration > User Types .
Select the user type for which you want to configure the activity labels.
Click Screen configuration.
Expand Application screens and click Activity time view label.
Click Click to Add. On the Add property window, select the properties that you want to display as labels.
Click OK.
In the [property] visibility section, click Add new visibility.

Read-Only is selected by default.
8. Click Save.
9. Click Add new visibility in the [property] value visibilities section. By default, all the values for the property are
visible. If you want to have it that way, click Save. If you want to add visibility to specific values, select the values
and then click Save.
10. Click Close. Go to the Month view in Dispatch Console.
The labels are displayed.

Configure Activity and Resource Hints
Activity hint is a context menu that is displayed when you click an activity on the List, Time, or Map view. Similarly,
resource hint is displayed when you click a resource in the resource tree. These menus can include static text such as
activity type or capacity category and buttons for actions such as adding or starting an activity. The menu can also
include links to open forms and plug-ins.
1.
2.
3.
4.

Click Configure > User Types .
Select the type of user for which you want to configure the hint and click Screen configuration.
Expand Application screens.
To add an activity hint, locate Activity hint in the Dispatch Console tree and click it. To add a resource hint,
locate Resource hint in the Main menu tree and click it.

The Context layout structure opens for the selected hint. This page displays two sections—Layout structure
and Actions.
5. Click Click to Add in the Layout structure section and select the required items.
The items in the Layout structure are static text items.
6. Click Click to Add in the Actions section.
The Add action dialog box appears and displays these options:
◦ Standard action screen: Lets you add standard actions such as Activate route, Add child resource, Add
to group, Resource calendar, Work Skills, Work Zones, Location, and so on.
◦ Plugins: Lets you add plug-ins. The plug-ins that you have added on the Forms & Plugins page are listed
here.
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◦

Custom forms: Lets you add custom forms. The Forms that you have added on the Forms & Plugins
page are listed here.
7. Select one of the three options and then select the required item in the Available list.
8. Click OK.
The properties of the newly added item are displayed.
9. Click Add new visibility.
Read-only is selected by default on the [item] visibility dialog box.
10. Click Conditions and add any conditions based on which you want to display the link.
11. Click Save.
The new item or link is added to the hint. The item is displayed when the user refreshes the application, or logs
in to it the next time.

Configure Time and List Views
You can configure the columns that display on the Time and List views to suit your business requirements.
1.
2.
3.
4.

Click Configure > User Types .
Select the type of user for which you want to configure the views and click Screen configuration.
Expand Application screens.
Click List view columns in the Dispatch Console tree.

Context layout structure opens and displays the default items available on the page. You can more static text
or action items to it.
5. Click Click to Add in the Layout structure section and select the required items.
The items in the Layout structure are static text items.
6. Click Click to Add in the Actions section.
The Add action dialog box appears and displays these options:
◦ Standard action screen: Lets you add standard actions such as Activate route, Add child resource, and
so on.
◦ Plugins: Lets you add plug-ins. The plug-ins that you have added on the Forms & Plugins page are listed
here.
◦ Custom forms: Lets you add custom forms. The Forms that you have added on the Forms & Plugins
page are listed here.
7. Select one of the three options and then select the required item in the Available list.
8. Click OK.
The properties of the newly added item are displayed.
9. Click Add new visibility.
Read-only is selected by default on the [item] visibility dialog box.
10. Click Conditions and add any conditions based on which you want to display the link.
11. Click Save.

Provide Access to the Required Inventory Page
You must provide access to the desired resources for the Required Inventory pages, so that the resources can add, edit,
and delete Required Inventory.
1. Follow these steps to provide access to the Add Required Inventory page:
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Click Configuration, User Types.
Select the user type for which you want to provide access.
Click Screen configuration.
Locate and click Inventory grid.
Click Click to add. Search for and select Add to Required.
Click OK.
Click Add new visibility and then click Save.

The Add to Required button is added to the Inventory list on the Activity details page.
2. Follow these steps to provide access to the Edit required inventory and Delete required inventory pages:
a. Repeat the steps a to c mentioned earlier.
b. Click Edit required inventory.
c. Add a button and select the Edit required inventory page. Similarly, add a button and select the Delete
required inventory page.
d. Click OK and then click Save.
The Edit required inventory and Delete required inventory buttons are added to the Inventory list on
the Activity details page.

Configure the Inventory Identifier Context Layout
Structure
You must configure the Inventory identifier Context Layout Structure page to view the inventory details on the Inventory
page.
1. Click Configuration > User Types .
2. Select the User Type for which you want to configure the Inventory identifiers page.
3. Expand Collaboration and Identifiers and click Identify equipment by.
The Inventory Identifier Context Layout Structure appears.
4. To add a new column to the inventory table, add a new property.
5. Click Add new visibility and add rules to hide or show the columns.
6. Change the order of properties to the order in which you want to display the columns of the table.
The columns are added to the inventory table.
7. Click X or Close.
These rules apply to the columns that you configure here:
◦ The columns of the table don't support custom styles.

◦
◦
◦
◦
◦
◦
◦

The column order corresponds to the order you have configured here.
If a column name is longer than the column width, then the full name shows as a tool tip.
If there are more columns than can be shown on the page, the horizontal scroll bar appears.
By default, Quantity is shown as the extreme right column and is fixed on the right side of the page, if
there is a scroll bar.
Required inventory displays first with the columns Inventory type, Inventory Model, Missing Quantity, and
Quantity. You cannot configure the columns for this section.
Pool statements are expanded by default and saved after you collapse or expand them.
You can hide the columns using the visibility conditions on the 'Inventory identifier' context layout, if
there is no value.
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Add 'Select Resource' to a Visual Form Editor
You can add the Select Resource button to the Edit/View activity and Add/Details inventory Visual Form Editor
to help dispatchers, field users, and supervisors view activities assigned to a technician in one click. For dispatchers,
Select Resource leads to the Dispatch Console, where resource is automatically selected in the resource tree. For users
working in the field and for supervisors who don’t have access to the Dispatch Console, Select Resource opens the
technicians’ landing page.
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Click Configuration > User Types .
Select the User Type for which you want to add the button and go to the Screen configuration tab.
Expand Application screens and click Edit/View activity.
Expand New element and drag and drop the Button element to the header.
Click the pencil icon in the Standard action screen field.
On the Select screen dialog, select Select Resource [select_provider] in the Screen field.
The Select Resource button is added with a default visibility of Read-Only.
Click OK.
Add any name translations and visibility conditions that you want.
Click Save on the Visual Form Editor.
Repeat steps 3 to 9 and add the button to the Add/Details inventory page.

Add Resource History to the Resource Info Context
Layout Structure
You must add the Resource History property to the Resource Info context layout structure, so that users can view, filter,
sort, and export the resource history.
1.
2.
3.
4.
5.
6.
7.
8.

Click Configuration > User Types .
Select the user type for which you want to add the Resource History option.
Click Screen configuration.
Under Application screens, locate and click Resource/User Info.
Select an existing tab or property and then click Group.
Add a name for the tab in the Name field.
In the Tab Type drop-down list, select Resource History and then click OK.
Click Add new visibility and then click Save.

Add the Access Schedule Fields to a Page
The Access Schedule fields include the Access Schedule and Access Hours fields. The Access Hours fields are autocalculated. Access Hours may be empty for a non-scheduled activity and/or when you are in the offline mode. As soon
as you are online and the Access Schedule changes are populated for a scheduled activity, the Access Hours data is
shown. You can add Access Schedule in Read-Only and Read-Write mode, but you can add Access Hours only as Read-
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Only. In most of the contexts (including activity-related pages, lists and hints, with the only exception of Activity details)
the Access Schedule field also includes Access Hours, if it is calculated.
1. Click Configuration > User Types .
2. Click the User Type for which you want to add the Access Schedule fields.
3. Click Screen configuration. Under Application screens, locate and click the page to which you want to add the
fields.
4. From the New element section, drag and drop the Input element to the required position on the Visual Form
Editor.
5. Click the element and then click the pencil icon in the Activity field drop-down list.
6. Select Access Schedule [access_schedule] and click OK.
7. Add the translations and the visibility.
8. Repeat steps 4 to 7 to add the Access Hours [access_hours] fields.
9. Click Save.

Add an External Plug-In to the Main Menu
You can add external plug-ins that are created as HTML5 applications to the Main menu. You cannot add the plug-ins
that have the Only for Legacy Manage main menu option selected. And, you cannot add native application plug-ins
either.
Note: If you add an external plug-in as the first item in the Main menu, the menu item shows in the correct order.
However, the plug-in does not open when the user logs in. Instead, a standard page or a plug-in that you have created
using the Plugin API Framework that is next in the order is opened.

1.
2.
3.
4.
5.
6.
7.
8.

Click Configuration > User Types .
Select the type of user for which you want to add the plug-in and then click Screen configuration.
Expand Application screens and click Main menu.
Select an existing button and click Add button.
On the Add button dialog box, click Plugins.
Select the plug-in that you want to add and click OK.
Click Add new visibility, and then click Save.
Follow these steps, if you want to pass any parameters to the plug-in:
a. Click Add new in the Parameters section.
b. Enter a name for the parameter in the Name field. For example, enter defaultScreen to define a page as
the default page in the plug-in. The maximum length of the name that you can enter is 248 characters.
c. Enter a value for the parameter. For example, enter part_order to display the Part order page as the
default page in the plug-in. The maximum length of the value that you can enter is 4000 characters.
d. Click Save.
e. Repeat the procedure for all the parameters that you want to configure. The total combined length of
all parameter names and values must not exceed 5000 characters. These parameters are not encrypted
when sent to the plug-in.
9. Click Close or X.

The plug-in is added to the Main menu.
10. Click the Main menu and confirm that the plug-in is available.
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Configure the Visibility for Booking Status, Quota, and
Available Capacity Pages
The visibility level of the Main menu item does not control the access level for the Booking status, Quota, and Available
capacity pages. You must configure the visibility levels for each of these pages separately.
1.
2.
3.
4.

Click Configuration > User Types .
Click the user type for which you want to add or modify the visibility for the Quota pages.
Click Screen configuration.
Expand Application screens and click Quota.

Booking status, Quota, and Available capacity are displayed in the Buttons section.
5. Click an item of your choice. Click Modify in the visibility table.
6. Click the access mode of your choice and then click Save.

Configure the Fields for Print Route
You must configure the fields to be displayed on the Print Route page, using the Print Route context layout. When a
user prints the route, all the fields configured for the selected resource or bucket are displayed and printed. In addition
to the configured fields, the list of inventory in the Resource pool is displayed at the bottom.
Note: The application can print a maximum of 1000 activities at a time using the Print Route function. If there are
more than 1000 activities, only the first 1000 activities are displayed with a note.
1.
2.
3.
4.
5.

Click Configuration > User Types .
Click the user type for which you want to configure Print Route.
Click Screen configuration.
Expand Application screens and click Print Route under Main menu > Activity list .
Click Click to Add and then select the required fields.

You can select all the activity related fields, including custom fields.
6. Click OK.
7. For all the fields, click Add new visibility and then click Save.

Enable Activity Selection by Location
Let's say a field resource is assigned with multiple activities in the same location. When the resource completes one
of the activities, they can see the other activities in location, if you have configured the Suggest activity by location
option. This functionality is available in the offline mode as well. An activity is considered to be at the same location, if
the distance is within ‘X meters, where X’ is the Resource Parameter is defined under the Smart Location section.
1. Click Configuration > User Types .
2. Select the user type for which you want to enable the Suggest activity by location option.
3. Under the Activity Management section, select the Suggest activity by location check box.
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4. Click Save.
5. To configure the Resource Parameter, click Configuration > Business Rules .
6. Go to the Maps and Geocoding section. In the Resource is considered to be at the activity location if the
distance to it is less than field, enter the distance in meters.
A resource is considered to be at the activity location if the distance to it is less than X meters. If you do not
have a license for Smart Location / Professional/ Enterprise Cloud services, then the value is set to 100 meters;
you cannot change this value.

Enable the En Route Support Feature
You can enable the En route Support option, so that the field resources can change the activity status to 'En route'. This
status is then shown to your customers on the 'Where is My Technician' page. After you enable the En route Support
option, the ‘En route’ status is available only for the activity types that have the Calculate travel option enabled.
Further, if you disable the En route Support option after using the 'En route' status for some time, then all the current
activities with the 'En route' status end their cycle. And, you cannot set the 'En route' status for new activities. The ‘En
route’ status integrates with the "Where is My Technician" page and you can use it in the Routing module to prevent
undesirable adjustments to the next appointment.
Note: When you upgrade to Update 21B, the En route Support feature is disabled for all the instances to save
backward compatibility. Enabling the 'En route' feature makes the "En Route" status available for travel activities
globally. The changes may impact the "Next activity" function, ETA, and "On my way" notifications to your customers.

1. Click Configuration > Business Rules .
2. Select the En route Support check box.
3. Click Save.
These changes are available for activities and resources:
◦ The 'Next activity' section includes the option I will be Idle for a while.

◦
◦
◦
◦

The activity selected as the next activity gets the status 'En route'.
The ETA of the activity is updated using real-time traffic although the activity has a Service window,
Access hours, or SLA. Real-time traffic is available only if you have a valid license for Oracle Field Service
Enterprise Edition with Google Maps.
The Adjust travel option is available when activity is in the 'En route' status.
When you enable the En route Support feature, if your resources do not set their activities as 'En route',
then:
- Oracle Field Service doesn't consider the resource as on the way to an activity until they set the "En
route" status.
- Travel time is not recalculated.
- If you have configured a Message Scenario to notify your customers about resources being on their
way, they are not notified.
- Where is My Technician page doesn't show the "On the way" status and the resource's position and
track.
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Configure a Color for the En Route Status
If you have enabled the En route Support feature, you can configure the color for the en route status. This helps
dispatchers identify quickly when a resource is on the way to an activity.
1. Go to Configuration > Activity types .
2. Click Modify for the required activity type.
The color for 'En route' status is inherited from the 'Pending' status by default.
3. Set another color and click Update.

Configure the Access to the 'En route' Button
Resources can set the 'En route' status at the beginning of the day, after selecting the next activity on the Complete
activity dialog box, or after taking a break. When resources come back from a break, they can set the status on the
My Route or Activity details page, or the activity hint. Use this procedure to add the En route button to the Edit/View
activity and Activity hint layouts.
1.
2.
3.
4.
5.
6.
7.
8.

Click Configuration > User type .
Select the user type for which you want to add the En route button.
Click Screen configuration.
Under Application Screens, click Edit/View activity or Activity hint.
Add a button element or click Click to Add.
Select Standard action screen and then select 'En route' (enroute_activity).
Click OK.
Configure the visibility conditions. Specify whether you want to have the 'En route' status mandatory before
starting an activity.
9. Click Save.

Configure the Access to the 'Stop Travel' Button
Sometimes your customers might ask you to reschedule an appointment even after the resource changes the status to
‘En route’. In such cases, your dispatchers or resources can return the activity to the Pending status and then reschedule
it.
1.
2.
3.
4.
5.
6.
7.
8.
9.

Click Configuration > User type .
Select the user type for which you want to add the Stop Travel button.
Click Screen configuration.
Under Application Screens, click Edit/View activity or Activity hint.
Add a button element or click Click to Add.
Select Standard action screen and then select 'Stop Travel' (stop_travel).
Click OK.
Configure the visibility conditions.
Click Save.
Stop Travel will be visible only for activities that have a status of En route.
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Configure the User Interface for Field Resources
As an administrator, you configure the interface for field resources. Typically, field resources are assigned to the
Technician user type.
Field resources see 'tiles' on their home page, where each tile opens the page for a specific function.

Add My Route to the Main Menu
You can configure the landing page for Field Resources to display either the My Route page or the list of activities.
1.
2.
3.
4.

Click Configuration > User Types .
Under Screen Configuration, go to Application Screens and click Main Menu.
Click Click to Add and add My Route.
Click Add new visibility and then click Save.
My Route is added to the Main menu. For users who have a route, My Route is always displayed in the Main
menu regardless of whether it is configured or not. If you have not configured My Route but have configured
other items for the Main menu, My Route is displayed as the first item. If you have configured My Route and
other items, the position of My Route is per the configuration. If a user has access to multiple resources and
also has a route of their own, if you have not configured any items, Manage and My Route are displayed in the
Main menu. If a user does not have a route of their own, My Route is not displayed in the Main menu even if
you have configured it for them.
Note: If you want the resources who do not have access to multiple resources to access the Main menu, then
set the 'Field Resource Landing Page' option on the Configuration → Display page to 'My Route'. If you set it to
'Activity List', these users will not have access to other Main menu items.

Add a Custom Form to the Landing Page
You can display custom Forms on the field resource Landing page. This is helpful when you have custom forms for field
resources to capture vehicle or safety inspection details or some type of expense.
1.
2.
3.
4.
5.
6.
7.
8.
9.

Open the Configuration page and click User Types.
Select the user type for which you want to modify the Landing page.
Go to the Screen Configuration page and click Activity List.
Click Click to Add.
On the Add button dialog box, select Custom Forms.
Select a form in the Available list and click OK.
Provide a custom name for the tile.
Click Add new visibility.
Add any conditions required for the visibility of the form and then click Save.

A link to the custom form appears as a tile on the Landing page. The link contains the name and icon. the
custom form is displayed when the user clicks the icon.
10. To display the History tile on the Landing page, repeat the steps 4 to 9 and add the Request History standard
action.
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Resource Entities
The ongoing management of resources typically involves managing one or more entities among calendars, work
schedules, shifts, work skills, and work zones.
Calendars, Work Schedules, and Shifts – This involves creating calendars that illustrate when a resource is available
for work and when they are off duty. Between calendars, work schedules, non-working time, internal activities, holidays,
and shifts, a great deal of flexibility is available in the application. Some parameters can be set in advance for planning,
and others are considered more day-to-day adjustments.
Work Skills –This refers to the correlation between what is required to complete incoming activities, and which
resources have the capabilities to accomplish them.
Work Zones – This refers to the area within which a resource is able or allowed to travel to complete activities.

Time Zone Settings
When you configure the application, it is possible to set different time zones for users and for resources. These time
zones are used in different contexts on different pages. Here’s an overview of how time zones are displayed throughout
Oracle Field Service.
Today's Date
The time zone of the currently logged in user is used when determining today's date. Let’s say it is 1:00 PM, Jun 10 in a
UTC+00:00 time zone. If you log in as a user who is in UTC+12:00 time zone, after logging in you see that the current
date is set to Jun 11. This is because, in the user's time zone it is already 01:00 AM, Jun 11.
Where is it Used?
Today's date is used as the initial date on these pages in Oracle Field Service Core Application: Activities, Daily, Offline
synchronization, Dashboard, and Print route. For example, on the "Activities" page, it is the date for which the activities
are shown after you log in to the application. You can change the date on these pages to see the information for another
date. Nevertheless, when you click the date field, the calendar widget shows you today's date in light blue color. This
screenshot shows the calendar with today’s date highlighted:
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The same behavior is present in Oracle Field Service Mobile for Android and iOS. When a field resource logs in, today's
date is marked with light red color on the date selection panel in the header, as shown in this screenshot:

When a field manager looks at the Calendars page in Oracle Field Service Mobile for Android and iOS, then today's date
is marked in light red, as shown in this screenshot:
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The same date is used in Oracle Field Service Core Application when searching for activities "starting today".
Current Date of the Resource
The current date of the resource is always determined in the time zone of the resource. You can activate the route and
start an activity only on the current date of the resource's time zone.
Changing Past Activities
Every instance has a specific time when all the data that is related to the previous day is frozen and can't be changed
any more. This time is configured in the Overnight work section on Business Rules, shown in this screenshot:

For example, you have configured that the working time is 5 hours since midnight in the Eastern time zone. This means
that at 5:00 AM in the Eastern time zone all data for the previous day becomes frozen.
Note: If you configure an instance to use in several time zones, you must set the time zone on Business Rules to the
most "western" time zone. If the work is performed several hours after midnight in this most "western" time zone,
then you must also specify the number of hours after midnight.

Time View in Oracle Field Service Core Application
Time view displays aggregated information for the hierarchy of resources. The information is presented in the same
time zone to look consistent on the time line. The time zone is determined as the time zone of the resource selected in
the resource tree on the left of the page. The current time, which is shown as a red vertical line is also in the time zone
of the selected resource, shown in this screenshot:
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Note: The only exceptions are the resource hint, activity hint, and activity label. Information on the resource hint is
displayed in the time zone of the resource this hint belongs to. Information on the activity hint and activity label is
displayed according to the rules described in the Activity related information section later in the topic.

Manage page in Oracle Field Service Mobile for Android and iOS
The Manage page in Oracle Field Service Mobile for Android and iOS shows the information similar to the Time view.
The difference is that there is no resource selected in the installed app. The information is shown for the list of resources
identified as a group, and the group is configured by a user. Since it is not possible to identify which resource time zone
must be used as the primary time zone, the time zone of the currently logged in user is used instead.
Note:
• The only exceptions are the resource hint, activity hint, and activity label. Information on the resource hint
displays in the time zone of the resource this hint belongs to. Information on the activity hint and activity label
displays according to the rules described in the Activity related information section later in the topic.
• When a user opens the non-scheduled or non-ordered activities on the right of the page, the activity identifier
shows information according to the rules described in the Activity related information section later in the topic.

Organizations with Multiple Time Zones
If your organization operates in multiple time zones, it is important that you configure both, the field resource and
activity time zones correctly. Configuring these time zones is even more important if they are different. A field resource
sees all the data in their own time zone, but when the activity (customer) is in a different time zone, both times are
shown as appropriate. The activity time zone is used for notifications and can be used in APIs (for example, for sending
messages). Typically, the time zone of a physical location is used for notifications, but you may use your preferred time
zone, such as your headquarters time zone or any other in which you prefer to get notifications.
Resource related information
Information that is related to a resource and the resource’s route is entered in the resource's time zone. It includes:
• Route Status (queue_status), includes the time when the route was activated
• Reactivated (reactivated)
• Resource working hours (calendar)
• Resource on-call hours (oncall_calendar)
Time view shows this information differently in Oracle Field Service Core Application and Oracle Field Service Mobile for
Android and iOS. See the earlier sections for more details.
Activity Related Information
Time related information on an activity is displayed and entered in the time zone of the resource for which the activity is
assigned. This information includes:
• Start (ETA)
• End (end_time)
• Start - End (eta_end_time)
• Delivery window (delivery_window)
• Activity Time of Booking (atime_of_booking)
• Activity Time of Assignment (atime_of_assignment)
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The only exceptions are:
• Time slot or service window (depending on what is used for the particular activity type)
• SLA window
These properties are either in the resource time zone or in the customer time zone. It depends on the SLA and Service
window use customer time zone field set on the activity type. Time view shows this information differently in Oracle
Field Service Core Application and Oracle Field Service Mobile for Android and iOS. See the earlier sections for more
details.
User related information
All user related information is shown in the time zone of the user. It includes:
• When the user was registered
• When the user was updated
• When the user logged in last time
• When the user changed the password
• Date and time till when the user is blocked
Collaboration
Each message in Collaboration includes the time when it was sent. This time is shown in the time zone of the currently
logged in user.

Change a Resource’s Organization
You can change the Organization for bucket and Organization unit resources. Resource types such as field resources,
tools, and vehicles inherit their parent’s Organization.
1.
2.
3.
4.

Select the resource in the resource tree.
Click Resource Settings > Resource Info .
Locate the Organization field and select the desired Organization.
Click OK.
The resource is displayed under the selected Organization in the resource tree.

Provide Access to Group Actions for Resources
You can provide access to users to select multiple users of a user type to perform actions such as deactivate, unlock,
delete, or activate.
If a user doesn’t have the permissions to change the resources or users of a particular User type, then the user can't
select such resources or users. Verify the Can create users of the following user type setting on the Configuration >
User Types > General tab.
1. Click Configuration > User Types .
2. Select the user type for which you want to provide the access.
3. Go to the Screen configuration tab and click Resources under Application screens.
4. Click Click to add and select Activate, Deactivate, Delete, Set Collaboration Group, and Unlock.
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5. For each button that you just added, click Add new visibility and then click Save.
The Activate, Deactivate, Delete, Set Collaboration Group, and Unlock buttons are displayed on the
Resources page, when a user with this permission selects a resource.

Calendars, Work Schedules, and Shifts
Whether they are set at the organization unit, bucket or resource level, overall calendar options are made up of
combinations of work schedules, shifts, working, and non-working time. Ultimately they represent a holistic view of who
is available or not available for work at any given time on any given day.
Here are a few rules regarding the hierarchy of calendars in general, and their levels of precedence:
• Work schedules, shifts, and working time applied to a bucket or an organization unit, by default, also apply to all
resources that fall under that bucket or organization unit.
• Calendars created or adjusted at a lower level override the calendar at a higher level. In other words, the
calendar that you have set up at a resource level overrides the calendar that the resource may have inherited
from its parent entity. However, the work schedule defined at the child level doesn't override the shift, custom
working time, and non-working time defined at the parent level.
• A calendar at the individual resource level applies only to that resource and overrides all other calendars.
To better understand calendars and their potential components, we must define the different options. The components
of a calendar are:
• Work Schedules: Work schedules contain multiple shifts and non-working times. Work schedules are the
mechanisms for grouping these items, so that they can be applied to a single resource, a bucket, or an entire
organization unit. Work schedules represent the highest level of calendar options.
• Shifts: Shifts are used to define the different working times as defined by an organization. They can be created
once and used by a variety of work schedules, simplifying the assignment of schedules. In addition to work
schedules, shifts can also be assigned directly to organization units, buckets, or resources.
• Working Time: The time frame in which a resource is scheduled to work that does not comply with one of a
company’s standard shift definitions.
• Non-working Time: Non-working time is used to identify known absences such as bereavement, illness,
holidays, and vacations.
Earlier portions of this guide covered the creation of work schedules, shifts, and non-working time. This section
will concentrate on assigning those calendar options to entities on the Resource Tree (organization units, buckets,
resources). While the process is the same for each, depending on what you select on the Resource Tree, the implications
differ. This ties back in with the explanation of the calendar hierarchy.
When associating calendar options with higher-level entities (organization units, buckets), their child resources assume
the same options. However, if you set options at the resource level, they take precedence over their inherited settings.
For the purpose of this guide, the steps for building calendars at the resource level are covered. The steps are the same
for organization units and buckets, so simply select them from the Resource Tree instead of individual resources.
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Add a Work Schedule or a Shift
You can assign a work schedule or a shift to a resource, bucket, or group. You can also define the on-call schedule of a
resource using the Calendar view.
1. Click the hamburger icon and click Calendars.
The calendar appears for the resources in your group or bucket.
2. For the resource for which you want to modify the calendar, click the shift for the required date.
The modify calendar dialog box appears for the selected resource and date.
3. To change the work schedule or shift for the resource, update these fields:
Name

Description

Schedule

This list includes work schedules and shifts. Select the work schedule or shift that you want to
apply to the resource.
Select Default schedule, to set the default schedule for the resource. Default schedule is the
working time configured for the whole organization, division, or for a particular geographic
region. In other words, a default schedule is the working time added at the Organization unit or
Bucket level, which is inherited by the child resources.
A default schedule is displayed with a darker color on the calendar, and an individual schedule
is displayed with a lighter color.

End date

The date on which the new work schedule or shift ends. Click No date specified to apply it for
an indefinite time.

Comment

Enter any comments that you wish to provide, for example, the reason for changing the
schedule.

4. To add the details of on-call for the resource, click On-Call and update these fields:
Name

Description

On-Call Schedule

The field that specifies that the resource is on call. When you select an on-call shift, the on-call
color coded icon that is attached to the shift appears. When you add this shift to a resource, this
icon is displayed on the Dispatch Console, Manage, Calendar, and Resource Calendar pages,
and on the resource avatar. Select On-Call. An On-Call shift visually shows the resources that
are available to be contacted outside a regular working shift. If you have not activated an OnCall shift, it is not suitable for activity assignment - either manually or in routing optimization,
and is not used in capacity calculations. However, when you activate an on-call shift, activities
can be assigned to the resource.

End Date, Repeat

Select the date on which you want to end the new working time.

Repeat

Select the frequency (Daily, Weekly, Yearly) at the new working time must be repeated. Enter the
number of days or select the day of the week on which you want the new working time to be
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Description
repeated. If you have selected Yearly, select the end date for the recurrence of the new working
time. The end date of the new schedule is displayed below the field.

5. Click Submit.

Add a Shift to a Resource's Calendar
Shifts are standard patterns of working time. They determine when a resource is available for work. Shifts applied at the
resource level override the shifts applied at a higher level in the resource tree.
1. Select a resource from the resource tree.
2. Click Resource Settings > Resource Calendars .
The Resource Calendars page displays.
3. Click the date for which you want to add a shift.
The Add Shift dialog box displays.
4. Complete the fields.
Field name

Action

Shift

Select a pre-configured shift from the drop-down list.

Start date

Select the start date of the shift.

End date

Select the end date of the shift, if applicable.

Comments

Enter comments, if any.

Recurrence-Repeats-Daily

Apply to schedules such as every other day or every 3rd day. If you select this option, add the
frequency of occurrence in the field Days between occurrences.

Recurrence-Repeats-Everyday

Applies to every day schedules that repeat without exception and without any modification
options.

Recurrence-Repeats-Weekly

Apply calendars that have a regular weekly pattern. Select the days that apply to this shift using
the check boxes for the individual days. Indicate the frequency of this pattern weekly by adding
a value to the Weeks between occurrences field.

Recurrence-Repeats-Yearly

Occurs every year from the selected date entered in the From day until the date entered in the
To day field.

5. Click OK.
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Add Working Time to a Calendar
Working time differs from shifts in that it represents start and stop times that may differ from the pre-defined shifts.
Use working time when resources work a different number of hours than they normally do or when they work at a
different time of the day than the other resources.
1. Click the hamburger icon and click Calendars.
The calendar appears for the resources in your group or bucket.
2. For the resource for which you want to modify the calendar, click the shift for the required date.
The modify calendar dialog box appears for the selected resource and date.
3. Fill up these fields:
Field name

Action

Schedule

Select Custom Working Time from the drop-down list.
Note: You can create only one on-call shift per day. If you create a second on-call shift, the
first one is deleted. You can remove an on-call shift if you assign a schedule for a resource.
You can't remove an on-call shift, if you assign a regular shift, custom working time, or nonworking time. You cannot remove an on-call shift, which is part of a Schedule.

Start Time

Enter the time when the resource's work is to begin.

End Time

Enter the time when the resource's day ends.

Points

If you are using points to cap activity assignments, you can enter them here. These points work
the same way as points associated with a shift.

Comments

Enter any comments that you would like to provide for the change in timings.

End Date

Select the end date for the schedule.

Repeat

Select the frequency (Daily, Weekly, Yearly) at the new working time must be repeated. Enter the
number of days or select the day of the week on which you want the new working time to be
repeated. If you have selected Yearly, select the end date for the recurrence of the new working
time. The end date of the new schedule is displayed below the field.
You cannot add recurrence for a schedule and for Non-Working Time.
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Field name

Action

Keep the Non-working days

Select this check box to retain the existing non-working days in the resource’s calendar. This
check box is selected by default.

This screenshot shows the dialog box where you add the custom working time:
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4. Click Submit.
The new schedule is displayed on the calendar.
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Add On-Call, Non-Working, or Custom Working Time to
a Calendar
Use non-working time to identify times when a resource, an organization unit, or a bucket is not available for work. You
can use the custom working time to specify a custom schedule for a resource. Similarly, you can use the on-call option
to specify the time during which a resource is available on call. Be aware that you can change the calendar, only if you
have the Read-Write permission for Resource Calendar on the Resource/User Info context layout structure.
1. Click the hamburger icon and then click Calendars.
The Calendar view appears for the group or bucket assigned to you.
2. Select the bucket, group, or resource for which you want to change the calendar.
3. Click the date for which you want to add the non-working time, custom working time, or an on-call schedule.
4. Click On-Call and update these fields:
Name

Description

On-Call Schedule

The field specifies whether the resource is not working, is working in a custom schedule, or is
on call. Select Non-Working Time, Custom Working Time, or On-Call. If you select the blank
option, the existing on-call schedule is removed and the earlier schedule is restored. You
cannot remove an on-call shift, which is part of a Schedule.

Reason

If you have selected Non-Working Time, select the reason for which the resource is not working.
For example, Others. This field is not displayed if you have selected Custom Working Time or
On-Call.

Start time, End time

If you have selected Custom Working Time, select the custom start and end time of the
schedule. This field is not displayed if you have selected Non-Working Time or On-Call.

Comment

Enter any comment that you wish to provide, for example, Daughter’s graduation day, or
Dentist’s appointment at 4:00 pm. This field is not displayed if you select On-Call.

End Date

Select the date on which you want to end the new working time.

Repeat

Select the frequency (Daily, Weekly, Yearly) at the new working time must be repeated. Enter the
number of days or select the day of the week on which you want the new working time to be
repeated. If you have selected Yearly, select the end date for the recurrence of the new working
time. The end date of the new schedule is displayed below the field.
You cannot add recurrence for a schedule and for Non-Working Time.

Keep the Non-working days

Select this check box to retain the existing non-working days in the resource’s calendar. This
check box is available and enabled by default if the schedule is changed for more than a day. In
other words, it's available if you change the End date field.

5. Click OK.
If the non-working time can be applied, the resource is marked as a non-working resource for the selected
date range. If the non-working time can't be applied, a warning message appears. If you click OK, the non-
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working time is applied, but a warning message appears on the resource tree for that resource on that day.
Non-working time can't be applied if the technician has anything other than repeating, shift, or mass type of
activities assigned on this route. The activities on the resource’s route, other than mass and repeating activities,
are rerouted or assigned to the bucket, if these conditions are met:
◦ The routing plan has the Enable reoptimization check box selected.

◦

The resource meets the routing plan filter conditions.

Add the Find Nearby Inventory Action to Part Details
Page
Field Resources can find out the availability of an item with any of the nearby technicians. You must first configure the
context layout of the Part details page to display the Find Nearby Inventory action on the Parts details page.
The Find Nearby Inventory option is available based on these rules:
1. The Find Nearby link is active ONLY if these conditions are true:
◦ Your company has a subscription to Smart Collaboration and Smart Location or Oracle Field Service
Enterprise edition or Oracle Field Service Professional edition.
◦ Collaboration is enabled and configured for the user type and user.

◦
◦
◦
◦

User location information is available and the location permission given in the browser.
Nearby resources are available for the current user and at least one nearby user is online.
Find Nearby action link is added to the Part Details context for the user.
User activated the route.

2. The Find Nearby Inventory tab shows the number of users who hold this inventory within 50 miles distance
from the resource. The distance is based on the Nearby Radius field configured on the Business Rules page.
3. The Find Nearby Inventory tab displays the travel duration only if these conditions are true:
◦ Your company has a subscription to Oracle Field Service Enterprise edition with Google Maps.

◦

You have enabled the Enable Real Time Traffic check box on the User Types page.

To add the Find Nearby Inventory action to the Parts details page:
1.
2.
3.
4.

Click Configuration.
Click User Types.
Open the Screen configuration tab.
In the Application screens section, click Parts details.

5.
6.
7.
8.

The Parts details context layout structure appears.
Under Action, click theClick to Add link.
Select the Standard action screen option.
Select the Nearby Resources with Parts check box and then click OK.
Click Add new visibility.

Read-only is selected by default.
9. Click Save.
The Find Nearby Inventory button is now available on the Parts details page.
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Add a Plug-in to the Parts Details Page
You may have created a plug-in that lets Field Resources order a part from the warehouse or from a vendor. To display a
link to the plug-in on the Parts Details page, you must configure the context layout of the Parts details page.
Prerequisite: You have added the plug-in on the Forms & Plugins page and configured it.
To add a plug-in to the Part details page:
1.
2.
3.
4.

Click Configuration.
Click User Types.
Open the Screen configuration tab.
In the Application screens section, click Parts details.

5.
6.
7.
8.

The Parts details context layout page appears.
Under Action, click theClick to Add link.
Select the Plugins option.
Select the check box for the plug-in to be displayed and then click OK.
Click Add new visibility for the newly selected plug-in.

Read-only is selected by default.
9. Click Save.
The plug-in is now available on the Parts details page.

Add a Mass Activity
When you create an activity for one resource that you would like to use for other resources, you can create a mass
activity. For example, if all the technicians are required to attend a training, you add a mass activity.
1. Add an activity to a resource as you normally would.
2. Complete the Activity Notes, Position in Route, Duration, SLA Start, SLA End, and Time Slot fields.
3. Click Mass activity.
The Mass activity check box is displayed only for the activity types for which it is configured.
4. Click Add new.
The resource tree displays.
5. Select the resources that you want to be part of this activity.
6. Click OK.
The activity is assigned to all the selected resources.

Add Repeating Activities to a Resource’s Route
You can add activities to a resource’s route that repeats for a specified period. Examples of repeating activities include
meetings and lunch breaks.
1. From the Resource Tree, select the resource to which you want to assign the activity.
2. Click the gear icon and select Add activity.
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The Add activity [resource name] page appears.
3. Complete these fields:
Field

Description

Activity Type

Select the internal activity type. Some common options include: Lunch Break, Assisting, Office
Activity, Warehouse Activity, Weather and Vehicle Maintenance. This list is populated with
activities designated specifically as allowed for repeating.

Activity Notes

Any notes or comments about the activity.

Position in Route

If Not Ordered is chosen, then the activity is displayed as a scheduled/not ordered activity
in the lower portion of the Time view interface. This is true whether a subsequent time slot is
indicated or not.
If Ordered is chosen and a time slot is indicated, then the activity is displayed on the resource’s
route within the time slot specified.
If Ordered is chosen and no time slot is indicated, then the activity is displayed as pending at
the beginning of the resource’s route.

Duration

The amount of time that the activity lasts.

SLA Start

The date and time at which the SLA starts for this activity.

SLA End

The date and time at which the SLA ends for this activity.

Time Slot

Select the period of time within which this activity can be started. Time slots for internal
activities are defined within the Activity Type settings. Time slots can also be created to support
internal activities, similar to how they work for scheduling external activities.

Repeating Activity

Select the frequency at which the activity occurs and complete the corresponding fields.

4. Click Submit.
The activity is added to the resource’s route.

Resource Work Skills
To ensure that a resource has the ability to perform the assigned activities, you must correlate the incoming activity skill
requirements with the skills specified for each resource.
The work skill functionality is what that correlation is based on. You first set up work skills and then assign them to
resource records, with the appropriate levels of qualification set for each. Incoming activities are also assigned work
skills based on certain conditions being met. The application matches up the resources with corresponding skills during
routing. For more information about how to add work skills, see the Configure Oracle Field Service chapter. In this
section, we’ll cover a common administrative task – assigning work skills to resources to help ensure that the right
resource is being assigned the right work by routing.
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Related Topics
• Create a Work Skill

Work Skill Group Considerations
Work skill groups are bundles of work skills that can be assigned to resources, similar to individual work skills. The
difference, however, is that work skill groups may already contain predetermined qualification levels of certain skills,
whereas when assigning works skills one at a time, you can define unique qualification levels for the resource.
If there is an overlap in qualification levels between what is defined within work skill groups and individual work skills,
then the resource is considered to have whichever is the highest. Work skill groups are assigned in the same manner
that work skills are (less selecting qualification levels), so this section only describes the process of assigning work skills.
Editing existing work skills for resources is another common task, and it is also accomplished in the same manner as
initially assigning skills.

Assign Work Skills to a Resource
Work skills are the competencies that each resource is qualified to perform. A resource without work skills is not
considered for activity assignments. You can assign work skills to resources through the Resource Info page.
1. In the resource tree, click on the group or bucket that you want to add the new resource to.
2. Click Settings > Resource Info from the drop-down list.
The Resource Info page displays.
3. Click the plus icon in the Work skills field.
The Add work skills window opens.
4. Assign a preference level for each work skill using a scale of 1 to 100.
A higher number means that the resource has a higher chance of being allocated the task. If a resource
performs this task only occasionally, enter a lower number.
5. Click Save.
The resource is now assigned the skills and will be considered for work only if their qualification level meets or
exceeds the level in the activity record. These guidelines are applicable:
◦ If no individual skills are defined for a resource, then the application interprets that the resource is
qualified to perform all of the skills at the highest qualification level. This is the default setting.
◦ When qualification levels are set for at least one work skill, then the resource is considered to have only
that specific skill. The resource is not considered for work requiring any of the other skills.
◦ A higher ratio number increases the likelihood that this resource will be assigned activities with this work
skill. If the ratios are conflicting, the application uses the higher ratio. If the work skill group ratio conflicts
with the individual work skill ratio, the application uses the individual work skill ratio.
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Resource Work Zones
Work zones provide two major capabilities—the first is to define the areas within which a resource is allowed to work (or
is restricted from working outside of). The second is to support the ability to cap or stop activities from being booked at
certain times on a zone-by-zone basis (capacity management).
You can assign work zones to resources through any level within the Resource Tree (group, bucket or resource). An
exception is temporary work zones – you can set them only at an individual resource level. If you set work zones at a
group or bucket level, then their child entities (resources) inherit the same settings. If you set work zones at the resource
level, then those settings override any higher-level settings. Given those rules, ensure that before assigning work zones,
you have selected the correct entity from the Resource Tree. The process of assigning work zones is the same for all
levels. This document includes the steps for assigning work zones to individual resources.
Related Topics
• Add a Work Zone

Add Work Zones to a Resource
Work zones define the regional areas in which technicians are permitted to work. When you add a work zone to a
resource, any work zone shape or custom map layer that is added to the work zone is displayed on the map. Work zone
shapes and custom map layers help you visualize your work area better.
1. Select the resource from the Resource Tree.
2. Click Resource Settings and then select Resource Work Zones from the drop-down list.
The Resource Work Zones page displays for the selected resource.
3. Click Add new.
The Add Resource Work Zone for <resource name> dialog box appears.
4. Complete these fields:
Field

Description

Work zone

Select the work zone from the drop-down list.

Display additional zones in the drop-

Select the box to view all the active work zones. For the group or bucket that this resource is in.

down list
Ratio

Type a value between 1 and 100. A higher number increases the likelihood that this resource
will be assigned activities in this work zone. If this is a work zone the resource works in daily, or
if it is a preferred zone for the resource, enter a higher number. If this resource only works in
this work zone occasionally or only by exception, enter a lower number. You can assign multiple
work zones with different ratios to one resource.

Schedule Section
Temporary

Select this check box to create a temporary work zone for a specified period of time.
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Field

Description

Date Start

Enter the date that this work zone assignment starts.

Date End

[Optional] If this is a temporary assignment, enter the date that this work zone assignment
ends.

Recurrence

Set the schedule for the work zone if the resource is alternating between work zone
assignments. Resources can cover different work zones on different days of the week. Use this
feature to change a resource’s work area on certain days of the week. Select the frequency of
recurrence and the days on which to recur.

5. Click Add.
The work zone is added to the resource. If any work zone shapes are added to this work zone, they are
displayed on the map.

Remove Work Zones from a Resource
If a resource doesn’t want to work in a specific region, you can delete the work zone from a resource’s record. Deleting a
work zone has a major impact on the activity assignments.
1.
2.
3.
4.
5.

Select the resource from which you want to delete a work zone.
Click Settings > Resource Work Zones .
Select the work zones you want to delete from this resource.
Click Delete.
Click OK.
Any activities associated with these work zones will no longer get routed to this resource. Deleting a work zone
from a resource does not delete it from the application. It will still be available to be assigned to other resources
as needed.

Assign a Temporary Work Zone
You can assign a temporary work zone to a resource, for the resource to perform a work outside the usual work zone.
Temporary work zones override all regular work zones of the resource for the defined period of time.
1. Select the appropriate resource from the Resource Tree.
2. Click Settings > Resource Work Zones .
3. Click Add new.
The Add resource work zone for [resource name] window appears.
4. Select the Work Zone that you want to assign temporarily to the resource.
5. Select the Temporary check box.
6. Adjust the Date Start and Date End dates.
Date End is mandatory for temporary work zones.
7. Click Add.
The work zone is added.
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There is no need to remove temporary work zones once the date has passed. They expire on the end date and the
normal work zones take precedence. These rules apply to temporary work zones:
• The End Date is mandatory.
• You can assign temporary work zones only to resources. You can’t assign them to buckets or groups.
• Only the Everyday recurrence is available for temporary work zones.
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View Scheduled Reports
The Schedule Report option enables you to view a list of reports that have been set up to run on a specified schedule.
Starting update 21A, users for whom the Schedule Report option is selected can access the Schedule Report option from
Core Application. Note that you cannot provide access privileges for users in a new user type.
These improvements were made:
• Schedule report functionality for existing users
• Dashboard style as per redwood design
• A limit of 25000 records is set for the number of records that can be exported. If this maximum limit is
exceeded, a warning message is shown to prevent possible out of memory/timeout issues.
• Removal of the survey reports as the survey functionality is not available for users
Schedule report functionality for existing users
Existing users configured with schedule report in legacy manage can now access schedule reports from Core
application.
1. Click Configuration. In the Configuration window, select Dashboards. This image shows the Configuration
window:
2. Click Schedule Reports from the Actions menu. This image shows the Configuration window. The Schedule
Reports window is displayed.
3. Make sure users who have privilege to access schedule report also have access to Dashboards from the
Configuration window.
Note: You cannot configure view or edit access privilege for a new user type in Update 21A. Existing user
types that have access to scheduled reports will have the same access privilege in Update 21A. However, new
users cannot modify the existing privilege in Update 21A
Improved Dashboard style as per redwood design
The Dashboard style and icons now appear in redwood style.
• The tabs style improved as per redwood style.
• Improved Tabs Design
• New icon style added on Available reports section.
• Icons on Available Reports
• Actions drop-down menu
• Add new predefined dashboard dialog box
• Chart settings dialog
• Dashboard configuration page (Available report selection & User type )
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Warning Message when exporting reports with huge data
When the user tries to export a report with more than 25,000 records, a warning message "Unable to load data. Change
parameters and press apply to export report" appears.
Removal of survey reports
Further to removal of the survey functionality, reports & charts corresponding to survey functionality will not be
available from Update 21A.
• Post Activity Survey Calls & Post Activity Survey Calls – Total reports
• PAS Response per Resource chart will not be available from Update 21A. The dashboard will no longer show an
already configured PAS Response per Resource chart tile after the upgrade.
Initial report scheduling is handled by your system administrator.
To view scheduled reports:
1. Select the Navigation button.
2. Select Schedule Report from the navigation pane.
A list of the reports that have been scheduled to run on a recurring basis by the system administrator appears.
This screenshot displays the Schedule Reports page showing the list of all scheduled reports.

This table provides the elements in the Scheduled Report and their description:

Column

Description

ID

The unique identifier for this report.

Report name

The name of the report.

Start Date

The start date of the reporting period.

End Date

The end date of the reporting period.

Report Type

The format of report to be sent or saved (CSV, HTML, XML, PDF).

Time

The time that the report was run.

Recurrence

How often this report is run. You cannot run or modify any recurring reports.
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Column

Description

Action

To view the details of the settings for an individual report (View).

Create a Scheduled Report
The Schedule Reports option allows you to view a list of recurring reports. The initial set-up to schedule a recurring
report is handled by the system administrator.
1. Click Reports > Schedule Reports .
The list of reports that are scheduled by the system administrator to run on a recurring basis appears.
2. Click Add new.
The Add schedule dialog box appears.
3. Complete these fields:
Field

Description

Report Name

Select the name of the report from the drop-down list of choices.

Report Type

Select the report output type from the drop-down list. Choices are: .csv, .html, .pdf, .xml

Save to File

Select to indicate if you want to you save the report to a file.

Email Address

Email address of the person receiving the file.

Name or ID

External ID of the resource or bucket used for this report.

Start Date

The date on which the report run begins.

End Date

The date on which the report run ends.

Time From

The time at which the report generates.

Recurrence

How often the report generates. Specify whether the report runs everyday, daily, or weekly:

◦
◦
Report Parameters

Weekly allows you to select specific days of the week.
Monthly allows you to select the day of the month.

Based on the report you selected from the drop-down list, this section resets with the
parameters for that report. Enter the value in the Value field.

4. Click Add.
The new scheduled report appears in the Schedule Report list.
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View the Messages Report
The Messages report details the results of messages sent out through the Notification Engine. This report shows only
those messages that use set property delivery channel (method) if they were generated in less than one hour. The only
exception from this rule: Messages with failed status. Such messages are important for troubleshooting therefore they
do not have the one-hour expiration time.
To view the Messages report:
1. Select the subject of your report from the resource tree.
2.
3.
4.
5.

This could be a bucket or organization, such as XYZ contractors, or one or more resources.
Click the Navigation button.
Select Messages Report from the navigation pane.
Click View to display the filtering options for this report.
Select your options.
a. From/To Date: Use the calendar icons to select the desired dates.
b. Trigger: Select a trigger from the drop-down menu. The trigger is the action taken within Oracle Field
Service that triggers the message. For example, if you would like to run a report showing all messages
triggered when an order is canceled, select Cancel.
c. Find: Use this field to search for a certain term, word, or character (such as the name of a resource) within
the results.
d. Rows: Enter the number of rows you want to see at one time. The default value is 20.
The Messages report details the results of messages sent out through the Notification Engine.

Field

Description

Method

How the message was sent. For example, internal process or external system.

Status

The status of the message at the time the report was run.

Description

Additional information about the message status.

Miscellaneous

Other information

Scenario (Step)

The scenario or step referenced in the message.

Trigger

The event or reason why the message was sent.

Call Day

The day the call was placed.

Day Created

The date and time that the message could be seen in the system.
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This document will continue to evolve as existing sections change and new information is added.

Date

What’s Changed

November 2021

These topics are added:
• Configure a Workflow

Notes

• Add a Workflow
• Add a Workflow Step
• Add a Workflow Condition
• Edit a Custom Form within a Workflow
• Tips to Configure Activity Pages for Workflows
• Use Cases to Configure a Workflow
• Export and Import Workflows
• Associate a Workflow with an Activity
These topics are updated:
• Define the Settings for a Scenario Step

August 2021

This topic is added: Download a Shape File that was
Uploaded from a Local Device
These topics are updated:
• Update Shape Properties
• Add a Map Layer
• View Statistical Parameters
• Travel Time Prediction

May 2021

Renamed the topic 'Add a Login Policy' to 'Add a Login Policy
for LDAP, SAML, or OpenID Connect Authentication Method'
and updated it

February 2021

These topics are added:
• Prerequisites for Using the Activity Booking Options
These topics are updated:
• Activity Booking
• Create a Layout for Booking an Activity
• Time Slot Page Configuration
• General Tab
• Add an Inventory Type
• Pre-Calculated Travel Statistics
• Add a Theme
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November 2020

These topics are added:
• Add an External Plug-In to the Main Menu

Notes

• Configure the Visibility for Booking Status, Quota, and
Available Capacity Pages
• Configure the Fields for Print Route
These topics are updated:
• Add a Login Policy

August 2020

These topics are added:
• Default Translations and Date-Time Format
• Example of NGINX Configuration
• Example of How You Can Open a Where Is My
Technician URL With a Custom Domain in iFrame
• Fields that cannot have the Barcode/QR Code Scanner
Option
• Add Resource History to the Resource Info Context
Layout Structure
• Add the Access Schedule Fields to a Screen
These topics are updated:
• Set Your Language
• Available Placeholders on the Localization Tab
• Configure the Where is My Technician Theme
• How to Use 'Time Notified'
• Screen Configuration Settings
• Add a Login Policy
• Define the Settings for a Scenario Step
• Define Message Content
• Extraction Files and Extraction Data Sets
• Add Access Schedule Fields
These topics are removed:
• Associate a Resource with a User Account
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